User's Manual

HP CERJAC 156MTS
SONET Maintenance Test Set
Warranty

The information contained in this document is subject to change without notice.

Hewlett-Packard makes no warranty of any kind with regard to this material, including, but not limited to, the implied warranties of merchantability and fitness for a particular purpose.

Hewlett-Packard shall not be liable for errors contained herein or for incidental or consequential damage in connection with the furnishing, performance, or use of this material.

Trademark Credits

Windows® is a registered trademark of Microsoft Corporation. SLC®-96 is a registered trademark of AT&T. All other trademarks are the property of their respective owners.

ISO Certification

Hewlett-Packard Service Test Division (STD) is an International Standards Organization (ISO) 9001 registered company, recognizing that the quality system operated by STD meets the requirements established in accordance with ISO 9001. The CERJAC 156MTS is manufactured by STD in strict compliance with this quality system.

STD received ISO 9001 certification (no. 6969) from National Quality Assurance (NQA) on August 30, 1995.

CERJAC Telecom Operation
2 Robbins Road
Westford, Massachusetts 01886 USA
Safety Notices

The following safety precautions must be observed whenever the 156MTS is operated, serviced, or repaired. Failure to comply with these and other specific warnings and cautions within this manual is a violation of Hewlett-Packard’s safety standards of design, manufacturing, and intended use of the test set.

Hewlett-Packard assumes no liability for the operator's failure to comply with these precautions.

Electric Shock Hazard

**Warning!** Do not remove the system covers. To avoid electric shock, use only the supplied power cords and connect only to properly grounded (three-pin) wall outlets.

Fire Hazard

**Caution!** For continued fire protection, use only fuses with the properly rated current, voltage, and type (see page 27–6). Disconnect power before replacing fuse.

Explosion Hazard

**Warning!** Do not operate the instrument in the presence of flammable gases.

Hazardous Material

**Warning!** If the LCD display is damaged, the liquid crystal material can leak. Avoid all contact with this material, especially swallowing. Use soap and water to thoroughly wash all skin and clothing contaminated with the liquid crystal material.

Cleaning

To clean the instrument use a damp cloth moistened with a mild solution of soap and water. Do not use harsh chemicals. Do not let water or other liquids get into the instrument.

Product Damage

**Caution!** Do not use this product if it shows visible damage, fails to perform, has been stored in unfavorable conditions, or has been subject to severe transportation stresses. Make the product inoperative and secure it against any unintended operation. Contact your Hewlett-Packard representative for assistance.

Lithium Battery

**Caution!** Danger of explosion if battery is incorrectly replaced. Replace only with same or equivalent type recommended by the manufacturer. Discard used batteries according to manufacturer’s instructions.

Symbols

The following are general definitions of safety symbols used on equipment and in manuals.

⚠️ Instruction manual symbol. Indicates the user should refer to the instruction manual in order to protect against damage to the unit.

_VOLTAGE
dangerous voltage.

GROUND Protective ground.

FRAME Frame or chassis ground.

AC Alternating current.

DC Direct current.

AC Alternating or direct current.
About This Book

Quick Start
Chapter 1, About the CERJAC 156MTS, includes brief topics that will help you get up and running quickly:

- The 156MTS at a glance
- Auto Test
- Trouble Scan

How To Test
These chapters contain step-by-step procedures for using the test set:

- Chapter 2, Testing SONET Networks
- Chapter 6, DS3 Network Testing
- Chapter 10, DS1, DS0, and FT1 Network Testing
- Chapter 14, E1 and Timeslot Network Testing
- Chapter 18, ATM Network Testing

Reference
These chapters contain reference information for the setup parameters:

- Chapter 3, SONET Configuration Reference
- Chapter 7, DS3 Configuration Reference
- Chapter 11, DS1, DS0, and FT1 Configuration Reference
- Chapter 15, E1 and Timeslot Configuration Reference
- Chapter 19, ATM Configuration Reference

Measurements
These chapters describe the error and alarm results:

- Chapter 4, SONET Measurement Reference
- Chapter 8, DS3 Measurement Reference
- Chapter 12, DS1 Measurement Reference
- Chapter 16, E1 Measurement Reference
- Chapter 20, ATM Measurement Reference

General Information
Chapters 22 through 27 contain general information about your 156MTS such as store and recall functions, global and auxiliary setups, printing, remote control, and downloading software.
About this Version

Applicability

This version of the HP CERJAC 156MTS User's Manual applies to HP E4480A 156MTS SONET maintenance test sets running operating software version 6.40. Some functions of 156MTS test sets running earlier versions of the software may operate differently; some functions of test sets running later software versions may not be covered by this manual. Be sure to refer to any user manual supplements or release notes that came with your set, or call CERJAC at 1-800-9-CERJAC.

E4480A CERJAC 156MTS User’s Manual printing history

<table>
<thead>
<tr>
<th>Version number</th>
<th>Release date</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>March, 1997</td>
<td>First release.</td>
</tr>
<tr>
<td>2.0</td>
<td>December, 1997</td>
<td>Updated to cover Release 6.40 (new ATM and other features).</td>
</tr>
</tbody>
</table>

Check the Software Version

You can check the version number of the operating software in your test set by observing the display during power-up. You can also view the software version at any time using the System Software Configuration screen (see System Software Revision, page 1-11).

Check the Installed Options

You can check the options installed in your test set using the System Software Configuration and System Hardware Configuration screens. See Hardware Configuration, page 1-11.
Contents

1

About the CERJAC 156MTS  1-1
At a Glance  1-2
Navigation Keys  1-5
The Control Screens Menu  1-5
To Perform an Auto Setup Test  1-6
To Use Trouble Scan  1-7
To Restore the Default Settings (Cold Start)  1-8
To Perform a Terminal Mode Test  1-9
To Display More Measurement Screens  1-10
To View System Information  1-11
About the Basic Testing Modes  1-12

2

Testing SONET Networks  2-1
To Set up for SONET Testing  2-2
To Configure the APS functions (K1/K2 bytes)  2-4
To Configure SONET Overhead Parameters  2-5
To Configure SONET Datalinks  2-7
To Inject SONET Alarms  2-8
To Run Pointer Adjustment Sequences  2-9
To Run a VT1.5 Test  2-11

3

SONET Configuration Reference  3-1
STS-N Setup Parameters  3-2
STS-1/OC-1 Signal Setup Parameters  3-4
Optical Transmitter Power-up State  3-6
STS-1 Payload Setup Parameters  3-7
STS-Nc Payload Setup Parameters  3-9
SONET Automatic Protection Switching (APS) Parameters  3-11
SONET Overhead Parameters  3-13
SONET Datalink Control Parameters  3-18
VT Overhead Parameters  3-20
VT1.5 Setup Parameters  3-23
Error Injection  3-28
4 SONET Measurement Reference 4-1
OC-N/STS-N Measurement Summary Screen 4-4
Section Code Violations (B1) Screen 4-5
Line Code Violations (B2) Screen 4-6
REI-L Measurements Screen 4-7
Path Measurement Summary Screen 4-8
Path Code Violation (B3) Screen 4-9
REI-P Measurements 4-10
STS-12c and STS-3c Bit Error Measurements 4-11
STS Frame Measurements (A1/A2) Screen 4-12
STS-1 BPV Measurements Screen 4-13
STS N Pointer Measurements Screen 4-14
STS-12c Pointer Bytes Screen 4-15
APS Measurements Screen 4-15
Transport Overhead Screen #1 and Screen #2 4-19
Path Overhead Screen 4-20
STS-N Path Trace (J1) Screens and OC-12 Section Trace (J0) Screens 4-21
STS-1 Signal Measurements 4-22
STS-1 Jitter Measurements 4-23
STS-N Alarm Screens 4-24
STS-N Status Screen 4-26
VT Indicators 4-27
VT1.5 Measurement Summary Screen 4-28
VT1.5 Code Violations Screen 4-29
VT1.5 FEBE Measurements Screen 4-30
VT1.5 Pointer Measurements Screen 4-31
VT1.5 Path Overhead Screen 4-31
VT1.5 Path Trace Byte (J2) Values (1-32 and 33-64) 4-32
VT Alarm Screens 4-33

5 SONET Specifications 5-1
SONET Electrical Interfaces 5-2
OC-N Optical Interfaces 5-5
STS-N Timing 5-6
STS-1 Jitter Option Specifications 5-7
SONET Formats 5-8
VT1.5 Format and Mapping 5-12
6 DS3 Network Testing  6-1
Set up for DS3 Testing  6-2
Configure the DS3 Signal  6-4
Configure the DS3-B Signal (Dual DS3 only)  6-5
Configure Other Signal Parameters  6-6
Configure DS3 Overhead Parameters  6-7
Configure the DS3 User Test Pattern  6-9
Run the DS3 Test  6-10
Perform a DS3 Pulse Mask Test  6-11

7 DS3 Configuration Reference  7-1
DS3 Setup Parameters  7-2
Dual DS3 Setup Parameters  7-5
DS3 FEAC Channel Parameters  7-8
DS3 C-Bit Configuration  7-11
DS3 Pulse Mask Configuration  7-12
User-Programmable DS3 Pattern  7-14
DS3 Datalink Parameters  7-15
DS2 X-Bit Control  7-16
DS3 and DS2 Error Injection  7-17

8 DS3 Measurement Reference  8-1
DS3 Indicators  8-2
About Dual-DS3 Measurements  8-3
DS3 Summary Screen  8-3
Bit Error Measurements Screens 1, 2, and 3  8-4
DS3 P-Bit Parity Measurements Screen  8-6
DS3 CP-Bit Parity Measurements Screen  8-7
DS3 Frame Measurements Screen  8-8
DS3 FFCV Measurements Screen  8-9
DS3 BPV Measurements Screen  8-10
DS3 FEAC Monitor Screen  8-11
DS3 C-Bit Monitor Screen  8-12
DS3 P-Bit and X-Bit Monitor Screen  8-12
DS3 Alarm Screens  8-13
DS3 Signal Measurements Screen  8-15
Jitter Measurements Screen  8-16
Contents

DS3 Status Screen 8-17
DS3 Pulse Mask Screens 8-18
DS2 Status Screen 8-20
DS2 Alarm and History Screen 8-21

9 DS3 Specifications 9-1
DS3 Interfaces 9-2
Data Link Interfaces 9-3
Jitter Option Specifications 9-4
DS3 (44.736 Mbs) and DS2 Signal Formats 9-5

10 DS1, DS0, and FT1 Network Testing 10-1
Set up for DS1 Testing 10-2
Configure the DS1 Signal 10-4
Configure the ESF Datalink Message 10-5
Configure DS1/E1 User Test Patterns 10-6
Configure the FT1 Signal 10-7
Configure the DS0 Signal 10-8
Configure Other Signal Parameters 10-11
Loopback the Far End 10-12
Run the DS1 Test 10-14
Run an Automatic DS1 Drop Scan 10-15
Run an Automatic DS0 Signaling Scan 10-17

11 DS1, DS0, and FT1 Configuration Reference 11-1
DS1 Setup Parameters 11-2
Additional DS1 Setup Parameters 11-7
DS1 and DS0 Error and Alarm Injection 11-8
FT1 Setup Parameters 11-9
DS0 Setup Parameters 11-10
User-Programmable DS1/E1 Patterns 11-13
DS1 Loop Codes 11-14
DS1 Data Link Parameters 11-16
DS1 Drop Scan Sequence 11-17
DS0/Timeslot Signaling Scan 11-19
Contents

12 DS1 Measurement Reference 12-1
   DS1 Indicators 12-2
   DS1 Measurement Summary Screen 12-3
   DS1 Bit Error Measurement Screens 12-4
   DS1 Block Error Measurements Screen 12-6
   DS1 CRC-6 Error Measurements Screen 12-7
   DS1 Frame Error Measurements Screen 12-8
   DS1 Combined Frame and CRC Errors Screen 12-9
   DS1 BPV Measurements Screen 12-10
   DS1 Slips Screen 12-11
   DS1 Idle/CDI Detection Screen 12-12
   DS1 ESF Datalink Display Screen 12-13
   DS1 Loop Code Display Screen 12-13
   DS1 Signal Measurements Screen 12-14
   Jitter Measurements 12-15
   DS1 Alarm Screens 12-16
   DS1 Status Screen 12-18
   DS0 VF Measurements Screen 12-19
   DS0/TS Bit Error Measurements Screen 12-20
   FT1 Measurement Summary Screens 12-21
   FT1 Bit Error Measurement Screens 12-22

13 DS1/DS0/FT1 Specifications 13-1
   DS1/DS0 Interfaces 13-2
   Data Link Interfaces 13-4
   Jitter Option Specifications 13-5
   DS1 Signal Formats—1.544 Mbs 13-6

14 E1 and Timeslot Network Testing 14-1
   Set up for E1 Testing 14-2
   Configure the E1 Signal 14-4
   Configure the Programmable Patterns 14-5
   Configure the DS3 and Higher-rate Signals 14-6
   Configure the Timeslot Parameters 14-7
   Configure the FE1 Signal 14-9
   Run the E1 Test 14-10
   Run an Automatic E1 Timeslot Signaling Scan 14-11
15 E1 and Timeslot Configuration Reference 15-1
   E1 Setup Parameters 15-2
   E1 to DS3 Mapping 15-5
   E1 Timeslot (TS) Setup Parameters 15-6
   Fractional E1 Setup Parameters 15-9
   E1 and TS Error and Alarm Injection 15-10

16 E1 Measurement Reference 16-1
   E1 Indicators 16-2
   E1 Measurement Summary Screen 16-3
   E1 Bit Error Measurement Screens 16-4
   E1 Block Error Measurements Screen 16-7
   E1 TS0 Frame Error Measurements Screen 16-8
   E1 CAS Frame Error Measurements Screen 16-9
   E1 CRC-4 Error Measurements Screen 16-10
   E1 BPV Measurements Screen 16-11
   E1 Slips Screen 16-12
   E1 Signal Measurements Screen 16-13
   Jitter Measurements 16-14
   E1 Alarm Screens 16-15
   E1 Status Screen 16-17
   E1 Timeslot Measurements Screen 16-18
   DS0/TS Bit Error Measurements Screen 16-19

17 E1 Specifications 17-1
   E1/TS Interfaces 17-2
   Jitter Option Specifications 17-4
   E1 Signal Format—2.048 Mbs 17-5

18 ATM Network Testing 18-1
   Run an Automatic VP/VC Scan 18-2
   Run a Cell Capture Test 18-4
   Set up for ATM Testing 18-7
   Choose an ATM Test Mode 18-8
   Configure Global ATM Parameters 18-10
   Configure the ATM Foreground Channel (no traffic shaping) 18-11
   Configure the ATM Foreground Channel (with basic traffic shaping) 18-12
Contents

Set ATM Cell Payloads 18-13
Set the Foreground, Idle and Receive VP/VC 18-14
Configure the ATM Background Channels (traffic shaping off) 18-15
Configure the ATM Background Channels (with basic traffic shaping) 18-16
Configure Misinserted Cell Errors 18-18
Setup for STS-12c ATM Testing 18-19
Run the ATM Test 18-21

19 ATM Configuration Reference 19-1
ATM Traffic Selection 19-2
About Cell Transmission 19-2
The ATM Setup Menu 19-3
Global ATM Parameters (ATM SETUP #1) 19-4
Foreground Channel Control Parameters (ATM SETUP #2) 19-6
Cell Payload Parameters (ATM SETUP #3) 19-12
Header Setup Parameters and Receive Cell Type (ATM SETUP #4) 19-13
Background Channel Control Parameters (ATM SETUP #5) 19-17
Background Payload Data Parameters
(ATM SETUP #6—traffic shaping on) 19-19
Background Header Setup Parameters
(ATM SETUP #6—traffic shaping off; ATM SETUP #7—traffic shaping on) 19-20
Misinserted Cell Error Control Parameters
(ATM SETUP #7—traffic shaping off; ATM SETUP #8—traffic shaping on) 19-21
STS-12c ATM Parameters 19-22
ATM Error Injection 19-23

20 ATM Measurement Reference 20-1
ATM Indicators 20-2
ATM Measurement Summary Screen 20-3
Selected VP/VC Measurement Screens 20-4
Total Cell Stream Measurement Screens 20-6
ATM Payload Bit Error Measurements Screen 20-9
ATM AAL-1 Cell Loss Measurements Screen 20-10
ATM AAL-1 SN CRC/Par Error Measurements Screen 20-11
ATM AAL-1 Misinserted Cell Measurements Screen 20-12
ATM Delay Measurements 20-13
ATM OAM Alarm Status 20-14
ATM OAM Alarm Seconds 20-15
PLCP Measurement Screens (DS3 only)  20-16
ATM Alarm Status  20-20
ATM Alarm Seconds  20-21

21 ATM Formats  21-1
Basic Cell Structure  21-2
AAL-0 Cell Implementation  21-2
AAL-1 Cell Implementation  21-3
AAL-3/4 Cell Implementation  21-3
AAL-5 (SEAL) Cell Implementation  21-4
ATM Test Cell Structure  21-4
Physical Layer Convergence Protocol (PLCP)  21-5

22 Store and Recall Functions  22-1
Configuration Storage and Retrieval  22-2
Results Storage and Retrieval  22-5
Event Logging  22-7

23 Global, Auxiliary, and Administrative Setups  23-1
Global Settings  23-2
Auxiliary Test Setup Parameters  23-4
Administrative Setup Parameters  23-8

24 Printing  24-1
Set up for Printing  24-2
Configure Automatic Printing  24-3
Print on Demand  24-4

25 Using Remote Control  25-1
About Remote Control  25-2
Remote Front Panel at a Glance  25-3
Setup for Remote Front Panel Operation  25-4
Use Remote Front Panel Operation  25-6
Setup for SCPI/IEEE-488 Remote Operation  25-7
Use the SCPI/IEEE-488 Interface  25-8
Using an Answer-only Modem  25-9
26 Downloading Operating Software  26-1
   About Software Downloading  26-2
   Download Procedure  26-3
   About the DOWNLOAD Program  26-6

27 General Specifications  27-1
   Printer and Control Ports  27-2
   Data Link Interfaces  27-4
   Physical and Electrical Characteristics  27-6
   About Error Injection Rates  27-7

Glossary  1
Index  1
1

At a Glance 1–2
   The Front Panel 1–2
   The Rear Panel 1–3
   LCD Display—Test Operation Screen 1–4
   LCD Display—Main Menu 1–4

Navigation Keys 1–5

The Control Screens Menu 1–5

To Perform an Auto Setup Test 1–6

To Use Trouble Scan 1–7

To Restore the Default Settings (Cold Start) 1–8

To Perform a Terminal Mode Test 1–9

To Display More Measurement Screens 1–10

About the Basic Testing Modes 1–12

About the CERJAC 156MTS
At a Glance

The Front Panel

Memory keys (see pg 22–5)
Error Inject & Action/Local keys
Auto Setup key (see pg 1–6)
Start/Stop keys

Contrast & Speaker keys
LCD Display (see pg 1–4)
Navigation keys (see pg 1–5)
Trouble Scan key (see pg 1–7)
Optical Signal connectors

DS3 Alarm & Status LEDs (see pg 8–2)
DS1/E1 Alarm & Status LEDs (see pg 12–2 and pg 16–2)
History Reset key
STS-N Alarm & Status LEDs (see pg 4–2)
Power switch

VT Alarm & Status LEDs (see pg 4–27)
ATM Alarm & Status LEDs (see pg 20–2)

Print & Display Held keys

Quick Start
About the CERJAC 156MTS

At a Glance

The Rear Panel

- Serial printer port
- Serial remote control port
- Optional connector panel
- Demodulated jitter output
- STS-1 Tx Clock input
- GPIB remote control port
- AC input and fuse
- Cooling fan

DS1/E1 signal input/output
SONET orderwire port
DS3 Error out and Tx Clock in connectors

Data Link drop and insert ports
DS0/TS Signaling TTL interface
VF/DS0/TS input/output connectors
DS1/E1 timing and error connectors

Error burst trigger input
About the CERJAC 156MTS

At a Glance

LCD Display—Test Operation Screen

Final or Elapsed time

Test Mode label
(see About the Basic Testing Modes, pages 1–12)

Memory buffer number

Measurement results screen
(scrolling controlled by RESULT)

Test configuration screen
(scrolling controlled by CONFIG)

---

1 STS1-STS1 (DS3/1) Final: 00:03:09.59
Trouble Scan >>>>>>>>
No Errors or Alarms

DS1: TxClk>Int Frm>SF Data>ORSS
Ins>1 Other DS1s>Same Drop>1
DS3: TxClk>Int Frm>M13 XBit>1
STS1: TxClk>Int Scramble>On
Tx>STS1 Rx>STS1
Err/Alm:Type>DS1 Data Rate>Single

---

LCD Display—Main Menu

Automatic setup
(see pg 1–6)

Test modes
(see pg 1–12)

Automatic sequences

General system setup
(see pg 23–1)

Configuration storage
(see pg 27–2)

---

MODEL 156 MAIN MENU

Auto Setup
Terminal Testing
Monitor Testing
Drop & Insert Testing
DS3/DS1/ATM Scans & Pointer Sequences
Setup System Parameters
Store and Recall Configurations

Press FIELD to highlight item, then
Press MENU to select item.
Navigation Keys

- Moves up and down through menu levels: ▲ MENU ▼
- Scrolls top half of display: ◄ RESULT ►
- Scrolls bottom half of display: ◄ CONFIG ►
- Selects parameters or menu items: ◄ FIELD ►
- Changes values of selected parameters: ◄ VALUE ►

The Control Screens Menu

Test Operation Screen

Control Screen Menu
- Global Settings
- Data Link Control
- Alarm Control
- PnP Control
- O2 Sensor
- Setpoint

Use CONFIG to scroll the display

Use FIELD to select a menu item

Selected Control Screen
- Modify
- Modify Config
- Results Log
- Inhibit Error
- Reset
- No
- Abort

Use FIELD & VALUE to make changes on the control screen
About the CERJAC 156MTS

To Perform an Auto Setup Test

---

To Perform an Auto Setup Test

1. Press the AUTO SETUP key.

   The Auto Setup Status screen is displayed.

   When the 156MTS detects a signal, it checks for subrate traffic. If there is traffic, the set prompts you to select a channel.

2. Use FIELD to highlight a channel. Press MENU down to proceed.

   The 156MTS configures itself to the signals format and test pattern, and then enters to appropriate terminal test mode.

3. Use the TROUBLE SCAN or RESULT keys to view test measurements.

---

Press the AUTO SETUP key.

The set begins to scan for input signals.

Connect an input signal or press MENU to leave AUTO SETUP

Apply an input signal.

Select a subrate channel on the signal, if necessary.

Use the RESULT keys to view measurements.
To Use Trouble Scan

A test must be running; if necessary, press START.

- Press the TROUBLE SCAN key.

Trouble Scan is automatically activated and the Trouble Scan display is automatically displayed.

The Trouble Scan display shows a summary of alarms and errors that have been detected.

**Note:** You can deactivate the Trouble Scan feature using the Global Settings control screen. See *Trouble Scan Activation*, page 23–2.

You can also scroll to the Trouble Scan display using the RESULT keys.
To Restore the Default Settings (Cold Start)

The 156MTS powers on using the same configuration in which it was switched off. You can restore all 156MTS setup options to their factory defaults at any time using this "cold start" procedure. This is useful for returning the instrument to a known configuration.

1. Press the POWER switch to 0 to switch off the 156MTS.
2. Press and hold the STOP key.
3. While holding the STOP key, press the POWER switch to 1 to switch the unit on.

   The display shows the message "Performing Cold Start Powerup."

4. If you want to clear any stored configurations out of memory, quickly release the STOP key and press the START key.

   The display shows the message "Clearing Config Storage Buffers."

   • When the unit completes its start-up routine, the factory default configuration will be in effect.

For more information on configuration storage, see Configuration Storage and Retrieval, page 22-2.
To Perform a Terminal Mode Test

This is the basic procedure for performing a test with your 156MTS.

1. Switch on the 156MTS and connect the signal to be tested.
   Connect the received signal to an RX jack; connect the transmit
   signal to a TX jack.

2. Use FIELD to select Terminal from the Main Menu and press the
   MENU-down key.

3. Use FIELD and VALUE to configure the transmitter, receiver, and
   payload as appropriate for your application. Press MENU-down.

4. Use FIELD and VALUE to further configure the transmitter and
   receiver as necessary by setting the parameters in the lower half
   of the display. Use the CONFIG keys to scroll the lower half of
   the display.

5. Press START to begin the test.
   - To pause a test in progress, press START. The timer is stopped,
     but not reset. To continue the test press START again.
   - To freeze the display without pausing the test, press
     DISPLAY HOLD. Press the key again to resume.

6. Press the RESULT keys to view different measurement screens in
   the top half of the display.

Select the test.

Set up the transmitter, receiver,
and payload.

View results in the top half of
the display.

Set signal parameters in the bottom
of the display.
To Display More Measurement Screens

The 156MTS has two results levels: summary and detail. You can select the level of results that are displayed by following this procedure.

1. From a test operation screen press CONFIG-right to display the Control Screens menu.

   ![Control Screens Menu]

   1 DS3-DS3 (DS3)  Final: 00:00:00.00
   DS3 Bit:      --  Sec Ago:      --
   Fm:            --
   C-Bit:         --  P-Bit:         --
   BPU:           --

   Global Settings
   DS3 FEIC Control
   DS3 C-Bit Control
   Data Link Control
   DS3 Pulse Mask
   DS3 Rng Pattern

2. Select Global Settings and press CONFIG right.

   ![Global Settings Menu]

   Modify Global Configurations
   Modify Config While Running? No
   Results Level: Summary
   Trouble Scan: On
   Inhibit Errors on Alarm? Yes
   Inv PRBS? No
   Jitter Hits Thresh. (UL): MB>5.0 HB>0.2

3. Use FIELD to highlight the Results Level field and use VALUE to set it to Summary or Detail.

   Summary makes fewer, higher-level results screens available.
   Detail makes additional, more in-depth screens available.

4. Press CONFIG-right to return to the test operation screen.
To View System Information

1. Select **Setup System Parameters** from the Main Menu and press MENU-down. The Setup System Parameters menu is displayed.

2. To view the software versions select **System Software Configuration** from the Setup menu and press MENU-down.

   ![System Software Configuration](image)

   The revision of the software installed in your test set is displayed, as well the date of installation.

3. Press MENU-up to return to the Setup menu.

Hardware Configuration

1. To view the hardware configuration select **System Hardware Configuration** from the Setup menu and press MENU-down.

   ![System Hardware Configuration](image)

   The options installed in your test set are displayed.

2. Press MENU-up to return to the Setup menu.
About the Basic Testing Modes

The 156MTS features different test modes to meet the needs of different test applications. You configure the test mode as you set up the test set, selecting the test mode category (terminal mode, drop & insert mode, and so forth) and then configuring the transmitter, receiver, and payload.

Terminal modes

Terminal mode tests feature independent transmitter and receiver setup. Terminal modes are indicated on the display in the format:

\[ \text{TransmitRate–ReceiveRate (Payload)} \]

where TransmitRate is the type of signal assigned to the transmitter, ReceiveRate is the type of signal assigned to the receiver, and Payload is the type of traffic the signals are carrying.

About Terminal Mode Applications

Terminal mode testing is used with a variety of transmission and multiplexing equipment, and is generally performed in out-of-service conditions.

Use Terminal mode when you need a test signal as an input to the system being tested. Often, such as for a multiplexer or demultiplexer test, the test set transmits a test signal at one rate and receives a different rate back. In other applications, you might perform a straight transmission test in which the same rate is both transmitted and received from the system under test.

Monitor modes

Monitor mode tests feature identically configured transmitter and receiver signals, with a non-intrusive pass-through of the received signal. Monitor modes are indicated on the display in the format:

\[ \text{ReceiveRate–MON (Payload)} \]

where ReceiveRate is the type of signal assigned to the receiver (the received signal is passed through to the transmitter), and Payload is the type of traffic the input signal is carrying.

About Monitor Mode Applications

Monitor mode testing is used to examine an incoming signal, gather error and performance statistics, and log alarm conditions. The test set regenerates the monitored signal to provide downstream keep-alive signals. Monitor mode is useful with a variety of in-service applications.
About the CERJAC 156MTS

About the Basic Testing Modes

You can drop channels from a monitored signal using the STS-1, DS3, or DS1/E1 electrical monitor connectors. In addition, SONET signals are sometimes accessed by interrupting the optical protection line, or through the use of optical splitters. The optical signal can be connected to the test set, and then the set's output optical signal can be used to complete a SONET ring.

Note: Interrupting the optical line typically causes protection switching to occur on the SONET ring.

Drop & Insert modes

Drop and insert (D&I) mode tests feature identically configured transmitter and receiver signals, similar to monitor mode tests, but with the added capability to monitor and modify a substrate signal (channel). D&I modes are indicated on the display in the format:

Transmit&ReceiveRate–D&I (Payload)

where Transmit&ReceiveRate is the type of signal assigned to the transmitter and receiver, and Payload is the type of substrate channel on which measurements are performed.

About Drop & Insert Applications

D&I mode allows you test at the rate you need, even if the signal access is at a higher rate. As in Monitor mode, the test set passes the receive signal through to the transmit signal. D&I mode, however, allows you to select and examine a channel on the signal. In addition, you can modify the transmit channel (transmit a pattern, inject errors, and so forth).

D&I mode is also useful for performing out-of-service testing on a channel of a signal that is in-service. For example, if a SONET signal is carrying DS1 payloads, you can use D&I mode to test a single DS1 even though the network access may be at a SONET interface.
About the CERJAC 156MTS
To Set up for SONET Testing  2–2
To Configure the APS functions (K1/K2 bytes)  2–4
To Configure SONET Overhead Parameters  2–5
To Configure SONET Datalinks  2–7
To Inject SONET Alarms  2–8
To Run Pointer Adjustment Sequences  2–9
To Run a VT1.5 Test  2–11

Testing
SONET
Networks
To Set up for SONET Testing

Example SONET Application

1. On the Main Menu use FIELD to select a testing mode.

2. Press MENU down. The testing setup screen for the mode you selected is displayed.

   **TERMINAL TESTING**
   
   **Tx Rate:** OC12  
   **Rx Rate:** OC12  
   **Payload:** UT1.5 Async  

   Select Tx and Rx Rates first  
   then select payload.  
   Press MENU down to enter test mode.  
   Press MENU to return to Main Menu.

3. Use the FIELD and VALUE keys to select a SONET Tx Rate and Rx Rate as appropriate for your application. The rates do not have to be the same; optical and electrical rates can be configured simultaneously.

   SONET rates include OC-12, OC-3, and STS-1/OC-1. The rates available depend on the options installed in your test set.

   **Note:** For OC-1 applications, select STS1/OC1 here, and set Rx> to Optical in step 6.

   For concatenated applications, select an STS Nc payload.

4. Press FIELD to select Payload, and then use VALUE to select a payload appropriate for your application.
Testing SONET Networks

To Set up for SONET Testing

5. Press MENU-down. The SONET test operation screen is displayed. Note that the screen may appear different depending on your application.

![SONET Measurement Screen]

6. Use the FIELD and VALUE keys to configure other signal parameters in the lower half of the display. These parameters vary depending on the test you are running. Some of the key parameters include:

**STS1** or **STSN**: **TxClk**- Sets the transmit timing source for the selected SONET transmit signal.

**STS1 In**, **Other**, and **Drop**- Configures the STS-1s on higher-rate SONET signals.

**Tx** and **Rx**- Selects the connectors and levels for the transmit and receive signals.

**Note**: For OC-1, you selected **STS1** for **Tx Rate** and **Rx Rate** in step 3. Next set **Rx** to **Optical** for an OC-1 receive signal. Transmit OC-1 is available when the lasers are enabled (OC-N TX connector).

**Note**: If your 156MTS has rear-panel SONET electrical connectors installed, set **Rx** to **STS** to select them (the rear-panel transmitters are always active).

7. Connect the signals to be tested.

If you are using the optical transmitter, press the TX ON/OFF key to enable it (TX ON LED lights).
To Configure the APS functions (K1/K2 bytes)

The 156MTS allows you to control the automatic protection switching (APS) channel of the SONET signal. The APS channel comprises the K1 and K2 bytes of the SONET overhead.

1. From a SONET test operation screen, press CONFIG-right to scroll to the control screen menu.

2. Use FIELD to select APS Control and press CONFIG-right. The APS Control screen is displayed in the bottom half of the display:

   >Press ACTION to update K1,K2<
   New Values | Current Values
   K1:00 K2:00 (Hex)  |  K1:00 K2:00 (Hex)
   [Blank]        |  No Request
   1+1 Future (000) | 1+1 Future (000)

   The message being transmitted on the APS channel is shown on the right side of the APS Control screen. The new, user-editable message is displayed on the left side.

3. Use the FIELD and VALUE keys to set the APS channel values. As you make changes, the hexadecimal display of the K1 and K2 bytes also changes. The five fields of the APS control screen include:

   - **Message**: Selects the text of the APS message.
   - **Rqst**: Sets the request channel.
   - **Brdg**: Sets the bridged channel indicator.
   - **Architecture**: Sets the APS architecture used.
   - **Mode**: Sets the APS mode, except for the LFERF and LAIS alarms.

4. When you finish configuring the APS values, press the ACTION key to activate them. The Current Values side of the APS Control screen changes to reflect the new K1 and K2 bytes being transmitted.

5. Press CONFIG-right to return to the SONET test operation screen.
To Configure SONET Overhead Parameters

The overhead features provide control of SONET transport and path overhead, and SONET path trace configuration.

1. From a SONET test operation screen, press CONFIG-right to scroll the lower half of the display to the control screens menu.

2. Use FIELD to select **SONET OH Control** and press CONFIG-right. The SONET Transport Overhead Control screen is displayed:

   See Transport Overhead Control, page 3–14, for more information on setting the transport overhead bytes.

3. Use the FIELD and VALUE keys to edit the displayed bytes. Bytes shown as "xx" cannot be edited.

4. Press CONFIG-right when you have finished setting the transport overhead. The SONET Path Overhead Control screen is displayed:

   **SONET Path Overhead Control**
   
   J1: xx ----Press MENU-down to access the
   J1
   E3: xx     Path Trace Control Screen
   C2: 10
   G1: 00 (DS3 & STS3c payload modes only)
   F2: 00
   H4: 00 (DS3 & STS3c payload modes only)
   Z3: 00
   Z4: 00
   Z5: 00
   DS3 0-Bits: 00000000000000000000000000000000

2–5
Testing SONET Networks

To Configure SONET Overhead Parameters

5. Use FIELD and VALUE to edit the displayed path overhead bytes.

6. When you have finished setting the path overhead, press CONFIG-right. The J1 Path Trace Control screen is displayed:

```
J1 Path Trace Control
Program in: Hex

ARB-------- 41 52 42 00 00 00 00 00
------------- 00 00 00 00 00 00 00 00
------------- 00 00 00 00 00 00 00 00
------------- 00 00 00 00 00 00 00 00
------------- 00 00 00 00 00 00 00 00
------------- 00 00 00 00 00 00 00 00
------------- 00 00 00 00 00 00 00 00
------------- 00 00 00 00 00 00 00 00
```

7. Use VALUE to select hexadecimal or ASCII programming.

8. Use FIELD and VALUE to edit each J1 byte in the 64-byte STS Path Trace string. As you edit the bytes in either ASCII (left side of the screen) or in hexadecimal (right side of the screen), the corresponding value is displayed on the other side of the screen.

9. When you have finished, press CONFIG-right.

   • If you are testing OC-12, the J0 Section Trace Control screen is displayed. You can edit the values on this screen as you did the J1 Path Trace in step 8.

10. When you have finished, press CONFIG-right. The display returns to the SONET test operation screen.
To Configure SONET Datalinks

You can configure the routing of SONET datalinks to the rear panel datalink ports.

1. From a SONET test operation screen, press CONFIG-right to scroll to the control screens menu.

2. Use FIELD to select Data Link Control and press CONFIG-right. The Data Link Control screen is displayed:

   ![Data Link Control](image)

   The items listed on the screen vary depending on the configuration of your test set and the operating mode.

3. Use the FIELD and VALUE keys to select and change the datalink options.

   Note that selecting a datalink insert or pass-through mode overrides the programming on the SONET overhead controls screens (see To Configure SONET Overhead Parameters, page 2-5).

4. Press CONFIG-right when you have finished to scroll back to the test operation display.

See SONET Datalink Control Parameters, page 3-18, for datalink information.
To Inject SONET Alarms

You can inject SONET alarms when the transmit signal is set for a SONET rate.

**Note:** You can also insert errors on the SONET signal by selecting an appropriate error type and rate. See *SONET Error Injection Types*, page 3–28.

1. From a SONET test operation screen, press CONFIG-right to display the control screens menu.

2. Use FIELD to select **Alarm Control** and press CONFIG-right. The Set SONET Alarm Conditions screen is displayed in the lower half of the display:

   ```
   >Set SONET Alarm Conditions<
   LOF>off   STS PAIS>off
   LOF>off   STS PYEL>off
   LAIS>off   UT PAIS>off
   LFERF>off   UT PYEL>off
   STS LOPNTR>off   UT LOPNTR>off
   ```

3. Use FIELD to select the SONET alarm you want. Press VALUE to set the alarm **Off** or **On**. The alarm remains active until reset to **Off**.

4. Use the RESULT keys to scroll through the measurement screens and observe the effect of the SONET alarms you inject.

   In loop tests, the red front panel alarm indicators on the instrument light to indicate the presence of the received alarm. When the alarm is cleared, the amber history indicators light.

5. To clear the history indicators, press RESET HIST.

6. Press CONFIG-right to return to the test operation display.
To Run Pointer Adjustment Sequences

You can run automated H1/H2 pointer justification sequences to increment and decrement the pointer value, or cause a new data flag (NDF) condition.

1. From the Main Menu, use FIELD to select **DS3/DS1/ATM Scans and Pointer Sequences**.

   ![MODEL 156 MAIN MENU](image)
   
   Press FIELD to highlight item, then press MENU-down to select item.

2. Press MENU-down. The Test Sequences Menu menu is displayed, similar to the following:

   ![TEST SEQUENCES](image)
   
   - **HPPointer Increment**
   - **HPPointer Decrement**
   - **HPPointer New Data Flag (NDF)**
   - **DS1 Drop Scan**
   - **Signaling Scan**
   - **ATM Path/Circuit Scan**

3. Use FIELD to select the H1/H2 pointer sequence you want to run.
Testing SONET Networks

To Run Pointer Adjustment Sequences

4. Press MENU-down. The display shows the appropriate sequence operation screen.

5. Use VALUE to select an Increment/Decrement Rate.

6. Press FIELD and select a Configuration From setting (background test mode), if desired.

7. Next select a channel to be dropped from the SONET signal using the Drop Channel field. This field is only valid for OC-12 and OC-3 tests.

8. Press START to begin the test.
   - During the test press ACTION to control the pointer justification.
To Run a VT1.5 Test

Example VT1.5 Application

Set the VT Counting Mode

VTs can either be identified individually (from 1 through 28), or identified by their VT group and their position within that group (1 through 7 VT groups, 1 through 4 VTs in each group). For example, VT 18 corresponds to VT 3 of VT group 4.

1. From the Main Menu press FIELD to select Setup and press MENU-down. The Setup menu is displayed.

2. Select Global Test Setups from the Setup menu and press MENU-down. The Global Test Setups screen is displayed.

3. Press FIELD to select VT Counting Mode and use VALUE to select either VT Group or 1 to 28.
Testing SONET Networks

To Run a VT1.5 Test

Set Tx Rate, Rx Rate, and Payload

The VT1.5 testing features are available whenever Payload is set to VT1.5 Async or VT1.5 Byte Sync (the transmitter and receiver must each be set for a SONET rate—STS-1, OC-3, or OC-12).

1. From the Main Menu press FIELD to select either Terminal or Monitor testing mode.

2. Press MENU-down. The test setup screen for the mode you selected is displayed (this example shows Terminal testing mode).

   TERMINAL TESTING
   Tx Rate: OC3       Rx Rate: OC3
   Payload: VT1.5 Async

   Select Tx and Rx Rates first
   then select payload.

   Press ENTER to enter test mode.
   Press MENU to return to Main Menu.

3. Use VALUE to set the transmitter (Tx Rate) for a SONET rate. For Monitor mode the transmitter and receiver are set simultaneously (Tx/Rx Rate).

4. Press the right FIELD key and the use VALUE to set the receiver (Rx Rate) for a SONET rate. For OC-12, the rate must match the transmitter.

5. Next press the right FIELD key again to select the Payload parameter. Use VALUE to select VT1.5 Async or VT1.5 Byte Sync.

6. Press MENU-down. The VT1.5 test operation screen is displayed (see next section).
Testing SONET Networks

To Run a VT1.5 Test

Configure the DS1 Signal

- When you press MENU down from the testing mode setup screen, the VT1.5 test operation screen is displayed. Note that the screen may appear differently depending on the test mode you selected.

<table>
<thead>
<tr>
<th>1 OC3-OC3 (VT1.5) Final: 00:00:00.00</th>
</tr>
</thead>
<tbody>
<tr>
<td>OC3 Measurement Summary</td>
</tr>
<tr>
<td>B1 (Sect CU): --- Sec Ago: ---</td>
</tr>
<tr>
<td>B2 (Line CU): ---</td>
</tr>
<tr>
<td>OC3 Rx Hz: ---</td>
</tr>
<tr>
<td>STS-1 Drop Hz: ---</td>
</tr>
</tbody>
</table>

**Note:** For Monitor mode tests, the transmit functions are not available (transmit clock, insert channel, etc).

1. Use VALUE to set the DS1 test channel’s timing source.

2. Press the right FIELD key to select Frm and then use VALUE to set the DS1 test channel’s framing format.

3. Press FIELD again to select Data and then use VALUE to set the payload pattern for the DS1 signal.

   If you set Data to DS0, you can insert and drop DS0 channels on the DS1. To configure the DS0 parameters, see *Configure the DS0 Signal*, page 10–8.

- Next configure the VT1.5 and VT group parameters (see next section).
Testing SONET Networks

To Run a VT1.5 Test

Configure the VT1.5 Signal and VT Group

1. On the VT1.5 test operation screen, use FIELD and VALUE to set the VT1.5 signal and VT group mapping parameters.

```
1 OC3-OC3 (VT1.5) Final: 00:00:00.00
OC3 Measurement Summary
B1 (Sect CU): -- Sec Adj: --
B2 (Line CU): -- --
OC3 Rx Hz: --
STS-1 Drop Hz: --
```

STC1: TxClk:Int Frm>SF Data>ORSS
VT1.5: Ins>1 Other VT’s>Same Drop>1
VTGrp: Ins>1 Other Grp’s>Same Drop>1
STS1: Ins>1 Other STS’s>Same Drop>1
STS2: TxClk:Int Scramble>On Rx>OC
Err/Alm:Type>DS1 Data Rate>Single

Note: For Monitor mode tests, the transmit functions are not available (insert channel, other, etc).

2. Select the VT1.5: Ins> field and use VALUE to select the VT1.5s on which the DS1 test signal is to be inserted. See Insert VT Selection, page 3–23.

3. Select Other VT’s to set the remaining VT1.5s. See Other Transmit VT Groups, page 3–26.

4. Select Drop and use VALUE to set the VT1.5 to be dropped from the selected VT group on the receive signal.

5. Next use FIELD and VALUE to set the Ins, Other Grp’s, and Drop fields for the VT groups (if applicable). Ins and Other set the VT group on which the VT1.5 signal is inserted and dropped, as you selected in steps 2 through 4.

Configure the STS-1 and STS-N Signals

After you configure the VT1.5 and VT group parameters, you need to configure the SONET signal parameters.

Depending on your test configuration, you will need to set the STS-1 or STS-N timing source, scrambling, and input/output connectors. For STS-N applications, you must also set the STS-1 drop and insert mapping.

- To configure the SONET signals, see step 6, page 2–3.
testing Sonet Networks

To Run a VT1.5 Test

Run the VT1.5 Test

- After you have configured the VT1.5, STS-1, and STS-N parameters you are ready to begin the test.

1. Press START to begin testing. On the first line of the display the elapsed time begins to increment.

2. If you want to inject errors on the DS1 signal being inserted on the transmit VT1.5, use FIELD and VALUE to set the appropriate Err/Alm Type and Rate. Press ERROR INJECTION to activate and deactivate error injection.

3. Observe the Trouble Scan display for any detected errors. See To Use Trouble Scan, page 1–7

You can also use the RESULT keys to view different measurement screens in the top half of the display. You may need to adjust the results level to view more measurements (see To Display More Measurement Screens, page 1–10).

4. To end the test, press STOP.
Testing SONET Networks
SONET Configuration Reference
STS-N Setup Parameters

STS-N parameters are applicable when the test configuration involves a signal with a rate higher than STS-1. A typical STS-N setup screen appears similar to the following:

<table>
<thead>
<tr>
<th>DS3:</th>
<th>Frn&gt;M13</th>
<th>Data&gt;2^15-1</th>
</tr>
</thead>
<tbody>
<tr>
<td>TxClk&gt;Int</td>
<td>FFE&gt;111</td>
<td>X_Bi&gt;1</td>
</tr>
<tr>
<td>STS1:</td>
<td>In&gt;1,1</td>
<td>Other&gt;Same</td>
</tr>
<tr>
<td>Drop&gt;1,1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>STS1:</td>
<td>TxClk&gt;Int</td>
<td>Scramble&gt;On</td>
</tr>
<tr>
<td>Err:</td>
<td>Type&gt;DS3</td>
<td>Data&gt;</td>
</tr>
</tbody>
</table>

STS-N Transmit Timing Source

TxClk> selects the STS-N transmit timing source. The timing source for the STS-N signal is independent from the asynchronous signals that are mapped into the payload. TxClk> can be set to one of the following:

- **Int**: Timing is from the 156MTH's internal Stratum-3 clock.
- **Loop**: Timing is extracted from the receive SONET signal.
- **Ext BITs**: Timing is based on the signal applied at the rear-panel BITs connector.
- **Ext 52M**: Timing is based on the signal applied at the rear-panel STS1 TX CLK IN connector. This choice is not applicable for OC-12 unless the payload is set to an STS-12c or STS-3c selection.

Receive Signal Source

Rx> selects the input source for the receive SONET signal. This field is only displayed if your set has a rear-panel SONET electrical connector option (US2 or 205). Rx> can be set to one of the following:

- **OC**: Signal is received at the optical input port (OC-N RX).
- **STS**: Signal is received at the electrical input port (rear-panel ECL RX).

Note that the rear-panel transmit connection is always active.
SONET Configuration Reference

STS-N Setup Parameters

STS12 # Scheme selects how STS-1 channel numbers are displayed for STS-12. This parameter is on the Auxiliary Test Setups screen (accessed from the Setup System Parameters menu) and can be set as follows:

**STS3#, STS1#:** This is the default value. The STS-1s are identified by their position in one of the four STS-3s on the STS-12.

**Order of Transmission:** STS-1s are identified by their place in the STS-12 transmission sequence.

**Order at Mux Input:** STS-1s are identified by their place in the sequence before multiplexing.

The setting you select is used in the STSN: Ins>, Drop>, or D&I> fields in OC-12/STS-12 testing modes. For “order of transmission” and “order at mux input” modes, these fields can be set from 1 through 12. For “STS3#, STS1#” mode these fields can be set from 1,1 through 4,3.

The following table and the figure below show the correspondence between the different schemes.

<table>
<thead>
<tr>
<th>STS3#,STS1# Notation:</th>
<th>1,1 2,1 3,1 4,1 1,2 2,2 3,2 4,2 1,3 2,3 3,3 4,3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Order of Transmission:</td>
<td>1 2 3 4 5 6 7 8 9 10 11 12</td>
</tr>
<tr>
<td>Order at Mux Input:</td>
<td>1 4 7 10 2 5 8 11 3 6 9 12</td>
</tr>
</tbody>
</table>

![Diagram showing STS-12 numbering scheme](image-url)
STS-1/OC-1 Signal Setup Parameters

STS-1 signal parameters are applicable when the STS-1 involved in the test is not a subrate channel in a higher-rate (STS-N) signal. When STS-1 is the highest-level signal involved in the test, the STS-1 setup parameters appear on the screen similar to the following:

<table>
<thead>
<tr>
<th>DS3:</th>
<th>Frame</th>
<th>Data</th>
<th>XBit</th>
<th>FEBA</th>
<th>15-1</th>
</tr>
</thead>
<tbody>
<tr>
<td>TxClk&gt;Int</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Note: For OC-1 applications, select STS1/OC1 for the transmitter and receiver. The OC-N TX connector provides an OC-1 signal in parallel with the STS-1 TX signal. Set Rx> to Optical to use the OC-N RX connector for an input OC-1 signal. The test mode label on the first line of the display indicates STS1 for both electrical and optical tests.

STS-1 Transmit Timing Source

TxClk> selects the STS-1 and OC-1 transmit timing source. The timing source is independent from the asynchronous signals that are mapped into the payload. TxClk> can be set to one of the following:

- **Int:** Timing is from the 156MST's internal Stratum 3 clock.
- **Loop:** Timing is extracted from the receive SONET signal.
- **Ext BITS:** Timing is based on the signal applied at the rear-panel BITS connector.
- **Ext 52M:** Timing is based on the signal applied at the rear-panel STS1 TX CLK IN connector.

STS-1 Scrambler

Scramble> turns the STS-1 scrambler On or Off at the front-panel STS-1 RX and TX connectors and the OC-N RX and TX connectors. The scrambler is frame-synchronous with a length of 127. Scrambling provides for clock extraction during extended transmission of all-zeros or all-ones.
SONET Configuration Reference

STS-1/OC-1 Signal Setup Parameters

Transmit STS-1 Level

Tx> selects the STS-1 transmit signal level. STS1:Tx> can be set to one of the following:

STSX1: STSX-1 level signal. LBO of 450 feet simulated cable.

High: High-level signal. No LBO.

Low: Low-level signal. Flat loss from High level.

900': LBO added simulating 900 feet of cable.

Note: The level of the OC-1 signal present at the OC-N TX connector depends on the laser installed in your test set.

Receive STS-1 Level

Rx> selects the input source and level for the receive STS-1 (or OC-N) signal. STS1:Rx> can be set to one of the following:

STSX1: STS-1 signal is received at the front-panel electrical input port (STS-1 RX). Automatic equalizer for 0 through 900 feet of cable.

High: STS-1 signal is received at STS-1 RX. Nominal 1.110 Vpk input signal.

Low: STS-1 signal is received at STS-1 RX. Nominal 0.206 Vpk input signal.

Monitor: STS-1 signal is received at STS-1 RX. Up to 26 dBstsx flat loss.

Aux: STS-1 signal is received at the rear-panel STS-1 NRZ input.

Optical: OC-N signal is received at the optical input port (OC-N RX).

STS-1 Jitter Thresholds

For information on setting the jitter hits thresholds, see Jitter Threshold Configuration, page 23–3.
Optical Transmitter Power-up State

You can set whether the optical transmitter (OC-N TX) is on or off when the unit is switched on.

**Warning!** The optical transmitter installed in the 156MTS contains a Class 1 Laser Product. Avoid visual contact with the transmitter.

Access the Auxiliary Test Setups screen from the Setup System Parameters screen.

```
Auxiliary Test Setups
Test Dur. Mode: Continuous
Timer Duration: 00:01:00 (hh:mm:ss)
Auto. Print Mode: Off
Auto. Store Mode: Off
Pwr Up Optical Tx State: Last State
STS12 # Scheme: STS3#, STS1#
UT Counting Mode: UT Group
DS2 Tx-XBit: 0
DS1 Block Size: 2Kbit
DS1 LOP & ODF Hold0off: 0.0 Seconds
Bits C1k Out Derived from: STS-N Rx C1k
```

The Pwr Up Optical Tx State parameter can be set as follows:

- **Last State:** The test set repowers with the optical transmitter in the same state as when the unit was switched off.
- **On:** The test set repowers with the optical transmitter active.
- **Off:** The test set repowers with the optical transmitter off.

**Note:** Press the OC-N TX ON/OFF key to enable or disable the optical transmitter at any time.
STS-1 Payload Setup Parameters

STS-1 payload parameters are applicable when the tested STS-1 is a substrate channel mapped into a higher-rate (STS-N) signal. The STS-1 payload setup parameters appear on the screen similar to the following:

<table>
<thead>
<tr>
<th>DS3:</th>
<th>Frm&gt;M13</th>
<th>Data&gt;2^15-1</th>
</tr>
</thead>
<tbody>
<tr>
<td>TxCli&gt;Int</td>
<td>FEBE&gt;111</td>
<td>XBit&gt;1</td>
</tr>
<tr>
<td>STS1:</td>
<td>Ins&gt;1,1</td>
<td>Other&gt;Same</td>
</tr>
<tr>
<td></td>
<td>Drop&gt;1,1</td>
<td>Scramble&gt;on</td>
</tr>
<tr>
<td>STSN:</td>
<td>TxCli&gt;Int</td>
<td>Rx&gt;OC</td>
</tr>
<tr>
<td></td>
<td>Type&gt;DS3 Data</td>
<td>Rate&gt;Single</td>
</tr>
</tbody>
</table>

**Insert STS-1 Channel**

*Ins>* selects which STS-1 within an OC-3 or OC-12 signal is used for the transmit STS-1. For OC-3, *Ins>* can be set from 1 through 3. For OC-12, *Ins>* can be set from 1,1 through 4,3 or from 1 through 12 (you can change the STS-1 scheme numbering used for STS-12; see *STS-12 Channel Numbering Scheme*, page 3-3).

**Other STS-1 Channels**

*Other>* sets the payload for the remaining STS-1s (that are not selected by *Ins>* ) within the OC-3 or OC-12 transmit signal. *Other>* can be set as follows:

- **Same:** Fills the STS-1s with the same payload as the selected *Ins>* STS-1.
- **Unequ:** Sets the remaining STS-1s to unequipped (all zeros in the path overhead and payload).
- **Ext:** Fills the remaining STS-1s with the STS-1 signal applied at the front-panel STS-1 RX port (not applicable for OC-12).

**Drop STS-1 Channel**

*Drop>* selects which STS-1 within an OC-3 or OC-12 signal is used for the receive STS-1. For OC-3, *Drop>* can be set from 1 through 3. For OC-12, *Drop>* can be set from 1,1 through 4,3 or from 1 through 12 (you can change the STS-1 scheme numbering used for STS-12; see *STS-12 Channel Numbering Scheme*, page 3-3).
STS-1 Signal Scrambler

**Scramble**: Turns the STS-1 scrambler On or Off at the front-panel STS-1 RX and TX connectors. The scrambler is frame-synchronous with a length of 127. Scrambling provides for clock extraction during extended transmission of all-zeros or all-ones.

STS-1 Drop & Insert Channel

This parameter is only available for drop and insert mode (D&I) tests. The D&I field simultaneously sets the STS-1 insert and drop channels to the same number. For OC-3 D&I tests, D&I can be set from 1 through 3. For OC-12 tests, D&I can be set from 1,1 through 4,3 or from 1 through 12 (you can change the STS-1 scheme numbering used for STS-12; see STS-12 Channel Numbering Scheme, page 3–3).

STS-1 Drop & Insert Payload

This parameter is only available for drop and insert tests in which the payload is set for STS-1. **Data** selects the payload pattern of the transmit STS-1 channel, and can be set to one of the following:

- **Ext**: Uses the payload of an STS-1 signal applied at the front-panel STS-1 RX jack.
- **Unequ**: Sets the path overhead and payload to all-zeros.
- **Loop**: Retransmits the received data on the transmit channel.
SONET Configuration Reference

STS-Nc Payload Setup Parameters

STS-Nc Payload Setup Parameters

The 156MPS can supports SONET concatenated signals at STS-12c and STS-3c:

- STS-12c parameters are available when the transmitter and receiver are set for OC-12 and the payload is set for STS12c. The STS-12c setup screen appears similar to the following:

  $STS12c$: Data>2^15−1 Pror32>12345678
  $STSH$: TxClk>Int
  $Errr$: Type>STS12c Data Rate>Single

- STS-3c setup parameters are applicable whenever the Payload is set to STS3C in an OC-3 or OC-12 testing mode (requires Option URY). The STS-3c setup screen appears similar to the following:

  $STS3c$: Data>2^15−1
  $Insr1$: Other>Same
  $STSH$: TxClk>Int Rx>OC
  $Errr$: Type>DS3 Data Rate>Single

Payload

The Data field sets the payload data pattern for the concatenated signal. This field can be set as follows:

PRBSS: A pseudorandom bit sequence. Choices include $2^{15}$−1, $2^{20}$−1, $2^{23}$−1, and $2^{31}$−1 ($2^{15}$−1 indicates a $2^{15}$−1 PRBS; $2^{31}$−1 available for STS-12c only).

Prog32: A repeating, user-programmable, 32-bit pattern. The bit values are defined by the Prog32 field (see below).

All Ones: A repeating, all binary ones pattern.

Live: No pattern. The receiver does not try to synchronize to a pattern. The transmitter sends the last selected pattern.
SONET Configuration Reference

STS-Nc Payload Setup Parameters

Programmable Pattern

(STS-12c only) The **Prog32>** field defines the user-programmable STS-12c pattern. This pattern is transmitted when the **Data>** field is set to **Prog32** (see above). Each digit in the **Prog32** value can be set from 0 through F (hexadecimal). The resulting value is converted to binary to form the 32-bit user pattern.

Insert STS-3c Channel

(STS-3c/OC-12 Tx only) **Ins>** selects which STS-3c channel within the OC-12 signal is used for the transmit STS-3c. **Ins>** can be set from 1 through 4.

Other STS-3c Channels

(STS-3c/OC-12 Tx only) **Other>** sets the payload for the remaining STS-3c channels (that are not selected by **Ins>**) within the OC-12 transmit signal. **Other>** can be set as follows:

- **Same**: Fills the STS-3c channels with the same payload as the selected **Ins>** STS-3c.
- **Unequ**: Sets the remaining STS-3c channels to unequipped (all zeros in the path overhead and payload).

Drop STS-3c Channel

(PTS-3c/OC-12 Rx only) **Drop>** selects which STS-3c within the OC-12 signal is used for the receive STS-3c. **Drop>** can be set from 1 through 4.

STS-3c Drop & Insert Channel

This parameter is available only for drop and insert mode tests (PTS-3c D&I tests are available only on OC-12 signals). The **D&I>** field simultaneously sets the STS-3c insert and drop channels to the same number. **D&I>** can be set from 1 through 4.
SONET Automatic Protection Switching (APS) Parameters

The 156MTS can transmit messages on the automatic protection switching channel (APS—K1 and K2 bytes). The APS parameters are accessed by selecting APS Control from the Additional Test Controls menu.

**APS Message**

The first field selects the APS message to be transmitted. The text of each message is displayed with its corresponding bit sequence (bits 1–4 of K1). The available messages are listed in the following table.

**APS Messages**

<table>
<thead>
<tr>
<th>APS Message</th>
<th>K1 Byte Display (hex)</th>
<th>Bit Sequence</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Request</td>
<td>0x</td>
<td>0000</td>
</tr>
<tr>
<td>Do Not Revert</td>
<td>1x</td>
<td>0001</td>
</tr>
<tr>
<td>Reverse Request</td>
<td>2x</td>
<td>0010</td>
</tr>
<tr>
<td>Not Used</td>
<td>3x</td>
<td>0011</td>
</tr>
<tr>
<td>Exercise</td>
<td>4x</td>
<td>0110</td>
</tr>
<tr>
<td>Not Used</td>
<td>5x</td>
<td>0101</td>
</tr>
<tr>
<td>Wait-to-Restore</td>
<td>6x</td>
<td>0110</td>
</tr>
<tr>
<td>Not Used</td>
<td>7x</td>
<td>0111</td>
</tr>
<tr>
<td>Manual Switch</td>
<td>8x</td>
<td>1000</td>
</tr>
<tr>
<td>Not Used</td>
<td>9x</td>
<td>1001</td>
</tr>
<tr>
<td>SD-Low Priority</td>
<td>Ax</td>
<td>1010</td>
</tr>
</tbody>
</table>
### APS Messages, continued

<table>
<thead>
<tr>
<th>APS Message</th>
<th>K1 Byte Display (hex)</th>
<th>Bit Sequence</th>
</tr>
</thead>
<tbody>
<tr>
<td>SD-High Priority</td>
<td>Bx</td>
<td>1011</td>
</tr>
<tr>
<td>SF-Low Priority</td>
<td>Cx</td>
<td>1100</td>
</tr>
<tr>
<td>SF-High Priority</td>
<td>Dx</td>
<td>1101</td>
</tr>
<tr>
<td>Forced Switch</td>
<td>Ex</td>
<td>1110</td>
</tr>
<tr>
<td>Lockout Protect</td>
<td>Fx</td>
<td>1111</td>
</tr>
</tbody>
</table>

**Requested Channel**

R<sub>qst</sub>&gt; determines the requested channel to which the message applies. The binary value of the channel number (0–15 = 0000–1111) is sent in bits 5–8 of K1. This is shown on the display in hex (the second digit of K1).

**Bridge Channel**

B<sub>rdg</sub>&gt; determines the bridge channel. The binary equivalent of the channel number (0–15 = 0000–1111) is transmitted in bits 1–4 of K2. This value is shown on the display in hexadecimal (the first digit of K2).

**Architecture**

The fourth field indicates the APS architecture, and corresponds to bit 5 of the K2 byte. For 1+1 bit 5 is set to 0; for 1:n bits 5 is set to 1.

**APS mode**

The fifth field indicates the APS mode. This field can be set as follows:

- **Unidirection**: Bit sequence = 100 (Bits 6–8 of K2).
- **Bidirection**: Bit sequence = 101.
- **Future**: Bit sequences = 000 through 011.
- **LFERF Alarm**: Bit sequence = 110.
- **LAIS Alarm**: Bit sequence = 111.

**Note**: LFERF and LAIS cannot be set from this screen, but will be displayed if received. To transmit SONET alarms, see *SONET Alarm Types*, page 3–29.
SONET Overhead Parameters

The 156MTS provides extensive control of SONET transport and path overhead configuration, and SONET path trace configuration.

SONET overhead control is accessed through the Control Screens menu. These parameters are available when the instrument is configured for SONET rates.

When you select SONET OH Control from the Control Screens menu and press CONFIG-right, a series of screens is presented. These screens give you access to the following SONET overhead parameters:

- Transport overhead bytes.
- Path overhead bytes.
- J1 Path trace string.
- J0 Section trace string (for OC-12 only).

Two additional screens provide access to VT overhead parameters (see VT Overhead Parameters, page 3–20).
SONET Configuration Reference

SONET Overhead Parameters

Transport Overhead Control

The SONET Transport Overhead Control screen allows you to program the values for the transport overhead bytes. Bytes shown as \textit{xx} cannot be edited on this screen.

![SONET Transport Overhead Control Screen]

\textbf{Note:} For STS-12c, the \textbf{C1: xx} byte is replaced by \textbf{J0: xx}. You can edit the \textbf{J0} Section Trace string using the Section Trace Control screen (see page 3-16).

\textbf{Transport Overhead Bytes:} Each byte value can be set in hexadecimal from \textbf{00} through \textbf{FF}.

\begin{table}[h]
\centering
\begin{tabular}{|l|l|}
\hline
\textbf{Byte} & \textbf{Description} \\
\hline
E1 & Section orderwire \\
\hline
F1 & Section user channel \\
\hline
D1, D2, D3 & Section data communication channel \\
\hline
K1, K2 & APS channel. See \textit{APS Message}, page 3-11. \\
\hline
D4–D12 & Line data communication channel \\
\hline
Z1 & S1 (STS-1 #1): Synchronization status. Z1 (other STS-1s): Growth. \\
\hline
Z2 & M0 (STS-1/OC-1 signals only): bits 5–8 = line FEBE M1 (STS-1 #3 of STS-N≥3 signals): Line FEBE Z2 (other STS-1s): Growth \\
\hline
E2 & Line orderwire \\
\hline
\end{tabular}
\end{table}
SONET Configuration Reference

SONET Overhead Parameters

**H1SS:** This field sets bits 5 and 6 of the H1 byte. H1SS can be set to 00(SONET) (indicates an OC-1 or higher SONET signal) or 10(SDH) (indicates a Synchronous Digital Hierarchy Signal).

The SONET Path Overhead Control screen allows you to program the path overhead bytes. Bytes shown as xx cannot be edited on this screen.

```
SONET Path Overhead Control
J1: xx  ----Press ENTER to access the J1
B2: xx  Path Trace Control Screen
C2: 00
G1: 00  (DS3 & STS3c payload modes only)
F2: 00
H4: 00  (DS3 & STS3c payload modes only)
Z3: 00
Z4: 00
Z5: 00
DS3 O-Bits: 00000000000000000000
```

**Path Overhead Bytes:** Each byte value can be set in hexadecimal from 00 through FF.

---

**User-programmable SONET Path Overhead Bytes**

<table>
<thead>
<tr>
<th>Byte</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>C2</td>
<td>STS path signal label</td>
</tr>
<tr>
<td>G1</td>
<td>Path status (programmable in DS3 and STS-3c payload modes only)</td>
</tr>
<tr>
<td>F2</td>
<td>Path user channel</td>
</tr>
<tr>
<td>H4</td>
<td>VT multiframe phase indicator (DS3 and STS-3c payloads only)</td>
</tr>
<tr>
<td>Z3, Z4</td>
<td>Growth</td>
</tr>
<tr>
<td>Z5</td>
<td>Tandem connection error count and data link</td>
</tr>
</tbody>
</table>

**DS3 O-Bits:** This field allows you to edit the 18 DS3 overhead communication channel bits (O-Bits). The O-Bits comprise two bits from each of the nine subframes in an asynchronous mapping of a DS3 into an STS-1. Each O-Bit can be set to 1 or 0.
J1 Path Trace and J0 Section Trace Control

The J1 Path Trace Control screen and the OC-12 J0 Section Trace Control screen allow you to program each byte of the 64-byte STS Path Trace string and STS Section Trace string, respectively. Each byte of the string is transmitted in the J1 or J0 byte of 64 consecutive frames. This screen shows the J1 Path Trace Control screen. The J0 control screen is similar.

```
J1 Path Trace Control
Program in: Hex

41 52 42 00 00 00 00 00
00 00 00 00 00 00 00 00
00 00 00 00 00 00 00 00
00 00 00 00 00 00 00 00
00 00 00 00 00 00 00 00
00 00 00 00 00 00 00 00
```

The J1/J0 bytes are transmitted left-to-right, top-to-bottom as shown on the display.

Each J1/J0 byte is shown twice on the display. On the right, the two-digit hexadecimal value of the byte is displayed. On the left, the ASCII equivalent of the byte’s value is shown in a corresponding character position.

**Program in:** Selects the mode in which you enter J1/J0 byte values:

- **Hex:** The cursor moves only in the hexadecimal display (right side of screen). Each of the 64 bytes can be set from 00h through FFh.

- **ASCII:** The cursor moves only in the ASCII display (left side of the screen). Each byte can be set from A through Z, to a blank, or to a dash.

Note that additional ASCII characters are available by programming the corresponding value on the hexadecimal side of the display (see table on next page).
### Displayed ASCII characters and their Hexadecimal equivalents

<table>
<thead>
<tr>
<th>Hex</th>
<th>ASCII</th>
<th>Hex</th>
<th>ASCII</th>
<th>Hex</th>
<th>ASCII</th>
<th>Hex</th>
<th>ASCII</th>
<th>Hex</th>
<th>ASCII</th>
</tr>
</thead>
<tbody>
<tr>
<td>20</td>
<td>blank</td>
<td>33</td>
<td>3</td>
<td>46</td>
<td>F</td>
<td>59</td>
<td>Y</td>
<td>6C</td>
<td>l</td>
</tr>
<tr>
<td>21</td>
<td>1</td>
<td>34</td>
<td>4</td>
<td>47</td>
<td>G</td>
<td>5A</td>
<td>Z</td>
<td>6D</td>
<td>m</td>
</tr>
<tr>
<td>22</td>
<td>“</td>
<td>35</td>
<td>5</td>
<td>48</td>
<td>H</td>
<td>5B</td>
<td></td>
<td></td>
<td>6E</td>
</tr>
<tr>
<td>23</td>
<td>#</td>
<td>36</td>
<td>6</td>
<td>49</td>
<td>I</td>
<td>5C</td>
<td>\</td>
<td>6F</td>
<td>o</td>
</tr>
<tr>
<td>24</td>
<td>$</td>
<td>37</td>
<td>7</td>
<td>4A</td>
<td>J</td>
<td>5D</td>
<td></td>
<td></td>
<td>70</td>
</tr>
<tr>
<td>25</td>
<td>%</td>
<td>38</td>
<td>8</td>
<td>4B</td>
<td>K</td>
<td>5E</td>
<td>^</td>
<td>71</td>
<td>q</td>
</tr>
<tr>
<td>26</td>
<td>&amp;</td>
<td>39</td>
<td>9</td>
<td>4C</td>
<td>L</td>
<td>5F</td>
<td>_</td>
<td>72</td>
<td>r</td>
</tr>
<tr>
<td>27</td>
<td>'</td>
<td>3A</td>
<td>:</td>
<td>4D</td>
<td>M</td>
<td>60</td>
<td>'</td>
<td>73</td>
<td>s</td>
</tr>
<tr>
<td>28</td>
<td>(</td>
<td>3B</td>
<td>;</td>
<td>4E</td>
<td>N</td>
<td>61</td>
<td>a</td>
<td>74</td>
<td>t</td>
</tr>
<tr>
<td>29</td>
<td>)</td>
<td>3C</td>
<td>&lt;</td>
<td>4F</td>
<td>O</td>
<td>62</td>
<td>b</td>
<td>75</td>
<td>u</td>
</tr>
<tr>
<td>2A</td>
<td>*</td>
<td>3D</td>
<td>=</td>
<td>50</td>
<td>P</td>
<td>63</td>
<td>c</td>
<td>76</td>
<td>v</td>
</tr>
<tr>
<td>2B</td>
<td>+</td>
<td>3E</td>
<td>&gt;</td>
<td>51</td>
<td>Q</td>
<td>64</td>
<td>d</td>
<td>77</td>
<td>w</td>
</tr>
<tr>
<td>2C</td>
<td>,</td>
<td>3F</td>
<td>?</td>
<td>52</td>
<td>R</td>
<td>65</td>
<td>e</td>
<td>78</td>
<td>x</td>
</tr>
<tr>
<td>2D</td>
<td>-</td>
<td>40</td>
<td>@</td>
<td>53</td>
<td>S</td>
<td>66</td>
<td>f</td>
<td>79</td>
<td>y</td>
</tr>
<tr>
<td>2E</td>
<td>.</td>
<td>41</td>
<td>A</td>
<td>54</td>
<td>T</td>
<td>67</td>
<td>g</td>
<td>7A</td>
<td>z</td>
</tr>
<tr>
<td>2F</td>
<td>/</td>
<td>42</td>
<td>B</td>
<td>55</td>
<td>U</td>
<td>68</td>
<td>h</td>
<td>7B</td>
<td>{</td>
</tr>
<tr>
<td>30</td>
<td>0</td>
<td>43</td>
<td>C</td>
<td>56</td>
<td>V</td>
<td>69</td>
<td>i</td>
<td>7C</td>
<td></td>
</tr>
<tr>
<td>31</td>
<td>1</td>
<td>44</td>
<td>D</td>
<td>57</td>
<td>W</td>
<td>6A</td>
<td>j</td>
<td>7D</td>
<td>}</td>
</tr>
<tr>
<td>32</td>
<td>2</td>
<td>45</td>
<td>E</td>
<td>58</td>
<td>X</td>
<td>6B</td>
<td>k</td>
<td>7E</td>
<td>~</td>
</tr>
</tbody>
</table>
SONET Datalink Control Parameters

The Data Link Control screen configures the functionality of the rear-panel data link ports.

```
Data Link Control
RS232>None
RS422>None
Handset>None
DCC Pass-Thru>Off
OC-12 APS Pass-Thru>Off
```

Selection of data link insert or pass-thru above overrides programmed byte values.

Note: For information on other data link rate uses, see DS3 Datalink Parameters, page 7-15 or DS1 Data Link Parameters, page 11-16.

Rear-Panel RS-232 Data Link Port

**RS232>** configures the rear-panel DATA-LINK RS-232 interface in both the transmit and receive directions. The choices are as follows:

**None:** The RS-232 data link interface is disabled.

**Section User Channel (F1):** The transmitted data on the Section user channel (F1 bytes) is derived from input at the rear-panel RS-232 data link port. Received F1 data is transmitted on the port's output.

**Section Order Wire (E1):** The transmit data on the Section orderwire channel (E1 bytes) is derived from input at the rear-panel RS-232 data link port. Received E1 data is transmitted on the port's output.

**Line Order Wire (E2):** The transmitted data on the Line orderwire channel (E2 bytes) is derived from input at the rear-panel RS-232 data link port. Received E2 data is transmitted on the port's output.

Note: The Line and Section choices can be overwritten by the **Handset>** setting (see Rear-Panel Handset Interface, page 3-19).
SONET Configuration Reference

SONET Datalink Control Parameters

Rear-Panel RS-422 Data Link Port

RS422> configures the operation of the rear-panel DATA-LINK RS-422 interface port in both the transmit and receive directions. The available choices are as follows:

**None:** The RS-422 data link port is disabled.

**Section DCC (D1-D3):** Section data communication channel (D1, D2, and D3 bytes) transmit data is derived from input at the RS-422 data link port. Received data is transmitted on the port's output.

**Line DCC (D4-D12):** The transmitted data on the Line data communication channel (D4–D12 bytes) is derived from input at the rear-panel RS-422 data link port. Received data is transmitted on the port's output.

**Note:** The Line DCC and Section DCC choices can be overwritten by the DCC Pass-Thru setting (see *SONET DCC Pass-Through Mode*, page 3–19).

Rear-Panel Handset Interface

Handset> configures the operation of the rear-panel Handset interface in both the transmit and receive directions. The available choices are:

**None:** The Handset interface is disabled.

**Section Order Wire (E1):** The transmitted data on the Section orderwire channel (E1 bytes) is derived from the VF (voice frequency) input at the rear-panel Handset port. Received E1 data is converted to a VF signal and transmitted on the port's output.

**Line Order Wire (E2):** The transmitted data on the Line orderwire channel (E2 bytes) is derived from the VF input at the handset port. Received E2 data is converted to a VF signal and transmitted on the port's output.

SONET DCC Pass-Through Mode

DCC Pass-Thru> configures the test set so that the Section data communication channel (bytes D1, D2, and D3) and Line DCC (bytes D4–D12) received at the SONET input are transmitted at the SONET output. Set DCC Pass-Thru to On to retransmit the DCC. Set DCC Pass-Thru to Off to disable this function.

**Note:** When DCC Pass-Thru is On, the SONET transmit clock is forced to loop mode. When DCC Pass-Thru is set to Off, the clock configuration returns to the state selected in the SONET mode configuration screen.

This item is not available in Monitor mode.
OC-12 APS Pass-Through Mode

APS Pass-Thru> configures the test set so that the Automatic Protection Switching channel (APS; bytes K1 and K2) received at the SONET input is transmitted at the SONET output. Set OC-12 APS Pass-Thru to On to retransmit the APS channel. Set OC-12 APS Pass-Thru to Off to disable this function.

Note: When APS Pass-Thru is On, the SONET transmit clock is forced to loop mode. When APS Pass-Thru is set to Off, the clock configuration returns to the state selected in the SONET mode configuration screen.

This item is not available in Monitor mode.

VT Overhead Parameters

For more information on VT overhead, see VT1.5 Format and Mapping, page 5–12.

The 156MTS provides control of VT overhead configuration and VT path trace configuration. Your test set must have Option UQA to take advantage of these features.

VT overhead control is accessed through the Additional Test Controls menu. These parameters are available when the instrument is configured for VT1.5 payloads.

```
Global Settings | DS1/E1 Patterns
Alarm Control   | DS1 Loop Codes
APS Control     | SONET OH Control
Data Link Control| DSO/TS/Frac Setup
```

When you select SONET OH Control from the Additional Test Controls menu and press CONFIG-right, a series of five screens is presented. The first three screens give you access to SONET overhead parameters (see SONET Overhead Parameters, page 3–13). The last two screens provide access to the following VT1.5 overhead parameters:

- VT path overhead bytes.
- J2 path trace string (byte-synchronous modes only).
VT Path Overhead Control

The VT1.5 Path Overhead Control screen allows you to program the VT overhead byte values. Bytes shown as **xx** cannot be edited on this screen.

```
VT1.5 Path Overhead Control
V5: Signal Label: 100 (Byte Synchronous)
J2: xx ---- Press ENTER to access the J2
     VT Path Trace Control Screen
Z6: 00
Z7: 00 ---- (MSB is RFI-V Alarm)
Demux Framing Regen> Passthrough
```

**VT Path Overhead Bytes:** Each byte can be set as described below.

**User-programmable VT Path Overhead Bytes**

<table>
<thead>
<tr>
<th>Byte</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>V5: Signal Label</td>
<td>VT path signal label: Bits 5–7 of the V5 byte are the path signal label. The VALUE keys cycle through the settings:</td>
</tr>
<tr>
<td>000</td>
<td>Unequipped</td>
</tr>
<tr>
<td>001</td>
<td>Equip Non-specif</td>
</tr>
<tr>
<td>010</td>
<td>Asynchronous</td>
</tr>
<tr>
<td>011</td>
<td>Bit Synchronous</td>
</tr>
<tr>
<td>100</td>
<td>Byte Synchronous</td>
</tr>
<tr>
<td>101</td>
<td>Future</td>
</tr>
<tr>
<td>110</td>
<td>PDI-V</td>
</tr>
<tr>
<td>111</td>
<td>Future</td>
</tr>
</tbody>
</table>

- **J2**
  - This byte is programmed using the J2 Path Trace Control screen. See *J2 Path Trace Control*, page 3–22.
  - Byte-synchronous modes only.

- **Z6**
  - Growth (undefined). VT byte-synchronous modes only.

- **Z7**
  - Bit 8 is the VT path remote failure indication (RFI-V). Other Z7 bits are undefined. VT byte-synchronous modes only.

**Demux Framing Regen>:** (Byte-synchronous mode only) This field affects the framing of the DS1 dropped from the VT1.5. When this field is set to **Passthrough** (default), the dropped DS1 data and framing are both derived from the VT1.5. When this field is set to **Regenerate**, the DS1 data and signaling is derived from the VT1.5, and the DS1 framing is internally generated by the test set.
J2 Path Trace Control

The J2 Path Trace Control screen allows you to program each byte of the 64-byte VT Path Trace string. Each byte of the string is transmitted in the J2 byte of 64 consecutive VTs.

<table>
<thead>
<tr>
<th>J2 Path Trace Control</th>
</tr>
</thead>
<tbody>
<tr>
<td>Program in: Hex</td>
</tr>
<tr>
<td>ARB------- 41 52 42 00 00 00 00 00</td>
</tr>
<tr>
<td>----------- 00 00 00 00 00 00 00 00</td>
</tr>
<tr>
<td>----------- 00 00 00 00 00 00 00 00</td>
</tr>
<tr>
<td>----------- 00 00 00 00 00 00 00 00</td>
</tr>
<tr>
<td>----------- 00 00 00 00 00 00 00 00</td>
</tr>
<tr>
<td>----------- 00 00 00 00 00 00 00 00</td>
</tr>
<tr>
<td>----------- 00 00 00 00 00 00 00 00</td>
</tr>
</tbody>
</table>

The J2 bytes are transmitted left-to-right, top-to-bottom as shown on the display.

Each J2 byte is shown twice on the display. On the right, the two-digit hexadecimal value of the byte is displayed. On the left, the ASCII equivalent of the byte's value is shown in a corresponding character position.

**Program in:** Selects the mode in which you enter J2 byte values:

- **Hex:** The cursor moves only in the hexadecimal display (right side of screen). Each of the 64 bytes can be set from 00\textsubscript{h} through FF\textsubscript{h}.

- **ASCII:** The cursor moves only in the ASCII display (left side of the screen). Each byte can be set from \texttt{A} through \texttt{Z}, to a blank, or to a dash.

Note that additional ASCII characters are available by programming the corresponding value on the hexadecimal side of the display (see table on page 3–17).
VT1.5 Setup Parameters

When equipped with Option UQA, the 156MTS can drop and insert VT1.5 mapped DS1 signals to and from an STS-1. VT1.5 setup parameters are available when Payload is set to VT1.5 Async or VT1.5 Byte Sync (the transmitter and receiver must be set for a SONET rate).

The VT1.5 parameters appear on the screen similar to the following:

```
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>DS1:</td>
<td>TxC&gt;Int Fmt&gt;SF Data&gt;BRSS</td>
</tr>
<tr>
<td>UT1.5:</td>
<td>Ins&gt;1 Other UT's&gt;Same Drop&gt;1</td>
</tr>
<tr>
<td>UTGrp:</td>
<td>Ins&gt;1 Other Grp's&gt;Same Drop&gt;1</td>
</tr>
<tr>
<td>STS1:</td>
<td>Ins&gt;1 Other STS's&gt;Same Drop&gt;1</td>
</tr>
<tr>
<td>STSN:</td>
<td>TxC&gt;Int Scram&gt;On Fc&gt;0C</td>
</tr>
<tr>
<td>Err/Alm/Type&gt;DS1 Data Rate&gt;Single</td>
<td></td>
</tr>
</tbody>
</table>
```

**Note:** The DS1 setup parameters on the first line apply to the DS1 signal that is mapped into the VTs. For information on the DS1 parameters, see Chapter 11, DS1, DS0, and FT1 Configuration Reference.

**Insert VT Selection**

See VT1.5 Channel Setup Mode, page 3–26.

**VT1.5: Ins>** selects which VT1.5 channel within the STS-1 or VT group is used for the transmit VT.

- If **VT Counting Mode** is set to **VT Group**, Ins> determines which VT in the group (from 1 through 4) is selected.

- If **VT Counting Mode** is set to **1 to 28**, Ins> determines which VT in the STS-1 (from 1 through 28) is selected.
Other Transmit VTs

VT1.5: **Other VTs** sets the payload for the remaining VT1.5 channels (that are not selected by **Ins**). **Other VTs** applies either to the remaining three VTs in a group, or to the remaining 27 VTs in an STS-1 depending on the VT counting mode. Depending on the VT and counting modes, **Other VTs** can be set as follows:

<table>
<thead>
<tr>
<th>When the VT mode is...</th>
<th>and the Counting Mode is...</th>
<th>the available payloads are...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asynchronous VT</td>
<td>VT Group</td>
<td>Same</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Inv</td>
</tr>
<tr>
<td></td>
<td></td>
<td>All 0s</td>
</tr>
<tr>
<td></td>
<td></td>
<td>DS1 AIS</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Ext</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Aux</td>
</tr>
<tr>
<td>Byte-synchronous VT</td>
<td>VT Group</td>
<td>Same</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Inv</td>
</tr>
<tr>
<td></td>
<td></td>
<td>All 0s</td>
</tr>
<tr>
<td>Asynchronous or Byte-synchronous VT</td>
<td>1 to 28</td>
<td>Same</td>
</tr>
<tr>
<td></td>
<td></td>
<td>AIS</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Unequ</td>
</tr>
</tbody>
</table>

The **Other VTs** payload selections are described on the next page.
SONET Configuration Reference

VT1.5 Setup Parameters

Same: Fills the VTs with the same payload as the selected Ins> VT.

Inv: Fills the VTs with an inverted copy of the Ins> VT payload.

All 0s: Fills the VTs with an all binary zeros pattern.

DS1 AIS: Inserts a DS1 alarm indication signal on the VTs (unframed all-ones).

AIS: Inserts one of two AIS signals on the VTs. In asynchronous VT modes, the AIS is a DS1 AIS (unframed all-ones). In byte-synchronous VT modes, the AIS is a VT path AIS (all-ones in the V1 and V2 bytes).

Ext: Fills the VTs with the DS1 signal applied at the front-panel DS1/E1 RX jack.

Aux: Fills the VTs with the signal applied at the rear-panel DS1 REF IN jack.

Unequ: Sets the remaining VTs as unequipped (path overhead and payload set to all zeros).

Drop VT Selection

VT1.5: Drop> selects which VT within the STS-1 or VT group is used for the receive VT.

See VT1.5 Channel Setup Mode, page 3–26.

- If VT Counting Mode is set to VT Group, Drop> determines which VT in the group (from 1 through 4) is selected.

- If VT Counting Mode is set to 1 to 28, Drop> determines which VT in the STS-1 (from 1 through 28) is selected.

- Setting Drop> to L automatically "locks" the drop VT to be the same channel number as VT1.5: Ins>.

Note: VTGrp: parameters are only displayed if VT Counting Mode is set to VT Group.
SOinet Configuration Reference

VT1.5 Setup Parameters

Insert VT Group Selection

VTGrp: Ins> selects which of the seven VT groups is selected to transmit the four VTs defined by VT1.5: Ins> and Other VTs>. Ins> can be set from 1 through 7 (see VT1.5 Channel Setup Mode below).

Other Transmit VT Groups

VTGrp: Other Grps> sets the remaining VT groups (not selected by VTGrp: Ins>). Other Grps> can be set to one of the following:

Same: Sets the remaining six VT groups as identical to the Ins> group.

VT PAIS: Transmits VT path AIS on the remaining groups.

Unequipped: Sets the remaining VT groups as unequipped (path overhead and payload set to all zeros).

Drop VT Group Selection

VTGrp: Drop> selects which VT group is dropped from the receive STS-1, and from which the VT1.5 Drop> channel is selected. Drop> can be set from 1 through 7, and to L ("locked" to the same channel number as VTGrp: Ins>).

VT1.5 Channel Setup Mode

There are two ways to specifying VT drop and insert channels on a SONET signal. The VT numbering scheme is set on the Auxiliary Test Setups screen. Select Setup System Parameters from the Main Menu and then select Auxiliary Test Setups.

<table>
<thead>
<tr>
<th>Auxiliary Test Setups</th>
</tr>
</thead>
<tbody>
<tr>
<td>Test Dur. Mode:</td>
</tr>
<tr>
<td>Timer Duration:</td>
</tr>
<tr>
<td>Auto. Print Mode:</td>
</tr>
<tr>
<td>Auto. Store Mode:</td>
</tr>
<tr>
<td>Sub Menu Opt Pwr:</td>
</tr>
<tr>
<td>Auto Tst: Stop</td>
</tr>
<tr>
<td>Pwr Up Optical Tx State:</td>
</tr>
<tr>
<td>STS12 # Scheme:</td>
</tr>
<tr>
<td>VT Counting: VT Group</td>
</tr>
<tr>
<td>DS1 Block Size:</td>
</tr>
<tr>
<td>DS1 L0P &amp; OOF Hold-off:</td>
</tr>
<tr>
<td>Bits Clk Out Derived from:</td>
</tr>
</tbody>
</table>

VT Counting Mode sets the method for specifying VT channels. This parameter can be set as follows:

VT Group: VT channels are specified in groups of seven, each comprising four VTs. A channel is specified as VT 1 through 4 in VT group 1 through 7.

1 through 28: VT channels are specified by their position in the overall STS-1 signal, from 1 through 28.
The following table lists the correlation between individual VT channels (1 through 28) and their positions when VT Group counting mode is used. The VT group number is listed across the top (1 through 7); the VT positions within each group are listed down the left (1 through 4).

<table>
<thead>
<tr>
<th>VT Group Number</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
</tr>
</thead>
<tbody>
<tr>
<td>VT1.5 Position in VT Group</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
<td>6</td>
<td>7</td>
</tr>
<tr>
<td>2</td>
<td>8</td>
<td>9</td>
<td>10</td>
<td>11</td>
<td>12</td>
<td>12</td>
<td>14</td>
</tr>
<tr>
<td>3</td>
<td>15</td>
<td>16</td>
<td>17</td>
<td>18</td>
<td>19</td>
<td>20</td>
<td>21</td>
</tr>
<tr>
<td>4</td>
<td>22</td>
<td>23</td>
<td>24</td>
<td>25</td>
<td>26</td>
<td>27</td>
<td>28</td>
</tr>
</tbody>
</table>
Error Injection

The following error types can be injected when the transmitter is set for a SONET rate.

**SONET Error Injection Types**

**Note:** For information on injection rates, see *About Error Injection Rates*, page 27-7.

**STS3c Data:** Generates bit errors in the STS-3c payload data pattern. **Rates:** Single, 1.0E-2 through 1.0E-9, Burst, Off.

**REI-P (path FEBE):** Generates Path Remote Event Indications (path FEBEs) on the G1 byte. **Rates:** Single, 1.0E-4 through 1.0E-8.

**Path BER:** Generates errors in the payload and the path overhead bytes, except for the B3 parity byte. **Rates:** Single, 1.0E-2 through 1.0E-9, Burst, Off.

**Section BER:** Generates errors at the selected rate in the entire SONET signal, except for the B1 parity byte and the A1 and A2 framing bytes (available in OC-3 transmitter modes and STS-12c payload modes only). **Rates:** Single, 1.0E-2 through 1.0E-9, Burst, Off.

**Line BER:** Generates errors at the selected rate in the entire SONET signal, except for the Section overhead and the B2 parity byte. **Rates:** Single, 1.0E-2 through 1.0E-9, Burst, Off.

**REI-L (line FEBE):** Generates Line Remote Event Indications (line FEBEs) using bits 2 through 8 of the M0 byte for STS-1/OC-1, or the M1 byte of STS-1 #3 for STS-N. **Rates:** Single, 1.0E-4 through 1.0E-8.

**B1 Byte:** Inverts the B1 byte in the transmit STS-N signal for one frame. This causes eight Section code violations (available in OC-3 transmitter modes and STS-12c payload modes only). Affects the parity byte; BER injection affects data. **Rates:** Single, Off.

**B2 Bytes:** Inverts all B2 bytes in the transmit STS-N signal for one frame. This causes 24 line code violations in an OC-3 signal, and 96 line code violations in an OC-12 signal. For OC-12, **Other** must be set to **Same** to fill the STS-1 channels. **Rates:** Single, Off.

**B3 Byte:** Inverts the B3 parity byte in the selected STS-1 for one frame. This causes eight Path code violations (available in OC-3 transmitter modes only). **Rates:** Single, Off.

**B1 Bit:** Inverts the least-significant bit (Bit 1) in the B1 byte (available in OC-12 transmitter modes only). **Rates:** Continuous, Off.
Error Injection

**B2 Bit**: Inverts the least-significant bit (Bit 1) in the B2 byte (available in OC-12 transmitter modes only).  *Rates*: Continuous, Off.

**A1 Bit**: Inverts the least-significant bit (Bit 1) in the A1 framing byte (available in OC-12 transmitter modes only).  *Rates*: Continuous, Off.

**H Pointer**: Transmits an illegal, out-of-range value in the STS-1 H1 and H2 (pointer) bytes.  *Rates*: Single, 7–9 Consec (LOF threshold), Continuous, Burst, Off.


**SONET Alarm Types**

SONET alarms can be transmitted by activating or deactivating transmission of a particular alarm using the Alarm Control screen. When you select *Alarm Control* from the Control Screens menu, the following screen is displayed:

```
>Set SONET Alarm Conditions<
  LOS : off  STS FAIS : off
  LOF : off  STS PYEL : off
  LAIS : off  VT FAIS : off
  LFERF : off  VT PYEL : off
  STS LOPNTR : off  VT LOPNTR : off
```

Each alarm type can be set to *On* (continuously transmitted) or *Off* (not transmitted). Note that VT PYEL has additional selections. The following table describes the types of SONET alarms available.

**SONET Alarm Injection Types**

<table>
<thead>
<tr>
<th>Alarm</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOS</td>
<td>Loss of signal: Simulates a loss of signal by transmitting all zeros.</td>
</tr>
<tr>
<td>LOF</td>
<td>Loss of frame synchronization: Simulates a loss of frame by transmitting errored framing patterns.</td>
</tr>
<tr>
<td>LAIS</td>
<td>Line alarm indication signal: Sets the transmit K2 bytes to XXXXX111.</td>
</tr>
<tr>
<td>LFERF</td>
<td>Line far-end receive failure: Sets the transmit K2 bytes to XXXXX110.</td>
</tr>
</tbody>
</table>
### SONET Alarm Injection Types, continued

<table>
<thead>
<tr>
<th>Alarm</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>STS LOPNTR</td>
<td>Loss of pointer: generates an illegal, out-of-range pointer value.</td>
</tr>
<tr>
<td>STS PAIS</td>
<td>Path alarm indication signal: Transmits all-ones in H1, H2, H3, and the entire SPE.</td>
</tr>
<tr>
<td>STS PYEL</td>
<td>Path Yellow alarm: Sets bit 5 of the transmit G1 bytes to 1.</td>
</tr>
<tr>
<td>VT PAIS</td>
<td>VT path alarm indication signal: Transmits all-ones in the entire VT, including the V1 and V2 bytes.</td>
</tr>
</tbody>
</table>
| VT PYEL    | On and Off: Activates a VT Path Yellow alarm (sets bits 4 and 8 of the transmit V5 byte to 01).  
               | PLM-V: VT Payload Label Mismatch. Sets bits 4 and 8 of the transmit V5 Byte to 10.  
               | UNEQ-V: VT path unequipped. Sets bits 4 and 8 of the transmit V5 byte to 11.       |
| VT LOPNTR  | Loss of pointer: generates an illegal, out-of-range pointer value.          |

**VT1.5 Error Injection**

The following error types can be injected when the payload is set for VT1.5.

**VT BER:** Generates bit errors at the selected rate on the selected VT1.5. *Rates:* Single, 1.0E-2 through 1.0E-9, Burst, Off.

**REI-V (VT FEBE):** Generates a VT path Remote Event Indication (path FEBE) error indication on the selected VT1.5 by setting bit 3 of the V5 byte to 1. *Rates:* Single, 1.0E-4 through 1.0E-8.

**V Pointer:** Generates an out-of-range illegal VT1.5 pointer value. *Rates:* Single, 7–9 Consec (LOP threshold), Continuous, Burst, Off.
## STS-N Indicators

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>HIST/ALARMS</strong></td>
<td></td>
</tr>
<tr>
<td>LOS</td>
<td>Loss of STS-N signal.</td>
</tr>
<tr>
<td>LOF</td>
<td>Loss of frame.</td>
</tr>
<tr>
<td>LOCLK</td>
<td>Loss of external clock signal.</td>
</tr>
<tr>
<td>AIS-L</td>
<td>Line Alarm Indication Signal.</td>
</tr>
<tr>
<td>RDI-L</td>
<td>Line Remote Defect Indication.</td>
</tr>
<tr>
<td>LOP-P</td>
<td>Path Loss of Pointer.</td>
</tr>
<tr>
<td>AIS-P</td>
<td>Path Alarm Indication Signal.</td>
</tr>
<tr>
<td>RDI-P</td>
<td>Path Remote Defect Indication.</td>
</tr>
<tr>
<td>LOPAT</td>
<td>Loss of payload pattern synchronization.</td>
</tr>
<tr>
<td><strong>STATUS</strong></td>
<td></td>
</tr>
<tr>
<td>STS-N SIG</td>
<td>Valid STS-N signal detected.</td>
</tr>
<tr>
<td>STS-N FRM</td>
<td>Frame synchronization achieved with STS-N signal.</td>
</tr>
<tr>
<td>PATH PTR</td>
<td>Valid SONET pointer detected.</td>
</tr>
<tr>
<td>CONCAT</td>
<td>Concatenated signal detected.</td>
</tr>
<tr>
<td>PAT SYNC</td>
<td>Payload pattern synchronization achieved.</td>
</tr>
<tr>
<td>ERRORS</td>
<td>STS-N errors detected.</td>
</tr>
</tbody>
</table>
### STS-N Alarm and Status Indicators, continued

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ERRORS</td>
<td></td>
</tr>
<tr>
<td>B1 CV</td>
<td>B1 byte code violation detected.</td>
</tr>
<tr>
<td>B2 CV</td>
<td>B2 byte code violation detected.</td>
</tr>
<tr>
<td>B3 CV</td>
<td>B3 byte code violation detected.</td>
</tr>
<tr>
<td>REI-L</td>
<td>Line Remote Error Indication detected.</td>
</tr>
<tr>
<td>REI-P</td>
<td>Path Remote Error Indication detected.</td>
</tr>
</tbody>
</table>
OC-N/STS-N Measurement Summary Screen

This screen displays summaries for OC-12, OC-3, OC-3c, and STS-1 tests. The specific OC-N or STS-N rate that is displayed depends on the receiver rate (and payload, for STS-12c and STS-3c).

**B1 (Sect CV):** B1 byte Section code violations count. Includes BIP-8 errors in the B1 byte (as many as eight in each frame).

**B2 (Line CV):** B2 byte line code-violations count. Includes BIP-8 errors in the B2 byte (as many as eight in each frame for STS-1, 24 for OC-3, and 96 for OC-12).

**OC-N Rx Hz:** Receive Frequency, in Hertz. The recovered clock frequency of the incoming OC-N data pattern.

**STS-1 Drop Hz:** Drop Frequency, in Hertz. The recovered clock frequency of the STS-1 data pattern dropped from the OC-N. Not applicable for STS-1 modes or for STS-12c and STS-3c payload modes.

**BPV:** Bipolar violation count (STS-1 screen only). The total number of BPVs detected on the STS-1 during the test.

**STS-12c or STS-3c Patt Sync:** Pattern Synchronization (STS-12c and STS-3c payload modes only). Indicates if the test set has synchronized to the receive STS-12c or STS-3c data pattern, based on the setting of **Data** (see **STS-Nc Payload Setup Parameters**, page 3-9). **ON** indicates the pattern matches.

**Rx Opt dBm:** Received optical signal strength, in decibels. Indicates the strength (relative to 1.0 milliwatt) of the optical signal at the OC-N RX port.
Section Code Violations (B1) Screen

This screen displays section code violation measurements (CVs in the B1 byte).

| Sect CV Count: | Section code violations count. Includes BIP 8 errors in the B1 byte (as many as eight in each frame). |
| CV BER (avg): | Section CV average bit error ratio. The number of section CVs over the total number of section bits transmitted, including section and line overhead, since the beginning of the test. |
| CV BER (cur): | Section CV current bit error ratio. The number of section CVs over the total number of section bits transmitted, including section and line overhead, during the previous 2.25 seconds. |
| ES: | Section errored seconds. The number of seconds in which one or more section CVs or OOF events occurred. |
| SES: | Section severely errored seconds. A count of seconds in which the number of section CVs met or exceeded the SES threshold, or in which an OOF event occurred. The threshold depends on the rate: STS-1 = 1 CV, OC-3 = 16 CVs, OC-12 = 63 CVs. |
| EFS: | Section error free seconds. The number of seconds in which no section CVs or OOF events occurred. |
| %EFS: | Section percentage of error-free sends. Section EFS expressed as a percentage of the total number of seconds since the beginning of the test. |
Line Code Violations (B2) Screen

This screen displays line CV measurements (code violations in the B2 byte).

<table>
<thead>
<tr>
<th>Line Code Violations (B2)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line CV Count: 268 ES: 2</td>
</tr>
<tr>
<td>CV BER (avg): 1.11E-03 SES: 0</td>
</tr>
<tr>
<td>CV BER (cur): 0.00E+00 EFS: 40</td>
</tr>
<tr>
<td>%EFS: 95.24</td>
</tr>
</tbody>
</table>

**Line CV Count:** Line code violations count. Includes BIP-8 errors in the B2 byte (as many as eight in each frame for STS-1, 24 for OC-3, and 96 for OC-12).

**CV BER (avg):** Line CV average bit error ratio. The number of line CVs over the total number of line bits transmitted (excludes section overhead) since the beginning of the test.

**CV BER (cur):** Line CV current bit error ratio. The number of line CVs over the total number of line bits transmitted (excludes section overhead) during the previous 2.25 seconds.

**ES:** Line errored seconds. The number of seconds in which one or more line CVs occurred.

**SES:** Line severely errored seconds. A count of seconds in which the number of line CVs met or exceeded the SES threshold. The threshold depends on the rate: STS-1 = 12 CVs, OC-3 = 32 CVs, OC-12 = 124 CVs.

**EFS:** Line error-free seconds. The number of seconds in which no line CVs occurred.

**%EFS:** Line percentage of error-free sends. Line EFS expressed as a percentage of the total number of seconds since the beginning of the test.
REI-L Measurements Screen

This screen displays line remote error indications (REI-L) measurements on SONET signals.

### Example Data

<table>
<thead>
<tr>
<th>DC12-OC3 (STS3c) Final: 00:00:00.00</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line REI-L (FEBE) Measurements</td>
</tr>
<tr>
<td>REI-L Count: 7</td>
</tr>
<tr>
<td>REI-L BER (avg): 1.9E-09 SES: 0</td>
</tr>
<tr>
<td>REI-L BER (cur): 3.6E-09 EFS: 2</td>
</tr>
<tr>
<td>%EFS: 33.33</td>
</tr>
</tbody>
</table>

**REI-L Count**: REI-L count. REI-L reporting uses bits 2 through 8 of the M0 byte for STS-1/OC-1, or the M1 byte of STS-1 #3 for STS-N.

**REI-L BER (avg)**: REI-L average bit error ratio. The number of BIP-8 errors over the total number of line bits transmitted (excludes section overhead) since the beginning of the test.

**REI-L BER (cur)**: REI-L current bit error ratio. The number of BIP-8 errors over the total number of line bits transmitted (excludes section overhead) during the previous 2.25 seconds.

**ES**: REI-L errored seconds. The number of seconds in which at least one REI-L was reported.

**SES**: REI-L severely errored seconds. The number of seconds in which at least 27 REI-Ls were reported.

**EFS**: REI-L error-free seconds. The number of seconds in which no REI-Ls were reported.

**%EFS**: Percentage of REI-L error-free seconds. REI-L is EFS expressed as a percentage of the total number of seconds since the beginning of the test.
Path Measurement Summary Screen

This screen displays path code violation measurements (CVs; BIP-8 errors in the B3 byte). In concatenated payload modes, the title indicates “STS-12c” or “STS-3c.”

B3 (Path CV): Path code violations count. Includes BIP-8 errors in the B3 byte (as many as eight in each frame).

FEBE: Path far-end block errors. The number of path FEBEs reported (bits 1 through 4 of the G1 byte).

Sec Ago shows time elapsed since last FEBE, in seconds.
Path Code Violation (B3) Screen

This screen displays path CV results (code violations in the B3 byte). For concatenated payloads, the title indicates "STS-12c" or "STS-3c."

<table>
<thead>
<tr>
<th>STS1-STS1&lt;VT1.5A&gt;F1nal: 00:00:00:00</th>
<th>Path Code Violations (B3)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Path CV Count: 7</td>
<td>ES: 6</td>
</tr>
<tr>
<td>CV BER (avg): 1.40E-08</td>
<td>SES: 0</td>
</tr>
<tr>
<td>CV BER (cur): 2.66E-08</td>
<td>EFS: 4</td>
</tr>
<tr>
<td>Path UAS: 0 %EFS: 40.00</td>
<td></td>
</tr>
</tbody>
</table>

**Path CV Count:** Path code violations count. Includes BIP-8 errors in the B3 byte (as many as eight in each frame).

**CV BER (avg):** Path CV average bit error ratio. The number of path CVs over the total number of path bits transmitted (excludes section and line overhead) since the beginning of the test.

**CV BER (cur):** Path CV current bit error ratio. The number of path CVs over the total number of path bits transmitted (excludes section and line overhead) during the previous 2.25 seconds.

**Path UAS:** Path unavailable seconds. The number of seconds the path was unavailable. The path is unavailable after ten consecutive path SESs. The path is declared available again after ten consecutive seconds with no path SESs. The Path UAS measurement includes the first ten seconds, but not the last ten seconds. The path is also unavailable during path AIS and path LOP conditions.

**ES:** Path errored seconds. The number of seconds in which one or more path CVs occurred.

**SES:** Path severely errored seconds. A count of seconds in which the number of path CVs was nine or more.

**EFS:** Path error-free seconds. The number of seconds in which no path CVs occurred.

**%EFS:** Path percentage of error-free seconds. Path EFS expressed as a percentage of the total number of seconds since the beginning of the test.
REI-P Measurements

This screen displays path remote error indication (REI-P) measurements. REI-P measurements are block code violations reported from the far-end using bits 1 through 4 of the G1 byte.

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1 STS1-STS1(VT1.5A)</td>
<td>Final: 00:00:00.00</td>
<td></td>
</tr>
<tr>
<td>Path REI-P (FEBE)</td>
<td>Measurements</td>
<td></td>
</tr>
<tr>
<td>REI-P Count:</td>
<td>7</td>
<td>ES: 6</td>
</tr>
<tr>
<td>CV BER (avg):</td>
<td>1.40E-08</td>
<td>SES: 0</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CV BER (cur):</td>
<td>2.66E-08</td>
<td>EFS: 4</td>
</tr>
<tr>
<td></td>
<td></td>
<td>%EFS: 40.00</td>
</tr>
</tbody>
</table>

**REI-P Count**: REI-P count. The number of REI-Ps reported.

**CV BER (avg)**: REI-P average bit error ratio. The number of BIP-8 errors over the total number of path bits transmitted (excludes section and line overhead) since the beginning of the test.

**CV BER (cur)**: REI-P current bit error ratio. The number of BIP-8 errors over the total number of path bits transmitted (excludes section and line overhead) during the previous 2.25 seconds.

**REI-P UAS**: REI-P unavailable seconds. The number of seconds that the (reverse) path was unavailable. The path is declared unavailable after ten consecutive path SESs. The path is declared available again after ten consecutive seconds with no path SESs. The REI-P UAS measurement includes the first ten seconds, but not the last ten seconds.

**ES**: REI-P errored seconds. The number of seconds in which at least one REI-P was reported.

**SES**: REI-P severely errored seconds. The number of seconds in which at least nine REI-Ps were reported.

**EFS**: REI-P error-free seconds. The number of seconds in which no REI-Ps were reported.

**%EFS**: Percentage of REI-P error-free seconds. REI-P EFS expressed as a percentage of the total number of seconds since the beginning of the test.
STS-12c and STS-3c Bit Error Measurements

This screen displays STS-12c or STS-3c bit error measurements depending on the test mode.

| Error Count: | 21 | ES: | 8 |
| Average Ratio: | 1.85E-09 | SES: | 0 |
| Current Ratio: | 7.42E-10 | EFS: | 11 |
| Patt Sync: | ON | %EFS: | 57.89 |

**Error Count:** The number of STS-12c/3c bit errors.

**Average Ratio:** STS-12c/3c average bit error ratio. The number of errored bits over the total number of bits since the beginning of the test.

**Current Ratio:** STS-12c/3c current bit error ratio. The number of errored bits over the total number of bits during the previous 2.25 seconds.

**Patt Sync:** Indicates ON when a valid STS-12c/3c payload pattern is received.

**ES:** STS-12c/3c errored seconds. The number of seconds in which at least one STS-3c bit error occurred.

**SES:** STS-12c/3c severely errored seconds. The number of seconds in which at least 27 STS-3c bit errors occurred.

**EFS:** STS-12c/3c error-free seconds. The number of seconds in which no STS-3c bit errors occurred.

**%EFS:** Percentage of STS-12c/3c error-free seconds. STS-12c/3c EFS expressed as a percentage of the total number of seconds since the beginning of the test.
STS Frame Measurements (A1/A2) Screen

This screen displays frame error measurements in the A1/A2 bytes of the STS frame.

**LOF (OOF) Events**: STS loss-of-frame events count. An LOF event is declared when four or more consecutive errored framing patterns are detected. (This measurement is not available in OC-12 receiver modes).

**EFS**: STS frame error-free seconds count. The number of seconds in which no OOF events occurred.

**%EFS**: Percentage of STS frame error-free seconds. STS frame EFS expressed as a percentage of the total number of seconds since the beginning of the test.

**Severely Err Frm Sec**: STS frame severely error seconds. The number of seconds in which at least one STS OOF occurred.
STS-1 BPV Measurements Screen

This screen displays bipolar violation measurements in the STS-1 signal.

<table>
<thead>
<tr>
<th>STS-1 BPV Measurements</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>BPV Count:</strong></td>
</tr>
<tr>
<td><strong>BPV BER (cur):</strong></td>
</tr>
<tr>
<td><strong>BPV BER (avg):</strong></td>
</tr>
<tr>
<td><strong>LCVR Sec:</strong></td>
</tr>
</tbody>
</table>

**BPV Count:** STS-1 bipolar violation count.

**BPV BER (cur):** STS-1 BPV average bit error ratio. The number of BPVs over the total number of transmitted bits since the beginning of the test.

**BPV BER (avg):** STS-1 BPV current bit error ratio. The number of BPVs over the total number of transmitted bits during the previous 2.25 seconds.

**LCVR Sec:** STS-1 line-code violation rate seconds. The number of seconds in which the LCVR state occurred. The LCVR state is declared when the BPV rate exceeds 44 BPVs per second for one second. The LCVR state continues until the BPV rate is less than 4 BPVs per second for one second.

**ES:** STS-1 BPV errored seconds. The number of seconds in which at least one BPV occurred.

**EFS:** STS-1 BPV error-free seconds. The number of seconds in which no BPVs occurred.

**%EFS:** Percentage of STS-1 BPV error-free seconds. STS-1 BPV EFS expressed as the percentage of total seconds since the beginning of the test.
STS-N Pointer Measurements Screen

This screen displays pointer measurements for STS-1, STS-12c, or STS-3c signals. The screen appears differently depending on the test mode.

**PJ + and PJ -:** STS-1, STS-12c, or STS-3c pointer justification count. The number of positive (+) and negative (−) pointer adjustments.

**Last PJ Dir:** Last pointer justification direction. The direction (positive or negative) of the previous pointer justification.

**LOP-P (LOPNTR):** Loss of pointer seconds. The number of seconds during which a loss of pointer condition was present.

**Pointer Value:** The decimal value of the STS-1, STS-12c, or STS-3c H1/H2 pointer. For STS-12c and STS-3c this is H1/H2 of STS-1 #1.

**NDF Sec:** New data flag seconds count. The number of seconds in which an NDF occurred. An NDF indicates an SPE alignment change. Bits 1-4 of the pointer carry the NDF which permits an arbitrary change in the pointer value because of a change in the payload.

**PJ Sec:** Pointer justification seconds count (STS-1 screen only). The number of second in which at least one pointer justification occurred.

**EFS:** STS-1 pointer error-free seconds (STS-1 screen only). The number of second in which no invalid H1/H2 pointers were detected.

**%EFS:** Percentage of STS-1 EFS (STS-1 screen only). STS-1 pointer EFS expressed as the percentage of total seconds since test start.

**H1/H2 #1, #2, and #3:** (STS-3c screen only) Hexadecimal value of the H1/H2 pointer bytes of STS-1 #1, #2, and #3. In STS-12c, the pointer bytes are displayed on a separate screen (see next page).
STS-12c Pointer Bytes Screen

This screen displays the values of the pointer bytes (H1 and H2 bytes) for each of the twelve STS-1s that make up the STS-12c frame. This screen is only available for STS-12c testing modes.

<table>
<thead>
<tr>
<th>#1</th>
<th>#5</th>
<th>#9</th>
<th>#12</th>
</tr>
</thead>
<tbody>
<tr>
<td>--</td>
<td>--</td>
<td>--</td>
<td>--</td>
</tr>
</tbody>
</table>

#1 through #12: The number indicates the STS-1 in the STS-12c frame (12 STS-1s are combined to form a concatenated STS-12).

**H1/H2 byte values:** The value for the H1 and H2 bytes of each STS-1 is displayed in hexadecimal format. For a valid STS-12c signal, the values of the H1/H2 bytes for STS-1s 2 through 12 must be 93/FF (hexadecimal).

APS Measurements Screen

This screen displays automatic protection switching (APS) measurements (K1 and K2 bytes).

<table>
<thead>
<tr>
<th>#1</th>
<th>#6</th>
<th>#9</th>
<th>#12</th>
</tr>
</thead>
<tbody>
<tr>
<td>--</td>
<td>--</td>
<td>--</td>
<td>--</td>
</tr>
</tbody>
</table>

**State Chng Sec:** APS state change seconds. The number of seconds in which one or more change in the received APS message occurred.

**Byte Fail Sec:** APS byte failure seconds. The number of seconds in which one or more APS byte failure events occurred. An APS byte failure is declared when eight consecutive frames are received in which there are not at least three consecutive frames with identical APS bytes.
**Request Chan:** APS requested channel: The number of the channel (0–15) to which the received condition message applies. This code is received in bits 5 through 8 of the K1 byte.

**Bridge Chan:** APS bridged channel: The number of the channel (1–15) currently bridged onto the protection line at the far end. This code is bits 1 through 4 of the K2 byte.

**APS State:** APS signal state message: Indicates the received message based on bits 1 through 4 of the K1 byte. The table below lists the displayed messages and their corresponding 4-bit codes.

**Type:** APS architecture type at the far-end. The result indicates either 1+1 (K2 bit 5 set to 0) or 1:n (K2 bit 5 set to 1).

**Mode:** APS switching mode at the far-end: Indicates one of the modes listed in the table on page 4–18. The mode is received on bits 6–8 of K2.
# APS Signal State Code (K2 byte, bits 1 through 4)

<table>
<thead>
<tr>
<th>K1 Bit 1</th>
<th>K1 Bit 2</th>
<th>K1 Bit 3</th>
<th>K1 Bit 4</th>
<th>APS State Message Displayed Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>No Request</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>Do Not Revert</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>Reverse Request</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>Not Used</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>Exercise</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>Not Used</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>Wait-to-Restore</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>Not Used</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>Manual Switch</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>Not Used</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>SD (signal degraded)—Low Priority</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>SD—High Priority</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>SF (signal failure)—Low Priority</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>SF—High Priority</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>Forced Switch</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>Lockout of Protection</td>
</tr>
</tbody>
</table>
### APS Switching Mode Code (K2 byte, bits 6 through 8)

<table>
<thead>
<tr>
<th>K2 Bit 6</th>
<th>K2 Bit 7</th>
<th>K2 Bit 8</th>
<th>APS Mode Displayed Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>0</td>
<td>Future</td>
</tr>
<tr>
<td>0</td>
<td>0</td>
<td>1</td>
<td>Future</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>0</td>
<td>Future</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>1</td>
<td>Future</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>0</td>
<td>Unidirectional switching</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>1</td>
<td>Bidirectional switching</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>0</td>
<td>Line FERF</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>1</td>
<td>Line AIS</td>
</tr>
</tbody>
</table>
Transport Overhead Screen #1 and Screen #2

These two screens display the transport overhead bytes of the SONET signal.

For each byte, the received value is displayed in hexadecimal notation. The table below describes the functions of the transport overhead bytes.

<table>
<thead>
<tr>
<th>Byte</th>
<th>Transport Overhead Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>D1–D3</td>
<td>Section DCC datalink</td>
</tr>
<tr>
<td>D4–D12</td>
<td>Line DCC datalink</td>
</tr>
<tr>
<td>E1</td>
<td>Section orderwire</td>
</tr>
<tr>
<td>E2</td>
<td>Line orderwire</td>
</tr>
<tr>
<td>F1</td>
<td>Section user channel</td>
</tr>
<tr>
<td>H1, H2</td>
<td>STS pointer</td>
</tr>
<tr>
<td>K1, K2</td>
<td>APS channel</td>
</tr>
<tr>
<td>Z1</td>
<td>S1/Z1, see SONET Overhead Parameters, page 3–13</td>
</tr>
<tr>
<td>Z2</td>
<td>M0/M1/Z2, see SONET Overhead Parameters, page 3–13</td>
</tr>
</tbody>
</table>
Path Overhead Screen

This screen displays the path overhead bytes of the SONET signal.

For each byte, the received value is displayed in hexadecimal notation. The table below describes the functions of the path overhead bytes.

### Displayed SONET Path Overhead Bytes

<table>
<thead>
<tr>
<th>Byte</th>
<th>Path Overhead Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>C2</td>
<td>STS path signal label. Identifies the STS payload mapping. Ten values identify the construction and content of the SPE, as listed below.</td>
</tr>
<tr>
<td>C3</td>
<td>Unequipped.</td>
</tr>
<tr>
<td>C4</td>
<td>Equipped; non-specific payload.</td>
</tr>
<tr>
<td>C5</td>
<td>Floating VT mode.</td>
</tr>
<tr>
<td>C6</td>
<td>Locked VT mode.</td>
</tr>
<tr>
<td>G1</td>
<td>Asynchronous mapping for DS3.</td>
</tr>
<tr>
<td>G2</td>
<td>Not used (mapping for byte-observable Syntran)</td>
</tr>
<tr>
<td>G3</td>
<td>Asynchronous mapping for DS4NA.</td>
</tr>
<tr>
<td>G4</td>
<td>Mapping for ATM.</td>
</tr>
<tr>
<td>G5</td>
<td>Mapping for DQDB.</td>
</tr>
<tr>
<td>G6</td>
<td>Asynchronous mapping for FDDI.</td>
</tr>
<tr>
<td>F2</td>
<td>Path user channel.</td>
</tr>
</tbody>
</table>

4–20
SONET Measurement Reference

STS-N Path Trace Byte (J1) Values Screens and OC-12 Section Trace Byte (J0) Values Screens

Displayed SONET Path Overhead Bytes, continued

<table>
<thead>
<tr>
<th>Byte</th>
<th>Path Overhead Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>H4</td>
<td>Payload indicator. Indicates the phase of the V1–V4 bytes in the VT1.5 overhead.</td>
</tr>
<tr>
<td>Z3, Z4, Z5</td>
<td>Growth bytes.</td>
</tr>
<tr>
<td>0-Bit</td>
<td>The DS3 overhead communication channel bits.</td>
</tr>
</tbody>
</table>

STS-N Path Trace Byte (J1) Values Screens and OC-12 Section Trace Byte (J0) Values Screens

These two screens display the 64-byte path trace message which is carried in the J1 byte. For OC-12, the Section Trace message is displayed on two similar screens.

```
1 OC12-OC12 (DS3) Final: 00:00:00.00
STS-N Path Trace Byte (J1) Values 1-32
1: 43 45 52 4A 41 43 00 00    CERJAC--
9: 54 65 66 63 6A 6F 60 00    Telecom--
17: 00 00 00 00 00 00 00 00    -------
25: 00 00 00 00 00 00 00 00    -------
```

```
1 OC12-OC12 (DS3) Final: 00:00:00.00
STS-N Path Trace Byte (J1) Values 33-64
33: 48 65 77 6C 65 74 74 00    Hewlett--
41: 50 61 63 68 61 72 64 00    Packard--
49: 00 00 00 00 00 00 00 00    -------
57: 00 00 00 00 00 00 00 00    -------
```

Eight bytes are displayed on each line. For example, the 1: line shows J1 or J0 bytes 1 through 8; The 9: line shows bytes 9 through 16; and so forth. For each byte, the hexadecimal value is shown on the left portion of the screen, and the ASCII equivalent value is shown on the right.
STS-1 Signal Measurements

This screen displays signal measurements for the STS-1 signal.

<table>
<thead>
<tr>
<th>OC12-OC12 (DS3) Final: 00:00:00.00</th>
</tr>
</thead>
<tbody>
<tr>
<td>STS-1 Signal Measurements</td>
</tr>
<tr>
<td>Rx Hz:</td>
</tr>
<tr>
<td>Rx Pk V:</td>
</tr>
<tr>
<td>Rx dBdsx:</td>
</tr>
</tbody>
</table>

**Rx Hz:** STS-1 receive frequency in Hertz: The recovered clock frequency of the receive STS-1 data pattern.

**Rx Pk V:** STS-1 receive peak voltage: The receive signal level measured in volts peak (Vpk). Accuracy is ±5%.

**Rx dBdsx:** STS-1 receive dBdsx level: The receive signal level measured in decibels relative to an STSX-1 signal (0 dBdsx = 0.53 Vpk). Accuracy is ±1 dB.
### STS-1 Jitter Measurements

This screen displays jitter peak results for the selected receiver rate.

| STS1-STS1 (DS3) Final: 00:00:00.00 |
|------------------------------|-----------------|-----------------|
| STS1 Jitter                 | Wide-Band       | High-Band       |
| Current P-to-P (UI):         | --              | --              |
| MAX P-to-P (UI):             | --              | --              |
| MAX Pos Peak (UI):           | --              | --              |
| MAX Neg Peak (UI):           | --              | --              |

**Current P-to-P:** Current peak-to-peak jitter: The sum of the positive jitter peak and the negative jitter peak for the most recent one-second period. Displayed in unit intervals.

**MAX P-to-P:** Maximum peak-to-peak jitter: The sum of the highest positive jitter peak and the highest negative jitter peak for the entire test duration. Displayed in unit intervals.

**MAX Pos Peak:** Maximum positive jitter peak: The greatest positive jitter peak since the beginning of the test. Displayed in unit intervals.

**MAX Neg Peak:** Maximum negative jitter peak: The greatest negative jitter peak since the beginning of the test. Displayed in unit intervals.

### Jitter Hits and Mask Results Screen

This screen displays jitter threshold and mask percentage results for the selected receiver rate.

| STS1-STS1 (DS3) Final: 00:00:00.00 |
|------------------------------|-----------------|-----------------|
| STS1 Jitter                 | --              | --              |
| Hits Count:                 | --              | --              |
| Total Hits Time (Sec):      | --              | --              |
| MAX Percent of Mask:        | --              | --              |

The measurements on this display are described below. Each measurement is calculated for both wide-band and high-band jitter.

**Hits Count:** Indicates the total number of jitter hits (jitter hit threshold exceeded) since the beginning of the test.

**Total Hits Time:** Indicates the cumulative total of time, in seconds, that the jitter hit threshold has been exceeded since the beginning of the test.

**MAX Percent of Mask:** Indicates the maximum peak-to-peak jitter for the entire test period expressed as a percentage of the jitter mask.

---

STS-N Alarm Screens

The screens described in this section display alarm results for the SONET signal. The alarms that are displayed on the screens are described in the following table.

<table>
<thead>
<tr>
<th>Alarm</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AIS-L</td>
<td>Line alarm indication signal (formerly “LAIS”): Declared when five consecutive K2 bytes are received containing XXXXX111. The alarm is cleared when five consecutive K2 bytes do not contain XXXXX111.</td>
</tr>
<tr>
<td>RDI-L</td>
<td>Line remote defect indication (formerly “far-end receive failure” or “FERF”): Declared when five consecutive K2 bytes are received containing XXXXX110. The alarm is cleared when five consecutive K2 bytes do not contain XXXXX110.</td>
</tr>
<tr>
<td>LOS</td>
<td>Loss of signal: Declared when between 10 and 100 μs of all-zeros pattern is detected. Nominal detect time is 55 μs. The alarm is cleared when a non-zero pulse is detected.</td>
</tr>
</tbody>
</table>
| LOP-P | Loss of pointer (formerly “LOPNTR”): Declared when eight consecutive frames are received that do not meet at least one of the following conditions:  
  • Normal flag (0110) and valid value (0–782).  
  • New data flag (1001) and valid value (0–782).  
  • Normal flag and valid value in STS-1 #1, and concatenation indicator (1001XX1111111111) in the other STS-1s.  
  LOP-P is not declared during AIS-P. The alarm is cleared when a consistent, valid pointer is received for three consecutive frames. |
| LOF | Loss of frame synchronization: Declared when an OOF condition (out of frame: four consecutive errored framing patterns) is detected for 24 consecutive frames (3 ms). The alarm is cleared after 24 consecutive frames of correct framing patterns. |
| LOCLK | Loss of clock synchronization: Declared when external clock source is no longer detected (when configured for external timing). This alarm is cleared when clock source is reapplied. |
**SONET Alarm Definitions, continued**

<table>
<thead>
<tr>
<th>Alarm</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOPatt</td>
<td>Loss of STS-12c or STS-3c pattern synchronization. Declared when the error ratio is 25% or higher (evenly distributed) on the SPE bytes, or when the error ratio exceeds 3.125% if the errors are not evenly distributed (STS-3c only). LOPatt is cleared when 64 consecutive pattern matches (bits) are received.</td>
</tr>
<tr>
<td>AIS-P</td>
<td>Path alarm indication signal (formerly &quot;PAIS&quot;): Declared when all-ones is received in H1/H2 for three consecutive frames. This alarm is cleared when all-ones is not received in H1/H2 for three consecutive frames.</td>
</tr>
<tr>
<td>RDI-P</td>
<td>Path remote defect indications (formerly Path Yellow alarm): Declared when ten consecutive frames are received containing bit 5 of the G1 byte set to 1. The alarm is cleared when ten consecutive frames are received containing bit 5 of the G1 byte set to 0.</td>
</tr>
</tbody>
</table>

**STS-N Alarm Seconds Screens**

These three screens display counts of SONET alarm seconds. An alarm second is a second during which a particular type of alarm is active.

```
1 OC12-OC12 <STS3c>Final: 00:00:00.00
STS-N Alarm Seconds
AIS-L<LAIS>: --
RDI-L<LPERF>: --
LOS: --
LOP-P<LOPNTR>: --
```

```
1 OC12-OC12 <STS3c>Final: 00:00:00.00
STS-N Alarm Seconds
AIS-P<PAIS>: --
RDI-P<PYEL>: --
LOF: --
LOCLK: --
```

**Note:** For concatenated payloads the “LOPat” alarm (loss of pattern) is added, and the alarms are displayed on three screens instead of two.
STS-N Alarm and History Screens

These screens display current and previous SONET alarms. Like front panel LEDs, the screens provide current status of the alarm (Alarm) and also indicate if the alarm has occurred previously (Hist).

---

Note: For concatenated payloads the "LOPat" alarm (loss of pattern) is added, and the alarms are displayed on three screens instead of two.

---

STS-N Status Screen

This screen displays the status of certain SONET signal parameters, similar to the front-panel STS-N STATUS indicators.

---

SONET Status Conditions

<table>
<thead>
<tr>
<th>Status Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>STS-N Signal</td>
<td>Valid STS-N signal present.</td>
</tr>
<tr>
<td>STS-N Frame</td>
<td>Frame synch (no OOF for at least 24 frames).</td>
</tr>
<tr>
<td>Valid Pointer</td>
<td>Consistent H1/H2 received for at least three frames.</td>
</tr>
<tr>
<td>STS-12c Patt Sync or STS-3c Patt Sync</td>
<td>Valid STS-12c or STS-3c payload pattern received.</td>
</tr>
</tbody>
</table>
VT Indicators

VT Alarm and Status Indicators

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>HIST/ALARMS</strong></td>
<td></td>
</tr>
<tr>
<td>LOP-V</td>
<td>Loss of VT pointer.</td>
</tr>
<tr>
<td>AIS-V</td>
<td>VT1.5 Path Alarm Indication signal.</td>
</tr>
<tr>
<td>RDI-V</td>
<td>VT1.5 path remote defect indication.</td>
</tr>
<tr>
<td><strong>STATUS</strong></td>
<td></td>
</tr>
<tr>
<td>VT PTR</td>
<td>Valid VT1.5 pointer detected.</td>
</tr>
<tr>
<td><strong>ERRORS</strong></td>
<td></td>
</tr>
<tr>
<td>V5 CV</td>
<td>Indicates V5 byte code violation.</td>
</tr>
<tr>
<td>REI-V</td>
<td>VT remote error indication.</td>
</tr>
</tbody>
</table>
VT1.5 Measurement Summary Screen

This screen displays a summary of VT1.5 test results.

**V5 (VT VC):** VT code violations count: Includes BIP-2 errors in the V5 byte (as many as two per frame).

**VT FEBE:** VT1.5 far-end block error count: Includes reported errors (VT FEBE reporting uses bit 3 of the V5 byte).
VT1.5 Code Violations Screen

This screen displays VT code violation measurements (CVs in the V5 byte).

VT CV Count: VT code violations count: Includes BIP-2 errors in the V5 byte (as many as two in each frame).

CV BER (avg): VT CV average bit error ratio: The number of VT CVs over the total number of VT bits transmitted since the beginning of the test.

CV BER (curr): VT CV current bit error ratio: The number of VT CVs over the total number of VT bits transmitted during the previous 2.25 seconds.

VT UAS: VT unavailable seconds: The number of seconds that the VT was unavailable. The VT is declared unavailable after ten consecutive VT SESS. The VT is declared available again after ten consecutive seconds with no VT SESS. The VT UAS measurement includes the first ten seconds, but not the last ten seconds. The path is also unavailable during VT AIS and VT LOP conditions.

ES: VT errored seconds. The number of seconds in which one or more VT CVs occurred.

SES: VT severely errored seconds. A count of seconds in which the number of VT CVs was four or more.

EFS: VT error-free seconds. The number of seconds in which no VT CVs occurred.

%EFS: VT percentage of error-free seconds. VT EFS expressed as a percentage of the total number of seconds since the beginning of the test.
VT1.5 FEBE Measurements Screen

This screen displays VT far-end block error (FEBE) measurements. FEBE measurements are block code violations reported from the far-end using bit 3 of the V5 byte.

FEBE CV Count: VT FEBE count. The number of VT CVs reported.

CV BER (avg): VT FEBE average bit error ratio. The number of BIP-2 errors over the total number of VT bits transmitted since the beginning of the test.

CV BER (cur): VT FEBE current bit error ratio. The number of BIP-2 errors over the total number of VT bits transmitted during the previous 2.25 seconds.

FEBE UAS: VT FEBE unavailable seconds. The number of seconds that the (reverse) VT was unavailable. The VT is declared unavailable after ten consecutive VT SESs. The VT is declared available again after ten consecutive seconds with no VT SESs. The FEBE UAS measurement includes the first ten seconds, but not the last ten seconds.

ES: VT FEBE errored seconds. The number of seconds in which at least one VT FEBE was reported.

SES: VT FEBE severely errored seconds. The number of seconds in which at least four VT FEBEs were reported.

EFS: VT FEBE error-free seconds. The number of seconds in which no VT FEBEs were reported.

%EFS: Percentage of VT FEBE error-free seconds. VT FEBE EFS expressed as a percentage of the total number of seconds since the beginning of the test.
VT1.5 Pointer Measurements Screen

This screen displays pointer measurements for VT signals.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOPNTR Sec.</td>
<td>Loss of pointer seconds: The number of seconds during which a loss of pointer condition was present.</td>
</tr>
<tr>
<td>Pointer Value</td>
<td>The decimal value of the VT1.5 (V1/V2) pointer.</td>
</tr>
<tr>
<td>V1 and V2</td>
<td>Hexadecimal value of the V1 and V2 bytes.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PJ Sec.</td>
<td>Pointer justification seconds count: The number of second in which at least one pointer justification occurred.</td>
</tr>
<tr>
<td>EFS</td>
<td>VT pointer error-free seconds. The number of seconds in which no invalid V1/V2 pointers were detected.</td>
</tr>
<tr>
<td>%EFS</td>
<td>Percentage of VT EFS. VT pointer EFS expressed as the percentage of total seconds since test start.</td>
</tr>
</tbody>
</table>

VT1.5 Path Overhead Screen

This screen displays the overhead bytes of the VT signal.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>V4</td>
<td>Displays the value of the received V4 (undefined) byte.</td>
</tr>
<tr>
<td>V5: Sig Lbl.</td>
<td>Displays the bit values and signal label definition of bits 5–7 of the received V5 byte.</td>
</tr>
<tr>
<td>Z6, Z7</td>
<td>Displays the value of the receive Z6 and Z7 (growth) bytes. Bit 8 of the Z7 byte is used for RFI-V.</td>
</tr>
</tbody>
</table>
VT1.5 Path Trace Byte (J2) Values (1–32 and 33–64)

These two screens display the 64-byte path trace message which is carried in the J2 byte.

<table>
<thead>
<tr>
<th>1</th>
<th>OC12-OC12 (VT1.5A) Final:</th>
<th>00:00:00.00</th>
</tr>
</thead>
<tbody>
<tr>
<td>VT1.5 Path Trace Byte (J2) Values 1–32</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1:</td>
<td>43 45 52 44 41 43 00 00</td>
<td></td>
</tr>
<tr>
<td>9:</td>
<td>54 65 6C 65 63 6F 6D 00</td>
<td></td>
</tr>
<tr>
<td>17:</td>
<td>00 00 00 00 00 00 00 00</td>
<td></td>
</tr>
<tr>
<td>25:</td>
<td>00 00 00 00 00 00 00 00</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>1</th>
<th>OC12-OC12 (VT1.5A) Final:</th>
<th>00:00:00.00</th>
</tr>
</thead>
<tbody>
<tr>
<td>VT1.5 Path Trace Byte (J2) Values 33–64</td>
<td></td>
<td></td>
</tr>
<tr>
<td>33:</td>
<td>48 65 77 6C 65 74 74 00</td>
<td></td>
</tr>
<tr>
<td>41:</td>
<td>50 61 63 6B 61 72 64 00</td>
<td></td>
</tr>
<tr>
<td>49:</td>
<td>00 00 00 00 00 00 00 00</td>
<td></td>
</tr>
<tr>
<td>57:</td>
<td>00 00 00 00 00 00 00 00</td>
<td></td>
</tr>
</tbody>
</table>

Eight bytes are displayed on each line. For example, the 1: line shows J2 bytes 1 through 8; The 9: line shows bytes 9 through 16; and so forth. For each byte, the hexadecimal value is shown on the left portion of the screen, and the ASCII equivalent value is shown on the right.
VT Alarm Screens

These two screens display counts of VT alarm seconds and current status.

An alarm second is a second during which a particular type of alarm is active. An alarm's current status is displayed as ON if that alarm condition is present.

**PAIS:** VT path alarm indication signal: Declared when all-ones is received in the V1 and V2 bytes for three consecutive frames. The alarm is cleared when all-ones is not received in the V1 and V2 bytes for three consecutive frames.

**PYEL:** VT path yellow: Declared when bits 4 and 8 of the V5 byte are set to 01 for ten consecutive VT superframes. The alarm is cleared when the bits are not 01 for ten consecutive VT superframes.

**LOPNTR:** VT loss of pointer: Declared when a valid VT pointer is not received for eight consecutive frames. The alarm is cleared when a consistent, valid pointer value is received for three consecutive frames.

**FEBE:** VT far-end block errors: Declared when bit 3 of the V5 byte is received set to 1. This alarm is cleared when bit 3 is received set to 0.
**RDI-V**: VT remote defect indication: Displays the values of bits 4 and 8 of the V5 byte, and indicates the corresponding alarm to which the remote device is responding:

<table>
<thead>
<tr>
<th>Bits 4 and 8</th>
<th>RDI Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 1</td>
<td>AIS-V or LOP-V: VT alarm indication signal or loss of pattern (also indicated as PYEL).</td>
</tr>
<tr>
<td>1 0</td>
<td>PLM-V: VT payload label mismatch.</td>
</tr>
<tr>
<td>1 1</td>
<td>UNEQ-V: VT unequipped.</td>
</tr>
<tr>
<td>0 0</td>
<td>—— (no alarm).</td>
</tr>
</tbody>
</table>

**RFI-V**: VT remote failure indication: Declared when bit 8 of the Z7 byte is received as 1.

**PDI-V**: VT payload defect indication: Declared when the received V5 signal label bits (Bits 5–7) are 110.

**P0/P1**: VT byte synchronization phase bit alignment alarm: Declared when VT byte-synchronous signaling framing is lost. Not valid for VT asynchronous modes.
SONET Electrical Interfaces  5–2
OC-N Optical Interfaces  5–5
STS-N Timing  5–6
STS-1 Jitter Option Specifications  5–7
SONET Formats  5–8
VT1.5 Format and Mapping  5–12
SONET Specifications

SONET Electrical Interfaces

SONET Electrical Interfaces

STS-1 Transmitter
STS-1 TX

Signals:

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>STSX-1</td>
<td>Per TR-NWT-000253 Section 4.4.</td>
</tr>
<tr>
<td></td>
<td>0.53 Vpk ±1.2 dB.</td>
</tr>
<tr>
<td></td>
<td>LBO = 450 ft simulated 728A cable.</td>
</tr>
<tr>
<td>High</td>
<td>1.11 Vpk ±1.2 dB.</td>
</tr>
<tr>
<td></td>
<td>LBO = none.</td>
</tr>
<tr>
<td>900</td>
<td>0.35 Vpk ±2.0 dB.</td>
</tr>
<tr>
<td></td>
<td>LBO = 900 ft simulated 728A cable.</td>
</tr>
<tr>
<td>Low</td>
<td>0.206 Vpk ±2.0 dB.</td>
</tr>
<tr>
<td></td>
<td>LBO = Flat loss from High level.</td>
</tr>
</tbody>
</table>

Line Code: B3ZS.

Impedance: 75 ohm ±5%; return loss >20 dB.

Connector: Accepts WECO 440. Optional WECO 358 or BNC.

STS-1 Receiver
STS-1 RX

Signals:

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>STSX-1</td>
<td>Automatic equalizer for 0 to 900 ft of 728A cable.</td>
</tr>
<tr>
<td>High</td>
<td>1.11 Vpk input signal, nominal.</td>
</tr>
<tr>
<td>Mon</td>
<td>Up to 26 dB flat loss relative to nominal STSX-1 level.</td>
</tr>
</tbody>
</table>

Line Code: B3ZS.

Impedance: 75 ohm ±5%.

Connector: Accepts WECO 440. Optional WECO 358 or BNC.
STS-1 Drop Output
STS-1 DROP

Signal:

STSX-1
Per TR-NWT-000253 Section 4.4. 0.53 Vpk ±1.2 dB.
LBO = 450 ft simulated 728A cable.
Provides STS-1 dropped from higher-rate signal.

Line Code: B3ZS.

Impedance: 75 ohm ±5%; return loss >20 dB.

Connector: Accepts WECO 440. Optional WECO 358 or BNC.

STS-12 and STS-3 I/O

These are the specifications for the optional rear-panel SONET electrical connectors. Option 205 is required for STS-12; Option US2 is required for STS-3.

Signals provided:

- Rx Data (input)
- Tx Data (output)
- Tx Clock (output).

Level: ECL.

Impedance: 50 Ohms.

Connectors: SMA (STS-12), BNC (STS-3).

Output Termination

The following figures show acceptable terminations for the STS-12 and STS-3 electrical connectors.

Note: For STS-12 the Tx Data and Tx Clock outputs are ac coupled, therefore the receiving equipment must set the dc bias level. For STS-3 the Tx Data and Tx Clock outputs are dc coupled.

Acceptable terminations for STS-12 and STS-3 electrical outputs
(Tx Data and Tx Clock)
Input Termination

The Rx Data input termination is as follows:

---

**Termination for the STS-12 electrical input (Rx Data)**

- **196 Ω**
- **61.9 Ω**
- **-5.2 V**

---

**Termination for the STS-3 electrical input (Rx Data)**

- **130 Ω**
- **82 Ω**
- **-5.2 V**
**OC-N Optical Interfaces**

**Transmitter:** Transmitters are hermetic, InGaAsP lasers optically coupled to a 5D, 8 m core, single-mode fiber pigtail.

**Receiver:** Receivers are planar, InGaAs PIN photodetectors with a 62.5 multimode fiber pigtail. When connecting to a single-mode source, you can use a single-mode or multi-mode fiber patch cable. When connecting to a multi-mode (LED) source, you must use a multi-mode fiber patch cable.

**Note:** When connecting a long reach (LR) laser transmitter to the receiver, either from the network or when looping the test set back on itself (LR laser installed), be sure to provide 8 dB of attenuation to avoid damaging the receiver.

### OC-12/OC-3/OC-1 Optical Interfaces

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Intermediate Reach</td>
<td>Long Reach</td>
<td>Long Reach</td>
</tr>
<tr>
<td>1310 nm (622 Mbs)</td>
<td>1310 nm (622 Mbs)</td>
<td>1550 nm (622 Mbs)</td>
</tr>
<tr>
<td>Option UQK</td>
<td>Option UQL</td>
<td>Option UQM</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Transmission</th>
<th>Min.</th>
<th>Max.</th>
<th>Typ.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Avg. Optical Power (dBm)</td>
<td>-12.0</td>
<td>-5.0</td>
<td>-8.0</td>
</tr>
<tr>
<td>Optical wavelength (nm)</td>
<td>1260</td>
<td>1360</td>
<td>1310</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Receiver</th>
<th>Min.</th>
<th>Max.</th>
<th>Typ.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Optical Sensitivity (dBm)</td>
<td>-26.0</td>
<td>-28.0</td>
<td>-26.0</td>
</tr>
<tr>
<td>Peak input power (dBm)</td>
<td>-7.0</td>
<td>-7.0</td>
<td>-7.0</td>
</tr>
<tr>
<td>Optical Wavelength (nm)</td>
<td>1240</td>
<td>1380</td>
<td>1500</td>
</tr>
</tbody>
</table>

**Connectors**

PC/PC connectors are standard. Optional ST, D4-PC, or SC connectors are available.
SONET Specifications

STS-N Timing

OC-3/OC-1 Optical Interfaces

<table>
<thead>
<tr>
<th>OC-3/OC-1</th>
<th>OC-3/OC-1</th>
<th>OC-3/OC-1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Intermediate Reach</td>
<td>Long Reach</td>
<td>Long Reach</td>
</tr>
<tr>
<td>1310 nm (155 Mbs)</td>
<td>1310 nm (155 Mbs)</td>
<td>1550 nm (155 Mbs)</td>
</tr>
<tr>
<td>Option UQG</td>
<td>Option UQH</td>
<td>Option UQJ</td>
</tr>
<tr>
<td>----------</td>
<td>----------</td>
<td>----------</td>
</tr>
<tr>
<td>Transmitter (OC-N TX)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Avg. Optical Power (dBm)</td>
<td>-15.0</td>
<td>-8.0</td>
</tr>
<tr>
<td>Optical wavelength (nm)</td>
<td>1260</td>
<td>1360</td>
</tr>
</tbody>
</table>

Receiver (OC-N RX)

| | | | | | | | | |
| Optical Sensitivity (dBm) | -28.0 | • | -34.0 | -28.0 | • | -34.0 | -28.0 | • | -34.0 |
| Peak input power (dBm) | • | -7.0 | • | • | -7.0 | • | • | -7.0 | • |
| Optical Wavelength (nm) | 1240 | 1380 | • | 1240 | 1380 | • | 1500 | 1570 | • |

Connectors

PC/PC connectors are standard. Optional ST, D4-PC, or SC connectors are available.

STS-N Timing

Internal Source

Stratum 3: 51.84 MHz, ±4.5 ppm.

External Source Inputs

STS1 TX CLK IN jack: TTL level, 50 ohm, BNC connector.

DS1 BITS IN jack: DSX-1 input signal per ANSI T1X1, CB119, and TR-TSY-000449.

• 1.544 Mhz, SF-framed, all-ones pattern.
• 3.0 Vpk ±1.0 dB (0 dBdsx) typical expected.
• 100 ohm, WECO 310 connector.
• DS1 BITS OUT jack provides output signal as described above.
STS-1 Jitter Option Specifications

STS-1 jitter measurement requires STS-1 testing (standard base unit or Option UQC) and Option UQN.

**Measurement Response**

**STS-1 Jitter Measurement per:** TR-NWT-000253

- **Wide-band cut-off frequency:** 100 Hz to 400 kHz
- **High-band cut-off frequency:** 20 kHz to 400 kHz
- **Roll-off (per decade) below lower 3 dB point:** ≥20 dB
- **Roll-off (per decade) above higher 3 dB point:** ≥60 dB

**Jitter Measurements**

<table>
<thead>
<tr>
<th>Measurement</th>
<th>Range</th>
<th>Resolution</th>
<th>Accuracy</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Peak Positive Jitter</td>
<td>0.1 to 6.0 Ul</td>
<td>0.1 Ul</td>
<td>±5% of reading, ±0.05 Ul.</td>
</tr>
<tr>
<td>Maximum Peak Negative Jitter</td>
<td>0.1 to 6.0 Ul</td>
<td>0.1 Ul</td>
<td>±5% of reading, ±0.05 Ul.</td>
</tr>
<tr>
<td>Current Peak-to-Peak Jitter</td>
<td>0.1 to 12.0 Ul</td>
<td>0.1 Ul</td>
<td>±5% of reading, ±0.05 Ul.</td>
</tr>
<tr>
<td>Max Peak-to-Peak Jitter</td>
<td>0.1 to 12.0 Ul</td>
<td>0.1 Ul</td>
<td>±5% of reading, ±0.05 Ul.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th></th>
<th>Wideband Mask</th>
<th>Highband Mask</th>
</tr>
</thead>
<tbody>
<tr>
<td>Percent of Mask</td>
<td>1.5 Ul</td>
<td>0.2 Ul</td>
</tr>
</tbody>
</table>

**Demodulated Jitter Output**

**DMOD JITTER OUT jack:** 50 ohm, BNC connector.

Scale = 100 mV/Ul; range = 0 to 6 Vdc.
SONET Specifications

SONET Formats

SONET Network Spans—Path, Line, and Section

STS-1 Frame

1 2 3 4 ← Columns of Bytes → 90

1 2 3 4 5 6 7 8 9

A1 A2 J0 J1
B1 E1 F1 B3
D1 D2 D3 C2
H1 H2 H3 G1
B2 K1 K2 F2
D4 D5 D6 H4
D7 D8 D9 Z3
D10 D11 D12 Z4
S1 M0 E2 Z5

125 µs
51.840 Mbs

Path Overhead

Synchronous Payload Envelope (SPE)
STS-N Frame

<table>
<thead>
<tr>
<th></th>
<th>A1</th>
<th>A1</th>
<th>A2</th>
<th>A2</th>
<th>A2</th>
<th>A2</th>
<th>J0</th>
<th>Z0</th>
<th>Z0</th>
<th>J1</th>
<th>J1</th>
<th>J1</th>
</tr>
</thead>
<tbody>
<tr>
<td>B1</td>
<td>B1</td>
<td>E1</td>
<td>E1</td>
<td>E1</td>
<td>E1</td>
<td>E1</td>
<td>F1</td>
<td>F1</td>
<td>F1</td>
<td>B3</td>
<td>B3</td>
<td>B3</td>
</tr>
<tr>
<td>D1</td>
<td>D1</td>
<td>D2</td>
<td>D2</td>
<td>D2</td>
<td>D2</td>
<td>D2</td>
<td>D3</td>
<td>D3</td>
<td>D3</td>
<td>C2</td>
<td>C2</td>
<td>C2</td>
</tr>
<tr>
<td>H1</td>
<td>H1</td>
<td>H2</td>
<td>H2</td>
<td>H2</td>
<td>H2</td>
<td>H2</td>
<td>H3</td>
<td>H3</td>
<td>H3</td>
<td>G1</td>
<td>G1</td>
<td>G1</td>
</tr>
<tr>
<td>B2</td>
<td>B2</td>
<td>K1</td>
<td>K1</td>
<td>K1</td>
<td>K1</td>
<td>K1</td>
<td>K2</td>
<td>K2</td>
<td>K2</td>
<td>F2</td>
<td>F2</td>
<td>F2</td>
</tr>
<tr>
<td>D4</td>
<td>D4</td>
<td>D5</td>
<td>D5</td>
<td>D5</td>
<td>D5</td>
<td>D5</td>
<td>D6</td>
<td>D6</td>
<td>D6</td>
<td>H4</td>
<td>H4</td>
<td>H4</td>
</tr>
<tr>
<td>D7</td>
<td>D7</td>
<td>D8</td>
<td>D8</td>
<td>D8</td>
<td>D8</td>
<td>D8</td>
<td>D9</td>
<td>D9</td>
<td>D9</td>
<td>Z3</td>
<td>Z3</td>
<td>Z3</td>
</tr>
<tr>
<td>O10</td>
<td>O10</td>
<td>O11</td>
<td>O11</td>
<td>O11</td>
<td>O11</td>
<td>O11</td>
<td>O12</td>
<td>O12</td>
<td>O12</td>
<td>Z4</td>
<td>Z4</td>
<td>Z4</td>
</tr>
<tr>
<td>S1</td>
<td>Z1</td>
<td>Z1</td>
<td>Z2</td>
<td>Z2</td>
<td>Z2</td>
<td>Z2</td>
<td>Z5</td>
<td>Z5</td>
<td>Z5</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**STS-1**: #1 #2 \ldots #N #1 #2 \ldots #N #1 #2 \ldots #N

STS-1s are byte-interleaved to form STS-N.

**Transport O.H.** = $N \times 3$ Columns

**SPE** = $N \times 87$ Columns

**Path O.H.** = $N \times 1$ Columns

<table>
<thead>
<tr>
<th></th>
<th>N = 3: 155.520 Mbs</th>
<th>N = 12: 622.080 Mbs</th>
<th>N = 48: 2.488 Gbs</th>
</tr>
</thead>
<tbody>
<tr>
<td>N × 125 μs</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## SONET Overhead Bytes

<table>
<thead>
<tr>
<th>Network Span</th>
<th>Byte</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>A1/A2</td>
<td>Framing Pattern = 11110110 00101000 (F6 28 hex).</td>
</tr>
<tr>
<td></td>
<td>J0/Z0</td>
<td>J0 (STS-1 #1) = Section trace. Z0 = Growth. (Formerly C1)</td>
</tr>
<tr>
<td></td>
<td>B1</td>
<td>Section bit-interleaved parity (BIP-8) code.</td>
</tr>
<tr>
<td></td>
<td>E1</td>
<td>Local orderwire channel.</td>
</tr>
<tr>
<td></td>
<td>F1</td>
<td>Section user channel.</td>
</tr>
<tr>
<td></td>
<td>D1–D3</td>
<td>Section data communication channel (DCC).</td>
</tr>
<tr>
<td></td>
<td>H1–H3</td>
<td>Payload pointers.</td>
</tr>
<tr>
<td></td>
<td>B2</td>
<td>Line bit-interleaved parity (BIP-8) code.</td>
</tr>
<tr>
<td></td>
<td>K1/K2</td>
<td>Automatic protection switching (APS) channel, also Line AIS and Line ROI indication.</td>
</tr>
<tr>
<td></td>
<td>D4–D12</td>
<td>Line data communication channel (DCC).</td>
</tr>
<tr>
<td></td>
<td>S1/Z1</td>
<td>S1 (STS-1 #1) = Synchronization status. Z1 = Growth.</td>
</tr>
<tr>
<td></td>
<td>M0</td>
<td>M0 (STS-1/OC-1 signals only): bits 5–8 = Line FEBE</td>
</tr>
<tr>
<td></td>
<td>M1</td>
<td>M1 (STS-1 #3 of STS-N≥3 signals) = Line FEBE.</td>
</tr>
<tr>
<td></td>
<td>Z2</td>
<td>Z2 (other STS-1s) = Growth.</td>
</tr>
<tr>
<td></td>
<td>E2</td>
<td>Express orderwire channel.</td>
</tr>
<tr>
<td></td>
<td>J1</td>
<td>Path trace.</td>
</tr>
<tr>
<td></td>
<td>B3</td>
<td>Path bit-interleaved parity (BIP-8) code.</td>
</tr>
<tr>
<td></td>
<td>C2</td>
<td>Path signal label.</td>
</tr>
<tr>
<td></td>
<td>G1</td>
<td>Path status. Bits 1–4 = path FEBE; bits 5–6 = path ROI.</td>
</tr>
<tr>
<td></td>
<td>F2</td>
<td>Path user channel.</td>
</tr>
<tr>
<td></td>
<td>H4</td>
<td>VT multiframe phase indicator.</td>
</tr>
<tr>
<td></td>
<td>Z5</td>
<td>Tandem connection error count and data link.</td>
</tr>
</tbody>
</table>
### SONET Specifications

#### SONET Formats

#### STS-3c Frame (concatenated SONET signal)

- **Transport OH = 9 Columns**
- **SPE = 261 Columns**

<table>
<thead>
<tr>
<th>Rows</th>
<th>Columns</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>A1</td>
</tr>
<tr>
<td></td>
<td>A1</td>
</tr>
<tr>
<td></td>
<td>A2</td>
</tr>
<tr>
<td></td>
<td>A2</td>
</tr>
<tr>
<td></td>
<td>A2</td>
</tr>
<tr>
<td></td>
<td>J0</td>
</tr>
<tr>
<td></td>
<td>Z0</td>
</tr>
<tr>
<td></td>
<td>Z0</td>
</tr>
<tr>
<td></td>
<td>J1</td>
</tr>
<tr>
<td></td>
<td>B1</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>E1</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>F1</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>B3</td>
</tr>
<tr>
<td></td>
<td>D1</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>D2</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>D3</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>C2</td>
</tr>
<tr>
<td></td>
<td>H1c</td>
</tr>
<tr>
<td></td>
<td>Hc</td>
</tr>
<tr>
<td></td>
<td>H2c</td>
</tr>
<tr>
<td></td>
<td>H2c</td>
</tr>
<tr>
<td></td>
<td>H3</td>
</tr>
<tr>
<td></td>
<td>H3</td>
</tr>
<tr>
<td></td>
<td>G1</td>
</tr>
<tr>
<td></td>
<td>B2</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>B2</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>K1</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>K2</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>F2</td>
</tr>
<tr>
<td></td>
<td>D4</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>D5</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>D6</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>H4</td>
</tr>
<tr>
<td></td>
<td>D7</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>D8</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>D9</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>Z3</td>
</tr>
<tr>
<td></td>
<td>D10</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>D11</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>D12</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>Z4</td>
</tr>
<tr>
<td></td>
<td>S1</td>
</tr>
<tr>
<td></td>
<td>Z1</td>
</tr>
<tr>
<td></td>
<td>Z1</td>
</tr>
<tr>
<td></td>
<td>Z2</td>
</tr>
<tr>
<td></td>
<td>Z2</td>
</tr>
<tr>
<td></td>
<td>M1</td>
</tr>
<tr>
<td></td>
<td>E2</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>Z5</td>
</tr>
</tbody>
</table>

**STS-1:** #1 | #2 | #3 | #1 | #2 | #3 | #1 | #2 | #3

- **H1c/H2c = Concatenation Indication**
- **uo = Undefined overhead byte**

#### STS-Nc Frame

- **Transport OH = N x 3 Columns**
- **SPE = N x 87 Columns**

<table>
<thead>
<tr>
<th>Rows</th>
<th>Columns</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>A1</td>
</tr>
<tr>
<td></td>
<td>A1</td>
</tr>
<tr>
<td></td>
<td>A2</td>
</tr>
<tr>
<td></td>
<td>A2</td>
</tr>
<tr>
<td></td>
<td>A2</td>
</tr>
<tr>
<td></td>
<td>A2</td>
</tr>
<tr>
<td></td>
<td>A2</td>
</tr>
<tr>
<td></td>
<td>J0</td>
</tr>
<tr>
<td></td>
<td>Z0</td>
</tr>
<tr>
<td></td>
<td>Z0</td>
</tr>
<tr>
<td></td>
<td>J1</td>
</tr>
<tr>
<td></td>
<td>B1</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>E1</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>F1</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>B3</td>
</tr>
<tr>
<td></td>
<td>D1</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>D2</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>D3</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>C2</td>
</tr>
<tr>
<td></td>
<td>H1</td>
</tr>
<tr>
<td></td>
<td>H1c</td>
</tr>
<tr>
<td></td>
<td>H2c</td>
</tr>
<tr>
<td></td>
<td>H2c</td>
</tr>
<tr>
<td></td>
<td>H3</td>
</tr>
<tr>
<td></td>
<td>H3</td>
</tr>
<tr>
<td></td>
<td>G1</td>
</tr>
<tr>
<td></td>
<td>B2</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>B2</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>K1</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>K2</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>F2</td>
</tr>
<tr>
<td></td>
<td>D4</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>D5</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>D6</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>H4</td>
</tr>
<tr>
<td></td>
<td>D7</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>D8</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>D9</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>Z3</td>
</tr>
<tr>
<td></td>
<td>D10</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>D11</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>D12</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>Z4</td>
</tr>
<tr>
<td></td>
<td>S1</td>
</tr>
<tr>
<td></td>
<td>Z1</td>
</tr>
<tr>
<td></td>
<td>Z1</td>
</tr>
<tr>
<td></td>
<td>Z2</td>
</tr>
<tr>
<td></td>
<td>Z2</td>
</tr>
<tr>
<td></td>
<td>Z2</td>
</tr>
<tr>
<td></td>
<td>Z2</td>
</tr>
<tr>
<td></td>
<td>E2</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>uo</td>
</tr>
<tr>
<td></td>
<td>Z5</td>
</tr>
</tbody>
</table>

**STS-1:** #1 | #2 | ... | #N | #1 | #2 | ... | #N | #1 | #2 | ... | #N

- **H1c/H2c = Concatenation Indication**
- **uo = Undefined overhead byte**
- **fs = Fixed stuff byte**

- **Path OH = 1 Column**
- **(N x 3) - 1 Columns**
VT1.5 Format and Mapping

VT1.5 SPE = 4 bytes POH + 100 bytes capacity

VT mapping uses seven groups of four VTs each.

VT1.5 #1 | VT1.5 #2 | VT1.5 #3 | VT1.5 #4

V 2 3 V 2 3 V V
4 5 6 4
7 8 9
10 11 12
13 14 15
16 17 16
19 20 21
22 23 24
25 26 27

VT1.5 SPE (26 bytes)

Column #: 1 29 30 31 58 59 60 87

STS-1 SPE
<table>
<thead>
<tr>
<th>Overhead</th>
<th>Byte</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>STS Path Overhead</td>
<td></td>
<td></td>
</tr>
<tr>
<td>H4</td>
<td></td>
<td>VT multiframe phase indicator.</td>
</tr>
<tr>
<td>V1/V2</td>
<td></td>
<td>VT payload pointer.</td>
</tr>
<tr>
<td>V3</td>
<td></td>
<td>VT pointer action byte.</td>
</tr>
<tr>
<td>V4</td>
<td></td>
<td>Undefined.</td>
</tr>
<tr>
<td>V5</td>
<td></td>
<td>Bits 1–2: VT bit-interleaved parity (BIP-2) code.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Bit 3: VT path FEBE</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Bits 4 and 8: path remote defect indication (RDI-V)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Bits 5–7: VT path signal label.</td>
</tr>
<tr>
<td>VT Path Overhead</td>
<td></td>
<td></td>
</tr>
<tr>
<td>J2</td>
<td></td>
<td>VT path trace.</td>
</tr>
<tr>
<td>Z6</td>
<td></td>
<td>Growth.</td>
</tr>
<tr>
<td>Z7</td>
<td></td>
<td>Growth.</td>
</tr>
</tbody>
</table>
SONET Specifications
Set up for DS3 Testing  6–2
Configure the DS3 Signal  6–4
Configure the DS3-B Signal (Dual DS3 only)  6–5
Configure Other Signal Parameters  6–6
Configure DS3 Overhead Parameters  6–7
Configure the DS3 User Test Pattern  6–9
Run the DS3 Test  6–10
Perform a DS3 Pulse Mask Test  6–11
Set up for DS3 Testing

DS3 testing features are available whenever the transmitter, receiver, or payload are configured for DS3.

Example DS3 Application

1. From the Main Menu press FIELD to select a testing mode (Terminal, Monitor, or Drop & Insert).

2. Press MENU-down. The test setup screen for the mode you selected is displayed (this example shows Terminal testing mode).

```
TERMINAL TESTING
Tx Rate: DS3    Rx Rate: Dual DS3
Payload: DS3

Select Tx and Rx Rates first then select payload.
Press MENU-down to enter test mode.
Press MENU-up to return to Main Menu.
```
3. Use the FIELD and VALUE keys to set the transmitter (Tx Rate) and receiver (Rx Rate). For Monitor and D&I mode tests the transmitter and receiver are set together (Tx/Rx Rate).
   - For a dual DS3 test, set one or both of TX Rate and RX Rate to Dual DS3. If different, the other rate must be set to DS3 or DS1.
   - If you are testing a DS3 that is the payload of a higher-rate signal, set the transmitter and receiver as appropriate for that higher rate.

4. Next press the right FIELD key to select the Payload parameter. Use VALUE to set the payload as appropriate for your application.
   - Remember that one of the transmitter, receiver, or payload must be set to a DS3 selection.

5. Press MENU-down. The DS3 operation screen is displayed (see next section).
Configure the DS3 Signal

Note that the screen may appear differently depending on the test mode you selected.

<table>
<thead>
<tr>
<th>1 DS3-DS3 (DS3)</th>
<th>Final: 00:00:00.00</th>
</tr>
</thead>
<tbody>
<tr>
<td>DS3 Summary</td>
<td>DS3-A</td>
</tr>
<tr>
<td>Bit:</td>
<td>--</td>
</tr>
<tr>
<td>Frame:</td>
<td>--</td>
</tr>
<tr>
<td>P-Bit:</td>
<td>--</td>
</tr>
<tr>
<td>BPM:</td>
<td>--</td>
</tr>
</tbody>
</table>

DS3: \( Tx > DSX3 \)  \( Rx > DSX3 \)
Frm: M15  Data: 2^15-1
TxClk: Int  FEBE: 111  XBit: 1
Err: Type: DS3 Data Rate: Single

**Note:** For dual DS3 testing, the parameters on this screen configure the DS3-A signal.

1. Use the FIELD and VALUE keys to set the transmit signal level (\( Tx \)) and the receive signal level (\( Rx \)). If you are testing a DS3 signal dropped from a higher-rate signal, the \( Tx \) and \( Rx \) fields do not apply and are not displayed.

2. Use FIELD and VALUE to set the framing format (\( Frm \)), the payload data pattern (\( Data \)), and the transmit timing source (\( TxClk \)). If you select **Progr** (programmable pattern) for \( Data \), you can set the pattern as desired (see *Configure the DS3 User Test Pattern*, page 6-9).

3. Next set the FEBE bits (\( FEBE \)) and the transmitted X-bit (\( XBit \)).
   - If you are performing a dual DS3 test, access the Dual DS3 Control configuration screen to configure the DS3-B signal (see *Configure the DS3-B Signal (Dual DS3 only)*, page 6-5).
   - If you are testing a DS3 signal dropped from a higher-rate signal, configure the higher-rate signal parameters for your application.
   - If you selected C-Bit parity framing, you can set the C-bits and FEAC channel next. See *Configure DS3 Overhead Parameters*, page 6-7.
Configure the DS3-B Signal (Dual DS3 only)

Note: At least one of the Tx Rate and Rx Rate parameters must be set to Dual DS3. See Set up for DS3 Testing, page 6-2.

1. From the DS3 test operation screen, press MENU-down. The control screens menu is displayed.

   Global Settings  |  DS3 Prog Pattern
   ---             |  ---
   DS3 FEC Control|  ---
   DS3 C-Bit Control|  ---
   Dual DS3 Control|  ---
   Data Link Control|  ---
   DS3 Pulse Mask|  ---

2. Use FIELD to select Dual DS3 Control and then press CONFIG-right. The Dual DS3 Control screen is displayed.

   1 DS3-DS3 (DS3)  |  Final: 00:00:00.00
   DS3 Summary  |  DS3-A  |  DS3-B
   Bit:  |  --  |  --
   Frame:  |  --  |  --
   P-Bit:  |  --  |  --
   BPU:  |  --  |  --

   Dual: DS1 from DS3, Shared LED: None
   DS3B: Tx>DSX3 Rx>DSX3
   Frame: 215 Data: 2151
   TxClk: Int FEBE: 111 BBit: 1
   DS1: Drop: 1 Insert: 1 Other: Same
   Err: Type: DS3 Data: Rate: Single

3. Use VALUE to select from which DS3 signal the test set drops and inserts DS1 channels (DS1 From DS3).

4. Press FIELD and then use VALUE to set the operation of the front-panel DS3 LED indicators.

5. Next use FIELD and VALUE to set the signal parameters for DS3-B as you did for DS3-A (see Configure the DS3 Signal, page 6-4).

Note: For test sets with receiver-only dual DS3, the DS3-B parameters apply only to the receiver. The DS3-B transmit signal is a passthrough of the receive signal.

* After you finish configuring both DS3 signals, you are ready to begin the test. See Run the DS3 Test, page 6-10.
Configure Other Signal Parameters

If you are testing a DS3 signal that is dropped and inserted from a SONET signal, the DS3 signal is mapped to an STS-1 signal. If necessary, the STS-1 is mapped into a higher-rate SONET signal. You must configure the SONET signal parameters to match your application.

1. On the test operation screen, use FIELD and VALUE to set the signal and STS-1 parameters. This example shows the DS3 carried in an STS-1 which is mapped to an OC-12 signal.

   | OC12-DC12 (DS3) Final: 00:00:00.00 |
   | OC12 Measurement Summary          |
   | B1 (Sect CU): -- Sec Ago: --      |
   | B2 (Line CU): --                  |
   | OC12 Rx Hz: --                    |
   | STS-1 Drop Hz: --                 |
   | Rx Opt dBm: --                    |

   | DS3:  Fw>H13  Data>2*15-1         |
   | TxClk>Int  FEBE>111  XBit>1       |
   | STS1:  Ins>1,1  Other>Same       |
   | Drop>1,1  Scramble>On            |
   | STS3:  TxClk>Int  Rx>OC           |
   | Err:  Type>DS3 Data  Rate>Single  |

   Note: For Monitor mode tests, the transmit functions are not available (insert channel, other, etc).

2. Set **STS1**: INS> to select the STS-1 signal onto which the DS3 signal is mapped.

3. Set **Other** to configure the remaining STS-1s.

4. Next select **Drop** and choose which STS-1 is dropped from the receive signal.

5. Set **Scramble** to activate or deactivate STS-1 scrambling.

6. Set the transmit timing source (**STS3: TxClk>**) and receive port (**Rx>**) for the higher-rate SONET signal.

   * After you finish configuring the DS3 and SONET signal parameters you already to run the test. See **Run the DS3 Test**, page 6–10.
Configure DS3 Overhead Parameters

The DS3 FEAC control and C-bit control features allow you to configure the DS3 signal overhead bits. To access the FEAC and C-bit control functions, select the appropriate item from the control screens menu.

Configure FEAC Transmission

- To access the FEAC control functions, select **DS3 FEAC Control** from the control screens menu and press CONFIG-right. The DS3 FEAC Control screen is displayed on the bottom of the screen.

1. Press VALUE to set continuous code transmission on or off.

2. Press the right FIELD key and use VALUE to select what is transmitted when a FEAC burst is activated.

3. Next set the number of codes sent in a burst (Burst of).

4. Select the Alarm/Status parameter and use VALUE to select the FEAC code to be transmitted.

5. Select **Loopback line** to select the signal to be affected when a FEAC loop-up or loop-down code is transmitted.

6. Press ACTION to activate the FEAC burst.
DS3 Network Testing

Configure DS3 Overhead Parameters

Configure C-Bit Transmission

- To access the C-bit control functions, select **DS3 C-Bit Control** from the Control Screens menu and press CONFIG-right. The DS3 C-Bit Control screen is displayed.

```
DS3 C-Bit Control

<table>
<thead>
<tr>
<th>Program Bits:</th>
<th>Use Data Link Control screen for inserting external Data.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Row</td>
<td>C1</td>
</tr>
<tr>
<td>1</td>
<td>x</td>
</tr>
<tr>
<td>2</td>
<td>1</td>
</tr>
<tr>
<td>3</td>
<td>x</td>
</tr>
<tr>
<td>4</td>
<td>1</td>
</tr>
<tr>
<td>5</td>
<td>1</td>
</tr>
<tr>
<td>6</td>
<td>1</td>
</tr>
<tr>
<td>7</td>
<td>1</td>
</tr>
</tbody>
</table>
```

1. Use FIELD to select the individual C-bits and then use VALUE to set them to either 1 or 0.

- C-bits displayed with an x are not user editable.

- C-bits displayed with an * are not editable from the DS3 C-Bit Control screen, but can be controlled using the FEBE parameter on the DS3 test operation screen.

2. When you have finished editing the C-bits, press CONFIG-right to return to the test operation display.
Configure the DS3 User Test Pattern

To use the DS3 user pattern set the **Data** field to **Progr** on the test operation screen.

```
DS3: Tx>DSX3       Rx>DSX3
    Frm>M15       Data:Progr
    TxClk>Int    FEBE>111   xBit>1
Err: Type:DS3    Data:    Rate:Single
```

Follow this procedure to configure the DS3 user test patterns.

1. From the test operation screen press CONFIG-right. The control screens menu is displayed.

```
Global Settings   |
DS3 FEAC Control  |
DS3 C-Bit Control |
Data Link Control |
DS3 Pulse Mask    |
DS3 Prog Pattern  |
```

2. Select **DS3 Prog Pattern** and press CONFIG-right. The DS3 Prog Pattern screen is displayed.

```
DS3 Prog Pattern

```

3. Use FIELD and VALUE to select the bits in the DS3 loop code and set them to binary 1 or 0.

4. When you have finished programming the pattern press CONFIG-right to return to the test operation screen.
Run the DS3 Test

- After you have configured the DS3 signal, DS3 overhead, and SONET signal parameters you are ready to begin the test.

1. Connect the signals to be tested. If you are performing a dual DS3 test, connect the DS3-B transmit and receive signals to the appropriate jacks on the rear optional connector panel.

2. Press START to begin testing. On the first line of the display the elapsed time begins to increment.

3. If you want to inject errors on the DS3 signal, use FIELD and VALUE to set the appropriate Err Type and Rate. Press ERROR INJECTION to activate and deactivate error injection.

Note: For dual DS3 tests, you must be on the DS3-A or DS3-B configuration screen (in the lower half of the display) to inject errors on that signal.

4. Use the RESULT keys to view different measurement screens in the top half of the display. You may need to adjust the results level to view more measurements (see To Display More Measurement Screens, page 1–10).

5. To end the test, press STOP.
Perform a DS3 Pulse Mask Test

The DS3 Pulse Mask testing feature allows you to evaluate the shape of a received DS3 pulse (a positive or negative pulse represents a binary 1) and compare it to one of a set of standardized "masks" (ranges that set ideal wave shape boundaries).

Set up for a Pulse Mask Test

The 156MTS can perform pulse mask testing any time the receiver is set for DS3 (Rx Rate: DS3). Configure the other DS3 signal parameters as you would for any DS3 test. See Set up for DS3 Testing, page 6–2.

Set up the Pulse Mask Parameters

- To access the DS3 Pulse Mask setup parameters, select DS3 Pulse Mask on the Control Screens menu.

1. Press CONFIG-right. The DS3 Pulse Mask Control screen is shown in the lower half of the display.

2. Use the VALUE keys to select a pulse mask (Mask>).

3. Next press use FIELD and VALUE to select a mask Tolerance. You can use the X% choices to loosen the mask specifications.

4. Select Polarity> and use the VALUE keys to select whether you want to measure positive pulses, negative pulses, or both.
Run the Pulse Mask Test

Pulse mask testing can only be performed while the DS3 Pulse Mask Control screen is displayed.

1. Check the results level to make sure that you will be able to view the measurement screens you want. See *To Display More Measurement Screens*, page 1–10.

2. Make sure the DS3 Pulse Mask Control screen is displayed.

3. Press START to begin a DS3 test.

4. Use the RESULT keys to scroll the top half of the display to show the Positive or Negative Pulse Mask results screen.

   ![DS3 Pulse Mask Control Screen]

   Pulse test not started

   Mask: None  Tolerance: Spec
   Polarity: Positive

   With test running, press ACTION to start/stop Pulse Mask acquisition.

5. Press ACTION to begin the pulse mask test.

   The bottom line of the results screen changes to show the status of the pulse mask test, for example “Acquiring Positive One Data,” “Calculating Results,” and so forth.

6. When the test is complete, observe the data on the results screen. Pulse mask parameters are displayed as “Pass” (meets mask specifications) or “Fail” (does not meet specifications), or as their numerical values.

   For more information on pulse mask measurements, see *DS3 Pulse Mask Screens*, page 8–18.
DS3 Setup Parameters  7–2
Dual DS3 Setup Parameters  7–5
DS3 FEAC Channel Parameters  7–8
DS3 C-Bit Configuration  7–11
DS3 Pulse Mask Configuration  7–12
User-Programmable DS3 Pattern  7–14
DS3 Datalink Parameters  7–15
DS2 X-Bit Control  7–16
DS3 and DS2 Error Injection  7–17

DS3
Configuration Reference
DS3 Setup Parameters

DS3 parameters are applicable when the transmitter, receiver, or payload is set for DS3. Not all DS3 parameters apply for every test mode, but DS3 setup parameters typically appear on the screen similar to the following:

```
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>DS3:</td>
<td>Tx&gt;DSX3</td>
</tr>
<tr>
<td></td>
<td>Frm&gt;M13</td>
</tr>
<tr>
<td></td>
<td>TxC1k&gt;Int</td>
</tr>
<tr>
<td>Err:</td>
<td>Type&gt;DS3</td>
</tr>
</tbody>
</table>
```

Transmit DS3 Level

**DS3:** Tx> sets the DS3 transmit signal level at the DS3 TX jack. This parameter is not available when the DS3 signal is the payload of a higher-rate signal. Tx> can be set as follows:

- **DSX3:** DS3 cross-connect level. LBO of 450 feet simulated cable.
- **High:** High-level signal. No LBO.
- **Low:** Low-level signal. Flat loss from High level.
- **900’:** LBO added simulating 900 feet of cable.

Receive DS3 Level

**DS3:** Rx> selects the input level for the receive DS3 signal. This parameter is not available when the DS3 signal is the payload of a higher-rate signal. Rx> can be set as follows:

- **DSX3:** Automatic equalizer for 0 through 900 feet of cable.
- **High:** Nominal 0.91 Vpk input signal.
- **Low:** Nominal 0.186 Vpk input signal.
- **Monitor:** Up to 26 dBdsx flat loss.

DS3 Framing Format

**DS3:** Frm> selects the transmit and receive DS3 signal framing format. DS3: Frm> can be set to either M13, CBit (C-bit Parity format), or Unfrm (unframed).
**DS3 Payload**

**DS3: Data** selects the payload for the DS3 signal. The choices for **DS3: Data** are described in the following table.

<table>
<thead>
<tr>
<th><strong>DS3 Payload Selections</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>DS3: Data</strong></td>
</tr>
<tr>
<td>2^15-1</td>
</tr>
<tr>
<td>2^20-1</td>
</tr>
<tr>
<td>2^23-1</td>
</tr>
<tr>
<td>Progr</td>
</tr>
<tr>
<td>AIS</td>
</tr>
<tr>
<td>All Ones</td>
</tr>
<tr>
<td>Passthru</td>
</tr>
<tr>
<td>Idle</td>
</tr>
<tr>
<td>Live</td>
</tr>
<tr>
<td>Ext</td>
</tr>
<tr>
<td>Loop</td>
</tr>
</tbody>
</table>
DS3 Configuration Reference

**DS3 Setup Parameters**

**Transmit Timing Source**

DS3: TxClk> selects the DS3 transmit timing source. This parameter can be set as follows:

**Int:** Timing is from the 156MTS's internal clock.

**Ext:** Timing is derived from the rear-panel DS3 TX CLK IN port.

**Loop:** Timing is derived from the receive or drop DS3 signal.

**Note:** If DS3: Data> is set to Ext, the transmit timing is derived from the input signal.

**FEBE Bit Status**

FEBE> sets the value of the three transmit Far-end Block Error (FEBE) bits. These bits are C41, C42, and C43, and each can be set to either 1 or 0.

**X-Bit Status**

DS3: XBit> sets the value of the transmit X1 and X2 bits simultaneously. XBit> can be set to 1 (X1 and X2 both set to 1) or 0 (both set to 0).

**DS3 Drop & Insert**

For DS3 testing on a SONET signal, one DS3 signal is mapped to and from an STS-1 signal. For STS-1, there is no drop and insert channel to select. For STS-N, the drop and insert is defined by the STS-1 Drop and Ins fields. See STS-1 Payload Setup Parameters, page 3-7.

Note that the DS3 DROP jack provides the DS3 signal dropped from the selected drop STS-1 or from the STS-1 RX jack.

**DS3 Jitter Thresholds**

For information on setting the jitter hits thresholds, see Jitter Threshold Configuration, page 23-3.
Dual DS3 Setup Parameters

Overview

There are two dual DS3 options available for the 156MTS. Each provides a second, independent DS3 interface, referred to as “DS3-B.”

- **Full** dual DS3 provides both a DS3 transmitter and receiver that allows full DS3 testing on two separate DS3 facilities simultaneously (requires Option UQZ).

- **Receiver-only** dual DS3 provides a DS3 receiver with a passthrough to the DS3-B transmit port (requires Option 0YJ).
Dual DS3 Setup Parameters

Transmit and Receive Rates

Dual DS3 setup parameters are available when the transmitter (TxRate>) or receiver (RxRate>) is set for Dual DS3. For receiver-only dual DS3, only the receiver can be set to Dual DS3.

Configuration of the second DS3 interface is accessed by selecting Dual DS3 Control from the Control Screens menu. The DS3-B setup parameters are displayed on the screen similar to the following:

```
Dual: DS1 from DS3>none
DS3B: Tx<>Rx<>Fram<>M13 Rx<>Data<>2/15-1
     TxClk<>Int FEDE<>111 XBit<>1
DS1: Drop<>Insert<>1 Others<>Same
Err: Type<>DS3 Data Rate<>Single
```

For receiver-only dual DS3, the DS3-B setup screen is shown as follows:

```
>>Dual DS3 Control<<
DS3B: RxFram<>M13 RxData<>2/15-1
     RxLevel<>DSX3 Drop Chan<>1
     Passthrough Error Rate<>Single
DS1 Drop From<>DS3A
Shared LED<>None
```

DS1/E1 Drop Selection

The Dual: DS1 from DS3> (or DS1 Drop From>) field selects which DS3 interface is used to drop the DS1/E1 signal and display DS1/E1 results. This parameter can be set to either A or B (DS3A or DS3B).

DS3 LED Setup

Shared LED> determines how the front-panel DS3 ALARMS and STATUS indicators are implemented in dual DS3 mode:

- **None**: LEDs are not shared; the front-panel LEDs show only DS3-A information.
- **Alarm**: ALARMS indicators only are shared, indicating when there is a current error or history state on either the receive DS3-A or DS3-B.
- **Alm/Stat**: ALARMS and STATUS indicators are shared; indicating when there is alarm, history, and signal status conditions on either the receive DS3-A or DS3-B.
DS3 Configuration Reference

Dual DS3 Setup Parameters

**DS3-B Error Rate**

**Passthrough Error Rate** sets the error injection rate (receiver-only dual DS3 modes only). Test sets with receive-only dual DS3 can inject logic errors on DS3-B as configured by this field. This field can be set to *Single, 1.0E-2* through *1.0E-9*, and *Off*.

**Note:** Test sets with full dual DS3 test sets can inject errors on DS3-B in the same manner as for DS3-A.

**DS3-B Configuration**

The setup parameters for the second DS3 interface (DS3-B) are the same as for the first DS3 interface (DS3-A, see *DS3 Setup Parameters*, page 7–2). However the configuration of DS3-B is completely independent of DS3-A. Note that DS3-B can drop and insert DS1/E1 channels (using **DS3B: Data**→**DS1 Data**) even if DS3-A is not configured for DS1/E1 traffic.

The DS3-B signal is input and output through the rear-panel DS3-B RX and DS3-B TX connectors installed on the optional connector panel.

**Note:** For receive-only dual DS3, only the receiver parameters apply.

**Note:** For DS3 monitor modes with an E1/TS payload, error injection is not available.
DS3 FEAC Channel Parameters

The 156MTS allows you to program what messages are transmitted on the far-end alarm and control (FEAC) channel. FEAC parameters are applicable when the DS3 framing format is set for C-bit parity.

FEAC setup parameters are accessed by selecting **DS3 FEAC Control** from the Control Screens menu.

**Continuous FEAC Transmission**

- **Continuous Alarm/Status** > sets continuous transmission of the selected FEAC code (see **Alarm/Status**) **On** or **Off**. When this parameter is set to **Off**, FEAC Burst transmission is still available.

**FEAC Code Type**

- **FEAC Burst** > selects the type of code transmitted when a FEAC burst is activated by the ACTION key. **FEAC Burst** > can be set as follows:
  - **None** : No codes are transmitted.
  - **Loopback Activate** : The loop up code for the selected Loopback Line is transmitted when the ACTION key is pressed.
  - **Loopback Deactivate** : The loop down code for the selected Loopback Line is transmitted when the ACTION key is pressed.
  - **Alarm/Status** : The FEAC alarm or status code as determined by the selected Alarm/Status is transmitted when the ACTION key is pressed.

**FEAC Burst Length**

- **Burst of** > sets the number of times the selected FEAC code is transmitted when the ACTION key is pressed. **Burst of** > can be set from **03** through **15**.

**FEAC Alarm and Status Codes**

- **Alarm/Status** > selects the FEAC code to be transmitted when **Continuous Alarm/Status** is set to **On** or when **FEAC Burst** > is set to **Alarm/Status** (see page 7–8). The following table describes the choices for **Alarm/Status** and lists their corresponding FEAC bit sequence.
**DS3 Configuration Reference**  
**DS3 FEAC Channel Parameters**

<table>
<thead>
<tr>
<th>Alarm/Status &gt; Field FEAC Code Selections</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>FEAC Code</strong></td>
</tr>
<tr>
<td>---------------</td>
</tr>
<tr>
<td>DS3 Eqpt Fail (SA)</td>
</tr>
<tr>
<td>DS3 LOS/HBER</td>
</tr>
<tr>
<td>DS3 Out-of-Frame</td>
</tr>
<tr>
<td>DS3 AIS Received</td>
</tr>
<tr>
<td>DS3 IDLE Received</td>
</tr>
<tr>
<td>DS3 Eqpt Fail (NSA)</td>
</tr>
<tr>
<td>Com Eqpt Fail (NSA)</td>
</tr>
<tr>
<td>Multi DS1 LOS/HBER</td>
</tr>
<tr>
<td>DS1 Eqpt Fail (SA)</td>
</tr>
<tr>
<td>Single DS1 LOS/HBER</td>
</tr>
<tr>
<td>DS1 Eqpt Fail (NSA)</td>
</tr>
<tr>
<td>DS3 NIU Loop Up</td>
</tr>
<tr>
<td>DS3 NIU Loop Down</td>
</tr>
<tr>
<td>All other bit sequences are unassigned.</td>
</tr>
</tbody>
</table>
FEAC Loopback Line Selection

**Loopback Line** selects which line is affected when **FEAC Burst** is set to **Loopback Activate** or **Loopback Deactiv** (see page 7–8). The following table lists the choices for **Loopback Line** and their corresponding FEAC bit sequences.

<table>
<thead>
<tr>
<th>Line</th>
<th>Line Identifier Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>DS3 Line</td>
<td>011011</td>
</tr>
<tr>
<td>DS1 Line—#1</td>
<td>100001</td>
</tr>
<tr>
<td>DS1 Line—#2</td>
<td>100010</td>
</tr>
<tr>
<td>DS1 Line—#3</td>
<td>100011</td>
</tr>
<tr>
<td>DS1 Line—#4</td>
<td>100100</td>
</tr>
<tr>
<td>DS1 Line—#5</td>
<td>100101</td>
</tr>
<tr>
<td>DS1 Line—#6</td>
<td>100110</td>
</tr>
<tr>
<td>DS1 Line—#7</td>
<td>100111</td>
</tr>
<tr>
<td>DS1 Line—#8</td>
<td>101000</td>
</tr>
<tr>
<td>DS1 Line—#9</td>
<td>101001</td>
</tr>
<tr>
<td>DS1 Line—#10</td>
<td>101010</td>
</tr>
<tr>
<td>DS1 Line—#11</td>
<td>101011</td>
</tr>
<tr>
<td>DS1 Line—#12</td>
<td>101100</td>
</tr>
<tr>
<td>DS1 Line—#13</td>
<td>101101</td>
</tr>
<tr>
<td>DS1 Line—#14</td>
<td>101110</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Line</th>
<th>Line Identifier Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>DS1 Line—#15</td>
<td>101111</td>
</tr>
<tr>
<td>DS1 Line—#16</td>
<td>110000</td>
</tr>
<tr>
<td>DS1 Line—#17</td>
<td>110001</td>
</tr>
<tr>
<td>DS1 Line—#18</td>
<td>110010</td>
</tr>
<tr>
<td>DS1 Line—#19</td>
<td>110011</td>
</tr>
<tr>
<td>DS1 Line—#20</td>
<td>110100</td>
</tr>
<tr>
<td>DS1 Line—#21</td>
<td>110101</td>
</tr>
<tr>
<td>DS1 Line—#22</td>
<td>110110</td>
</tr>
<tr>
<td>DS1 Line—#23</td>
<td>110111</td>
</tr>
<tr>
<td>DS1 Line—#24</td>
<td>111000</td>
</tr>
<tr>
<td>DS1 Line—#25</td>
<td>111001</td>
</tr>
<tr>
<td>DS1 Line—#26</td>
<td>111010</td>
</tr>
<tr>
<td>DS1 Line—#27</td>
<td>111011</td>
</tr>
<tr>
<td>DS1 Line—#28</td>
<td>111100</td>
</tr>
<tr>
<td>DS1 Line—All</td>
<td>010011</td>
</tr>
</tbody>
</table>
DS3 C-Bit Configuration

You can set the status of many of the DS3 C-bits. C-bit control is available when the DS3 framing format is set to CBit and is accessed by selecting **DS3 C-Bit Control** from the Control Screens menu.

**DS3 C-Bit Control**

<table>
<thead>
<tr>
<th>Program Bits:</th>
<th>Use Data Link Control screen for inserting external Data.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Row</td>
<td>C1</td>
</tr>
<tr>
<td>1</td>
<td>x</td>
</tr>
<tr>
<td>2</td>
<td>1</td>
</tr>
<tr>
<td>3</td>
<td>x</td>
</tr>
<tr>
<td>4</td>
<td>*</td>
</tr>
<tr>
<td>5</td>
<td>1</td>
</tr>
<tr>
<td>6</td>
<td>1</td>
</tr>
<tr>
<td>7</td>
<td>1</td>
</tr>
</tbody>
</table>

* Use FEBE Settings

**Restricted C-Bits**

C-Bits displayed with an x cannot be edited on this screen.

**FEBE C-Bits**

The three C-bits in row 4 (FEBE bits, displayed as *) cannot be edited on this screen, but are set using **FEBE** (see **FEBE Bit Status**, page 7–4).

**Programmable C-Bits**

The C-bits displayed as either 1s or 0s can be edited. Some bits may have specific functions in the DS3 signal as described below:

- C3 in row 1 (FEAC bit) may be overwritten by the setup on the FEAC control screen (see **DS3 FEAC Channel Parameters**, page 7–8).

- Rows 2, 6, and 7 can be used to form an 84.6 kbs data link that can be dropped and inserted using the rear-panel DATA LINK RS-232 port.

- Row 5 can be used as the 28.2 kbs path maintenance data link (PMDL) and can be dropped and inserted using the rear-panel DATA LINK RS-232 port.

- Rows 6 and 7 can be used to form an 56.4 kbs data link that can be dropped and inserted using the rear-panel DATA LINK RS-232 port.

---

See **DS3 Datalink Parameters**, page 7–15.
DS3 Pulse Mask Configuration

To perform DS3 Pulse Mask testing your test set must have Option 202.

DS3 Pulse Mask testing is available when the receiver is set for DS3 (Rx Rate: DS3 or Dual DS3). Pulse mask parameters are accessed by selecting DS3 Pulse Mask from the control screens menu.

```
>DS3 Pulse Mask Control<
Mask>None< Tolerance>Spec
Polarity>Positive

With test running, press ACTION to start/stop Pulse Mask acquisition.
```

**Note:** For dual DS3 test set configurations, pulse mask testing is only available on the DS3 A signal.

**Pulse Mask Type**

A *pulse mask* is a standardized range defining the boundaries of an ideal waveform shape.

**Mask** selects the pulse mask to be used for the pulse mask test. The available choices are:

**None:** No mask is used. Mask fit and imbalance results are not applicable, but other results are still valid.

**G.703:** Pulse mask as defined by the proposed update to CCITT recommendation G.703 (DS3 Electrical Interface Spec. T1X1.4/95-013).

**T1.102:** Pulse mask as defined by ANSI specification T1.102.

**T1.404:** Pulse mask as defined by ANSI specification T1.404.

**TR499:** Pulse mask as defined by Bellcore specification TR-NWT-000499.
Mask Tolerance Adjustment

**Tolerance** specifies an adjustment to the pulse mask specification selected by **Mask**. **Tolerance** can be set as follows:

**Spec:** The selected mask specification is not adjusted.

**3%:** The selected mask specification is offset ±3 percent of the peak amplitude (see figure).

**6%:** The selected mask specification is offset ±6 percent of the peak amplitude (see figure).

**Pulse Mask Tolerance Adjustment**

Capture Pulse Polarity

**Polarity** determines whether the test set evaluates a received positive voltage pulse (**Positive**), negative voltage pulse (**Negative**), or both (**Pos + Neg**). For mask imbalance measurements, both positive and negative pulses must be evaluated.
User-Programmable DS3 Pattern

The user-programmable data pattern is accessed by selecting DS3 Prog Pattern from the Control Screens menu.

The DS3 programmable pattern configuration screen appears as follows:

```
  DS3 Prog Pattern

  DS3 Prog Pat:  11100000
```

The DS3 Prog Pat fields represent the bits the DS3 user pattern. Each bit can be set to 1, 0, or to a dot. A dot represents an unused bit position and is not transmitted. The pattern length can be from two through eight bits, and is defined by the number of bits set to 1 or 0.

The pattern is transmitted with the most significant bit following the frame bit (for pattern lengths that divide evenly into 84).
DS3 Datalink Parameters

The Data Link Control screen configures the functionality of the rear-panel data link ports.

<table>
<thead>
<tr>
<th>Selection</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RS232</td>
<td>None</td>
</tr>
<tr>
<td>RS422</td>
<td>None</td>
</tr>
<tr>
<td>Handset</td>
<td>None</td>
</tr>
<tr>
<td>DCC Pass-Thru</td>
<td>Off</td>
</tr>
<tr>
<td>OC-12 APS Pass-Thru</td>
<td>Off</td>
</tr>
</tbody>
</table>

Selection of data link insert or pass-thru above overrides programmed byte values.

Note: For information on other data link rate uses, see SONET Datalink Control Parameters, page 3–18 or DS1 Data Link Parameters, page 11–16.

Rear-Panel RS-232 Data Link Port

**RS232**: configures the rear-panel DATA-LINK RS-232 interface in both the transmit and receive directions. The choices for DS3 are as follows:

- **None**: The RS-232 data link interface is disabled.

- **DS3 C-Bit PMDL (Row 5)**: The transmitted data on the Path Maintenance Data Link (PMDL; the three C-Bits in Row 5) is derived from input at the RS-232 data link port. Received data is transmitted on the port’s output (DS3 C-Bit format only).

- **DS3 C-Bit Rows 6 & 7**: The transmitted data on the six C-Bits in Rows 6 and 7 (three bits in each row) is derived from the RS-232 Data-Link port. Received data is transmitted on the port’s output (DS3 C-Bit format only).

- **DS3 C-Bit Rows 2, 6, 7**: The transmitted data on the nine C-Bits in Rows 2, 6, and 7 (three bits in each row) is derived from the RS-232 data link port. Received data is transmitted on the port’s output (DS3 C-Bit format only).

Note: The remaining data link parameters on this screen apply only for SONET rate testing. See SONET Datalink Control Parameters, page 3–18.
DS2 X-Bit Control

You can set the state of the transmit DS2 X-bit. Access the Auxiliary Test Setups screen from the Setup System Parameters screen.

```
Auxiliary Test Setups
Test Dur. Mode: Continuous
Timer Duration: 00:01:00 (HH:mm:ss)
Auto. Print Mode: Off
Auto. Store Mode: Off
Sub Menu Opt Pwr.: Off    Auto Tst: Stop
Pwr. Up Optical Tx State: Last State
STS12 F Scheme:  STS3, STS1
UT Counting: UT Group    DS2 Tx-XBit: 0
DS1 Block Size: 2Kbit
DS1 LOP & OOF Hold-off: 0.0 Seconds
Bits Clock Out Derived from: STS-N Rx Clock
```

VALUE toggles the X-bit state between binary 1 and 0.
DS3 and DS2 Error Injection

The following type of error can be injected when the transmitter or payload is set for DS3. The rates for each selection (except DS3 LOS) are Single, 1.0E-2 through 1.0E-9, Burst, and Off.

Note: For information on injection rates, see About Error Injection Rates, page 27-7.

DS3 Data: Generates DS3 data bit errors before the parity is calculated, so parity errors are not generated.

DS3 Dat, Par: Generates DS3 data bit errors after the parity is calculated, resulting in both data and parity errors.

DS3 BPV: Generates bipolar violations.

DS3 Frame: Generates errors in the F1 and F0 frame bits.

DS3 C1: Generates errors in the C1 bits of the DS3 subframes.

DS3 C2: Generates errors in the C2 bits of the DS3 subframes.

DS3 C3: Generates errors in the C3 bits of the DS3 subframes.

DS3 C ALL: Generates errors among all the C bits of the DS3 subframes.

DS3 LOS: Generates DS3 loss of signal. Rates: Continuous, Burst, Off.

DS2 C1: Generates errors in the C1 bits of the DS2 signal.

DS2 C2: Generates errors in the C2 bits of the DS2 signal.

DS2 C3: Generates errors in the C3 bits of the DS2 signal.

DS2 C ALL: Generates errors among all the C bits of the DS2 signal.
DS3 Indicators  8–2
About Dual DS3 Measurements  8–3
DS3 Summary Screen  8–3
Bit Error Measurements Screens 1, 2, and 3  8–4
DS3 P-Bit Parity Measurements Screen  8–6
DS3 CP-Bit Parity Measurements Screen  8–7
DS3 Frame Measurements Screen  8–8
DS3 FFCV Measurements Screen  8–9
DS3 BPV Measurements Screen  8–10
DS3 FEAC Monitor Screen  8–11
DS3 C-Bit Monitor Screen  8–12
DS3 P-Bit and X-Bit Monitor Screen  8–12
DS3 Alarm Screens  8–13
DS3 Signal Measurements Screen  8–15
Jitter Measurements Screen  8–16
DS3 Status Screen  8–17
DS3 Pulse Mask Screens  8–18

DS2 Status Screen  8–20
DS2 Alarm and History Screen  8–21

DS3 Measurement Reference
DS3 Indicators

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>HIST/ALARMS</strong></td>
<td></td>
</tr>
<tr>
<td>LOS</td>
<td>Loss of DS3 signal.</td>
</tr>
<tr>
<td>OOF</td>
<td>Out of frame.</td>
</tr>
<tr>
<td>AIS</td>
<td>DS3 alarm indication signal.</td>
</tr>
<tr>
<td>LOPAT</td>
<td>Loss of pattern.</td>
</tr>
<tr>
<td>FFM</td>
<td>Frame format mismatch.</td>
</tr>
<tr>
<td><strong>STATUS</strong></td>
<td></td>
</tr>
<tr>
<td>DS3 SIG</td>
<td>Valid DS3 signal detected.</td>
</tr>
<tr>
<td>M13 SYNC</td>
<td>Detected signal is M13 format.</td>
</tr>
<tr>
<td>C-BIT SYNC</td>
<td>Detected signal is C-bit parity format.</td>
</tr>
<tr>
<td>PAT SYNC</td>
<td>Receiver synchronized with test pattern.</td>
</tr>
<tr>
<td>X-BIT</td>
<td>X-bit status indication.</td>
</tr>
<tr>
<td>IDLE CHNL</td>
<td>DS3 idle channel detected.</td>
</tr>
<tr>
<td>ERRORS</td>
<td>DS3 error detected.</td>
</tr>
</tbody>
</table>

8-2
About Dual-DS3 Measurements

For dual DS3 testing some results screens change to display results for both DS3 A and DS3 B on the screen. For example:

<table>
<thead>
<tr>
<th>DS3 Summary</th>
<th>DS3-A</th>
<th>DS3-B</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bit:</td>
<td>--</td>
<td>--</td>
</tr>
<tr>
<td>Frame:</td>
<td>--</td>
<td>--</td>
</tr>
<tr>
<td>P-Bit:</td>
<td>--</td>
<td>--</td>
</tr>
<tr>
<td>BPU:</td>
<td>--</td>
<td>--</td>
</tr>
<tr>
<td>DS3 Bit:</td>
<td>--</td>
<td>--</td>
</tr>
<tr>
<td>C-Bit:</td>
<td>--</td>
<td>--</td>
</tr>
<tr>
<td>P-Bit:</td>
<td>--</td>
<td>--</td>
</tr>
<tr>
<td>BPU:</td>
<td>--</td>
<td>--</td>
</tr>
</tbody>
</table>

s

DS3 Summary Screen

This screen displays a summary of DS3 test results. The screen appears differently, depending on the payload setting (DS3 or DS1).

For each screen, an "s" indicates Summary results level and a "d" indicates Detail level. See To Display More Measurement Screens, page 1–10.

Bit: DS3 bit error count: The number of errored bits (transmitted at one level, but received at another).
Frm: DS3 frame error count: The number of errored F1 and F10 bits.
C-Bit: DS3 C-bit parity error count: The number of CP-bit errors (not applicable in M13 format).
P-Bit: DS3 P-bit parity error count: The number of P-bit errors.
BPU: DS3 bipolar violation count: The number of DS3 BPVs detected.
Bit Error Measurements Screens 1, 2, and 3

These three screens display DS3 bit error measurement results (in DS1 payload modes, only a variation of screen #3 is shown).

<table>
<thead>
<tr>
<th>DS3 Bit Error Measurements #1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Final: 00:00:00.00</td>
</tr>
<tr>
<td>DS3 Bit Error Measurements #2</td>
</tr>
<tr>
<td>Final: 00:00:00.00</td>
</tr>
<tr>
<td>ES: --</td>
</tr>
<tr>
<td>EFS: --</td>
</tr>
<tr>
<td>%EFS: --</td>
</tr>
<tr>
<td>Unavail Sec: --</td>
</tr>
<tr>
<td>DS3 Bit Error Measurements #3 (Seconds)</td>
</tr>
<tr>
<td>Final: 00:00:00.00</td>
</tr>
<tr>
<td>DS3 Thresh E-3: --</td>
</tr>
<tr>
<td>DS3 Thresh E-4: --</td>
</tr>
<tr>
<td>DS3 Thresh E-5: --</td>
</tr>
<tr>
<td>DS3 Thresh E-6: --</td>
</tr>
</tbody>
</table>

### DS3 Bit Error Measurements

<table>
<thead>
<tr>
<th>Measurement</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Error Count</td>
<td>The total number of DS3 bit errors detected.</td>
</tr>
<tr>
<td>Average Ratio</td>
<td>Average DS3 BER: The number of DS3 bit errors over the total DS3 bits transmitted since the start of the test.</td>
</tr>
<tr>
<td>Current ratio</td>
<td>Current DS3 BER: The number of DS3 bit errors over the number of DS3 bits transmitted in the previous 2.25 sec.</td>
</tr>
<tr>
<td>ES</td>
<td>DS3 errored seconds: The number of seconds during which at least one DS3 bit error occurred (seconds are counted beginning at test start).</td>
</tr>
<tr>
<td>EFS</td>
<td>DS3 error-free seconds: The number of seconds during which no DS3 bit errors occurred.</td>
</tr>
</tbody>
</table>
### DS3 Bit Error Measurements, continued

<table>
<thead>
<tr>
<th>Measurement</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>%EFS</td>
<td>Percentage of DS3 error-free seconds: DS3 EFS expressed as the percentage of the total number of seconds in the test.</td>
</tr>
<tr>
<td>Sync ES</td>
<td>DS3 synchronous errored seconds: The number of seconds in which at least one DS3 bit error occurred (seconds are counted beginning at the error occurrence).</td>
</tr>
<tr>
<td>Sev ES</td>
<td>DS3 severely errored seconds (SES): The number of seconds during which the error rate was $10^{-3}$ or greater (approximately 44,100 errors per second or more for framed modes, 44,700 for unframed).</td>
</tr>
<tr>
<td>Avail Sec</td>
<td>DS3 available seconds: The number of seconds during the test that were not unavailable (see below).</td>
</tr>
<tr>
<td>Unavail Sec</td>
<td>DS3 unavailable seconds: The DS3 is declared unavailable after ten consecutive seconds of SES or LOP. The DS3 is declared available again after ten consecutive seconds with no SESs or LOPs.</td>
</tr>
<tr>
<td>Thresh E-N</td>
<td>DS3 threshold seconds: The number of available seconds during which the bit error rate or P-bit error rate (which ever is larger) exceeded the indicated threshold. The thresholds correspond to the following values (Framed/unframed): E-3 = 44,100/44,700; E-4 = 4,410/4,470; E-5 = 441/447; E-6 = 44/44.</td>
</tr>
<tr>
<td>Dribble</td>
<td>DS3 dribbling error seconds: The number of seconds in which the error rate does not exceed $10^{-6}$ (approximately 1 through 43 errors).</td>
</tr>
<tr>
<td>CSES3</td>
<td>DS3 Consecutively severely-errored seconds count: The number of SESs for which the previous two seconds were also SESs. This count is reset during LOS, LOF, and LOP.</td>
</tr>
<tr>
<td>Burst ES</td>
<td>DS3 burst error seconds: The number of seconds in which 100 or more bit errors occurred.</td>
</tr>
</tbody>
</table>
DS3 P-Bit Parity Measurements Screen

This screen displays a summary of DS3 section parity (P-bit) measurements.

**Count:** DS3 P-bit parity error count: The number of P-bit parity errors that occurred since the beginning of the test.

**Cur Ratio:** DS3 P-bit parity current bit error ratio: The number of P-bit errors over the number of bits transmitted during the previous 2.25 sec.

**Avg Ratio:** DS3 P-bit parity average bit error ratio: The number of P-bit errors over the number of bits transmitted since the beginning of the test.

**ES:** DS3 P-bit parity errored seconds: The number of seconds during which at least one P-bit parity error occurred.

**EFS:** DS3 P-bit parity error-free seconds: The number of seconds during which no P-bit errors occurred.

**%EFS:** Percentage of DS3 P-bit parity error-free seconds: DS3 P-bit EFS expressed as the percentage of seconds since the beginning of the test.
DS3 CP-Bit Parity Measurements Screen

This screen displays a summary of DS3 path parity (CP-bit) results. This screen is applicable in C-bit parity framing modes only.

<table>
<thead>
<tr>
<th>Count</th>
<th>Cur Ratio</th>
<th>Avg Ratio</th>
<th>ES</th>
<th>EFS</th>
<th>%EFS</th>
</tr>
</thead>
<tbody>
<tr>
<td>--</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>--</td>
<td>--</td>
</tr>
</tbody>
</table>

**Count**: DS3 CP-bit parity error count: The number of CP-bit parity errors that occurred since the beginning of the test.

**Cur Ratio**: DS3 CP-bit parity current bit error ratio: The number of CP-bit errors over the number of bits transmitted during the previous 2.25 sec.

**Avg Ratio**: DS3 CP-bit parity average bit error ratio: The number of CP-bit errors over the number of bits transmitted since the beginning of the test.

**ES**: DS3 CP bit parity errored seconds: The number of seconds during which at least one CP-bit parity error occurred.

**EFS**: DS3 CP-bit parity error-free seconds: The number of seconds during which no CP-bit errors occurred.

**%EFS**: Percentage of DS3 CP-bit parity error-free seconds: CP-bit EFS expressed as the percentage of seconds since the beginning of the test.
DS3 Frame Measurements Screen

This screen displays a summary of DS3 framing error measurements.

<table>
<thead>
<tr>
<th>DS3-DS3 (DS3)</th>
<th>Final: 00:00:00.00</th>
</tr>
</thead>
<tbody>
<tr>
<td>DS3 Frame Measurements</td>
<td></td>
</tr>
<tr>
<td>Count: --</td>
<td>ES: --</td>
</tr>
<tr>
<td>Cur Ratio: --</td>
<td>EPS: --</td>
</tr>
<tr>
<td>Avg Ratio: --</td>
<td>%EFS: --</td>
</tr>
</tbody>
</table>

**Count:** DS3 framing error count: The number of F1 and F10 bit errors that occurred since the beginning of the test.

**Cur Ratio:** DS3 framing current bit error ratio: The number of F-bit errors over the number of F-bits transmitted during the previous 2.25 sec.

**Avg Ratio:** DS3 framing average bit error ratio: The number of F-bit errors over the number of F-bits transmitted since the beginning of the test.

**ES:** DS3 framing errored seconds: The number of seconds during which at least one F-bit error occurred.

**EFS:** DS3 framing error free seconds: The number of seconds during which no F-bit errors occurred.

**%EFS:** Percentage of DS3 framing error-free seconds: DS3 framing EFS expressed as the percentage of seconds since the beginning of the test.
DS3 FFCV Measurements Screen

This screen displays DS3 frame-format coding violation (FFCV) results.

<table>
<thead>
<tr>
<th>DS3-DS3 (DS3)</th>
<th>Final: 00:00:00.00</th>
</tr>
</thead>
<tbody>
<tr>
<td>DS3 FFCV Measurements</td>
<td></td>
</tr>
<tr>
<td>NE Cnt: --</td>
<td>FE Cnt: --</td>
</tr>
<tr>
<td>NE ES A: --</td>
<td>FE ES A: --</td>
</tr>
<tr>
<td>NE ES B: --</td>
<td>FE ES B: --</td>
</tr>
<tr>
<td>NE ES C: --</td>
<td>FE ES C: --</td>
</tr>
</tbody>
</table>

**NE Cnt:** Near-end FFCV count: For M13 this is the number of F- or M-bit errors within an M-frame. For C-bit this is the number of F- or M-bit errors within an M-frame, or CP-bit errors in the following M-frame.

**FE Cnt:** Far-end FFCV count: For M13 this measurement is not applicable. For C-bit this is the number of FE/BE-bit errors (any of the three FE/BE bits not set to 1).

**NE ES A:** Near-end errored seconds, type A: The number of one-second intervals with exactly one near-end FFCV and no near-end OOF or AIS events.

**FE ES A:** Far-end errored seconds, type A: The number of one-second intervals with exactly one far-end FFCV and no far-end OOF or AIS events.

**NE ES B:** Near-end errored seconds, type B: The number of one-second intervals during which 2 through 44 near-end FFCVs occurred, and no near-end OOF or AIS events occurred.

**FE ES B:** Far-end errored seconds, type B: The number of one-second intervals during which 2 through 44 far-end FFCVs occurred, and no far-end OOF or AIS events occurred.

**NE ES C:** Near-end errored seconds, type C: The number of one-second intervals during which more than 44 near-end FFCVs occurred, or at least one near-end OOF or AIS events occurred.

**FE ES C:** Far-end errored seconds, type C: The number of one-second intervals during which more than 44 far-end FFCVs occurred, or at least one far-end OOF or AIS events occurred.
DS3 BPV Measurements Screen

This screen displays DS3 bipolar violation (BPV) measurements.

<table>
<thead>
<tr>
<th>DS3 BPV Measurements</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Count:</td>
<td>--</td>
<td>ES:</td>
</tr>
<tr>
<td>Cur Ratio:</td>
<td>--</td>
<td>EFS:</td>
</tr>
<tr>
<td>Avg Ratio:</td>
<td>--</td>
<td>%EFS:</td>
</tr>
<tr>
<td>LCUR Sec:</td>
<td>--</td>
<td></td>
</tr>
</tbody>
</table>

**Count**: DS3 BPV count: The number of bipolar violations that occurred since the beginning of the test.

**Cur Ratio**: DS3 BPV current bit error ratio: The number of BPVs over the number of bits transmitted during the previous 2.25 sec.

**Avg Ratio**: DS3 BPV average bit error ratio: The number of BPVs over the number of bits transmitted since the beginning of the test.

**ES**: DS3 BPV errored seconds: The number of seconds during which at least one BPV occurred.

**EFS**: DS3 BPV error-free seconds: The number of seconds during which no BPVs occurred.

**%EFS**: Percentage of DS3 BPV error free seconds: DS3 BPV EFS expressed as the percentage of seconds since the beginning of the test.
DS3 FEAC Monitor Screen

This screen displays the received DS3 far-end alarm and control (FEAC) codes.

<table>
<thead>
<tr>
<th>1 DS3-DS3 (DS3)</th>
<th>Final: 00:00:00.00</th>
</tr>
</thead>
<tbody>
<tr>
<td>DS3 FEAC Monitor</td>
<td></td>
</tr>
<tr>
<td>Last Rx Code:</td>
<td>--</td>
</tr>
<tr>
<td>Seconds Ago:</td>
<td>--</td>
</tr>
<tr>
<td>Rx Sequence:</td>
<td>--</td>
</tr>
<tr>
<td>Seconds Ago:</td>
<td>--</td>
</tr>
<tr>
<td>Line:</td>
<td>--</td>
</tr>
</tbody>
</table>

**Last Rx Code:** Last received FEAC alarm/status code: Displays the text and six-bit sequence for the most recently received FEAC alarm or status code. Does not display loopback control sequences.

**Seconds Ago** displays the elapsed time since the code was received, in seconds.

**Rx Sequence:** Last received FEAC loopback control sequence: Displays the type of FEAC loopback code (Activate or Deactivate) most recently received. **Seconds Ago** displays the elapsed time since the sequence was received, in seconds.

**Line:** Last line affected by loopback control sequence: Indicates which line was affected by the most recently received FEAC loopback sequence, for example DS1 #7, and so forth.
DS3 C-Bit Monitor Screen

This screen displays the binary state of the received DS3 C-Bits.

<table>
<thead>
<tr>
<th>1 DS3-DS3 &lt;DS3&gt;</th>
<th>Final: 00:00:00.00</th>
</tr>
</thead>
<tbody>
<tr>
<td>DS3 C-Bit Monitor</td>
<td></td>
</tr>
<tr>
<td>Row 1: X 1 1 1</td>
<td>Row 5: 1 1 1</td>
</tr>
<tr>
<td>Row 2: 1 1 1</td>
<td>Row 6: 1 1 1</td>
</tr>
<tr>
<td></td>
<td>Row 7: 1 1 1</td>
</tr>
</tbody>
</table>

A 1 or a 0 is displayed for each C-bit on the receive signal.

- The third C-bit in row 1 (C3) is the FEAC bit.
- Rows 2, 5, 6, and 7 are used in various combinations to form different data links. For more information see Programmable C-Bits, page 7-11.

DS3 P-Bit and X-Bit Monitor Screen

This screen displays the binary state of the received DS3 P- and X-bits.

<table>
<thead>
<tr>
<th>1 DS3-DS3 &lt;DS3&gt;</th>
<th>Final: 00:00:00.00</th>
</tr>
</thead>
<tbody>
<tr>
<td>DS3 P and X Bit Monitor</td>
<td></td>
</tr>
<tr>
<td>X1:1</td>
<td>X2:1</td>
</tr>
<tr>
<td>P1:0</td>
<td>P2:0</td>
</tr>
</tbody>
</table>

A 1 or a 0 is displayed for each X-bit (message bits) and P-bit (parity bits) on the receive signal.
# DS3 Alarm Screens

The screens described in this section display alarm results for the DS3 signal. The alarms that are displayed on the screens are described in the following table.

## DS3 Alarm Definitions

<table>
<thead>
<tr>
<th>Alarm</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AIS</td>
<td>Alarm indication signal: Declared when the received signal is a repeating 1010... pattern (1 following the framing bit) with valid framing and all C-bits set to 0. Signal must be present for three consecutive one-second intervals.</td>
</tr>
<tr>
<td>Idle</td>
<td>Idle signal: Declared when the received signal is a repeating 1100... pattern (11 following the framing bit) with valid M-frame and M-subframe alignment and P-bit parity. Also, the C-bits are set to 0 in M-subframe #3 and X-bits are both set to 1.</td>
</tr>
<tr>
<td>LOP</td>
<td>Loss of pattern synchronization: Declared when 240 bit errors out of 1024 consecutive data bits. This alarm is cleared when there are no pattern errors for 64 consecutive data bits.</td>
</tr>
<tr>
<td>LOS</td>
<td>Loss of signal: Declared after 128 or more pulse positions are received with neither a positive or negative pulse. The alarm is cleared when a pulse is received.</td>
</tr>
<tr>
<td>OOF</td>
<td>Out of frame: Declared when the receiver cannot achieve either F-sync or M-sync frame synchronization. F-bit synchronization is declared lost when the number of 100% errored bit bursts exceeds 1020. M-bit synchronization is declared lost when two out of three consecutive M-groups are errored (an M-group is an M0, M1, M0 sequence; an errored M-group is an M-group that is not set to 010).</td>
</tr>
<tr>
<td>FFM</td>
<td>Frame format mismatch: Declared when the received frame format does not match the set’s selected format, and no AIS or OOF exists for three consecutive seconds. The alarm is cleared when these conditions are not met for three consecutive seconds.</td>
</tr>
</tbody>
</table>
DS3 Measurement Reference

DS3 Alarm Screens

DS3 Alarm Definitions, continued

<table>
<thead>
<tr>
<th>Alarm</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LCVA</td>
<td>Line code violation alarm: Declared when three consecutive one-second intervals contain a LOS or a BPV error rate greater than 44 errors per second (1^7). The alarm is cleared when there is no LOS and the error rate is less than 44 errors/sec for three consecutive seconds.</td>
</tr>
<tr>
<td>Blue</td>
<td>Blue alarm: Declared when the received signal is a repeating 1010... pattern (1 following the framing bit) with valid framing. Signal must be present for three consecutive one-second intervals.</td>
</tr>
</tbody>
</table>

DS3 Alarm & Status Seconds Screen

This screen displays counts of DS3 alarm seconds. An alarm second is a one-second interval during which at least one DS3 alarm of the specified type occurred.

```
1 DS3-DS3 (DS3) Final: 00:00:00.00
DS3 Alarm & Status Seconds
AIS Sec: -- LOS Sec: --
Idle Sec: -- OOF Sec: --
LCP Sec: --
```

DS3 Alarm and History Screen

This screen displays the current and previous occurrence of DS3 alarms. Like the front-panel indicator LEDs, the screen provides a current status of the alarm (Alarm) and also indicates if the alarm has occurred previously (Hist).

```
1 DS3-DS3 (DS3) Final: 00:00:00.00
DS3 Alarm Hist DS3 Alarm Hist
LOS: -- -- AIS: -- --
FFM: -- -- LCU: -- --
OOF: -- -- Blue: -- --
LCP: -- --
```
DS3 Signal Measurements Screen

This screen displays signal measurements for the DS3 signal.

<table>
<thead>
<tr>
<th>1 DS3-DS3 (DS3)</th>
<th>Final: 00:00:00.00</th>
</tr>
</thead>
<tbody>
<tr>
<td>DS3 Signal Measurements</td>
<td></td>
</tr>
<tr>
<td>Rx Hz: --</td>
<td>Mask: --</td>
</tr>
<tr>
<td>Rx Pk V: --</td>
<td></td>
</tr>
<tr>
<td>Rx dBdsx: --</td>
<td></td>
</tr>
<tr>
<td>EXZ: --</td>
<td></td>
</tr>
</tbody>
</table>

**Rx Hz:** DS3 receive frequency in Hertz: The recovered clock frequency of the receive DS3 data pattern.

**Rx Pk V:** DS3 receive peak voltage: The receive signal level measured in volts peak (Vpk). Accuracy is ±5%.

**Rx dBdsx:** DS3 receive dBdsx level: The receive signal level measured in decibels relative to a DS3 signal (0 dBdsx = 0.48 Vpk). Accuracy is ±1 dB.

**EXZ:** DS3 excess zeros: Shows ON when three or more consecutive zeros are received.

**Mask:** Displays the name of the selected pulse mask (see *DS3 Pulse Mask Configuration*, page 7–12) and indicates whether the received pulse meets the mask specifications. This field displays one of the following messages:

- **Pass:** indicates the pulse meets the specified shape.
- **Fail:** indicates the pulse did not meet the specified shape.
- **Unavail:** indicates the pulse mask data is not available.

See *DS3 Pulse Mask Screens*, page 8–18, for additional pulse mask measurement information.
Jitter Measurements Screen

This screen displays jitter peak results for the selected receiver rate.

Current P-to-P: Current peak-to-peak jitter: The sum of the positive jitter peak and the negative jitter peak for the most recent one-second period. Displayed in unit intervals.

MAX P-to-P: Maximum peak-to-peak jitter: The sum of the highest positive jitter peak and the highest negative jitter peak for the entire test duration. Displayed in unit intervals.

MAX Pos Peak: Maximum positive jitter peak: The greatest positive jitter peak since the beginning of the test. Displayed in unit intervals.

MAX Neg Peak: Maximum negative jitter peak: The greatest negative jitter peak since the beginning of the test. Displayed in unit intervals.

Jitter Hits and Mask Results Screen

This screen displays jitter threshold and mask percentage results for the selected receiver rate.

The measurements on this display are described below. Each measurement is calculated for both wide-band and high-band jitter.

Hits Count: Indicates the total number of jitter hits (jitter hit threshold exceeded) since the beginning of the test.

Total Hits Time: Indicates the cumulative total of time, in seconds, that the jitter hit threshold has been exceeded since the beginning of the test.

MAX Percent of Mask: Indicates the maximum peak-to-peak jitter for the entire test period expressed as a percentage of the jitter mask.

DS3 Status Screen

This screen displays the status of certain DS3 signal parameters, similar to the front panel DS3 STATUS indicators.

<table>
<thead>
<tr>
<th>DS3-DS3 (DS3)</th>
<th>Final: 00:00:00.00</th>
</tr>
</thead>
<tbody>
<tr>
<td>DS3 Status</td>
<td>DS3 Status</td>
</tr>
<tr>
<td>Signal:</td>
<td>Pat Sync:</td>
</tr>
<tr>
<td>M13 Frm:</td>
<td>X-Bit:</td>
</tr>
<tr>
<td>C-Bit Frm:</td>
<td>Idle:</td>
</tr>
</tbody>
</table>

The displayed status parameters are described in the following table.

**SONET Status Conditions**

<table>
<thead>
<tr>
<th>Status Condition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Signal</td>
<td>Signal present: Indicates ON when an 128 contiguous pulse are received.</td>
</tr>
<tr>
<td>M13 Frm</td>
<td>M13 frame synchronization: Indicates ON when F-sync and M-sync have been found and at least 16 C11 (F10) bits set to 0 were received during the previous 0.25 second.</td>
</tr>
<tr>
<td>C-Bit Frm</td>
<td>C-bit frame synchronization: Indicates ON when F-sync and M-sync have been found and fewer than 16 C11 (F10) bits set to 0 were received during the previous 0.25 second.</td>
</tr>
<tr>
<td>Pat Sync</td>
<td>Pattern synchronization: Indicates ON when a valid payload pattern match is detected for at least 64 consecutive bits.</td>
</tr>
<tr>
<td>X-Bit</td>
<td>X-bit status: Indicates ON when both received X-bits are set to 0.</td>
</tr>
<tr>
<td>Idle</td>
<td>Idle channel: Indicates ON when the received signal is a repeating 1100... pattern (11 following the framing bit) with valid M-frame and M-subframe alignment and P-bit parity. Also, the C-bits are set to 0 in M-subframe #3 and X-bits are both set to 1.</td>
</tr>
</tbody>
</table>
DS3 Pulse Mask Screens

These screens display DS3 pulse mask measurements, based on the shape of a received DS3 pulse (binary 1). Both positive and negative pulses can be measured (see Capture Pulse Polarity, page 7–13).

Positive/Negative Pulse Mask: Indicates whether this screen applies to the positive or negative pulse being evaluated. Mask indicates the selected pulse mask specification (see Pulse Mask Type, page 7–12).

Tol: Displays the selected mask tolerance adjustment (see Mask Tolerance Adjustment, page 7–13).

Pulse Fit: Indicates Pass if the received pulse fits the selected pulse mask and tolerance.

Rise Time: Indicates the calculated rise time of the received pulse, in nanoseconds.

Fall Time: Indicates the calculated fall time of the received pulse, in nanoseconds.

Imbal: Indicates Pass when the ratio of the amplitude of the positive received pulse and the amplitude of the negative received pulse meets the specifications of the selected pulse mask. Polarity> must be set to Pos + Neg, see Capture Pulse Polarity, page 7–13.

Amp: Indicates Pass when the amplitude of the receive pulse is in the range 360 to 850 millivolts.

Width: Indicates the width of the received pulse, in nanoseconds.
Pulse Mask Status Line

The bottom line of the pulse mask results display indicates the status of the pulse mask test. The status line indicates one of the messages described in the following table.

**Pulse Mask test has not been started:** Indicates a pulse mask test has not yet begun.

**Acquiring Positive One Data or Acquiring Negative One Data:** Indicates the test set is acquiring a positive or negative pulse to evaluate.

**Done—Not Enough Isolated Ones:** Indicates the pulse mask test was canceled because a pulse could not be acquired, or a LOS was detected. Pulse acquisition requires a sufficient number of isolated ones. An *isolated one* is a one (pulse) preceded by at least two zeros (non-pulses) and followed by at least one zero.

**Calculating Results: X% Complete:** Indicates that all pulse acquisitions are complete and that pulse mask calculations are being performed.

**Positive Test Complete or Negative Test Complete:** Indicates pulse acquisition and calculations are done.
DS2 Status Screen

This screen displays the status of certain DS2 signal parameters, similar to the front-panel STATUS indicators. This screen is only shown when the payload is set to DS1 (the DS2 signal is part of the DS1 to DS3 multiplex process). Each status indicator shows ON if its condition is present.

<table>
<thead>
<tr>
<th>Status</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>DS3-DS3</td>
<td>Final: 00:00:00.00</td>
</tr>
<tr>
<td>X/A Bit</td>
<td>--</td>
</tr>
<tr>
<td>DS1 Payl</td>
<td>--</td>
</tr>
<tr>
<td>E1 Payl</td>
<td>--</td>
</tr>
<tr>
<td>M12 Loopback</td>
<td>--</td>
</tr>
</tbody>
</table>

**X/A Bit:** DS2 X-bit or A-bit status: Declared when the receive X-bit (DS1-mapped DS3 signals) or A-bit (E1-mapped DS3 signals) is set to 1.

**DS1 Payl and E1 Payl:** DS3 mapping type: Indicates the mapping present on the receive DS3 signal (DS1 or E1). Only one status indicates ON at a time.

**M12 Loopback:** DS1 loopback request: Indicates a loopback request for the selected DS1 channel (uses the DS2 C-bits).
DS2 Alarm and History Screen

This screen displays DS2 alarms. This screen is only shown when the payload is set to DS1.

| DS2-DS3 (DS1) Final: 00:00:00.00 |
|-------------------------------|-----------------|
| DS2 Alarm Hist                |                 |
| LOS: -- --                    |                 |
| OOF: -- --                    |                 |
| AIS: -- --                    |                 |

**LOS:** DS2 loss of signal: Declared when 192 DS2 bits are received set to 0. This alarm is cleared when a single DS2 bit is received.

**OOF:** DS2 out of frame: Declared when DS2 F-sync or M-sync is detected. Loss of DS2 F-sync is declared when three F-bits out of 15 are errored. Loss of DS2 M-sync is declared when 2 M-bit sequences out of three are errored.

This condition is cleared when DS2 F-sync or DS2 M-sync is reestablished. DS2 F-sync is established when 15 consecutive, error-free F-bits are received. DS2 M-sync is established when two consecutive, error-free M-bit sequences are received.

**AIS:** DS2 Alarm Indication Signal: Declared when an all-ones, unframed DS2 signal is detected (the all-ones requires a 99.9% ones density).
DS3 Interfaces 9–2
Data Link Interfaces 9–3
Jitter Option Specifications 9–4

DS3 Specifications
DS3 Interfaces

**Note:** For dual DS3 options installed in the instrument, additional DS3 TX and DS3 RX are installed on the rear-panel optional connector plate. The signal specifications for these connectors are the same as for the front-panel.

### DS3 Transmitter
#### DS3 TX

**Signals:**

<table>
<thead>
<tr>
<th>Signal</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>DSX-3</strong></td>
<td>Per CB119, ANSI T1X1 and TR-TSY-000499. 0.48 Vpk ±1.2 dB. LBO = 450 ft simulated 728A cable.</td>
</tr>
<tr>
<td><strong>High</strong></td>
<td>0.91 Vpk ±1.2 dB. LBO = none.</td>
</tr>
<tr>
<td><strong>900</strong></td>
<td>0.33 Vpk ±2.0 dB. LBO = 900 ft simulated 728A cable.</td>
</tr>
<tr>
<td><strong>Low</strong></td>
<td>0.186 Vpk ±2.0 dB. LBO = Flat loss from High level.</td>
</tr>
</tbody>
</table>

**Line Code:** B3ZS.

**Impedance:** 75 ohm ±5%, return loss >20 dB.

**Connector:** Accepts WECO 440. Optional WECO 358 or BNC.

### DS3 Receiver
#### DS3 RX

**Signals:**

<table>
<thead>
<tr>
<th>Signal</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>DSX-3</strong></td>
<td>Automatic equalizer for 0 to 900 ft of 728A cable. 44.736 MHz ±300 ppm. Jitter tolerance per Bellcore TR-TSY-000009.</td>
</tr>
<tr>
<td><strong>High</strong></td>
<td>0.91 Vpk input signal, nominal.</td>
</tr>
<tr>
<td><strong>Mon</strong></td>
<td>Up to 26 dB flat loss relative to nominal DSX-3 level.</td>
</tr>
<tr>
<td><strong>Low</strong></td>
<td>0.186 Vpk input signal, nominal.</td>
</tr>
</tbody>
</table>

**Line Code:** B3ZS.

**Impedance:** 75 ohm ±5%.

**Connector:** Accepts WECO 440. Optional WECO 358 or BNC.
DS3 Specifications

Data Link Interfaces

DS3 Drop Output

**DS3 DROP**

**Signal = DSX-3:** DS3 dropped from higher-rate signal.
- Per TR-TSY-000499.
- 0.48 Vpk ±1.2 dB.
- LBO = 450 ft. simulated 728A cable.

**Line Code:** B3ZS.

**Impedance:** 75 ohm ±5%; return loss >20 dB.

**Connector:** Accepts WECo 440. Optional WECo 358 or BNC.

DS3 Timing

**Internal:** 44.736 MHz ±20 ppm.

**DS3 TX CLK IN jack:** Input DS3 signal. TTL levels, 50 ohm, BNC connector.

Bit Error Output

**DS3 ERR OUT:** Provides a single pulse output for each DS3 error detected. TTL level, 50 ohm, BNC connector.

Data Link Interfaces

For data link port pinout information, see *Data Link Interfaces*, page 27-4. For DS3 data link control information, see *DS3 Datalink Parameters*, page 7-15.
Jitter Option Specifications

DS3 jitter measurement requires DS3 testing (E4480A-001 base unit or Option URR), Option UQP, and either Option UQN or 201.

Measurement Response

**DS3 Jitter Measurement per:** TR-TSY-000499

**Wide-band cut-off frequency:** 10 Hz to 400 kHz

**High-band cut-off frequency:** 30 kHz to 400 kHz

**Roll-off (per decade) below lower 3 dB point:** ≥20 dB

**Roll-off (per decade) above higher 3 dB point:** ≥60 dB

Jitter Measurements

<table>
<thead>
<tr>
<th>Measurement</th>
<th>Range</th>
<th>Resolution</th>
<th>Accuracy</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Peak Positive Jitter</td>
<td>0.1 to 6.0 UI</td>
<td>0.1 UI</td>
<td>±5% of reading, ±0.05 UI.</td>
</tr>
<tr>
<td>Maximum Peak Negative Jitter</td>
<td>0.1 to 6.0 UI</td>
<td>0.1 UI</td>
<td>±5% of reading, ±0.05 UI.</td>
</tr>
<tr>
<td>Current Peak-to-Peak Jitter</td>
<td>0.1 to 12.0 UI</td>
<td>0.1 UI</td>
<td>±5% of reading, ±0.05 UI.</td>
</tr>
<tr>
<td>Max Peak-to-Peak Jitter</td>
<td>0.1 to 12.0 UI</td>
<td>0.1 UI</td>
<td>±5% of reading, ±0.05 UI.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Wideband Mask</th>
<th>Highband Mask</th>
</tr>
</thead>
<tbody>
<tr>
<td>Percent of Mask</td>
<td>5.0 UI</td>
</tr>
</tbody>
</table>

Demodulated Jitter Output

**DMOD JITTER OUT jack:** 50 ohm, BNC connector.

Scale = 100 mV/UI; range = 0 to 6 Vdc.
DS3 Specifications
DS3 (44.736 Mbs) and DS2 Signal Formats

DS3 (44.736 Mbs) and DS2 Signal Formats

M-subframe

49-bit Block

M1 Subframe

M2 Subframe

M3 Subframe

M4 Subframe

DS2 M-frame

85-bit Block

DS3 M-frame

X1 84 bits F1 C1 C0 C9 Fe C11 F1

A/C N FEAC

X2 F1 C1 C0 C9 Fe C11 F1

DL DL DL

P1 F1 C1 C0 C9 Fe C11 F1

CP CP CP

P2 F1 C1 C0 C9 Fe C11 F1

FEBE FEBE FEBE

M0 F1 C1 C0 C9 Fe C11 F1

DL DL DL

M1 F1 C1 C0 C9 Fe C11 F1

DL DL DL

M2 F1 C1 C0 C9 Fe C11 F1

DL DL DL

M3 F1 C1 C0 C9 Fe C11 F1

DL DL DL

M4 F1 C1 C0 C9 Fe C11 F1

DL DL DL
### DS3 Overhead Bits

<table>
<thead>
<tr>
<th>Bit</th>
<th>M13 Format Function</th>
<th>C-Bit Parity Format Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>F1/F0</td>
<td>Frame bits (F1=1; F0=0).</td>
<td>Frame bits (F1=1; F0=0).</td>
</tr>
<tr>
<td>P1/P2</td>
<td>Parity bits</td>
<td>Parity bits.</td>
</tr>
<tr>
<td>M0/M1</td>
<td>Multiframe bits (M0=0; M1=1).</td>
<td>Multiframe bits (M0=0; M1=1).</td>
</tr>
<tr>
<td>C11</td>
<td>Bit-stuffing control/indication.</td>
<td>AIC: Application identification channel.</td>
</tr>
<tr>
<td>C12</td>
<td></td>
<td>N: Reserved network application bit.</td>
</tr>
<tr>
<td>C13</td>
<td></td>
<td>FEAC: far-end alarm/control channel.</td>
</tr>
<tr>
<td>C41/C42/C43</td>
<td></td>
<td>FEBE: far-end block error indication.</td>
</tr>
<tr>
<td>Other C-bits</td>
<td></td>
<td>DL: datalinks.</td>
</tr>
</tbody>
</table>
Set up for DS1 Testing 10–2
Configure the DS1 Signal 10–4
Configure the ESF Datalink Message 10–5
Configure DS1/E1 User Test Patterns 10–6
Configure the FT1 Signal 10–7
Configure the DS0 Signal 10–8
Configure Other Signal Parameters 10–11
Loopback the Far End 10–12
Run the DS1 Test 10–14
Run an Automatic DS1 Drop Scan 10–15
Run an Automatic DS0 Signaling Scan 10–17

DS1, DS0, and FT1 Network Testing
Set up for DS1 Testing

Example DS1 Application

DS1 testing features are available whenever the transmitter, receiver, or payload are configured for DS1.

1. From the Main Menu press FIELD to select a testing mode.

2. Press MENU-down. The testing setup screen for the mode you selected is displayed (this example shows Terminal testing mode).

```
TERMINAL TESTING
Tx Rate: DS1
Rx Rate: DS1
Payload: DS0

Select Tx and Rx Rates first then select payload.
Press ENTER to enter test mode.
Press MENU to return to Main Menu.
```
DS1, DS0, and FT1 Network Testing

Set up for DS1 Testing

3. Use the FIELD and VALUE keys to set the transmitter (**Tx Rate**) and receiver (**Rx Rate**) for your application. For Monitor and D&I tests the transmitter and receiver are set simultaneously (**Tx/Rx Rate**).

   - If you are testing a DS1 that is the payload of a higher-rate signal, set the transmitter and receiver as appropriate for that higher rate.

4. Next press the right FIELD key to select the **Payload** parameter. Use VALUE to set the payload as appropriate for your application.

   - To test DS0 signals set **Payload** to **DS0** (this step is optional).
   - Remember that one of the transmitter, receiver, or payload must be set to a DS1 selection.

5. Press MENU-down. The DS1 operation screen is displayed (see next section).
Configure the DS1 Signal

- When you press MENU down from the testing mode setup screen, the test operation screen is displayed. Note that the screen may appear differently depending on the test mode you selected.

<table>
<thead>
<tr>
<th>Bit:</th>
<th>Sec Ago:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**DS1: TxClick** Frm>SF Code>AMI
Tx>DSX1 Term>Term
Rx>DSX1

Data>OPSS

Err/Alm: Type>DS1 Data Rate>Single

1. Use the FIELD and VALUE keys to set the transmit timing source (TxClick), the framing format (Frm) and the line coding (Code).

2. Next use FIELD and VALUE to set the transmit signal level (Tx), the receive signal level (Rx), and the termination mode (Term).

3. Use FIELD and VALUE to select a pattern (Data). For FT1 testing set Data to the FT1. Select a Progr pattern to use a custom bit sequence. See *Configure DS1/E1 User Test Patterns*, page 10-6.

- If you are testing a DS1 signal dropped from a higher-rate signal, the Tx, Rx, and Term fields do not apply and are not displayed.

- If you are testing a DS1 dropped from a higher-rate signal, configure the higher-rate signal. See *Configure Other Signal Parameters*, page 10-11.

- If you selected FT1 for the payload (Data), configure the FT1 parameters. See *Configure the FT1 Signal*, page 10-7.

- If you are testing DS0 signals, configure the DS0 parameters. See *Configure the DS0 Signal*, page 10-8.
Configure the ESF Datalink Message

If you set the DS1 framing format to Extended Superframe (ESF), you can set the message to be transmitted on the ESF datalink.

1. From the test operation screen press CONFIG-right to display the control screen menu.

2. Use FIELD to select DS1/E1 Patterns and press CONFIG-right. The Programmable Patterns screen is displayed.

3. Use VALUE to select the datalink message.

4. If you selected User 1 or User 2 for the datalink message, use FIELD and VALUE to define the user pattern. Each bit can be set to 1 or 0.

5. When you finish editing, press CONFIG-right to return to the test operation screen.
Configure DS1/E1 User Test Patterns

The 156MTS has six programmable test patterns for use in DS1 and E1 testing. To use the patterns, set Data> to a Progr selection. Follow this procedure to configure the six DS1 user test patterns.

```
DS1: TxCtl>Int  Frm>SF  Code>AMI
      Tx>DS1           Term>Term
      Rx>DS1
Data>Progr  III
Err/Alm:Type>DS1 Data  Rate>Single
```

1. From the test operation screen press CONFIG-right to display the control screen menu.

2. Use FIELD to select DS1/E1 Patterns and press CONFIG-right. The Programmable Patterns screen is displayed.

```
DS1/E1 Prog Pattern
ESF datalink message
  Data link idle  (01111110 01111110)
ESF Programmable datalink patterns
User 1: v10001000 xxxxxxxxxxx (v=0) (x=1)
User 2: v01100000 xxxxxxxxxxx (v=0) (x=1)
  Prog Pat 1:  01000000.............
  Prog Pat 2:  01000000.............
  Prog Pat 3:  010001000000...........
  Prog Pat 4:  01000100000000000000
  Prog Pat 5:  0100010000000000000000000100...
  Prog Pat 6:  0100010000000000000000000000000000100...
```

3. Use FIELD and VALUE to select the individual bits in each pattern and set them to binary 1, 0, or to a dot.

4. When you finish editing, press CONFIG-right to return to the test operation screen.
Configure the FT1 Signal

**Note:** The Data field must be set for FT1. See Configure the DS1 Signal, page 10-4.

1. The FT1 parameters are controlled from the Fractional T1 Setup screen. Press CONFIG-right to call the control screens menu.

   ![Global Settings](image)

2. Use FIELD to highlight **DS0/TS/Frac Setup** and press CONFIG-right twice to display the Fractional T1 Setup screen.

   ![Fraction T1 Setup](image)

3. Use VALUE to select the base rate for the fractional T1 signal. Set **N** to either **64k** or **56k** (kilobytes).

4. Next use FIELD and VALUE to select the DS0 channels of the DS1 signal that make up the N×64 or N×56 signal (Select). Each active DS0 is represented by an asterisk; inactive DS0s are represented by a dot.

5. Use FIELD and VALUE to select the payload for the FT1 signal (Data).

6. Press CONFIG-right to return to the test operation screen.
Configure the DS0 Signal

This section describes how to configure the DS0 payload of a DS1 signal. There are two ways to configure the DS0 parameters, depending on whether you are testing from a directly-connected DS1 or from a subrate DS1 carried on a higher-rate signal (See Set up for DS1 Testing, page 10–2).

DS0 from Direct DS1 Connection

This procedure describes how to configure the DS0 payload of a DS1 signal that is connected directly to the test set (input and output at the DS1 RX and TX jacks).

1. The DS0 parameters are displayed on the test operation screen. Use FIELD to highlight Ins>.

2. Use VALUE to select the channel into which the transmit DS0 is inserted.

3. Next use FIELD and VALUE to set status of the other transmit DS0 channels of the DS1 signal.

4. Use FIELD and VALUE to select the channel number from which the DS0 is dropped.

5. Finally, use FIELD and VALUE to set the transmit tone (Tone). This parameter also allows you to transmit the VF signal applied at the rear-panel VF IN jack.
   - After you finish configuring the DS0 parameters, you are ready to begin the test.
Configure the DS0 Signal

This procedure describes how to configure the DS0 payload of a subrate DS1 signal that is carried on a higher-rate signal.

1. To enable DS0 transmission on the subrate DS1 signal, you must set the DS1 Data field to DS0. This example shows the test operation screen of a DS3-to-DS3 terminal mode test with a DS1 payload (DS0 is available when the payload is set to DS1):

```
1 DS3-DS3 <DS1> Final: 00:00:02.00
DS0 UF Meas: -60....-40....-20....0.
Level: 0.5
>3dBM: 0 Thres. Sec
Freq: 1004 Hz
Data: 10111010 A=0 B=0 C=0 D=0
DS3: Rx>DSX3 Tx>DSX3 TxC1k>Int
Frm>M13 XBit>1 FEBE>111
DS1: TxC1k>Int Frm>ESF Data DS0
Ins>1 Other>Same
Drop>1 Code>AM1
Err->Alm>Typ>DS1 Data Rate>Single
```

2. From the test operation screen, press CONFIG-right. The control screens menu is displayed in the bottom half of the screen:

```
Global Settings | DS1/E1 Patterns
DS3 FEC Control | DS1 Loop Codes
DS3 C-Bit Control | Data Link Control
Data Link Control | DS0/TS/Frac Setup
DS3 Pulse Mask
```

3. Press FIELD to highlight DS0/TS/Frac Setup and then press CONFIG-right. The DS0 Setup screen is displayed in the lower half of the screen:

```
DS0 Setup:
Data: 1004 Hz
Ins>1 Drop>1
Other>Same (UF Tone Only)
Tx Signaling: A>1 B>1 C>1 D>1
```
DS1, DS0, and FT1 Network Testing

**Configure the DS0 Signal**

4. Press VALUE to adjust the setting of Data>. You can select a VF tone, external VF signal, or a bit pattern.

5. Press FIELD to select N> and use VALUE to set the DS0 base rate.

6. Next press FIELD to select the Ins> field and then use VALUE to set the insert VF channel number on the DS1 signal.

7. Press FIELD to select Drop> and use VALUE to set the drop channel number. You can also select L to lock the drop channel to match the insert channel.

8. Select Other> and use VALUE to set the remaining channels in the DS1 signal.

9. Use FIELD and VALUE again to configure each ABCD Tx Signaling bit to either binary 1 or 0.

10. When you have finished setting the DS0 parameters, press CONFIG-right to return to the test operation screen. You can also remain in the DS0 Setup screen and observe the effect of your changes on the upper half of the display as you make them.
DS1, DS0, and FT1 Network Testing

Configure Other Signal Parameters

Configure Other Signal Parameters

If you are testing a DS1 signal that is dropped and inserted from a DS3 or SONET signal you must configure the mapping of the lower-rate signals to the higher-rate signals.

- After you have set the DS1 signal parameters (See Configure the DS1 Signal, page 10-4), use FIELD and VALUE to set the higher-rate signal parameters. This example shows a DS1 carried in an DS3 which is mapped to an STS-1 signal, which is in turn mapped to an OC-12 signal.

```
DS1: TxClk>Int  Frm>SF  Data>GRSS
   Ins>1  Oths>Same  Drop>1  Code>B82B
DS3: TxClk>Int  Frm>M13  XBit>1
STS1: Ins>1,1  Other STSs>Same  Drop>1,1
STS3: TxClk>Int  Scramble>On
Err/Alm:Type>DS1  Data  Rate>Single
```

**Note:** For monitor tests, the transmit functions are not available (insert channel, etc).

1. Set **Ins** to select the transmit DS1 channel on the DS3. Set **Oths** to configure the remaining DS1 channels. Next set **Drop** to select the receive DS1 channel on the DS3.

2. Configure the DS3 signal by setting the transmit timing source (TxClk), framing format (Frm), and X-bit status (XBit).

3. Set **STS1: INS>** to select the STS-1 signal onto which the DS3 signal is mapped.

4. Set **Other** to configure the remaining STS-1s.

5. Next select **Drop** and choose which STS-1 is dropped from the receive signal.

6. Set the transmit timing source for the higher-rate SONET signal (STS3: TxClk>).

7. Set **Scramble** to activate or deactivate STS-N scrambling.

- After you finish configuring the DS1 and higher-rate signal parameters you already to run the test. See Run the DS1 Test, page 10-14.
Loopback the Far End

This section describes how to set up and transmit codes to activate and deactivate loopback at the far-end equipment.

1. Select the loop code to be transmitted. Use FIELD to highlight the **Err/Alm:Type** field and then use VALUE to select **DS1 LoopUp** or **LoopDn**.

    

    | DS1: TxClk|Int | Frm|SF | Code|ANI | Term|Term |
    |-----------|----|----|----|-----|-----|-----|-----|
    | Tx>DSN1   |     |    |    | Rx>DSN1 |
    | Data>FRSS |     |    |    |      |
    | Err/Alm:Type|DS1 LoopUp | Rate>8 Seconds |

2. Next use FIELD and VALUE to set **Rate>** to the appropriate length of time the code is to be transmitted.

3. Press CONFIG right to display the Control Screens menu.

    Global Settings | Data Link Control | DS0/TS/Frac Setup | DS1/E1 Patterns | DS1 Loop Codes |

4. Select **DS1 Loop Codes** and press CONFIG-right again. The DS1 Loop Code Setup screen is displayed.

    **DS1 Loop Code Setup**
    
    LoopUp Code: **Inband Line [CSU] (10000)**
    LoopDn Code: **Inband Line [CSU] (100)**
    Framing Overwrite: On
    
    User Codes | Inband | Outband (ESF)
    -----------|--------|-----------------|
    LpUp:Tx>10000........... | 000111 |
    Rx>10000................. |
    LpDn:Tx>100.............. | 011100 |
    Rx>100................... |
DS1, DSO, and FT1 Network Testing

**Loopback the Far End**

5. Use FIELD and VALUE to configure the loop up and down code parameters.

   Select predefined loop codes or select a “Usr” code to use the programmable codes.

6. Set **Framing Overwrite** to **On** or **Off** as appropriate for your test.

7. If you selected a “Usr” code in step 5, use FIELD and VALUE to program the **LpUp** (loop up) and **LpDn** (loop down) user codes.

   **Tx>** sets the code that the test set transmits. **Rx>** sets the code that the test set monitors for on the input signal. Inband loop coes are defined on the left side of the screen and out-of-band (for ESF) loop codes are defined on the right.

8. When you have finished, use **CONFIG-right** to return to the test operation screen.

9. To transmit the loop code, press the **ERROR INJECT** key.

   The 156MTS transmits the currently selected loop code.

10. Verify that the far-end has looped back by observing the DS1 PAT SYNC and LOPAT indicators.

    When loopback is successfully activated, PAT SYNC lights and the LOPAT alarm LED goes off (the LOPAT history LED lights).

11. When the far-end is looped, perform any other testing you require.

12. To deactivate the loopback, set **Err/Alm:Type>** to DS1 **LoopDn** and press **ERROR INJECT**.

    When the loopback is deactivated, the DS1 PAT SYNC indicator goes off and the red LOPAT alarm indicator lights.
Run the DS1 Test

- After you have configured the DS1 signal, FT1 signal, and higher-rate signal parameters you are ready to begin the test.

1. Press START to begin testing. On the first line of the display the elapsed time begins to increment.

2. If you want to inject errors on the DS1 or FT1 signal, use FIELD and VALUE to set the appropriate Err/Alm Type and Rate. Press ERROR INJECT to activate and deactivate error injection.

3. Press TROUBLE SCAN to view the Trouble Scan results screen. Any detected errors or alarms will be shown here.

4. Use the RESULT keys to view different measurement screens in the top half of the display. You may need to adjust the results level to view more measurements (see To Display More Measurement Screens, page 1–10).

5. To end the test, press STOP.

DS1, DS0, and FT1 Network Testing
Run an Automatic DS1 Drop Scan

The 156MTS features an automatic test sequence that scans a DS3 signal and analyzes each of the 28 DS1 channels for framing and pattern. The DS3 signal can be dropped from a higher-rate signal. This section describes how to set up and run the DS1 Drop Scan sequence.

1. Connect the signal to be tested. The signal must be a DS3 signal or a higher-rate signal carrying DS3 signals.

2. Setup the background mode by configuring the test set as if you were going to run a manual test. For example, set up an STS-1 monitor mode test with a channelized DS3 payload.

3. From the Main Menu, use FIELD to select DS3/DS1/ATM Scans & Pointer Sequences.

```
MODEL 156 MAIN MENU
Auto Setup
Terminal Testing
Monitor Testing
Drop & Insert Testing
DS3/DS1/ATM Scans & Pointer Sequences
Setup System Parameters
Store and Recall configurations

Press < FIELD > to highlight item, then Press MENU-down select item.
```

4. Press MENU-down. The Test Sequences menu is displayed.

```
TEST SEQUENCES
HPPointer Increment
HPPointer Decrement
HPPointer New Data Flag (HDF)

DS1 Drop Scan
Signaling Scan
ATM Path/Circuit Scan
ATM Cell Capture
```
DS1, DS0, and FT1 Network Testing

Run an Automatic DS1 Drop Scan

5. Use FIELD to select **DS1 Drop Scan** and press MENU-down. The DS1 Drop Scan operation screen is displayed.

   ![DS1 Drop Scan Screen]

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>DS1 Drop Scan</td>
</tr>
<tr>
<td>1</td>
<td>--</td>
</tr>
<tr>
<td>2</td>
<td>--</td>
</tr>
<tr>
<td>3</td>
<td>--</td>
</tr>
<tr>
<td>4</td>
<td>--</td>
</tr>
<tr>
<td>5</td>
<td>--</td>
</tr>
</tbody>
</table>

   Configurations From: DS3-MON (DS1)
   Channel Scan Mode: Single

6. Set **Configurations From** to match your application. For example, if you are testing an STS-1 signal carrying channelized DS3 traffic, you could select **STS1-MON (DS3/1)**.

7. Next set **Channel Scan Mode** to either **Single** (one scan) or **Continuous** (repetitive scanning).

8. Press START to begin the scan. The test set begins checking each DS1 on the DS3 signal for framing format and pattern, and displays the results on the appropriate display line.

9. The scan ends automatically in **Single** mode; press STOP to end the scan in **Continuous** mode.
Run an Automatic DS0 Signaling Scan

The 156MTS features an automatic test sequence that scans a DS1 signal, analyzes each of the DS0 channels, and displays the status of the signaling bits for each channel. The DS1 signal can be dropped from a DS3 signal.

1. Connect the signal to be tested. The signal must be a DS1 signal or a DS3 signal carrying DS1 traffic.

2. Setup the background mode by configuring the test set as if you were going to run a manual test. For example, set up an DS1 terminal mode test with a DS0 payload (see Set up for DS1 Testing, page 10–2).

3. From the Main Menu, use FIELD to select DS3/DS1/ATM Scans & Pointer Sequences.

4. Press MENU down. The Test Sequences menu is displayed.
DS1, DS0, and FT1 Network Testing

Run an Automatic DS0 Signaling Scan

5. Use FIELD to select **Signaling Scan** and press CONFIG-right. The Signaling Scan operation screen is displayed.

![Signaling Scan Configuration](image)

6. Set **Configurations From** to match your application. For example, if you are testing a DS1 signal carrying DS0 traffic, you could select **DS1-DS1 (DS0)**.

7. Next set **Channel Scan Mode** to either **Single** (one scan) or **Continuous** (repetitive scanning).

8. Press START to begin the scan. The test set begins checking each DS0 on the DS1 signal for the signaling bit status, and displays the results on the appropriate display line.

9. Use the RESULTS keys to scroll through the displays of DS0 channels and their signaling bit status.

10. The scan ends automatically in **Single** mode; press STOP to end the scan in **Continuous** mode.
DS1 Setup Parameters  11-2
  Transmit Timing Source  11-2
  DS1 Framing Format  11-3
  Line Coding  11-3
  Transmit DS1 Level  11-3
  Receive DS1 Level  11-4
  DS1 Payload  11-4

Additional DS1 Setup Parameters  11-7
  DS1 Block Size  11-7
  DS1 Alarm Delay  11-7
  DS1 Jitter Hits Threshold  11-7

DS1 and DS0 Error and Alarm Injection  11-8

FT1 Setup Parameters  11-9

DS0 Setup Parameters  11-10

User-Programmable DS1/E1 Patterns  11-13

DS1 Loop Codes  11-14

DS1 Data Link Parameters  11-16

DS1 Drop Scan Sequence  11-17

DS0/Timeslot Signaling Scan  11-19

DS1, DS0, and FT1 Configuration Reference
DS1 Setup Parameters

DS1 parameters are applicable when the transmitter, receiver, or payload is set for DS1 (or VT1.5). Not all DS1 parameters apply for every test mode, but DS1 setup parameters typically appear on the screen similar to the following:

```
DS1:  TxClk<Int>  Frm>Sf  Code>AMI
     Tx>DSX1       Term>Term
     Rx>DSX1
     Data>GRSS
     Err/Alm:Type>DS1  Data  Rate>Single
```

### Transmit Timing Source

**DS1: TxClk>** selects the DS1 transmit timing source. This parameter can be set as follows:

- **Int**: Timing is from the 156MTS's internal clock.
- **Ext**: Timing is derived from the rear-panel DS1 TX CLK IN port.
- **Loop**: Timing is derived from the receive or drop DS1 signal.
- **Ref**: Timing is derived at the rear-panel DS1 REF IN.

**Note**: If **DS1: Data>** is set to **Ext**, the transmit timing is derived from the input signal.
DS1, DS0, and FT1 Configuration Reference

**DS1 Setup Parameters**

**DS1 Framing Format**

- **DS1: Frm>** selects the transmit and receive DS1 signal framing format.
- **DS1: Frm>** can be set to as follows:
  - **SF:** Superframe format (also called D4).
  - **ESF:** Extended superframe format.
  - **SLC-96:** SLC-96 format (also called TR8). Not available for VT1.5 byte-synchronous modes.
  - **Unfrm:** Unframed format. Not available for VT1.5 byte-synchronous modes.
  - **MBLT:** Mobile Both-Line Terminal format. This is a modified SF format used by certain Ericsson switching equipment. Not available for VT1.5 modes.
  - **UnfT1e:** Unframed T1C format.
- **SF/ESF:** Auto-match mode. The test set analyzes the receive DS1 for SF or ESF format, and sets the transmitter to match. Not available for VT1.5 modes.

**Note:** If **DS1: Data>** is set to **Ext**, the framing format is determined by the input signal.

**Note:** If **DS1: Data>** is set to **AIS**, the transmitted signal is unframed regardless of the **DS1: Frm>** setting. On VT1.5 signals, the AIS is transmitted as a VT path AIS.

**Line Coding**

- **DS1: Code>** selects the line coding scheme as either **AMI** (alternate mark inversion) or **B8ZS** (bipolar with eight-zero substitution).

**Transmit DS1 Level**

- **DS1: Tx>** sets the DS1 transmit signal level at the DS1 TX port. This parameter is not available when the DS1 signal is the payload of a higher-rate signal. **Tx>** can be set as follows:
  - **DSX1:** DS1 cross-connect level, per TR-TSY-000499.
  - **LBO –7.5 dB:** Adds a line build out (LBO) 7.5 decibels attenuation from the DSX-1 level.
  - **LBO –15 dB:** Adds an LBO of 15 dB from DSX-1 level.
  - **LBO –22 dB:** Adds an LBO of 22 dB from DSX-1 level.
DS1 Setup Parameters

Receive DS1 Level  
**DS1: Rx** selects the input level for the receive DS1 signal. This parameter is not available when the DS1 signal is the payload of a higher-rate signal. **Rx** can be set as follows:

- **DSX1**: DS1 cross-connect level. Equalized for 0 to 655 feet of cable.
- **Mon**: Monitor level. 10 to 25 dB flat loss relative to DSX-1 signal.
- **ALBO**: Automatic equalizer for 400 to 4000 feet of cable.

Termination Mode  
**DS1: Term** sets the DS1 RX port to either terminate (**Term**) or bridge (**Bridge**) the received signal. This parameter is not available when the DS1 signal is the payload of a higher-rate signal.

DS1 Payload  
**DS1: Data** selects the payload for the DS1 signal. The choices for **DS1: Data** are described in the following table.

<table>
<thead>
<tr>
<th>Selection</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>QRSS</td>
<td>A quasirandom signal source comprising a $2^{20}-1$ pattern with a 14-zero constraint.</td>
</tr>
<tr>
<td>$2^6-1$</td>
<td>A $2^6-1$ pseudorandom bit sequence (PRBS). This is a six-stage PRBS generator with feedback taps at stages 5 and 6.</td>
</tr>
<tr>
<td>$2^9-1$</td>
<td>A $2^9-1$ PRBS. Nine-stage with feedback taps at 5 and 9.</td>
</tr>
<tr>
<td>$2^{11}-1$</td>
<td>A $2^{11}-1$ PRBS. 11-stage with feedback taps at 9 and 11.</td>
</tr>
<tr>
<td>$2^{15}-1$</td>
<td>A $2^{15}-1$ PRBS. 15-stage with feedback taps at 14 and 15.</td>
</tr>
<tr>
<td>$2^{20}-1$</td>
<td>A $2^{20}-1$ PRBS. 20-stage with feedback taps at 17 and 20.</td>
</tr>
<tr>
<td>$2^{23}-1$</td>
<td>A $2^{23}-1$ PRBS. 23-stage with feedback taps at 18 and 23.</td>
</tr>
<tr>
<td>All 0s</td>
<td>All binary zeros (not available in VT1.5 byte sync modes).</td>
</tr>
<tr>
<td>All Ones</td>
<td>All binary ones pattern.</td>
</tr>
<tr>
<td>Alt 1/0</td>
<td>Alternating binary 1s and 0s pattern.</td>
</tr>
</tbody>
</table>
### DS1 Payload Selections (DS1: Data), continued

<table>
<thead>
<tr>
<th>Selection</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 in 8</td>
<td>A 12.5% ones density pattern, synchronized to the F-bit as follows: F 0100 0000.</td>
</tr>
<tr>
<td>2 in 8</td>
<td>A 25% ones density pattern synchronized to the F-bit as follows: F 0110 0000</td>
</tr>
<tr>
<td>3 in 24</td>
<td>A 12.5% ones density pattern, synchronized to the F-bit as follows: F 0100 0100 0000 0000 0000 0000</td>
</tr>
<tr>
<td>Progr #1</td>
<td>User-defined pattern. See User-Programmable DS1/E1 Patterns, page 11-13.</td>
</tr>
<tr>
<td>AIS</td>
<td>DS1 alarm indication signal: an unframed all-ones signal that overrides the DS1: Frm setting. In VT1.5 this is transmitted as a VT path AIS (all-ones in the V1 and V2 bytes).</td>
</tr>
<tr>
<td>Ext</td>
<td>A signal applied at the front-panel DS1 RX port is used as the transmit DS1. The received timing and framing override DS1: TxC1k and Frm. This selection is available only when the DS1 signal is the payload in a higher-rate signal.</td>
</tr>
<tr>
<td>Passthru</td>
<td>The receive DS1 signal is passed through to the transmit DS1 port as-is (line code violations are corrected). Errors can be injected on the pass-through signal, except in monitor mode.</td>
</tr>
<tr>
<td>55 Octet</td>
<td>This is also known as the Daly pattern. Framing does not overwrite the pattern. The pattern bit sequence is as follows:</td>
</tr>
<tr>
<td></td>
<td>10000000 10000000 10000000 10000000 10000000</td>
</tr>
<tr>
<td></td>
<td>10000000 00000001 10000000 10000000 10000000</td>
</tr>
<tr>
<td></td>
<td>10000000 10000000 10000000 10000000 10000000</td>
</tr>
<tr>
<td></td>
<td>10000000 10000000 10000000 11100000 10000000</td>
</tr>
<tr>
<td></td>
<td>10000000 10000000 10000000 10000000 10101010 10101010</td>
</tr>
<tr>
<td></td>
<td>10101010 10101010 10101010 10101010 10101010</td>
</tr>
<tr>
<td></td>
<td>01010101 10000000 10000000 10000000 10000000</td>
</tr>
<tr>
<td></td>
<td>1000000 10000000 11111111 11111111 11111111</td>
</tr>
<tr>
<td></td>
<td>11111111 11111111 11111111 00000001 10000000</td>
</tr>
<tr>
<td></td>
<td>00000001 10000000 00000000 10000000 00000000 10000000</td>
</tr>
<tr>
<td></td>
<td>01000000 00000001 10000000 00000000 10000000</td>
</tr>
<tr>
<td>Live</td>
<td>No pattern. The receiver does not try to synchronize to a pattern. The transmitter sends the last-selected pattern.</td>
</tr>
</tbody>
</table>
DS1 Setup Parameters

### DS1 Payload Selections (DS1: Data>), continued

<table>
<thead>
<tr>
<th>Selection</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DS0</td>
<td>DS0 traffic. The DS1 carries DS0 channels. See DS0 Setup Parameters, page 11–10.</td>
</tr>
<tr>
<td>FT1</td>
<td>Fractional T1 traffic. The DS1 signal carries subrate traffic made up of N number of DS0 channels. See FT1 Setup Parameters, page 11–9.</td>
</tr>
</tbody>
</table>

#### Insert DS1 Channel

**DS1: Ins>** selects which DS1 within a DS3 signal is used for the transmit DS1. **DS1: Ins>** can be set from 1 through 28. This parameter is only applicable when the DS1 is the payload in a higher-rate signal.

#### Other DS1 Channels

**DS1: Other>** sets the payload for the other DS1s (that are not selected by **Ins>**) on the DS3 transmit signal. **Other>** is only applicable when the DS1 is the payload in a higher-rate signal, and can be set as follows:

- **Same**: Fills the DS1s with the same payload as the selected **Ins>** DS1.
- **Inv**: Sets the DS1s to an inverted version of the **Ins>** DS1 payload.
- **AIS**: Fills the remaining DS1s with a DS1 alarm indication signal (AIS).

This field is labeled “Oths” in SONET tests with DS3/DS1 payloads.

#### Drop DS1 Channel

**DS1: Drop>** selects which DS1 within a DS3 signal is used for the receive DS1. **DS1: Drop>** can be set from 1 through 28 or to L (locked to match the **Ins>** channel). This parameter is only applicable when the DS1 is the payload in a higher-rate signal.

Note that the front-panel DS1 DROP jack provides the selected DS1 signal dropped from the DS3.

#### DS1 Drop & Insert Channel

This parameter is only available for drop and insert mode (D&I) tests. The **D&I>** field simultaneously sets the DS1 insert and drop channels to the same number. **D&I>** can be set from 1 through 28. This parameter is only applicable when the DS1 is the payload in a higher-rate signal.

Note that the front-panel DS1 DROP jack provides the selected DS1 signal dropped from the DS3.
Additional DS1 Setup Parameters

DS1 Block Size

**DS1 Block Size** sets the DS1 information block size for applications involving block transfer protocols (such as video telephony).

**Note:** The **DS1 Block Size** value is used for E1 block measurements too.

This parameter is located on the Auxiliary Test Setups screen:

- Select **Setup System Parameters** from the Main Menu and press MENU-down.
- Next select Auxiliary Test Setups and press MENU-down.

```plaintext
Auxiliary Test Setups
Test Dur. Mode: Continuous
Timer Duration: 00:01:00 (hh:mm:ss)
Auto. Print Mode: Off
Auto. Store Mode: Off
For Up Optical Tx State: Last State
STS12 # Scheme: STS3#, STS1#
UT Counting Mode: UT Group
DS2 Tx-2bit: 0
  ❯ DS1 Block size: 2Kbit
  ❯ DS1 LOP & OOF Hold-off: 0.0 seconds
  Bits Clk Out Derived from: STS-N Rx Clk
```

**DS1 Block Size** can be set from **2Kbit** through **8Kbit** (kilobits). The block size is used to compute block error measurements (see *DS1 Block Error Measurements Screen*, page 12–6).

DS1 Alarm Delay

You can set a DS1 alarm hold-off period to delay the declaration of DS1 LOP (loss of pattern) and OOF (out of frame) alarms.

**DS1 LOP & OOF Hold-off:** Sets the length of time alarms are delayed. This can be set from **0.0** (no delay) to **9.9**.

DS1 Jitter Hits Threshold

For information on setting the jitter hits thresholds, see *Jitter Threshold Configuration*, page 23–3.
DS1 and DS0 Error and Alarm Injection

The following type of error can be injected when the transmitter or payload is set for DS1 or VT1.5. The rates for each selection are Single, 1.0E-2 through 1.0E-9, Burst, Continuous, and Off.

**Note:** For information on injection rates, see *About Error Injection Rates*, page 27-7.

**DS1 Data:** Generates data bit errors before the CRC is calculated, so no CRC errors are generated.

**DS1 Dat, CRC:** Generates combined data bit errors and CRC errors by erroring the data bits after the CRC is calculated.

**DS1 Frame:** Generates DS1 frame bit errors. For SF and SLC-96 formats, the F<sub>c</sub> bits are errored. For ESF format, the FPS bits are errored.

**DS1 BPV:** Generates bipolar violations in the DS1 data. For B8ZS coding, BPVs cause data bit errors as well.

**DS1 Yellow:** Generates a Yellow alarm condition on the transmit DS1 using DS0 bit 2 in SF format, or an alternating 00 FF (hex) pattern in the facility data link for ESF format.

**DS1 LoopUp:** Generates the currently defined DS1 loopback activate code. See *DS1 Loop Codes*, page 11-14.

**DS1 LoopDn:** Generates the currently defined DS1 loopback deactivate code. See *DS1 Loop Codes*, page 11-14.

**DS1 Idle:** Generates a DS1 Idle/CDI (customer defect indication) signal. This is the pattern 0001 0111 on all 24 timeslots on the DS1. For ESF, a Yellow alarm is also sent on the datalink.

**DS0 Data:** Generates data bit errors on the selected DS0 when DS1: Data> is set to DS0 and DS0 Data> is set to a pattern.
FT1 Setup Parameters

FT1 parameters are applicable when the DS1 payload (Data>) is set for FT1. FT1 parameters are accessed by selecting DS0/TS/Frac Setup from the Control Screens menu and pressing CONFIG-right twice. The Fractional T1 Setup screen appears as follows:

```
  >Fraction T1 Setup<
  
  N> 4k
  1   |   |   |   | 24
  Select>********************************
        Data> QRSS
```

**FT1 Base Rate**

N> selects the base rate for the FT1 signal. The base rate is the rate of a single DS0 channel. N> can be set to **64k** (64 kbs) or **56k** (56 kbs).

**Note:** This selection also sets the N> setting on the DS0 Setup screen.

**Selected DS0 Channels**

Select> determines which DS0s are used to generate the FT1 signal. A channel set to "*" is included in the FT1 signal. A channel set to "-" is not included in the FT1 signal.

Channels that are not selected are transmitted as all-ones.

**FT1 Payload**

Data> selects the payload for the FT1 signal. The data is distributed across the entire FT1 signal, even if the DS0s that make up the FT1 are not contiguous. The payload choices for Data> include the following (see DS1 Payload, page 11-4, for a description of each payload):

- QRSS
- PRBSs \((2^6-1, \text{ and so on})\)
- All 0s or All 1s
- Alt 1/0
- 1 in 8, 2 in 8, or 3 in 24
- Progr #1 through Progr #6
- 55 Octet


DS0 Setup Parameters

DS0 setup parameters are applicable when the Payload is DS1 or DS0.

There are two ways that DS0 parameters are displayed. When the DS0 traffic is carried in a DS1 signal connected directly to the test set, the DS0 parameters appear similar to the following:

```
DS1:  Rx>DSM1  Tx>DSM1
      Frm>SF     Code>RMI
      TxClk:Int  Term:Term

DS0:  Ins>  Other>Same  Drop>1
      Tone>DRS 1004 Hz
```

When the DS0 traffic is carried in a DS1 that is the payload of a higher-rate signal, the DS0 parameters are accessed by selecting **DS0 Control** from the Control Screens menu. The DS0 Setup screen appears as follows:

```
>DS0 Setup<
Data>1004Hz  Nx>64k
Ins>1        Drop>1
Other>Same (UF Tone Only)
Tx Signaling: A>1 B>1 C>1 D>1
```

**DS0**: **Ins>** selects which DS0 within a DS1 signal is used for the transmit DS0. **DS0**: **Ins>** can be set from 1 through 24.

**DS0**: **Other>** sets the payload for the other DS0s (that are not selected by **Ins>**) on the DS1 transmit signal. **Other>** can be set as follows:

- **Same**: Fills the DS0s with the same payload as the selected **Ins>** DS0.
- **All Ones**: Sets the DS0s to an all-ones pattern.
- **Passthru**: The DS0 payloads are retransmitted as received.
DS0 Setup Parameters

Drop DS0 Channel  
**DS0: Drop** selects which DS0 within a DS1 signal is used for the receive DS0. **DS0: Drop** can be set from 1 through 24. On the DS0 Setup screen, **Drop** can also be set to **L**, which locks the drop DS0 to match the insert DS0 (**L** is not available for monitor mode tests).

DS0 Drop & Insert Channel  
This parameter is only available for drop and insert mode (D&I) tests. The **D&I** field simultaneously sets the DS0 insert and drop channels to the same number. **D&I** can be set from 1 through 24.

DS0 Base Rate  
**Nx** selects the base rate for the DS0 signal. **Nx** can be set to **64k** (64 kbps) or **56k** (56 kbps).

**Note:** This selection also sets the **Nx** setting on the Fractional T1 Setup screen.

DS0 Payload  
The DS0 payload is set by one of two parameters, depending on the DS0 test mode (see **DS0 Mode Implementation**, page 11–10).

DS0 Setup Screen **Data**  
On the DS0 Setup screen, **Data** sets the DS0 payload as described in the following table.

---

### DS0 Payload Selection (Data)

<table>
<thead>
<tr>
<th>Selection</th>
<th>Payload Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1004Hz</td>
<td>These four selections apply a test tone at the indicated frequency (in Hertz). Not available for monitor test modes.</td>
</tr>
<tr>
<td>1012Hz</td>
<td>The 1012 Hz tone is transmitted at −12 dB.</td>
</tr>
<tr>
<td>1020Hz</td>
<td></td>
</tr>
<tr>
<td>2010Hz</td>
<td></td>
</tr>
<tr>
<td><strong>Tone</strong></td>
<td>Monitor modes only. Sets the receiver to expect an input tone on the drop signal.</td>
</tr>
<tr>
<td><strong>Ext VF</strong></td>
<td>Transmits a VF signal applied at the rear panel VF IN jack. Not available for monitor test modes.</td>
</tr>
<tr>
<td><strong>QRSS</strong></td>
<td>Quasirandom Sequence Signal. Transmits a quasirandom signal.</td>
</tr>
<tr>
<td><strong>2^E-1</strong></td>
<td>PRBS. A pseudorandom bit sequence of length 2^E-1 where E is the exponent. For example 2^9-1 is a 2^9-1 PRBS.</td>
</tr>
<tr>
<td><strong>All 0s</strong></td>
<td>All binary zeros pattern (not available in VT1.5 byte sync modes).</td>
</tr>
<tr>
<td><strong>All 1s</strong></td>
<td>All binary ones pattern.</td>
</tr>
</tbody>
</table>

---
**DS0 Setup Parameters**

### DS0 Payload Selection (Data>), continued

<table>
<thead>
<tr>
<th>Selection</th>
<th>Payload Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alt 1/0</td>
<td>Alternating binary 1s and 0s pattern.</td>
</tr>
<tr>
<td>1 in 8</td>
<td>A 12.5% ones density pattern, synchronized to the F-bit as follows: F 0100 0000.</td>
</tr>
<tr>
<td>2 in 8</td>
<td>A 25% ones density pattern synchronized to the F-bit as follows: F 0110 0000</td>
</tr>
<tr>
<td>3 in 24</td>
<td>A 12.5% ones density pattern, synchronized to the F-bit as follows: F 0100 0100 0000 0000 0000 0100.</td>
</tr>
<tr>
<td>Prog#1 --</td>
<td>User-programmable patterns. Transmits the corresponding user pattern (see <em>User-Programmable DS1/E1 Patterns</em>, page 11–13).</td>
</tr>
<tr>
<td>Prog#6</td>
<td></td>
</tr>
<tr>
<td>55 Oct</td>
<td>Transmits a specific repeating 55-byte pattern, also known as the Daly Pattern.</td>
</tr>
<tr>
<td>DATA-LINK- RS232</td>
<td>Transmits the data applied at the rear-panel DATALINK RS-232 port.</td>
</tr>
</tbody>
</table>

---

**Test Configuration Screen**

**DS0: Tone>**

On the test configuration screen (for direct DS1 signals) **DS0: Tone>** sets the DS0 payload as follows:

- **DRS 1004 Hz**: Transmits a Digital Reference Signal of 1004 Hertz.
- **DRS 1012 Hz**: Transmits a Digital Reference Signal of 1012 Hertz.
- **DRS 1020 Hz**: Transmits a Digital Reference Signal of 1020 Hertz.
- **External VF**: Transmits the signal applied at the rear-panel VF IN port.

**Transmit DS0 Signaling**

The **Tx Signaling**: fields on the DS0 Setup screen set the binary status of the transmitted ABCD signaling bits of the selected insert DS0. Each bit (A>, B>, C>, and D>) can be set to either 1 or 0. C> and D> are applicable only in ESF format.
User-Programmable DS1/E1 Patterns

The user-programmable DS1/E1 data patterns are accessed by selecting **DS1/E1 Patterns** on the Control Screens menu and then pressing CONFIG-right. These patterns are used when the DS1, E1, or DS0 **Data** field is set to a **Prog #**.

The DS1/E1 programmable pattern configuration screen appears as follows:

```
DS1/E1 Prog Pattern
ESF datalink message
  Data link idle  <01111110 01111110>
ESF Programmable datalink patterns
  User 1: <1100010v xxxxxxxx  <v=0>  <x=1>
  User 2: <0110000v xxxxxxxx  <v=0>  <x=1>
  Prog Pat 1: 01000000000000000000000000000000
  Prog Pat 2: 01000000000000000000000000000000
  Prog Pat 3: 01000100000000000000000000000000
  Prog Pat 4: 01000100000000000000000000000000
  Prog Pat 5: 01000100000000000000000000000000
  Prog Pat 6: 01000100000000000000000000000000
```

The **Prog Pat #** fields represent the bits in each of the DS1/E1 user patterns. Each bit can be set to 1, 0, or to a dot. A dot represents an unused bit position and is not transmitted. Pattern length can be from 2 through 24 bits, and is defined by the number of bits set to 1 or 0.

The pattern is transmitted with the most significant bit following the frame bit (for pattern lengths that divide evenly into 192).
DS1 Loop Codes

Loop codes are transmitted by setting **Err/Alm:Type** to DS1 LoopUp or DS1 LoopDn. The transmitted loop up or loop down code is configured on the DS1 Loop Code Setup screen. To access this screen, select **DS1 Loop Codes** from the Control Screens menu and press CONFIG-right.

![DS1 Loop Code Setup](image)

Loop Up and Loop Down Codes

**LoopUp Code** selects the code transmitted when **Err/Alm:Type** is set to DS1 LoopUp. **LoopDn Code** selects the code transmitted when **Err/Alm:Type** is set to DS1 LoopDn. These fields can be set as follows:

- **Inband Line [CSU] (10000)**: In-band line loop code: repeating 5-bit sequence (10000) typically used by CSUs.
- **Inband Ntwk [NIU] (11000)**: In-band network loop code: repeating 5-bit sequence (11000), typically used by NIUs.
- **Inband 4bit (1100)**: In-band 4-bit loop code (repeating 1100 sequence).
- **Inband Usr**: In-band user-defined loop code. The code defined for **Inband LpUp:Tx>** (loop up) or **Inband LpDn:Tx>** (loop down) is transmitted when this is selected.
- **Outband Line [CSU] (000111)**: Out-of-band line loop code: six bit code transmitted in the ESF facility datalink; typically used by CSUs.
- **Outband Ntwk [NIU] (001001)**: Out-of-band network loop code: six bit code transmitted in the ESF FDL; typically used by NIUs.
DS1, DS0, and FT1 Configuration Reference

**DS1 Loop Codes**

**Outband Pyld (001010):** Out-of-band payload loop code: six bit code transmitted in the ESP FDL. This type loops only the payload of the signal.

**Outband Usr:** Out-of-band user-defined loop code. The code defined for **Outband LpUp:Tx>** (loop up) or **Outband LpDn:Txx>** (loop down) is transmitted when this is selected.

Frame Format Overwrite

**Framing Overwrite** sets whether the transmitted loop code writes over the DS1 framing. **On** means framing is overwritten; **Off** means framing is not overwritten.

User-defined Loop Codes

There are two sets of use-defined loop codes:

**LpUp:** The codes used for loop activation.

**LpDn:** The codes used for loop deactivation.

In-band Codes

For in-band loop codes (codes transmitted in the payload portion of the DS1 signal) each user-defined loop code has a Tx and an Rx bit sequence:

**Tx:** This is the bit sequence that is transmitted when ERROR INECT is pressed.

**Rx:** This is the bit sequence for which the 156MTS monitors on the received signal.

Each code can be set from 2 through 16 bits long. Each bit can be set to either 1 or 0. Unused bits are set to a dot.

Out-of-band Codes

Out-of-band codes are transmitted and received in the facility datalink (FDL) of Extended Superframe (ESF) formatted signals. Each code is six bits long, and is transmitted as part of a 16-bit sequence, as follows:

\[0\text{bbbbbb}11111111\]

where **bbbbbb** is the six-bit code.
DS1 Data Link Parameters

The Data Link Control screen configures the functionality of the rear-panel data link ports.

![Data Link Control Screen]

**Note:** For information on other data link rate uses, see *SONET Datalink Control Parameters*, page 3–18 or *DS3 Datalink Parameters*, page 7–15.

**Rear-Panel RS-232 Data Link Port**

**RS232>** configures the rear-panel DATA-LINK RS-232 interface in both the transmit and receive directions. The choices for DS1 are as follows:

- **None:** The RS-232 data link interface is disabled.

**DS1 ESF or SLC-96 Data Link:** The transmitted data on the DS1 data link channel (ESF or SLC-96 formats) is derived from the RS-232 data link port. Received data from this data link is transmitted on the port's output.

**DS0 Data:** The transmitted DS0 data on the DS1 signal is derived from the RS-232 data link port. Received DS0 data is output on this port.

**Note:** The remaining data link parameters on this screen apply only for SONET rate testing. See *SONET Datalink Control Parameters*, page 3–18.
DS1 Drop Scan Sequence

The DS1 drop sequence scans the 28 DS1 channels of a DS3 signal one at a time. The DS3 signal can be an electrical signal at the DS3 RX port, or it can be dropped from an STS-1, OC3, or OC-12 signal. The DS1 drop scan setup and results screen appears as follows:

<table>
<thead>
<tr>
<th>1 DS1 Drop Scan</th>
<th>Final: 00:00:00.00</th>
</tr>
</thead>
<tbody>
<tr>
<td>1: --</td>
<td>6: --</td>
</tr>
<tr>
<td>2: --</td>
<td>7: --</td>
</tr>
<tr>
<td>3: --</td>
<td>8: --</td>
</tr>
<tr>
<td>4: --</td>
<td>9: --</td>
</tr>
</tbody>
</table>

The **Configurations From** field selects the test mode that is used for the DS1 drop scan sequence. The configuration that was last set-up for the selected mode (the background mode) is used for the test sequence. The modes are listed in the following table. The modes available depend on the configuration of your test set.

**DS1 Drop Scan Sequences Configurations From Selections**

<table>
<thead>
<tr>
<th>DS3-MON (DS1)</th>
<th>DS3-DS3 (DS1)</th>
<th>STS1-MON (DS3/1)</th>
</tr>
</thead>
<tbody>
<tr>
<td>OC3-OC3 (DS3/1)</td>
<td>OC3-MON (DS3/1)</td>
<td></td>
</tr>
<tr>
<td>OC12-OC12 (DS3/1)</td>
<td>OC12-MON (DS3/1)</td>
<td></td>
</tr>
</tbody>
</table>

**Scan Mode**

**Channel Scan Mode** selects the method used to control the DS1 scan.

**Single:** The 28 DS1s are scanned and then the sequence ends.

**Continuous:** After each scan of the 28 DS1s is performed, the scan is repeated.
DS1, DS0, and FT1 Configuration Reference

**DS1 Drop Scan Sequence**

**Drop Scan Results**

The results of the DS1 drop scan are displayed on the top half of the display. Each channel is listed, along with its detected status. The RESULT keys scroll through the channel list screens.

After each DS1 is analyzed, one of the following is displayed for that channel:

**No Signal:** No detectable signal. Either no DS3, or no DS1 traffic present on the DS3.

**AIS:** Alarm indication signal detected on the DS1.

**No Frame:** The framing format as set in the background mode was not detected on the DS1.

**Frame:** The DS1 framing format as set in the background mode was detected, but without pattern synchronization.

**Frm & Pat:** Both DS1 frame format and pattern were detected, as selected in the background mode.
DS0/Timeslot Signaling Scan

The DS0/TS signaling sequence scans the 24 DS0 channels of a DS1, or the 31 TS (timeslot) channels of an E1, and reports the signaling bit status. The DS1 or E1 can be directly connected at the DS1/E1 RX port, or it can be dropped from a DS3. The signaling scan screen appears as follows:

```
1 Signaling Scan   Final: 00:00:00.00
                   ABCD ABCD ABCD ABCD ABCD ABCD
1: 00-- 00-- 00-- 00-- 00-- 00--
7: 00-- 00-- 00-- 00-- 00-- 00--
13: 00-- 00-- 00-- 00-- 00-- 00--
19: 00-- 00-- 00-- 00-- 00-- 00--

Configurations From: DS1-DS1 (DS0)
Channel Scan Mode: Single
```

**Signaling Scan Configuration**

The *Configurations From* field selects the test mode for the signaling scan sequence, using the configuration that was last set-up for the selected mode (the background mode). The modes are listed in the following table.

<table>
<thead>
<tr>
<th>Signaling Scan Sequences</th>
<th>Configurations From Selections</th>
</tr>
</thead>
<tbody>
<tr>
<td>DS1-MON (DS0)</td>
<td>E1-MON (TS)</td>
</tr>
<tr>
<td>DS1-DS1 (DS0)</td>
<td>E1-E1 (TS)</td>
</tr>
<tr>
<td>DS3-MON (DS0)</td>
<td>DS3-MON (E1/TS)</td>
</tr>
</tbody>
</table>

**Scan Mode**

*Channel Scan Mode* selects whether the DS0/TS scan repeats:

- **Single**: The 24 DS0s are scanned and then the sequence ends.
- **Continuous**: After all channels are scanned, the scan is repeated.

**Signaling Scan Results**

The results of the signaling scan are shown on the top half of the display. Each channel is listed, along with the status of its signaling bits (either 1 or 0). The C and D signaling bits are only applicable to DS1 ESP format and E1 CAS (30-channel) format signals.
DS1, DS0, and FT1 Configuration Reference
DS1 Indicators 12-2
DS1 Measurement Summary Screen 12-3
DS1 Bit Error Measurement Screens 12-4
DS1 Block Error Measurements Screen 12-6
DS1 CRC-6 Error Measurements Screen 12-7
DS1 Frame Error Measurements Screen 12-8
DS1 Combined Frame and CRC Errors Screen 12-9
DS1 BPV Measurements Screen 12-10
DS1 Slips Screen 12-11
DS1 Idle/CDI Detection Screen 12-12
DS1 ESF Datalink Display Screen 12-13
DS1 Loop Code Display Screen 12-13
DS1 Signal Measurements Screen 12-14
Jitter Measurements 12-15
DS1 Alarm Screens 12-16
DS1 Status Screen 12-18
DS0 VF Measurements Screen 12-19
DS0/TS Bit Error Measurements Screen 12-20
FT1 Measurement Summary Screens 12-21
FT1 Bit Error Measurement Screens 12-22

DS1 Measurement Reference
DS1 Indicators

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOS</td>
<td>Loss of DS1 (or E1) signal.</td>
</tr>
<tr>
<td>OOF</td>
<td>Out of frame.</td>
</tr>
<tr>
<td>AIS</td>
<td>DS1 (E1) alarm indication signal.</td>
</tr>
<tr>
<td>YEL</td>
<td>DS1 Yellow alarm; (E1 Remote alarm).</td>
</tr>
<tr>
<td>LOPAT</td>
<td>Loss of pattern.</td>
</tr>
<tr>
<td>COFA</td>
<td>DS1 Change of frame alignment.</td>
</tr>
</tbody>
</table>

**DS1 STATUS**

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DS1 SIG</td>
<td>Valid DS1 signal detected.</td>
</tr>
<tr>
<td>DS1C SIG</td>
<td>Valid DS1C signal detected.</td>
</tr>
<tr>
<td>SF SYNC</td>
<td>Valid Superframe (SF) format detected.</td>
</tr>
<tr>
<td>ESF SYNC</td>
<td>Valid Extended Superframe (ESF) format detected.</td>
</tr>
<tr>
<td>PAT SYNC</td>
<td>Receiver synchronized with test pattern.</td>
</tr>
<tr>
<td>B8ZS</td>
<td>DS1 B8ZS zero substitution codes detected.</td>
</tr>
<tr>
<td>ERRORS</td>
<td>DS1 error detected.</td>
</tr>
</tbody>
</table>
DS1 Measurement Summary Screen

This screen displays an overview of DS1 error measurements.

| Bit: DS1 bit error count: The number of errored bits (transmitted at one level, but received at another). |
| Frm: DS1 frame error count: The number of framing bits received in error. The framing bits are $F_t$ or $F_s$ (for SF format), FPS bits (ESF), and $F_t$ (SLC-96). |
| CRC: DS1 CRC-6 error count: The number of ESF CRC-6 fields that are received in error. |
| BPV: DS1 bipolar violation count: The number of DS1 BPVs. A BPV is the occurrence of two consecutive pulses of the same polarity (unless the pulses are part of a B8ZS zero-substitution code). |
| DS1 Drop Hz: Drop DS1 frequency: The frequency, in Hertz, of the DS1 signal dropped from a higher-rate signal. This measurement is only displayed when testing higher-rate signals carrying DS1 subrate traffic. |
DS1 Bit Error Measurement Screens

### DS1 Bit Error Measurements

<table>
<thead>
<tr>
<th>Measurement</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Error Count</td>
<td>The total number of DS1 bit errors detected.</td>
</tr>
<tr>
<td>Current Ratio</td>
<td>Current DS1 BER: The number of DS1 bit errors over the number of DS1 bits received in the previous 2.25 seconds.</td>
</tr>
<tr>
<td>Average Ratio</td>
<td>Average DS1 BER: The number of DS1 bit errors over the total DS1 bits received since the beginning of the test.</td>
</tr>
<tr>
<td>ES</td>
<td>DS1 errored seconds: Number of seconds with at least one DS1 bit error, LOP, or LOS (seconds are counted from test start). Seconds during which a LOS are not counted.</td>
</tr>
<tr>
<td>EFS</td>
<td>DS1 error-free seconds: The number of seconds during which no DS1 bit errors occurred.</td>
</tr>
<tr>
<td>%EFS</td>
<td>Percentage of DS1 error-free seconds: EFS expressed as the percentage of the total number of seconds in the test.</td>
</tr>
</tbody>
</table>
## DS1 Bit Error Measurements, continued

<table>
<thead>
<tr>
<th>Measurement</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sev ES</td>
<td>DS1 severely errored seconds (SES): The number of seconds during which the error ratio was $10^{-9}$ or greater.</td>
</tr>
<tr>
<td>Sync ES</td>
<td>DS1 synchronous errored seconds: The number of seconds in which at least one DS1 bit error occurred (seconds are counted beginning at the error occurrence).</td>
</tr>
<tr>
<td>Avail Sec</td>
<td>DS1 available seconds: The number of seconds during the test that were not unavailable (see below).</td>
</tr>
<tr>
<td>Unavail Sec</td>
<td>DS1 unavailable seconds: The DS1 is declared unavailable after ten consecutive seconds of SES or LOP. The DS1 is declared available again after ten consecutive seconds with no SESs or LOPs.</td>
</tr>
<tr>
<td>Degrad Min</td>
<td>DS1 degraded minutes: The number of 60-second intervals during which the available seconds and bit error counts are both greater than zero, but do not exceed the SES threshold; or, the number of 60-second intervals during which the available seconds and CRC error counts are both greater than zero but less than 320. The 60-second intervals do not need to be contiguous.</td>
</tr>
<tr>
<td>Thrsh E-n</td>
<td>DS1 threshold seconds: Number of available seconds during which the bit or CRC error rate (whichever is larger) exceeded the threshold. Thresholds correspond to the following values (framed/unframed): E-3 = 1,536/1,544; E-4 = 154/154; E-5 = 15/15; E-6 = 2/2.</td>
</tr>
<tr>
<td>Dribble</td>
<td>DS1 dribbling error seconds: The number of seconds during which the error rate is greater than 1, but does not exceed $10^{-6}$ (between 1 and 14 errors).</td>
</tr>
<tr>
<td>CSES</td>
<td>DS1 Consecutively severely-errored seconds count: The number of SESs for which the previous two seconds were also SESs. This count is reset during LOS, LOF, and LOP.</td>
</tr>
<tr>
<td>Burst ES</td>
<td>DS1 burst error seconds: The number of seconds in which three or more bit errors occurred.</td>
</tr>
</tbody>
</table>
DS1 Block Error Measurements Screen

This screen displays measurements based on DS1 block errors.

<table>
<thead>
<tr>
<th>1 DS1-DS1 (DS1)</th>
<th>Final: 00:00:00.00</th>
</tr>
</thead>
<tbody>
<tr>
<td>DS1 Block Error Measurements</td>
<td></td>
</tr>
<tr>
<td>Est. Total Blocks: --</td>
<td></td>
</tr>
<tr>
<td>Block Err Count: --</td>
<td></td>
</tr>
<tr>
<td>Burst Err Seconds: --</td>
<td></td>
</tr>
<tr>
<td>SEE: --</td>
<td>CATV UAS: --</td>
</tr>
</tbody>
</table>

**Est. Total Blocks:** Estimated count of DS1 blocks: The estimated number of blocks received, as determined by the selected block size.

**Block Err Count:** DS1 block error count: The number of DS1 blocks that contained one or more errors.

**Burst Err Seconds:** DS1 block burst errored seconds: The number of seconds in which the number of block errors was three or greater.

**SEE:** Severe error event count. A SEE is four consecutive quarters, seconds each containing 93 or more bit errors, or more than \( N \) block errors. The value of \( N \) depends on the DS1 block size (see following table). A SEE ends when there are two consecutive error-free seconds.

### Severe Error Event (SEE) Block Error Threshold Values

<table>
<thead>
<tr>
<th>Block Size</th>
<th>( N ) (number of block errors)</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 Kbit</td>
<td>46</td>
</tr>
<tr>
<td>3 Kbit</td>
<td>30</td>
</tr>
<tr>
<td>4 Kbit</td>
<td>23</td>
</tr>
<tr>
<td>5 Kbit</td>
<td>18</td>
</tr>
<tr>
<td>6 Kbit</td>
<td>15</td>
</tr>
<tr>
<td>7 Kbit</td>
<td>13</td>
</tr>
<tr>
<td>8 Kbit</td>
<td>11</td>
</tr>
</tbody>
</table>

**CATV UAS:** Cable TV unavailable seconds count: The number of CATV UASs. A CATV UAS interval is declared when there are 60 consecutive BESs, ten consecutive SESs, or ten consecutive LOP seconds. These seconds are included in the unavailable time.

A CATV UAS interval ends when there are 60 consecutive error-free seconds. These seconds are not included in the unavailable time.
DS1 CRC-6 Error Measurements Screen

This screen displays measurements based on CRC-6 errors in ESF formatted DS1 signals.

```
1 DS1-D6 (DS1)  Final: 00:00:00.00
DS1 CRC-6 Error Measurements
  Count: --  ES: --
  Cur Ratio: --  EFS: --
  Avg Ratio: --  %EFS: --
```

**Count:** CRC error count: The number of ESF CRC-6 values that are errored.

**Cur Ratio:** Current CRC error ratio: The average CRC error ratio during the previous 2.25 seconds.

**Avg Ratio:** Average CRC error ratio: The number of CRC-6 errors over the number of bits received since the beginning of the test.

**ES:** CRC errored seconds: The number of seconds during which at least one CRC error occurred.

**EFS:** CRC error-free seconds: The number of seconds during which no CRC errors occurred.

**%EFS:** CRC error-free seconds percentage: DS1 CRC-6 EFS expressed as a percentage of the total time since the beginning of the test.
DS1 Frame Error Measurements Screen

This screen displays measurements based on framing errors in framed DS1 signals.

<table>
<thead>
<tr>
<th>Count:</th>
<th>ES:</th>
<th>Count:</th>
<th>ES:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cur Ratio:</td>
<td>EFS:</td>
<td>Avg Ratio:</td>
<td>%EFS:</td>
</tr>
</tbody>
</table>

**Count:** Frame bit error count: The number of errored frame bits, including $F_1$ or $F_5$ bits (for SF format), FFS bits (for ESF), or $F_1$ bits (for SLC-96).

**Cur Ratio:** Current frame bit error ratio: The average frame bit error ratio during the previous 2.25 seconds.

**Avg Ratio:** Average frame bit error ratio: The number of frame bit errors over the number of frame bits received since the beginning of the test.

**ES:** Frame bit errored seconds: The number of seconds during which at least one frame bit error occurred.

**EFS:** Frame bit error free seconds: The number of seconds during which no frame bit errors occurred.

**%EFS:** Frame bit error free seconds percentage: DS1 frame bit EFS expressed as a percentage of the total time since the beginning of the test.
DS1 Combined Frame and CRC Errors Screen

This screen displays errored seconds measurements based on combined DS1 framing and CRC errors.

<table>
<thead>
<tr>
<th>1 DS1-DS1 (DS1)</th>
<th>Final: 00:00:00.00</th>
</tr>
</thead>
<tbody>
<tr>
<td>DS1 Combined Frame &amp; CRC Errors</td>
<td></td>
</tr>
<tr>
<td>ES: --</td>
<td>SES: --</td>
</tr>
<tr>
<td>ES A: --</td>
<td>Cons SES: --</td>
</tr>
<tr>
<td>ES B: --</td>
<td>--</td>
</tr>
</tbody>
</table>

**ES:** Frame/CRC errored second count: The number of seconds during which at least one frame bit or CRC-6 error occurred, but no OOF events occurred.

**ES A:** CRC type A errored seconds count: The number of seconds during which a single CRC-6 error occurred, and no OOF events occurred.

**ES B:** CRC type B errored seconds count: The number of seconds during which at least one but fewer than 320 CRC-6 errors occurred, but no OOF events occurred.

**SES:** Frame/CRC severely errored seconds count: The number of seconds during which an OOF event or 320 CRC-6 errors occurred.

**Cons SES:** Frame/CRC consecutive severely errored seconds count: The number of seconds counted as CSESs. This value increments by ten for every ten successive frame/CRC SESs that occur.
DS1 BPV Measurements Screen

This screen displays measurements based on bipolar violations (BPVs).

<table>
<thead>
<tr>
<th>DS1-BPV Measurements</th>
<th>Final: 00:00:00.00</th>
</tr>
</thead>
<tbody>
<tr>
<td>Count:</td>
<td>--</td>
</tr>
<tr>
<td>Cur Ratio:</td>
<td>--</td>
</tr>
<tr>
<td>Avg Ratio:</td>
<td>--</td>
</tr>
<tr>
<td>LCVR Sec:</td>
<td>--</td>
</tr>
</tbody>
</table>

**Count:** BPV error count: The number of bipolar violations. A BPV is the occurrence of two consecutive pulses of the same polarity (unless the pulses are part of a B8ZS zero-substitution code).

**Cur Ratio:** Current BPV error ratio: The average BPV error ratio during the previous 2.25 seconds.

**Avg Ratio:** Average BPV error ratio: The number of BPVs over the number of bits received since the beginning of the test.

**LCVR Sec:** Line code violation rate seconds count: The number of seconds in which the LCVR state was declared. The LCVR state is declared when the BPV error rate exceeds 15 for one second (approximately $10^{-6}$). The LCVR state is cleared when the BPV rate drops to less than one per second (approximately $10^{-7}$).

**ES:** BPV errored seconds: The number of seconds during which at least one BPV occurred.

**EFS:** BPV error-free seconds: The number of seconds during which no BPV errors occurred.

**%EFS:** BPV error-free seconds percentage: Bipolar violation EFS expressed as a percentage of the total time since the beginning of the test.
DS1 Slips Screen

This screen displays DS1 slips measurements based on comparing the timing relationship between the receive DS1 signal to an external reference signal. The reference signal is a bipolar DSX-1 source applied at the rear-panel DS1 REF IN connector.

Frm Slips: Frame slip count: The number of frame slip occurrences. A frame slip is declared when a difference of 193 time slots (bits) is detected between the receive and reference signals. Multiple frame slips within 0.25 seconds are counted as a single frame slip.

Bit Slips: Bit slip count: The number of individual time slot differences between the receive and reference signals, in either direction. A positive value indicates that the receive frequency is greater than the reference frequency. A negative value indicates the receive frequency is less than the reference. If the reference is lost, the bit slip count is restarted from zero when the reference is restored.

Bit Slips (graphic): This arrow provides a repeating graphic showing the number of bit slips. When the arrow reaches the right side of the display, 193 bits slips have been counted and a frame slip is declared.

Slip Sec: Slip seconds count: The number of second during which one or more frame slips occurred.

Rx Hz: Receive DS1 frequency: The received signal frequency displayed in Hertz.

Delta Hz: Frequency difference in Hertz: The difference between the receive DS1 frequency and the reference frequency. A positive value indicates the receive frequency is faster than the reference; a negative value indicates the receive frequency is slower.
DS1 Idle/CDI Detection Screen

This screen displays measurements based on the detected of the DS1 Idle/CDI code. The Idle/CDI (customer defect indicator) is often transmitted by DS1 NIUs upon detection of a customer-side loss of signal.

The Idle/CDI code is defined as the repeating pattern 0001 0111 in all 24 timeslots on the DS1. In ESF format, a Yellow alarm is also transmitted in the facility datalink.

<table>
<thead>
<tr>
<th>DS1 Idle Detection</th>
<th>Final: 00:00:00.00</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current State: --</td>
<td>History: --</td>
</tr>
<tr>
<td>Received Sec: --</td>
<td></td>
</tr>
<tr>
<td>Seconds Ago: --</td>
<td></td>
</tr>
</tbody>
</table>

**Current State:** Indicates whether the Idle/CDI code is currently being detected on the selected receive DS1 signal. ON indicates the code is present.

**History:** Indicates whether the Idle/CDI code was previously detected since the beginning of the test.

**Received Sec:** The number of seconds during which the Idle/CDI code was detected since the beginning of the test.

**Seconds Ago:** The number of second since the last Idle/CDI code was detected.
DS1 ESF Datalink Display Screen

This screen displays the received DS1 Extended Superframe (ESF) facility datalink (FDL). The received signal must be ESF framed.

![DS1 ESF Datalink Display](image)

**Binary**: Shows the current 16-bit FDL sequence.

**Message**: Shows the corresponding text message of the received FDL code (if applicable).

**Received Sec**: Displays how long the current code has been received.

---

DS1 Loop Code Display Screen

This screen displays the status of loop codes received by the test set.

![DS1 Loop Code Display](image)

The screen reports the status of in-band and out-of-band loop-up and loop-down codes. For each type of loop code, the **Cur** (current) field will display **ON** when that code is being detected. The **Hist** (history) field shows **ON** when that loop code has been detected since the start of the test.

The **Seconds** field indicates how long the loop code was detected. **Sec Ago** shows how long it has been since the code was last detected.
DS1 Signal Measurements Screen

This screen displays signal measurements for the DS1 receive signal.

| Rx Hz: Receive DS1 signal frequency: The frequency of the receive DS1 signal, in Hertz. |
| Rx Pk V: Receive DS1 level, Vpk: The level of the receive DS1 signal in volts peak (accuracy is ±5%). |
| Rx dBdsx: Receive DS1 level, dB: The level of the receive DS1 signal in decibels, referenced to a DSX-1 level (accuracy is ±1 dB). The range is -30 to +6 dBdsx. |
| Rx ma: Simplex current, mA: The level of DC current between the transmit and receive pairs in milliamperes (mA). A positive (+) value indicates current flow from the receive pair to the transmit pair. |
| Ref Hz: Reference DS1 signal frequency: The frequency of the reference DS1 signal applied at the rear-panel DS1 REF IN connector, in Hertz. |
| EXZ: Excessive zeros count: The number of consecutive-zero strings greater than 15 (for AMI) or greater than 7 (for B8ZS). Each string is considered a single event. |
Jitter Peak Results

For DS1, the wide-band jitter cut-off frequency is 10 kHz to 40 kHz and the high-band cut-off frequency is 8 kHz to 40 kHz.

Each result is calculated for both wide-band and high-band jitter.

**Current P-to-P:** Current peak-to-peak jitter: The sum of the positive jitter peak and the negative jitter peak for the most recent one-second period. Displayed in unit intervals.

**MAX P-to-P:** Maximum peak-to-peak jitter: The sum of the highest positive jitter peak and the highest negative jitter peak for the entire test duration. Displayed in unit intervals.

**MAX Pos Peak:** Maximum positive jitter peak: The greatest positive jitter peak since the beginning of the test. Displayed in unit intervals.

**MAX Neg Peak:** Maximum negative jitter peak: The greatest negative jitter peak since the beginning of the test. Displayed in unit intervals.

Jitter Hits and Mask Results

For DS1, the wide-band mask is 5.0 UI and the high-band mask is 0.1 UI.

Each result is calculated for both wide-band and high-band jitter.

**Hits Count:** Indicates the total number of jitter hits (jitter hit threshold exceeded) since the beginning of the test.

**Total Hits Time:** Indicates the cumulative total of time, in seconds, that the jitter hit threshold has been exceeded since the beginning of the test.

**MAX Percent of Mask:** Indicates the maximum peak-to-peak jitter for the entire test period expressed as a percentage of the jitter mask.
DS1 Alarm Screens

These screens display alarm results for the DS1 receive signal. The alarms displayed on the screens are described in the following table.

<table>
<thead>
<tr>
<th>Alarm</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOS</td>
<td>DS1 loss of signal: Declared when there are 175 or more contiguous pulse positions with no pulses. LOS is cleared when there is a 12.5% or higher ones density on the receive signal.</td>
</tr>
<tr>
<td>LOP</td>
<td>DS1 loss of pattern: Declared when pattern synchronization is not achieved or when the receive pattern does not correspond to the internal reference pattern. Pattern synchronization is declared when 64 consecutive pattern matches (bits) are received. Loss of pattern synchronization is declared when 224 out of 1,024 consecutive pattern bits are errored. (User patterns with less than 25% transition density use 85 errors out of 1,024 bits.) The 1,024-bit blocks are counted from the beginning of pattern synchronization.</td>
</tr>
<tr>
<td>AIS</td>
<td>DS1 alarm indication signal: Declared when an unframed all-ones pattern is received (&quot;all-ones&quot; is considered to be fewer than three zeros in two consecutive frames).</td>
</tr>
<tr>
<td>Yellow</td>
<td>DS1 Yellow alarm: Declared when Bit 2 of at least 256 consecutive DS0 timeslots is set to 0 (SF format) or 16 pattern sets of 000 and FF1 are received on the FDL (ESF format).</td>
</tr>
<tr>
<td>OOF</td>
<td>DS1 out of frame: Declared when two out of four framing bits are errored (Ft and Fs bits for SF format, FPS bits for ESF, or Ft for SLC-96 and MBIL).</td>
</tr>
<tr>
<td>COFA</td>
<td>Change of frame alignment: Declared when the test set resynchronizes to a new frame or multiframe alignment after an OOF condition.</td>
</tr>
<tr>
<td>1s Den</td>
<td>DS1 ones density alarm: Declared when more than 15 consecutive zeros are received (AMI) or more than 7 consecutive zeros are received (B8ZS).</td>
</tr>
</tbody>
</table>
DS1 Measurement Reference

**DS1 Alarm Screens**

**DS1 Alarm Seconds Screen**

This screen displays counts of DS1 alarm seconds. An alarm second is one during which at least one occurrence of that alarm occurred.

```
1 DS1-DS1 (DS1)  Final: 00:00:00.00
DS1 Alarm Seconds
LOS: --  OOF: --
LOF: --
AIS: --
Yellow: --
```

**DS1 Alarm and History Screen**

This screen displays the current and previous occurrence of DS1 alarms on the receive signal. Like the front-panel indicator LEDs, the screen provides a current status of the alarm (Alarm) and also indicates if the alarm has occurred previously (Hist).

```
1 DS1-DS1 (DS1)  Final: 00:00:00.00
DS1 Alarm Hist  DS1 Alarm Hist
LOS: --  --  COFA: --  --
OOF: --  --  LOF: --  --
YEL: --  --  Is Den: --  --
AIS: --  --
```

**DS1 Monitor Alarm & Status Seconds**

This screen is only available in DS1 monitor test modes, and displays counts of DS1 alarm seconds on the monitored DS1 signal.

```
1 DS1-DS1 (DS1)  Final: 00:00:00.00
DS1 Monitor Alarm & Status Seconds
LOS: --  OOF: --
AIS: --
Yellow: --
```

12-17
DS1 Status Screen

This screen displays the status of certain DS1 signal parameters, similar to the front-panel DS1/E1 STATUS indicators.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>DS1 Signal</td>
<td>--</td>
</tr>
<tr>
<td>Pattern</td>
<td>--</td>
</tr>
<tr>
<td>SF Sync</td>
<td>--</td>
</tr>
<tr>
<td>ESF Sync</td>
<td>--</td>
</tr>
<tr>
<td>DS1 (D1) Final</td>
<td>00:00:00.00</td>
</tr>
</tbody>
</table>

For each parameter, the display shows ON if that condition is present.

**DS1 Signal**: DS1 signal present: Declared when a DS1 signal is received with at least a 12.5% ones density.

**Pattern**: DS1 pattern synchronization: Declared when 64 consecutive pattern matches (bits) are received.

**SF Sync**: Valid SF signal frame synchronization: Declared when 24 consecutive error-free F-bits are received.

**ESF Sync**: Valid ESF signal frame synchronization: Declared when 24 consecutive error-free FFS-bits are received.

**DS1C Signal**: DS1C signal present: Declared when at least 175 contiguous pulses are received at the DS1C rate (3.152 Mbs).
DS0 VF Measurements Screen

This screen displays VF level, frequency, data, and signaling results for the selected DS0 drop channel on the DS1 signal (this screen is only active when the DS0 Data> is set for a tone).

Level: DS0 level: The DS0 signal tone level in decibels (dBm). The bar graph to the right gives a graphical display of the signal.

>+3dBm Thresh Sec: DS0 3 dBm threshold seconds: The number of seconds in which the signal level exceeded +3 dBm.

Freq: DS0 frequency: The frequency of the received tone in Hertz.

Data: DS0 payload: The current eight bits in binary format (1s or 0s).

ABCD: DS0 channel signaling bits: The binary status of the four signaling bits. Bits C and D are only active if the DS1 signal is set for ESF framing.
DS0/TS Bit Error Measurements Screen

This screen displays BER results on the selected DS0. This screen is only active when the DS0 Data> is set for a pattern.

<table>
<thead>
<tr>
<th>DS1-DS1 (DS1)</th>
<th>Final: 00:00:02.00</th>
</tr>
</thead>
<tbody>
<tr>
<td>DS0/TS Bit Error Measurements</td>
<td></td>
</tr>
<tr>
<td>Error Count:</td>
<td>0</td>
</tr>
<tr>
<td>Average Ratio:</td>
<td>0.00E+00</td>
</tr>
<tr>
<td>Current Ratio:</td>
<td>0.00E+00</td>
</tr>
</tbody>
</table>

**Error Count:** DS0 pattern bit errors: The number of bit errors detected on the selected DS0 since the beginning of the test.

**Average Ratio:** DS0 average pattern bit error ratio: The average ratio of errored bits over the total number of bits for the selected DS0 since the beginning of the test.

**Current Ratio:** DS0 current pattern bit error ratio: The average ratio of errored bits over the total number of bits for the selected DS0 during the most recent 2.25 seconds.
FT1 Measurement Summary Screens

This screen displays an overview of fractional T1 (FT1) error measurements.

| DS1-DS1 (DS1) | Final: 00:00:00:00 |
| FT1 Measurement Summary |
| Bit: -- | Sec Ago: -- |
| Frm: -- | |
| CRC: -- | |
| BPV: -- | |

**Sec Ago** shows the time elapsed since the last error, in seconds.

**Bit:** FT1 bit error count: The number of errored bits (transmitted at one level, but received at another).

**Frm:** FT1 frame error count: The number of framing bits received in error.

**CRC:** FT1 CRC error count: The number of FT1 CRC fields that are received in error.

**BPV:** FT1 bipolar violation count: The number of FT1 BPVs. A BPV is the occurrence of two consecutive pulses of the same polarity.
FT1 Bit Error Measurement Screens

These three screens display results based on FT1 bit error measurements.

![FT1 Bit Error Measurement Screens](image)

The results displayed on the screens are similar to the DS1 bit error measurements, except that they apply to FT1 signal. See DS1 Bit Error Measurements, page 12-4.
DS1/DS0 Interfaces  13–2
Data Link Interfaces  13–4
Jitter Option Specifications  13–5
DS1/DS0/FT1 Specifications

DS1/DS0 Interfaces

DS1 Transmitter

DS1 TX

Signal = DSX-1: DSX-1 signal with selectable LBOs:

- Per CB119, ANSI T1X1 and TR-TSY-000499.
- 3.0 Vpk ±1.0 dB (0 dBdsx).
- Supports Simplex power.
- LBO = -7.5, -15.0, or -22.0 dBdsx.

Line Code: AMI or B8ZS.

Impedance: 100 ohm ±5% balanced; return loss >20 dB.

Connector: Accepts WECO 310. Optional Bantam.

DS1 Receiver

DS1 RX

Signals:

<table>
<thead>
<tr>
<th>DSX-1</th>
<th>Per CB119, ANSI T1X1 and TR-TSY-000499.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>3.0 Vpk ±1.0 dB (0 dBdsx).</td>
</tr>
<tr>
<td></td>
<td>1.544 MHz ±1000 ppm.</td>
</tr>
<tr>
<td></td>
<td>Sensitivity = 26 dB below 0 dBdsx.</td>
</tr>
<tr>
<td></td>
<td>Jitter tolerance per Bellcore TR-TSY-000009</td>
</tr>
</tbody>
</table>

| ALBO  | Automatic LBO equalized for 400 to 4000 ft of 22 AWG pulp insulated cable. |

| Mon   | 10 to 25 dB flat loss relative 0 dBdsx. |

Line Code: AMI or B8ZS.

Impedance:

- **Term** = 100 ohms ±5%, return loss >20 dB.
- **Bridge** = >1000 ohms.

Connector: Accepts WECO 310 plug. Optional Bantam.
**DS1/DS0/FT1 Specifications**

**DS1/DS0 Interfaces**

**DS1 Drop Output**

**DS1 DROP**

**Signal = DSX-1:** DS1 dropped from higher-rate signal.

- Per ANSI T1X1 and TR-TSY-000499.
- 3.0 Vpk±1.0 dB (0 dBdsx).

**Line Code:** AMI or B8ZS.

**Impedance:** 75 ohm ±5%, return loss >20 dB.

**Connector:** Accepts WECO 310 plug. Optional Bantam.

**DS1 Timing**

**Internal:** 1.544 MHz ±20 ppm.

**DS1 TX CLK IN jack:** Input DS1 signal. TTL levels, 50 ohm, BNC connector. Requires a 2.5 Vdc offset.

**Bit Error Output**

**DS1 ERR OUT:** Provides a single pulse output for each DS3 error detected. TTL level, 50 ohm, BNC connector.

**Input:** DS1 REF IN jack: DSX-1, per TR-TSY-000499.

- 3.0 Vpk input level, typical.
- WECO 310 connector.

**DS1 Network Interface**

**DS1 INTERFACE port:** DB-15 socket connector. Provides parallel connections to the front-panel DS1 TX and DS1 RX connectors.

<table>
<thead>
<tr>
<th>Pin</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>DS1 Tx tip</td>
</tr>
<tr>
<td>9</td>
<td>DS1 Tx ring</td>
</tr>
<tr>
<td>3</td>
<td>DS1 Rx tip</td>
</tr>
<tr>
<td>11</td>
<td>DS1 Rx ring</td>
</tr>
<tr>
<td>All others</td>
<td>No connection</td>
</tr>
</tbody>
</table>

---

13–3
Data Link Interfaces

DS1 Errors Output

**DS1 ERR OUT jack:** TTL, 50 ohm, BNC connector.

DS0 Interfaces

**VF Drop Port:** VF OUT jack: 600 ohm, internal codec.

**VF Insert Port:** VF IN 600 ohm, internal codec.

ABCD Signaling Bits Drop

**SIGNALING TTL port:** TTL, DB-9 socket connector, 50 ohms.

<table>
<thead>
<tr>
<th>Pin</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>Signaling bit A</td>
</tr>
<tr>
<td>8</td>
<td>Signaling bit B</td>
</tr>
<tr>
<td>4</td>
<td>Signaling bit C</td>
</tr>
<tr>
<td>9</td>
<td>Signaling bit D</td>
</tr>
<tr>
<td></td>
<td>All others</td>
</tr>
<tr>
<td></td>
<td>Ground</td>
</tr>
</tbody>
</table>

**Note:** The rear-panel DS1 REF IN, DS1 INTERFACE, DS1 ERR OUT, and SIGNALING TTL connectors serve the corresponding E1 functions when the test set is in an E1 mode.

---

Data Link Interfaces

For data link port pinout information, see *Data Link Interfaces*, page 27-4. For DS1 data link control information, see *DS1 Data Link Parameters*, page 11-16.
Jitter Option Specifications

DS3 jitter measurement requires DS3 testing (E4480A-001 base unit or Option URR), Option UQP, and either Option UQN or 201.

**Measurement Response**

**DS1 Jitter Measurement per:** TR-TSY-000499

- **Wide-band cut-off frequency:** 10 Hz to 400 kHz
- **High-band cut-off frequency:** 8 kHz to 400 kHz
- **Roll-off (per decade) below lower 3 dB point:** ≥20 dB
- **Roll-off (per decade) above higher 3 dB point:** ≥60 dB

**Jitter Measurements**

<table>
<thead>
<tr>
<th>Measurement</th>
<th>Range</th>
<th>Resolution</th>
<th>Accuracy</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Peak Positive Jitter</td>
<td>0.1 to 6.0 UI</td>
<td>0.1 UI</td>
<td>±5% of reading, ±0.05 UI.</td>
</tr>
<tr>
<td>Maximum Peak Negative Jitter</td>
<td>0.1 to 6.0 UI</td>
<td>0.1 UI</td>
<td>±5% of reading, ±0.05 UI.</td>
</tr>
<tr>
<td>Current Peak-to-Peak Jitter</td>
<td>0.1 to 12.0 UI</td>
<td>0.1 UI</td>
<td>±5% of reading, ±0.05 UI.</td>
</tr>
<tr>
<td>Max Peak-to-Peak Jitter</td>
<td>0.1 to 12.0 UI</td>
<td>0.1 UI</td>
<td>±5% of reading, ±0.05 UI.</td>
</tr>
<tr>
<td><strong>Wideband Mask</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Percent of Mask</td>
<td>5.0 UI</td>
<td>0.1 UI</td>
<td></td>
</tr>
<tr>
<td><strong>Highband Mask</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Demodulated Jitter Output</strong></td>
<td></td>
<td></td>
<td><strong>DMOD JITTER OUT jack:</strong> 50 ohm, BNC connector. Scale = 100 mV/UI; range = 0 to 6 Vdc.</td>
</tr>
</tbody>
</table>
DS1 Signal Formats—1.544 Mbs

1 Timeslot (DS0) = 8 bits

1 DS1 Frame = 24 eight-bit timeslots + 1 framing bit = 193 bits

1 Superframe = 12 Frames

1 Extended Superframe = 2 Superframes = 24 Frames

SF Format Framing Word:
F-bit sequence = 100011011100
(F1 = 101010; F5 = 001110)
Signaling bits:
A = bit 8 of frame 6
B = bit 8 of frame 12

ESF Format Framing Word (F-bits of frames 4, 8, 12, 16, 20, 24) = 001011
CRC-6 Bits = F-bits of frames 2, 6, 10, 14, 18, 22.
Facility Data Link (FDL: 4 kbs) = F-bits of odd-numbered frames.
Signaling bits:
A = bit 8 of frame 6, B = bit 8 of frame 12, C = bit 8 of frame 18, D = bit 8 of frame 24
Set up for E1 Testing  14–2
Configure the E1 Signal  14–4
Configure the Programmable Patterns  14–5
Configure the Timeslot Parameters  14–7
Run the E1 Test  14–10
Run an Automatic E1 Timeslot Signaling Scan  14–11

E1 and Timeslot Network Testing
E1 and Timeslot Network Testing

Set up for E1 Testing

Example E1 Application

---

E1 testing is available when the payload is set for DS3/E1, E1, or TS.

1. From the Main Menu use FIELD to pick a test mode and press MENU-down. The testing setup screen for the mode you selected is displayed (terminal mode is shown here):

   TERMINAL TESTING
   Tx Rate: STS1/OC1    Rx Rate: STS1/OC1
   Payload: DS3/E1

   Select Tx and Rx Rates first then select payload.
   Press ENTER to enter test mode, Press MENU to return to Main Menu.

2. Use FIELD and VALUE to set the transmitter (Tx Rate) and receiver (Rx Rate) as appropriate for your application. For Monitor mode tests the transmitter and receiver are set simultaneously (Tx/Rx Rate).

3. Next press the right FIELD key to select the Payload parameter.
E1 and Timeslot Network Testing

Set up for E1 Testing

4. Use VALUE to set the payload to DS3/E1, E1, or TS.
   - **DS3/E1**: To test E1 signals mapped to and from a DS3 on a higher rate signal.
   - **E1**: To test clear channel E1, timeslot traffic, or fractional E1.
   - **TS**: To test timeslot traffic on an E1 (Tx and Rx must be set to E1).

5. Press MENU-down. The E1 test operation screen is displayed (see next section).
Configure the E1 Signal

- When you press MENU-down from the test mode setup screen, the test operation screen is displayed. The screen may appear differently based on the test mode you selected (this example shows DS3/E1 testing).

<table>
<thead>
<tr>
<th>1 STS1-STS1(DS3/E1) Final: 00:00:00.00</th>
</tr>
</thead>
<tbody>
<tr>
<td>E1 Measurement Summary</td>
</tr>
<tr>
<td>Bit:</td>
</tr>
<tr>
<td>TS0 Frm:</td>
</tr>
<tr>
<td>CRC-4:</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>E1: TxClk&gt;Int</td>
</tr>
<tr>
<td>Data&gt;GRS5</td>
</tr>
<tr>
<td>Code&gt;HDB3</td>
</tr>
<tr>
<td>Frm&gt;TS0</td>
</tr>
<tr>
<td>Ins&gt;1</td>
</tr>
<tr>
<td>Oths&gt;Same Drop&gt;1</td>
</tr>
<tr>
<td>DS3: TxClk&gt;Int</td>
</tr>
<tr>
<td>Frm&gt;M13</td>
</tr>
<tr>
<td>%Bit&gt;1</td>
</tr>
<tr>
<td>STS1:TxClk&gt;Int</td>
</tr>
<tr>
<td>Scramble&gt;On</td>
</tr>
<tr>
<td>T&gt;STSX1</td>
</tr>
<tr>
<td>Rx&gt;STSX1</td>
</tr>
<tr>
<td>Err: Type&gt;E1 Data</td>
</tr>
<tr>
<td>Rate&gt;Single</td>
</tr>
</tbody>
</table>

1. Use FIELD and VALUE to set the E1 transmit timing source (TxClk), payload (Data), line coding (Code), and framing format (Frm).

   If you select a user pattern for Data>, define that pattern as desired. See Configure the Programmable Patterns, page 14-5.

   For timeslot or fractional E1 testing set Data> to TS or FE1, respectively.

2. Next configure the E1 mapping to and from the DS3 (if applicable). Set the insert channel (Ins), other transmit channels (Oths), and the drop channel (Drop).

   - If you are testing E1 signals mapped to and from a DS3, configure the DS3 and any higher-rate signals next. See Configure the DS3 and Higher-rate Signals, page 14-6.

   - If you are testing timeslot traffic on the E1 signal, you can configure the TS parameters now. See Configure the Timeslot Parameters, page 14-7.

   - If you are testing fractional E1 signals, you can configure the FE1 parameters now. See Configure the FE1 Signal, page 14-9.
Configure the Programmable Patterns

The 156MTS has six programmable test patterns for use in DS1 and E1 testing. To use the patterns, set Data to a Progr selection. Follow this procedure to configure the six E1 user test patterns.

1. From the test operation screen press CONFIG-right to display the control screen menu.

2. Use FIELD to select DS1/E1 Patterns and press CONFIG-right. The Programmable Patterns screen is displayed.

3. Use FIELD and VALUE to select the individual bits in each pattern and set them to binary 1, 0, or to a dot.

4. When you finish editing, press CONFIG-right to return to the test operation screen.
Configure the DS3 and Higher-rate Signals

If you are testing E1 signals mapped to and from a DS3 signal, you need to set the DS3 signal parameters after you have configured the E1 parameters. You also must configure any higher-rate signals on which the DS3s are carried.

1. Use FIELD and VALUE to configure the DS3 transmit and receive levels (Rx and Tx). These fields are not displayed when the DS3 is carried on a higher-rate signal.

2. Next set the DS3 timing source (TxClk), framing format (Frm), transmit X-bit status (XBit), and transmit FEBE bits (FEBE).

3. Configure the SONET parameters as appropriate for your application. Set the transmit timing source (TxClk), scrambling, and transmit and receive levels (Tx and Rx).
   - If you are testing timeslot traffic on the E1 signal, you can configure the TS parameters now. See Configure the Timeslot Parameters, page 14-7.
   - If you are not testing the TS signals, you can begin the test right now. See Run the E1 Test, page 14-10.

For information on DS3 setup, see DS3 Setup Parameters, page 7-7.
Configure the Timeslot Parameters

This section describes how to configure the timeslot (TS) payload of an E1 signal. There are two ways to configure the TS parameters depending on whether you are using the E1-E1 (TS) mode, or testing an E1 carried on a DS3 signal (see Set up for E1 Testing, page 14–2).

This procedure describes how to configure the TS payload in the E1-E1 (TS) test mode. Note that the E1 signal is connected directly to the E1 jacks. Both Tx Rate and Rx Rate must be set to E1, and Payload must be set to TS.

1. The TS parameters are displayed on the E1 test operation screen. Use FIELD to highlight TS:Ins>.

2. Use VALUE to select the timeslot on which you want to insert the transmit TS signal.

3. Select Other and set the format for the remaining transmit timeslots.

4. Next select Drop and choose the timeslot you want to drop from the E1 for the receive TS signal.

5. Set the state of each of the transmit signaling bits (ABCD) as desired.

6. Select a transmit tone for the inserted timeslot (Tone). This parameter also allows you to insert the VF signal applied at the rear-panel VF IN jack.

- After you finish configuring the E1 and TS parameters, you are ready to begin the test.
Configure the Timeslot Parameters

This procedure describes how to configure the TS payload when either the transmit or receive E1 is mapped to a DS3.

1. To enable the TS on the transmit E1, set the E1 Data field to TS:

```
E1: TxClk>Int Data>TS Code>HDB3
  Frm>TSO Ins>1 Oth>Same Drop>1
DS3: TxClk>Loop Frm>CBit XBit>1 FEBE>111
STS1: TxClk>Int Scramble>On
  Tx>STSX1 Rx>STSX1
Err: Type>E1 Data Rate>Single
```

2. From the test operation screen press CONFIG-right. The Control Screens menu is displayed in the bottom half of the screen:

```
Global Settings | Data Link Control
Alarm Control   | DS0/DS/Frac Setup
APS Control     | DS1/E1 Patterns
DS3 FEC Control | DS1 Loop Codes
DS3 C-Bit Control | SONET OH Control
```

3. Select DS0/TS Settings and then press CONFIG-right. The TS Setup screen is displayed:

```
  >TS Setup<
  Data>1004Hz
  Ins>1 Drop>1
  Other>Same (VF Tone and Ext RS232 Only)
  Tx Signaling: A>1 B>1 C>1 D>1
```

4. Set the TS payload (Data>). You can select a VF tone, an external VF signal, or a bit pattern.

5. Set Ins> and Drop> to configure the insert and drop TSSs. You can select L to lock the drop channel to match the insert channel.

6. Set Other> to configure the remaining channels in the E1 signal.

7. Next set each ABCD Tx Signaling bit to either binary 1 or 0.

8. When you have finished setting the TS parameters, press CONFIG-right to return to the test operation screen.
Configure the FE1 Signal

**Note:** The Data> field must be set for FE1. See *Configure the E1 Signal*, page 14-4.

1. The FE1 parameters are controlled from the Fractional E1 Setup screen. Press CONFIG-right to call the control screens menu.

   ![Global Settings Menu]

   - [Global Settings]
   - [Data Link Control]
   - [DS0/TS/Frac Setup]
   - [D1/E1 Patterns]
   - [DS1 Loop Codes]

2. Use FIELD to highlight **DS0/TS/Frac Setup** and press CONFIG-right twice to display the Fractional T1 Setup screen.

   ![Fractional E1 Setup]

   ```
   >Fractional E1 Setup<
   1  |  |  |  |  |  | 31
   Select>******************************
   TS16 not used From TS0/16 or TS0/16+CRC
   Data>0RSS
   ```

3. Next use FIELD and VALUE to select the TS channels of the E1 signal that make up the fractional E1 signal (**Select**). Each active timeslot is represented by an asterisk; inactive DS0s are represented by a dot.

4. Use FIELD and VALUE to select the payload for the FT1 signal (**Data**).

5. Press CONFIG-right to return to the test operation screen.
Run the E1 Test

- After you have configured the E1 signal, TS signal, and DS3 and any higher-rate signal parameters you are ready to begin the test.

1. Press START to begin testing. On the first line of the display the elapsed time begins to increment.

2. If you want to inject an alarm on the E1 signal, use FIELD and VALUE to set the **Err: Type** and **Rate** as desired (**Modify Config While Running** must be set to **Yes**, see **Configuration Lock During Test**, page 23–2).

3. Watch the Trouble Scan display for any errors, or use the RESULT keys to view different measurement screens in the top half of the display. You may need to adjust the results level to view more measurements (see **To Display More Measurement Screens**, page 1–10).

4. To end the test, press STOP.
Run an Automatic E1 Timeslot Signaling Scan

The 156MTS features an automatic test sequence that scans an E1 signal, analyzes each timeslot, and displays the status of the signaling bits for each timeslot. The E1 signal can be dropped from a DS3 signal. This section describes how to set up and run the Signaling Scan sequence.

1. Connect the signal to be tested. The signal must be an E1 signal or a DS3 signal carrying E1 traffic.

2. Setup the background mode by configuring the test set as if you were going to run a manual test. For example, set up an E1 terminal mode test with a TS (timeslot) payload. See Set up for E1 Testing, page 14-2.

3. From the Main Menu, use FIELD to select DS3/DS1/ATM Scans & Pointer Sequences.

4. Press MENU-down. The Test Sequences menu is displayed.

---

MODEL 156 MAIN MENU
Auto Setup
Terminal Testing
Monitor Testing
Drop & Insert Testing
DS3/DS1/ATM Scans & Pointer Sequences
Setup System Parameters
Store and Recall configurations

Press < FIELD > to highlight item, then
Press MENU-down select item.

TEST SEQUENCES
HPointer Increment
HPointer Decrement
HPointer New Data Flag (NDF)

DS1 Drop Scan
Signaling Scan
ATM Path.Circuit Scan
ATM Cell Capture
Run an Automatic E1 Timeslot Signaling Scan

5. Use FIELD to select **Signaling Scan** and press MENU-down. The Signaling Scan operation screen is displayed.

```
1 Signaling Scan  Final: 00:00:00.00
  AB CD  AB CD  AB CD  AB CD  AB CD  AB CD
  1: 00-- 00-- 00-- 00-- 00-- 00-- 00-- 00--
  7: 00-- 00-- 00-- 00-- 00-- 00-- 00-- 00--
 13: 00-- 00-- 00-- 00-- 00-- 00-- 00-- 00--
 19: 00-- 00-- 00-- 00-- 00-- 00-- 00-- 00--
```

Configurations From> E1-E1 (TS)
Channel Scan Mode > Single

6. Set **Configurations From** to match your application. For example, if you are testing an E1 signal carrying TS traffic, you could select **E1-E1 (TS)**.

7. Next set **Channel Scan Mode** to either **Single** (one scan) or **Continuous** (repetitive scanning).

8. Press START to begin the scan. The test set begins checking each timeslot on the E1 signal for the signaling bit status, and displays the results on the appropriate display line.

9. Use the **RESULTS** keys to scroll through the displays of timeslots and their signaling bit status.

10. The scan ends automatically in **Single** mode; press **STOP** to end the scan in **Continuous** mode.
E1 Setup Parameters  15–2
E1 to DS3 Mapping  15–5
E1 Timeslot (TS) Setup Parameters  15–6
Fractional E1 Setup Parameters  15–9
E1 and TS Error and Alarm Injection  15–10

E1 and Timeslot Configuration Reference
E1 Setup Parameters

E1 setup parameters appear on the screen similar to the following (the E1–E1 (E1) mode is shown):

```
E1: TxClk>Int
    Data>GRSS
    Rx>DSX
    Err: Type>E1 BPU

Frm>TS0
    Code>HDB3
    Term>Term

Rate>Single
```

Transmit Timing Source

**E1: TxClk>** selects the E1 transmit timing source. This parameter can be set as follows:

**Int:** Timing is from the 156MTS’s internal clock.

**Ext:** Timing is derived from the rear-panel DS1 TX CLK IN port (E1 signal expected).

**Loop:** Timing is derived from the receive E1 signal.

E1 Framing Format

**E1: Frm>** selects the transmit and receive E1 signal framing format. **E1: Frm>** can be set to as follows:

**TS0:** E1 Timeslot 0 format (31-channel, non-CAS). No CRC.

**TS0+CRC:** E1 Timeslot 0 format with CRC-4.

**TS0+TS16:** E1 Channel Associated Signaling format (CAS, 30-channel). Uses timeslot 0 and 16 framing.

**TS0+TS16+CRC:** E1 CAS format with CRC-4

**Unfrm:** Unframed E1 signal.

**Note:** If **E1: Data>** is set to **AIS**, the framing format is forced to unframed regardless of the **Frm>** setting.
**E1 Payload**

**E1: Data** selects the payload for the E1 signal. The choices for **E1: Data** are described in the following table. This parameter is not applicable for E1/TS mode.

<table>
<thead>
<tr>
<th>E1: Data Selection</th>
<th>Payload Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>QRSS</td>
<td>A quasirandom signal source comprising a (2^{26} - 1) pattern with a 14-zero constraint.</td>
</tr>
<tr>
<td>(2^{6} - 1)</td>
<td>A (2^6 - 1) pseudorandom bit sequence (PRBS). A six-stage PRBS generator with feedback taps at stages 5 and 6.</td>
</tr>
<tr>
<td>(2^{9} - 1)</td>
<td>A (2^9 - 1) PRBS. Nine-stage with feedback taps at 5 and 9.</td>
</tr>
<tr>
<td>(2^{11} - 1)</td>
<td>A (2^{11} - 1) PRBS. 11-stage with feedback taps at 9 and 11.</td>
</tr>
<tr>
<td>(2^{15} - 1)</td>
<td>A (2^{15} - 1) PRBS. 15-stage with feedback taps at 14 and 15.</td>
</tr>
<tr>
<td>(2^{20} - 1)</td>
<td>A (2^{20} - 1) PRBS. 20-stage with feedback taps at 17 and 20.</td>
</tr>
<tr>
<td>(2^{23} - 1)</td>
<td>A (2^{23} - 1) PRBS. 23-stage with feedback taps at 18 and 23.</td>
</tr>
<tr>
<td>All 0s</td>
<td>All binary zeros pattern.</td>
</tr>
<tr>
<td>All Ones</td>
<td>All binary ones pattern.</td>
</tr>
<tr>
<td>Alt 1/0</td>
<td>Alternating binary 1s and 0s pattern.</td>
</tr>
<tr>
<td>1 in 8</td>
<td>A 12.5% ones density pattern, synchronized to the F-bit as follows: F 0100 0000.</td>
</tr>
<tr>
<td>2 in 8</td>
<td>A 25% ones density pattern synchronized to the F-bit as follows: F 0110 0000.</td>
</tr>
<tr>
<td>3 in 24</td>
<td>A 12.5% ones density pattern, synchronized to the F-bit as follows: F010001000000000000000100.</td>
</tr>
<tr>
<td>Progr #1 — Progr #6</td>
<td>User-defined pattern. The most significant bit follows the frame bit for lengths that divide evenly into 192. See <em>User-Programmable DS1/E1 Patterns</em>, page 11–13.</td>
</tr>
<tr>
<td>AIS</td>
<td>E1 alarm indication signal. This is an unframed all-ones signal that overrides the <strong>E1: Frm</strong> setting.</td>
</tr>
</tbody>
</table>
E1 Payload Selections, continued

<table>
<thead>
<tr>
<th>E1: Data Selection</th>
<th>Payload Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>55 Octet</td>
<td>This is also known as the Daly pattern. Framing does not overwrite the pattern. The pattern bit sequence is shown in the DS1 payload table (see page 11–5).</td>
</tr>
<tr>
<td>Live</td>
<td>No pattern. The receiver does not try to synchronize to a pattern. The transmitter sends the last-selected pattern.</td>
</tr>
<tr>
<td>TS</td>
<td>Timeslot traffic. The E1 carries TS channels generated by the test set or from an external source. Seeexx.</td>
</tr>
<tr>
<td>FE1</td>
<td>Fractional E1 traffic. The E1 signal carries subrate traffic made up of N number of TS channels. See Fractional E1 Setup Parameters, page 15–9.</td>
</tr>
<tr>
<td>Ext</td>
<td>A signal applied at the front-panel E1 RX port is used as the transmit E1. The input timing and framing override the E1: TxClk&gt; and Frm&gt; settings. This selection is only available when the E1 signal is the payload of a higher-rate signal.</td>
</tr>
</tbody>
</table>

### Line Coding

**E1: Code>** selects the line coding scheme as either **AMI** (alternate mark inversion) or **HDB3** (high-density bipolar three-zero substitution).

### Transmit E1 Level

The transmit signal level for E1 applications is fixed at the cross-connect level (approximately 3.0 Vpk, ±1 dB).

### Receive E1 Level

**E1: Rx>** sets the input level for the input E1 signal. **Rx>** is not available when the E1 is mapped to a DS3 signal. **Rx>** can be set as follows:

- **DSX:** Cross-connect level.
- **Monitor:** Monitor level.

### Termination Mode

**E1: Term>** sets the E1 RX port to either terminate (**Term**) or bridge (**Bridge**) the received signal.

### E1 Insert Channel

**E1: Ins>** selects which E1 within a DS3 signal is used for the transmit E1. **E1: Ins>** can be set from 1 through 21. This parameter is only applicable when the E1 is mapped to a DS3 signal. See **E1 to DS3 Mapping**, page 15–5.
Other E1 Channels

**E1: Oth** sets the payload for the E1s that are not selected by **Ins** on the transmit DS3. **Oth** can be set as follows:

- **Same**: Fills the E1s with the same payload as the selected **Ins** E1.
- **Inv**: Sets the E1s to an inverted version of the **Ins** E1 payload.
- **AIS**: Fills the remaining E1s with an E1 alarm indication signal (AIS).

**E1 Drop Channel**

**E1: Drop** selects which E1 within a DS3 is used for the receive E1, from 1 through 21. This parameter is only applicable when the E1 is mapped to a DS3 signal. See *E1 to DS3 Mapping*, page 15-5.

---

**E1 to DS3 Mapping**

When the E1 is mapped to and from a DS3, the mapping scheme is as follows: three E1s are mapped into each DS2; seven DS2s are mapped into each DS3. The following table lists the location of each E1 mapped on the DS3. E1s are selected using the **E1: Drop** or **Ins** fields.

<table>
<thead>
<tr>
<th>Drop/Ins E1</th>
<th>DS2 No.</th>
<th>E1 No.</th>
<th>Drop/Ins E1</th>
<th>DS2 No.</th>
<th>E1 No.</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>1</td>
<td>12</td>
<td>4</td>
<td>3</td>
</tr>
<tr>
<td>2</td>
<td>1</td>
<td>2</td>
<td>13</td>
<td>5</td>
<td>1</td>
</tr>
<tr>
<td>3</td>
<td>1</td>
<td>3</td>
<td>14</td>
<td>5</td>
<td>2</td>
</tr>
<tr>
<td>4</td>
<td>2</td>
<td>1</td>
<td>15</td>
<td>5</td>
<td>3</td>
</tr>
<tr>
<td>5</td>
<td>2</td>
<td>2</td>
<td>16</td>
<td>6</td>
<td>1</td>
</tr>
<tr>
<td>6</td>
<td>2</td>
<td>3</td>
<td>17</td>
<td>6</td>
<td>2</td>
</tr>
<tr>
<td>7</td>
<td>3</td>
<td>1</td>
<td>18</td>
<td>6</td>
<td>3</td>
</tr>
<tr>
<td>8</td>
<td>3</td>
<td>2</td>
<td>19</td>
<td>7</td>
<td>1</td>
</tr>
<tr>
<td>9</td>
<td>3</td>
<td>3</td>
<td>20</td>
<td>7</td>
<td>2</td>
</tr>
<tr>
<td>10</td>
<td>4</td>
<td>1</td>
<td>21</td>
<td>7</td>
<td>3</td>
</tr>
<tr>
<td>11</td>
<td>4</td>
<td>2</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
E1 Timeslot (TS) Setup Parameters

There are two ways that TS parameters are displayed. In E1-E1 (TS) test modes, the TS parameters appear similar to the following:

```
E1: TxClk>Int.  Frm>TS0
    Code>HDB3  Rx>DSK  Term>Term
TS:  Ins>1  Other>Same  Drop>1
    A>1   B>1   C>1   D>1
    Tone>DRS 1004 Hz
```

For other E1 modes (Payload set to DS3/E1 or E1) the TS parameters are accessed by selecting DS0/TS Settings from the Additional Test Controls menu. The TS Setup screen appears as follows:

```
>TS Setup<
Data>1004Hz
Ins>1  Drop>1
Other>Same (UF Tone and Ext RS232 Only)
Tx Signalling: A>1 B>1 C>1 D>1
```

**Insert Timeslot**

Ins> selects which TS within an E1 signal is used for the transmit TS. Ins> can be set from 1 through 31.

**Note:** You can select TS 16 and overwrite it with the selected Tone> even in TS 16 (CAS) framing modes.

**Other Timeslots**

Other> sets the payload for the other TSs (that are not selected by Ins>) on the E1 transmit signal. Other> can be set as follows:

- **Same:** Fills the TSs with the same payload as the selected Ins> TS.
- **All Ones:** Sets the TSs to an all-ones pattern.

**Note:** When TS 16 framing is selected, the Other> setting does not overwrite TS 16.

**Drop Timeslot**

Drop> selects which TS within an E1 signal is used for the receive TS. Drop> can be set from 1 through 31. On the TS Setup screen Drop> can also be set to L, which locks the drop TS to automatically match the insert TS.
**Timeslot Drop & Insert Channel**

This parameter is only available for drop and insert mode (D&I) tests. The **D&I** field simultaneously sets the TS insert and drop channels to the same number. D&I can be set from 1 through 31.

**Transmit TS Signaling**

The **A**, **B**, **C**, and **D** fields set the binary status of the transmitted ABCD signaling bits of the selected insert TS. Each bit can be set to either 1 or 0. **C** and **D** are applicable only in TS 16 framing.

**TS Payload (Tone)**

**TS**: **Tone** sets the payload for the selected **Ins** timeslot as follows (this parameter is only available in E1-E1 (TS) test mode):

- **DRS 1004 Hz**: Transmits a Digital Reference Signal of 1004 Hertz.
- **DRS 1012 Hz**: Transmits a Digital Reference Signal of 1012 Hertz.
- **DRS 1020 Hz**: Transmits a Digital Reference Signal of 1020 Hertz.
- **External VF**: Transmits the signal applied at the rear-panel VF IN port.

**TS Payload (Data)**

The **Data** field on the TS Setup screen sets the TS payload as described in the following table.

---

### E1 Timeslot Payload Selection

<table>
<thead>
<tr>
<th>Data Selection</th>
<th>Payload Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1004Hz</td>
<td>These three selections apply a test tone at the indicated frequency (in Hertz). Not available for monitor test modes.</td>
</tr>
<tr>
<td>1012Hz</td>
<td>The 2010 Hz tone is transmitted at −12 dB.</td>
</tr>
<tr>
<td>1020Hz</td>
<td></td>
</tr>
<tr>
<td>2010Hz</td>
<td></td>
</tr>
<tr>
<td>Tone</td>
<td>Monitor modes only. Sets the receiver to expect an input tone on the drop signal.</td>
</tr>
<tr>
<td>Ext VF</td>
<td>Transmits a VF signal applied at the rear panel VF IN jack. Not available for monitor test modes.</td>
</tr>
<tr>
<td>QRSS</td>
<td>Quasirandom Sequence Signal. Transmits a quasirandom signal.</td>
</tr>
<tr>
<td>2^E-1</td>
<td>PRBS. Transmits a pseudorandom bit sequence of length 2^E-1 where E is the exponent. For example 2^9-1 is a 2^9-1 PRBS.</td>
</tr>
</tbody>
</table>
### E1 Timeslot Payload Selection, continued

<table>
<thead>
<tr>
<th>Data&gt; Selection</th>
<th>Payload Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All 0s</td>
<td>Transmits a binary zeros pattern.</td>
</tr>
<tr>
<td>All 1s</td>
<td>Transmits a binary ones pattern.</td>
</tr>
<tr>
<td>Alt 1/0</td>
<td>Transmits an alternating binary 1s and 0s pattern.</td>
</tr>
<tr>
<td>1 in 8</td>
<td>Transmits a repeating pattern of one binary 1 in every eight bits.</td>
</tr>
<tr>
<td>2 in 8</td>
<td>Transmits a repeating pattern of two binary 1s in every eight bits.</td>
</tr>
<tr>
<td>3 in 24</td>
<td>Transmits a repeating pattern of three binary 1s in every 24 bits.</td>
</tr>
<tr>
<td>Prog#1 through Prog#6</td>
<td>User-programmable patterns. Transmits the corresponding user pattern (See User-Programmable DS1/E1 Patterns, page 11-13).</td>
</tr>
<tr>
<td>55 Oct</td>
<td>Transmits a specific repeating 55-byte pattern, also known as the Daly Pattern.</td>
</tr>
<tr>
<td>External</td>
<td>Transmits the data applied at the rear-panel RS232 DATA LINK RS-232 interface.</td>
</tr>
</tbody>
</table>
Fractional E1 Setup Parameters

FE1 parameters are applicable when the E1 payload (Data>) is set for FE1. FE1 parameters are accessed by selecting DSO/TS/Frac Setup from the Control Screens menu and pressing CONFIG-right twice. The Fractional E1 Setup screen appears as follows:

<table>
<thead>
<tr>
<th>Fraction E1 Setup</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
</tr>
<tr>
<td>Select&gt;</td>
</tr>
<tr>
<td>TS16 not used Frm&gt;TS0/16 or TS0/16+CRC</td>
</tr>
<tr>
<td>Data&gt;QRSS</td>
</tr>
</tbody>
</table>

Selected Timeslots

Select> determines which timeslots are used to generate the FE1 signal. A channel set to "*" is included in the FE1 signal. A channel set to "-" is not included in the FE1 signal.

Channels that are not selected are transmitted as all-ones.

Note: Timeslot 16 is not used when the E1 frame format (Frm>) is set to either TS0/16 or TS0/16+CRC.

FE1 Payload

Data> selects the payload for the FE1 signal. The data is distributed across the entire FE1 signal, even if the TSs that make up the FE1 are not contiguous. The payload choices for Data> include the following (see E1 Payload Selections, page 15-3, for a description of each payload):

- QRSS
- PRBSs (2^6-1, and so on)
- All 0s or All 1s
- Alt 1/0
- 1 in 8, 2 in 8, or 3 in 24
- Progr #1 through Progr #6
- 55 Octet
E1 and TS Error and Alarm Injection

The following types of error can be injected in E1 testing modes. The rates for the selections include Single, 1.0E-2 through 1.0E-9, Burst, Continuous, and Off.

**Note:** For information on injection rates, see *About Error Injection Rates*, page 27-7.

**E1 BPV:** Generates bipolar violations in the E1 data. This type is not available for DS3-mapped E1 modes.

**E1 Data:** Generates data bit errors before the CRC is calculated, so no CRC errors are generated.

**E1 Data, CRC:** Generates combined data bit errors and CRC errors by erroring the data bits after the CRC is calculated.

**E1 Frm, CRC:** Generates combined E1 frame bit errors and CRC errors by erroring the frame alignment pattern in timeslot 0 after the CRC is calculated.

**E1 MFrm, CRC:** Generates combined E1 multiframe frame bit errors and CRC errors by erroring timeslot 16 after the CRC is calculated.

**E1 MFrm, Alm:** Generates an E1 distant multiframe alarm condition by setting bit 6 of timeslot 16 (in frame 0) to 1.

**E1 Rmt Alm:** Generates an E1 remote alarm condition by setting bit 3 of timeslot 0 to 1.

**TS Data:** Generates data bit errors in the selected timeslot when **E1 Data** is set for TS and **TS Data** is set to a pattern.
**E1 Indicators**

---

**E1 Alarm and Status Indicators**

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>HIST/ALARMS</strong></td>
<td></td>
</tr>
<tr>
<td>LOS</td>
<td>Loss of E1 signal.</td>
</tr>
<tr>
<td>OOF</td>
<td>Out of frame.</td>
</tr>
<tr>
<td>AIS</td>
<td>E1 alarm indication signal.</td>
</tr>
<tr>
<td>YEL</td>
<td>E1 Remote (&quot;Yellow&quot;) alarm.</td>
</tr>
<tr>
<td>LOPAT</td>
<td>Loss of pattern.</td>
</tr>
<tr>
<td>COFA</td>
<td>E1 &quot;change of frame alignment.&quot;</td>
</tr>
<tr>
<td><strong>STATUS</strong></td>
<td></td>
</tr>
<tr>
<td>E1 SIG</td>
<td>Valid E1 signal detected.</td>
</tr>
<tr>
<td>TS0 SYNC</td>
<td>Valid Timeslot 0 (TS0) framing detected.</td>
</tr>
<tr>
<td>TS16 SYNC</td>
<td>Valid TS16 framing detected.</td>
</tr>
<tr>
<td>CRC SYNC</td>
<td>Valid CRC framing detected.</td>
</tr>
<tr>
<td>PAT SYNC</td>
<td>(DS1 and E1) Receiver synchronized with test pattern.</td>
</tr>
<tr>
<td>HDB3</td>
<td>E1 HDB3 zero substitution codes detected.</td>
</tr>
<tr>
<td>ERRORS</td>
<td>E1 error detected.</td>
</tr>
</tbody>
</table>
E1 Measurement Summary Screen

This screen displays an overview of E1 error measurements.

<table>
<thead>
<tr>
<th>E1 Measurement Summary</th>
<th>Final: 00:00:00.00</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bit:</td>
<td>Sec Ago</td>
</tr>
<tr>
<td>TS0 Frm:</td>
<td></td>
</tr>
<tr>
<td>CRC-4:</td>
<td></td>
</tr>
<tr>
<td>BPV:</td>
<td></td>
</tr>
</tbody>
</table>

**Bit:** E1 bit error count: The number of errored bits (transmitted at one level, but received at another).

**TS0 Frm:** E1 frame error count: The number of TS0 frame word errors.

**CRC-4:** E1 CRC-4 error count: The number of CRC-4 fields that are received in error.

**BPV:** E1 bipolar violation count: The number of E1 BPVs. A BPV is the occurrence of two consecutive pulses of the same polarity (unless the pulses are part of an HDB3 zero-substitution code). This measurement is not displayed for DS3-mapped E1 signals.

**E1 Drop Hz:** Drop E1 frequency: The frequency, in Hertz, of the E1 signal dropped from the DS3 signal. This measurement is only displayed for DS3-mapped E1 signals.
E1 Bit Error Measurement Screens

These three screens display results based on E1 bit error measurements.

The results displayed on the screens are described in table beginning on the next page.
# E1 Bit Error Measurements

<table>
<thead>
<tr>
<th>Measurement</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Error Count</td>
<td>The total number of E1 bit errors detected.</td>
</tr>
<tr>
<td>Current ratio</td>
<td>Current E1 BER: The number of E1 bit errors over the number of E1 bits received in the previous 2.25 seconds.</td>
</tr>
<tr>
<td>Average Ratio</td>
<td>Average E1 BER: The number of E1 bit errors over the total number of E1 bits received since the beginning of the test.</td>
</tr>
<tr>
<td>ES</td>
<td>E1 errored seconds: The number of seconds during which at least one E1 bit error occurred (seconds are counted from test start).</td>
</tr>
<tr>
<td>EFS</td>
<td>E1 error-free seconds: The number of seconds during which no E1 bit errors occurred.</td>
</tr>
<tr>
<td>%EFS</td>
<td>E1 error-free seconds percentage: E1 EFS expressed as the percentage of the total number of seconds in the test.</td>
</tr>
<tr>
<td>Sev ES</td>
<td>E1 severely errored seconds (SES): The number of seconds during which the error rate was $10^{-3}$ or greater and during which no loss of pattern occurred.</td>
</tr>
<tr>
<td>Sync ES</td>
<td>E1 synchronous errored seconds: The number of seconds in which at least one E1 bit error occurred (seconds are counted beginning at the error occurrence).</td>
</tr>
<tr>
<td>Avail Sec</td>
<td>E1 available seconds: The number of seconds during the test that were not unavailable (see below).</td>
</tr>
<tr>
<td>Unavail Sec</td>
<td>E1 unavailable seconds: The E1 is declared unavailable after ten consecutive seconds of SES or LOP. The E1 is declared available again after ten consecutive seconds with no SESs or LOPs.</td>
</tr>
<tr>
<td>Degrad Min</td>
<td>E1 degraded minutes: The number of 60-second intervals during which available seconds and bit error counts are both greater than zero, but do not exceed the SES threshold; or, the number of 60-second intervals during which the available seconds and CRC error counts are both greater than zero but less than 320. The 60-second intervals do not need to be contiguous.</td>
</tr>
</tbody>
</table>
### E1 Bit Error Measurements, continued

<table>
<thead>
<tr>
<th>Measurement</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Thrsh E-n</td>
<td>E1 threshold seconds: The number of available seconds during which the bit error rate or CRC error rate (whichever is larger) exceeded the indicated E-n threshold. The thresholds correspond to the following values:</td>
</tr>
<tr>
<td></td>
<td><strong>Bits (Unfrm)</strong></td>
</tr>
<tr>
<td>E-3</td>
<td>2,048</td>
</tr>
<tr>
<td>E-4</td>
<td>205</td>
</tr>
<tr>
<td>E-5</td>
<td>21</td>
</tr>
<tr>
<td>E-6</td>
<td>2</td>
</tr>
<tr>
<td>Dribble</td>
<td>E1 dribbling error seconds: The number of seconds during which the error rate is greater than 1, but does not exceed $10^{-8}$ (between 1 and 14 errors).</td>
</tr>
<tr>
<td>CSES3</td>
<td>E1 Consecutively severely errored seconds count: The number of SESs for which the previous two seconds were also SESs. This count is reset during LOS, LOF, and LOP.</td>
</tr>
</tbody>
</table>
E1 Measurement Reference

E1 Block Error Measurements Screen

To determine block errors, the received E1 bits are counted into blocks of 2 through 8 kilobits (block size is user-programmable, see DS1 Block Size, page 11-7).

**E1 Block Error Measurements Screen**

<table>
<thead>
<tr>
<th>1 E1-E1 (E1)</th>
<th>Final: 00:00:00.00</th>
</tr>
</thead>
<tbody>
<tr>
<td>E1 Block Error Measurements</td>
<td>--</td>
</tr>
<tr>
<td>Est. Total Blocks:</td>
<td>--</td>
</tr>
<tr>
<td>Block Err Count:</td>
<td>--</td>
</tr>
<tr>
<td>Burst Err Seconds:</td>
<td>--</td>
</tr>
<tr>
<td>SEE:</td>
<td>CATV UAS:</td>
</tr>
</tbody>
</table>

**Est. Total Blocks:** Estimated count of E1 blocks: The estimated number of blocks received, as determined by the selected block size.

**Block Err Count:** E1 block error count: The number of E1 blocks that contained one or more errors.

**Burst Err Seconds:** E1 block burst errored seconds: The number of seconds in which the number of block errors was three or greater.

**SEE:** Severe error event count: The number of SEEs; a SEE is declared when there are four consecutive quarter-seconds each containing 93 or more bit errors, or more than N number of block errors. The value of N depends on the E1 block size (see following table). A SEE ends when there are two consecutive error-free seconds.

### Severe Error Event (SEE) Block Error Threshold Values

<table>
<thead>
<tr>
<th>E1 Block Size</th>
<th>N (number of block errors)</th>
<th>E1 Block Size</th>
<th>N (number of block errors)</th>
</tr>
</thead>
<tbody>
<tr>
<td>2 Kbit</td>
<td>46</td>
<td>6 Kbit</td>
<td>15</td>
</tr>
<tr>
<td>3 Kbit</td>
<td>30</td>
<td>7 Kbit</td>
<td>13</td>
</tr>
<tr>
<td>4 Kbit</td>
<td>23</td>
<td>8 Kbit</td>
<td>11</td>
</tr>
<tr>
<td>5 Kbit</td>
<td>18</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**CATV UAS:** Cable TV unavailable seconds count: The number of CATV UASs. A CATV UAS interval is declared when there are 60 consecutive BESs, ten consecutive SEEs, or ten consecutive LOP seconds. These seconds are included in the unavailable time.

A CATV UAS interval ends when there are 60 consecutive error-free seconds. These seconds are not included in the unavailable time.
E1 TS0 Frame Error Measurements Screen

This screen displays measurements based on TS0 frame word errors in framed E1 signals.

<table>
<thead>
<tr>
<th>1 E1-E1 (E1)</th>
<th>Final: 00:00:00.00</th>
</tr>
</thead>
<tbody>
<tr>
<td>E1 TS0 Frame Error Measurements</td>
<td></td>
</tr>
<tr>
<td>Count: --</td>
<td>ES: --</td>
</tr>
<tr>
<td>Cur Ratio: --</td>
<td>EFS: --</td>
</tr>
<tr>
<td>Avg Ratio: --</td>
<td>%EFS: --</td>
</tr>
</tbody>
</table>

**Count:** E1 TS0 frame word error count: The number of errored TS0 frame words.

**Cur Ratio:** Current TS0 frame word error ratio: The average frame word error ratio during the previous 2.25 seconds.

**Avg Ratio:** Average TS0 frame word error ratio: The number of frame word errors over the number of frame words received since the beginning of the test.

**ES:** Frame word errored seconds: The number of seconds during which at least one frame word error occurred.

**EFS:** Frame word error-free seconds: The number of seconds during which no frame word errors occurred.

**%EFS:** Frame word error-free seconds percentage: E1 TS0 frame word EFS expressed as a percentage of the total time since the beginning of the test.
E1 CAS Frame Error Measurements Screen

This screen displays measurements based on TS16 channel associated signaling (CAS) frame word errors in TS16 framed E1 signals.

<table>
<thead>
<tr>
<th>E1 CAS Frame Error Measurements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Count: --</td>
</tr>
<tr>
<td>Cur. Ratio: --</td>
</tr>
<tr>
<td>Avg. Ratio: --</td>
</tr>
</tbody>
</table>

**Count:** E1 TS16 frame word error count: The number of errored TS16 frame words.

**Cur. Ratio:** Current TS16 frame word error ratio: The average frame word error ratio during the previous 2.25 seconds.

**Avg. Ratio:** Average TS16 frame word error ratio: The number of frame word errors over the number of frame words received since the beginning of the test.

**ES:** Frame word errored seconds: The number of seconds during which at least one TS16 frame word error occurred.

**EFS:** Frame word error-free seconds: The number of seconds during which no TS16 frame word errors occurred.

**%EFS:** Frame word error-free seconds percentage: E1 TS16 frame word EFS expressed as a percentage of the total time since the beginning of the test.
E1 CRC-4 Error Measurements Screen

This screen displays measurements based on CRC errors in CRC-4 formatted E1 signals.

```
1 E1-E1 (E1) Final: 00:00:00.00
E1 CRC-4 Error Measurements
Count: -- ES: --
Cur Ratio: -- EFS: --
Avg Ratio: -- %EFS: --
```

**Count:** CRC error count: The number of E1 CRC-4 values that are errored.

**Cur Ratio:** Current CRC error ratio: The average CRC error ratio during the previous 2.25 seconds.

**Avg Ratio:** Average CRC error ratio: The number of CRC-4 errors over the number of bits received since the beginning of the test.

**ES:** CRC errored seconds: The number of seconds during which at least one CRC error occurred.

**EFS:** CRC error-free seconds: The number of seconds during which no CRC errors occurred.

**%EFS:** CRC error-free seconds percentage: E1 CRC-4 EFS expressed as a percentage of the total time since the beginning of the test.
E1 BPV Measurements Screen

This screen displays measurements based on bipolar violations (BPVs). This screen is not displayed for E1 signals mapped to and from a DS3 signal.

<table>
<thead>
<tr>
<th>E1-E1 (E1)</th>
<th>Final: 00:00:00.00</th>
</tr>
</thead>
<tbody>
<tr>
<td>E1 BPV Measurements</td>
<td></td>
</tr>
<tr>
<td>Count:</td>
<td>--</td>
</tr>
<tr>
<td>Cur Ratio:</td>
<td>--</td>
</tr>
<tr>
<td>Avg Ratio:</td>
<td>--</td>
</tr>
<tr>
<td>ES:</td>
<td>--</td>
</tr>
<tr>
<td>EFS:</td>
<td>--</td>
</tr>
<tr>
<td>%EFS:</td>
<td>--</td>
</tr>
</tbody>
</table>

**Count:** BPV error count: The number of bipolar violations. A BPV is the occurrence of two consecutive pulses of the same polarity (unless the pulses are part of a DS3 zero-substitution code).

**Cur Ratio:** Current BPV error ratio: The average BPV error ratio during the previous 2.25 seconds.

**Avg Ratio:** Average BPV error ratio: The number of BPVs over the number of bits received since the beginning of the test.

**ES:** BPV errored seconds: The number of seconds during which at least one BPV occurred.

**EFS:** BPV error-free seconds: The number of seconds during which no BPV errors occurred.

**%EFS:** BPV error-free seconds percentage: Bipolar violation EFS expressed as a percentage of the total time since the beginning of the test.
E1 Slips Screen

This screen displays E1 slips measurements based on comparing the timing relationship between the receive E1 signal to an external reference signal. The reference signal is a bipolar DSX source applied at the rear-panel DS1 REF IN connector.

<table>
<thead>
<tr>
<th>E1 Slips</th>
<th>Final: 00:00:00.00</th>
</tr>
</thead>
<tbody>
<tr>
<td>E1 Slips</td>
<td></td>
</tr>
<tr>
<td>Frm Slips: --</td>
<td>Slip Sec: --</td>
</tr>
<tr>
<td>Bit Slips: --</td>
<td></td>
</tr>
<tr>
<td>Bit Slips:------&gt;</td>
<td>Delta Hz: --</td>
</tr>
<tr>
<td>Rx Hz: --</td>
<td>$s$</td>
</tr>
</tbody>
</table>

_Frm Slips:_ Frame slip count: The number of frame slip occurrences. A frame slip is declared when a difference of 256 time slots (bits) is detected between the receive and reference signals. Multiple frame slips within 0.25 seconds are counted as a single frame slip.

_Bit Slips:_ Bit slip count: The number of individual time slot differences between the receive and reference signals, in either direction. A positive value indicates that the receive frequency is greater than the reference frequency. A negative value indicates the receive frequency is less than the reference. If the reference is lost, the bit slip count is restarted from zero when the reference is restored.

_Bit Slips (graphic):_ This arrow provides a repeating graphic showing the number of bit slips. When the arrow reaches the right side of the display, 256 bits slips have been counted and a frame slip is declared.

_Slip Sec:_ Slip seconds count: The number of second during which one or more frame slips occurred.

_Rx Hz:_ Receive E1 frequency: The received signal frequency displayed in Hertz.

_Delta Hz:_ Frequency difference in Hertz: The difference between the receive E1 frequency and the reference frequency. A positive value indicates the receive frequency is faster than the reference; a negative value indicates the receive frequency is slower.
E1 Signal Measurements Screen

This screen displays signal measurements for the E1 receive signal. This screen is not displayed for E1 signals mapped to and from a DS3 signal.

<table>
<thead>
<tr>
<th>E1 Signal Measurements</th>
</tr>
</thead>
<tbody>
<tr>
<td>E1 E1 (E1)</td>
</tr>
<tr>
<td>Final: 00:00:00.00</td>
</tr>
</tbody>
</table>

**Rx Hz**: Receive E1 signal frequency: The frequency of the receive E1 signal, in Hertz.

**Rx Pk V**: Receive E1 signal level, Vpk: The level of the receive DS1 signal in volts peak (accuracy is ±5%).

**Rx dBdsx**: Receive E1 signal level, dB: The level of the receive E1 signal in decibels, referenced to a DSX level (accuracy is ±1 dB). The range is –30 to +6 dBdsx.

**Rx ma**: Receive E1 level, mA: The level of the receive E1 signal in milliamperes (mA).

**Ref Hz**: Reference E1 signal frequency: The frequency of the reference E1 signal applied at the rear-panel DS1 REF IN connector, in Hertz.

**EXZ**: Excessive zeros count: The number of consecutive zero strings greater than 15 (for AMI) or greater than 4 (for HDB3). Each string is considered a single event.
Jitter Measurements

Jitter Peak Results

<table>
<thead>
<tr>
<th>1 E1-E1 (E1)</th>
<th>Final: 00:00:00.00</th>
</tr>
</thead>
<tbody>
<tr>
<td>E1 Jitter</td>
<td></td>
</tr>
<tr>
<td>Current P-to-P (UI):</td>
<td>-- --</td>
</tr>
<tr>
<td>MAX P-to-P (UI):</td>
<td>-- --</td>
</tr>
<tr>
<td>MAX Pos Peak (UI):</td>
<td>-- --</td>
</tr>
<tr>
<td>MAX Neg Peak (UI):</td>
<td>-- --</td>
</tr>
</tbody>
</table>

Each result is calculated for both wide-band and high-band jitter.

**Current P-to-P:** Current peak-to-peak jitter: The sum of the positive jitter peak and the negative jitter peak for the most recent one-second period. Displayed in unit intervals.

**MAX P-to-P:** Maximum peak-to-peak jitter: The sum of the highest positive jitter peak and the highest negative jitter peak for the entire test duration. Displayed in unit intervals.

**MAX Pos Peak:** Maximum positive jitter peak: The greatest positive jitter peak since the beginning of the test. Displayed in unit intervals.

**MAX Neg Peak:** Maximum negative jitter peak: The greatest negative jitter peak since the beginning of the test. Displayed in unit intervals.

Jitter Hits and Mask Results

<table>
<thead>
<tr>
<th>1 E1-E1 (E1)</th>
<th>Final: 00:00:00.00</th>
</tr>
</thead>
<tbody>
<tr>
<td>E1 Jitter</td>
<td></td>
</tr>
<tr>
<td>Hits Count:</td>
<td></td>
</tr>
<tr>
<td>Total Hits Time (Sec):</td>
<td>-- --</td>
</tr>
<tr>
<td>MAX Percent of Mask:</td>
<td>-- --</td>
</tr>
</tbody>
</table>

Each result is calculated for both wide-band and high-band jitter.

**Hits Count:** Indicates the total number of jitter hits (jitter hit threshold exceeded) since the beginning of the test.

**Total Hits Time:** Indicates the cumulative total of time, in seconds, that the jitter hit threshold has been exceeded since the beginning of the test.

**MAX Percent of Mask:** Indicates the maximum peak-to-peak jitter for the entire test period expressed as a percentage of the jitter mask.
E1 Alarm Screens

These two screens display alarm results for the E1 receive signal. The alarms displayed on the screens are described in the following table.

<table>
<thead>
<tr>
<th>Alarm</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOS</td>
<td>E1 loss of signal: Declared when there are 175 or more contiguous pulse positions with no positive or negative pulses. LOS is cleared when there is a 12.5% or higher ones-density on the receive signal.</td>
</tr>
<tr>
<td>OOF</td>
<td>E1 out of frame: Declared when the frame alignment word is received errored for three consecutive frames.</td>
</tr>
<tr>
<td>AIS</td>
<td>E1 alarm indication signal: Declared when an unframed all-ones pattern is received (&quot;all-ones&quot; is considered to be fewer than three zeros in two consecutive frames).</td>
</tr>
<tr>
<td>LOP</td>
<td>E1 loss of pattern: Declared when pattern synchronization is not achieved or when the receive pattern does not correspond to the internal reference pattern. Pattern synchronization is declared when 64 consecutive pattern matches (bits) are received. Loss of pattern synchronization is declared when 250 out of 1,024 consecutive pattern bits are errored. (User patterns with less than 25% transition density use 85 errors out of 1,024 bits.)</td>
</tr>
<tr>
<td>RAI</td>
<td>Remote alarm indication: Declared when bit 3 of the received timeslot 0 is set to 1 for three consecutive non-FAS frames.</td>
</tr>
</tbody>
</table>
| Dist  | Distant multiframe alarm: Declared when bit 6 of timeslot 16 in frame 0 is set to 1 for three consecutive multiframe.
E1 Alarm Screens

E1 Alarm Seconds Screen
This screen displays counts of E1 alarm seconds. An alarm second is one during which at least one occurrence of that alarm occurred.

<table>
<thead>
<tr>
<th>E1 Alarm Seconds</th>
<th>Final: 00:00:00.00</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOS: --</td>
<td>AIS: --</td>
</tr>
<tr>
<td>OOF: --</td>
<td>LOP: --</td>
</tr>
<tr>
<td>RAI: --</td>
<td>Dist: --</td>
</tr>
</tbody>
</table>

E1 Alarm and History Screen
This screen displays the current and previous occurrence of E1 alarms on the receive signal. Like front-panel indicator LEDs, the screen provides a current status of the alarm (Alarm) and also indicates if the alarm has occurred previously (Hist).

<table>
<thead>
<tr>
<th>E1 Alarm Hist</th>
<th>E1 Alarm Hist</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOS: --</td>
<td>RAI: --</td>
</tr>
<tr>
<td>OOF: --</td>
<td>Dist: --</td>
</tr>
<tr>
<td>AIS: --</td>
<td></td>
</tr>
<tr>
<td>LOP: --</td>
<td></td>
</tr>
</tbody>
</table>
E1 Status Screen

This screen displays the status of certain E1 signal parameters, similar to the front-panel DS1/E1 STATUS indicators.

<table>
<thead>
<tr>
<th>E1 Signal</th>
<th>E1 Status</th>
<th>Final: 00:00:00.00</th>
</tr>
</thead>
<tbody>
<tr>
<td>E1 Signal: --</td>
<td>E1 Status: --</td>
<td>Pattern: --</td>
</tr>
<tr>
<td>TS0 Sync: --</td>
<td>HDB3: --</td>
<td></td>
</tr>
<tr>
<td>TS16 Sync: --</td>
<td>CRC4 Sync: --</td>
<td></td>
</tr>
</tbody>
</table>

For each parameter, the display shows **ON** if that condition is present.

**E1 Signal**: E1 signal present: Declared when an E1 signal is received with at least a 12.5% ones-density.

**TS0 Sync**: Valid TS0 frame synchronization: Declared when valid FAS words are received in two consecutive FAS frames, and bit 2 in timeslot 0 of the intervening non-FAS frame is set to 0.

**TS16 Sync**: Valid CAS multiframe synchronization: Declared when a valid MFA signal is detected in timeslot 16, and timeslot 16 of the previous frame does not contain all-zeros.

**CRC4 Sync**: Valid CRC-4 format frame synchronization: Declared when two consecutive valid CRC-4 signals are detected within 12–14 ms after frame synchronization.

**Pattern**: E1 pattern synchronization: Declared when 64 consecutive pattern matches (bits) are received.

**HDB3**: E1 high-density bipolar signal present: Declared when valid HDB3 (three-zero substitution) codes are detected on the receive E1 signal.

The TS0, TS16, and CRC4 sync indications work cumulatively together. For example, if your E1 signal is CAS and CRC-4 formatted (Frm>TS0+TS16+CRC) all three indicators will show **ON** when a valid signal is received.
E1 Timeslot Measurements Screen

This screen displays timeslot level, frequency, data, and signaling results for the selected TS drop channel on the E1 signal (this screen is only active when the DS0 Data is set for a tone).

<table>
<thead>
<tr>
<th></th>
<th>Final: 00:00:00.00</th>
</tr>
</thead>
<tbody>
<tr>
<td>E1 Time Slot</td>
<td>-60...-40...-20...0.</td>
</tr>
<tr>
<td>Level: 0.5</td>
<td>0.0000000000000000</td>
</tr>
<tr>
<td>&gt;3dBM: 0 Thres. Sec</td>
<td></td>
</tr>
<tr>
<td>Freq: 1004 Hz</td>
<td></td>
</tr>
<tr>
<td>Data: 10111010 A=0 B=0 C=0 D=0</td>
<td></td>
</tr>
</tbody>
</table>

**Level:** TS level: The TS signal RMS power in decibels (dBm). The bar graph to the right gives a graphical display of the signal.

**>3dBM Thresh Sec:** TS 3 dBm threshold seconds: The number of seconds in which the dropped TS signal level exceeded +3 dBm.

**Freq:** TS frequency: The frequency of the dropped tone in Hertz.

**Data:** TS payload: The current eight bits in binary format (1s or 0s).

**ABCD:** TS channel signaling bits: The binary status of the four signaling bits for the dropped TS.
DS0/TS Bit Error Measurements Screen

This screen displays BER results on the selected TS. This screen is only active when the TS Data is set for a pattern.

<table>
<thead>
<tr>
<th>DS0-DS1 (DS1)</th>
<th>Final: 00:00:02.00</th>
</tr>
</thead>
<tbody>
<tr>
<td>DS0/TS Bit Error Measurements</td>
<td>Error Count: 0</td>
</tr>
<tr>
<td></td>
<td>Average Ratio: 0.00E+00</td>
</tr>
<tr>
<td></td>
<td>Current Ratio: 0.00E+00</td>
</tr>
</tbody>
</table>

**Error Count:** TS pattern bit errors: The number of bit errors detected on the selected TS since the beginning of the test.

**Average Ratio:** TS average pattern bit error ratio: The average ratio of errored bits over the total number of bits for the selected TS since the beginning of the test.

**Current Ratio:** TS current pattern bit error ratio: The average ratio of errored bits over the total number of bits for the selected TS during the most recent 2.25 seconds.
E1 Measurement Reference
E1/TS Interfaces  17-2

Jitter Option Specifications  17-4

E1 Specifications
E1/TS Interfaces

E1 Transmitter

E1 TX

**Signal:** DSX

- Per CCITT G.703.
- 3.0 Vpk ±1.0 dB (0 dBdsx).

**Line Code:** AMI or HDB3.

**Impedance:** 120 ohm ±5% balanced; return loss >20 dB.

**Connector:** Accepts WECO 310 plug. Optional Bantam.

E1 Receiver

E1 RX

**Signals:**

<table>
<thead>
<tr>
<th><strong>DSX</strong></th>
<th>Per CCITT G.703.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>3.0 Vpk ±1.0 dB (0 dBdsx). 2.048 MHz ±1000 ppm.</td>
</tr>
<tr>
<td></td>
<td>Equalized for 0 to 655 ft of 22 AWG pulp insulated cable.</td>
</tr>
<tr>
<td></td>
<td>Sensitivity = 26 dB below 0 dBdsx.</td>
</tr>
<tr>
<td></td>
<td>Jitter tolerance per CCITT G.823.</td>
</tr>
</tbody>
</table>

**Mon**

| Per CCITT G.703. 0.3 Vpk input level typical (–20 dBdsx). |

**Line Code:** AMI or HDB3.

**Impedance:**

- **Term** = 120 ohms ±5%, return loss >20 dB.
- **Bridge** = >1000 ohms.

**Connector:** Accepts WECO 310 plug. Optional Bantam.

E1 Drop Ouput

E1 DROP

**Signal = DSX:** E1 dropped from higher-rate signal.

- Per CCITT G.703.
- 3.0 Vpk ±1.0 dB (0 dBdsx).

**Line Code:** AMI or B8ZS.

**Impedance:** 75 ohm ±5%; return loss >20 dB.

**Connector:** Accepts WECO 310 plug. Optional Bantam.
E1 Specifications

**E1/Ts Interfaces**

**E1 Timing**

**Internal**: 2.048 MHz ±20 ppm.

**DS1 TX CLK IN jack**: Input E1 signal. TTL levels, 50 ohm, BNC connector.

**E1 Timeslot Interfaces**

**TS VF Drop Port**: VF OUT jack: 600 ohm, internal codec.

**TS VF Insert Port**: VF IN jack: 600 ohm, internal codec.

**ABCD Signaling Bits Drop**

**SIGNALING TTL port**: TTL, DB-9S connector, 50 ohms. For pinout information, see *ABCD Signaling Bits Drop*, page 13–4.

**Note**: The rear-panel DS1 REF IN, DS1 INTERFACE, DS1 ERR OUT, and SIGNALING-TTL connectors serve the corresponding E1 functions when the test set is in an E1 mode.

**E1 Slips Reference**

**Input**: DS1 REF IN jack: accepts E1 signal.

- 3.0 Vpk input level, typical.
- WECO 310 connector.

**E1 Network Interface**

**DS1 INTERFACE port**: DB-15 socket connector. Provides parallel connections to the front-panel DS1 TX and DS1 RX connectors.

<table>
<thead>
<tr>
<th>Pin</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>E1 Tx tip</td>
</tr>
<tr>
<td>9</td>
<td>E1 Tx ring</td>
</tr>
<tr>
<td>3</td>
<td>E1 Rx tip</td>
</tr>
<tr>
<td>11</td>
<td>E1 Rx ring</td>
</tr>
<tr>
<td>All others</td>
<td>No connection</td>
</tr>
</tbody>
</table>

**E1 Errors Output**

**DS1 ERR OUT jack**: TTL, 50 ohm, BNC connector.
**Jitter Option Specifications**

E1 jitter measurement requires E1 testing (Option URQ), Option UQR, and either Option UQN or 201.

**Measurement Response**

- **E1 Jitter Measurement per:** CCITT G.823
- **Wide-band cut-off frequency:** 20 Hz to 100 kHz
- **High-band cut-off frequency:** 20 kHz to 100 kHz
- **Roll-off (per decade) below lower 3 dB point:** ≥20 dB
- **Roll-off (per decade) above higher 3 dB point:** ≥60 dB

**Jitter Measurements**

<table>
<thead>
<tr>
<th>Measurement</th>
<th>Range</th>
<th>Resolution</th>
<th>Accuracy</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Peak Positive Jitter</td>
<td>0.1 to 6.0 UI</td>
<td>0.1 UI</td>
<td>±5% of reading, ±0.05 UI.</td>
</tr>
<tr>
<td>Maximum Peak Negative Jitter</td>
<td>0.1 to 6.0 UI</td>
<td>0.1 UI</td>
<td>±5% of reading, ±0.05 UI.</td>
</tr>
<tr>
<td>Current Peak-to-Peak Jitter</td>
<td>0.1 to 12.0 UI</td>
<td>0.1 UI</td>
<td>±5% of reading, ±0.05 UI.</td>
</tr>
<tr>
<td>Max Peak-to-Peak Jitter</td>
<td>0.1 to 12.0 UI</td>
<td>0.1 UI</td>
<td>±5% of reading, ±0.05 UI.</td>
</tr>
</tbody>
</table>

**Wideband Mask**

- Percent of Mask: 1.5 UI

**Highband Mask**

- resolution: 0.2 UI

**Demodulated Jitter Output**

- **DMOD JITTER OUT jack:** 50 ohm, BNC connector.
- Scale = 100 mV/UI; range = 0 to 6 Vdc.
E1 Specifications

E1 Signal Format—2.048 Mbs

1 Timeslot (TS) = 8 bits

1 E1 Frame = 32 eight-bit timeslots = 256 bits

TS0 (CRC-4 format)
- C: 0 0 1 1 0 1 1
- FAS frames (0 and even frames)
- 0 0 1 A S0 S1 S2 S3
- Non-FAS frames (odd frames)
- Non-FAS frames (odd frames)

TS16 (CAS format)
- 0 0 0 0 X Y X
- MF alignment (frame 0 only)
- A B C D A B C D
- Signaling (frames 1–15)

TS0 (non-CRC-4 format)
- 0 0 1 1 0 1 1
- FAS frames (0 and even frames)
- 0 1 A S0 S1 S2 S3
- Non-FAS frames (odd frames)
### E1 Multiframe Structure (showing TS0 and TS16 bits)

<table>
<thead>
<tr>
<th>Frame</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>TS1-TS15</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>TS17-TS31</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>C1</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td></td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>X</td>
<td>Y</td>
<td>X</td>
<td>X</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>1</td>
<td>A</td>
<td>S</td>
<td>S</td>
<td>S</td>
<td>S</td>
<td>S</td>
<td></td>
<td>A1</td>
<td>B1</td>
<td>C1</td>
<td>D1</td>
<td>A16</td>
<td>B16</td>
<td>C16</td>
<td>D16</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>C2</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td></td>
<td>A2</td>
<td>B2</td>
<td>C2</td>
<td>D2</td>
<td>A17</td>
<td>B17</td>
<td>C17</td>
<td>D17</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>0</td>
<td>1</td>
<td>A</td>
<td>S</td>
<td>S</td>
<td>S</td>
<td>S</td>
<td>S</td>
<td></td>
<td>A3</td>
<td>B3</td>
<td>C3</td>
<td>D3</td>
<td>A18</td>
<td>B18</td>
<td>C18</td>
<td>D18</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>C3</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td></td>
<td>A4</td>
<td>B4</td>
<td>C4</td>
<td>D4</td>
<td>A19</td>
<td>B19</td>
<td>C19</td>
<td>D19</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>1</td>
<td>1</td>
<td>A</td>
<td>S</td>
<td>S</td>
<td>S</td>
<td>S</td>
<td>S</td>
<td></td>
<td>A5</td>
<td>B5</td>
<td>C5</td>
<td>D5</td>
<td>A20</td>
<td>B20</td>
<td>C20</td>
<td>D20</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>C4</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td></td>
<td>A6</td>
<td>B6</td>
<td>C6</td>
<td>D6</td>
<td>A21</td>
<td>B21</td>
<td>C21</td>
<td>D21</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>0</td>
<td>1</td>
<td>A</td>
<td>S</td>
<td>S</td>
<td>S</td>
<td>S</td>
<td>S</td>
<td></td>
<td>A7</td>
<td>B7</td>
<td>C7</td>
<td>D7</td>
<td>A22</td>
<td>B22</td>
<td>C22</td>
<td>D22</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>C1</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td></td>
<td>A8</td>
<td>B8</td>
<td>C8</td>
<td>D8</td>
<td>A23</td>
<td>B23</td>
<td>C23</td>
<td>D23</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>1</td>
<td>1</td>
<td>A</td>
<td>S</td>
<td>S</td>
<td>S</td>
<td>S</td>
<td>S</td>
<td></td>
<td>A9</td>
<td>B9</td>
<td>C9</td>
<td>D9</td>
<td>A24</td>
<td>B24</td>
<td>C24</td>
<td>D24</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>C2</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td></td>
<td>A10</td>
<td>B10</td>
<td>C10</td>
<td>D10</td>
<td>A25</td>
<td>B25</td>
<td>C25</td>
<td>D25</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>1</td>
<td>1</td>
<td>A</td>
<td>S</td>
<td>S</td>
<td>S</td>
<td>S</td>
<td>S</td>
<td></td>
<td>A11</td>
<td>B11</td>
<td>C11</td>
<td>D11</td>
<td>A26</td>
<td>B26</td>
<td>C26</td>
<td>D26</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>C3</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td></td>
<td>A12</td>
<td>B12</td>
<td>C12</td>
<td>D12</td>
<td>A27</td>
<td>B27</td>
<td>C27</td>
<td>D27</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>E</td>
<td>1</td>
<td>A</td>
<td>S</td>
<td>S</td>
<td>S</td>
<td>S</td>
<td>S</td>
<td></td>
<td>A13</td>
<td>B13</td>
<td>C13</td>
<td>D13</td>
<td>A28</td>
<td>B28</td>
<td>C28</td>
<td>D28</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>C4</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td></td>
<td>A14</td>
<td>B14</td>
<td>C14</td>
<td>D14</td>
<td>A29</td>
<td>B29</td>
<td>C29</td>
<td>D29</td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>E</td>
<td>1</td>
<td>A</td>
<td>S</td>
<td>S</td>
<td>S</td>
<td>S</td>
<td>S</td>
<td></td>
<td>A15</td>
<td>B15</td>
<td>C15</td>
<td>D15</td>
<td>A30</td>
<td>B30</td>
<td>C30</td>
<td>D30</td>
<td></td>
</tr>
</tbody>
</table>

- **C1-C4:** CRC-4 bits.
- **A:** Remote alarm indication bits.
- **S:** Spare bits.
- **E:** CRC error indication bits.
- **A_n-D_n:** ABCD signaling bits for channel n.
Run an Automatic VP/VC Scan  18–2
Run a Cell Capture Test  18–4
Set up for ATM Testing  18–7
Choose an ATM Test Mode  18–8
Configure Global ATM Parameters  18–10
Configure the ATM Foreground Channel
    No Traffic Shaping  18–11
    With Traffic Shaping  18–12
Set ATM Cell Payloads  18–13
Set the Foreground, Idle and Receive VP/VC  18–14
Configure the ATM Background Channels
    No Traffic Shaping  18–15
    With Traffic Shaping  18–16
Configure Misinserted Cell Errors  18–18
Setup for STS-12c ATM Testing  18–19
Run the ATM Test  18–21

ATM Network Testing
Run an Automatic VP/VC Scan

The VP/VC scan is not available for STS-12c ATM applications.

The 156MTS features an automatic ATM scan that analyzes the receive signal for ATM traffic and identifies the active channels and bandwidth. This procedure describes how to setup and run the test.

1. Connect the signal to be tested to the appropriate 156MTS input connector.

2. From the Main Menu, select Terminal, Monitor, or Drop & Insert test mode and press MENU-down.

3. On the test setup screen, configure the transmitter, receiver, and payload as necessary for your test. For ATM on SONET signals, be sure the Payload is set for ATM. Press MENU-down.

4. On the test operation screen, configure the signal parameters as needed. For ATM on T-carrier, set the Data> field to ATM.

5. Press CONFIG-right to display the Control Screen menu. Use FIELD to select ATM Setup and press CONFIG-right again.

6. On the ATM Setup menu, select VPI/VCI Scan and press CONFIG-right.

For loop tests, configure the ATM transmit stream before you begin the VPI/VCI scan. See Configure Global ATM Parameters, page 18-10.
ATM Network Testing

Run an Automatic VP/VC Scan

The ATM VPI/VCI Scan operation screen is displayed.

```
<table>
<thead>
<tr>
<th>Function</th>
<th>Channel Search</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notation</td>
<td>Hex</td>
</tr>
<tr>
<td>Further measurement on item</td>
<td>1</td>
</tr>
</tbody>
</table>
```

Select the Channel Search function, then press START to execute.

7. Use FIELD and VALUE to set Function > to Channel Search and then press the START key.

The instrument scans the input signal for ATM traffic. Active VP/VC addresses are displayed in the list on the top half of the display.

8. Press STOP to end the scan (the scan ends automatically when 40 VP/VCs are detected).

9. Use VALUE to set Function > to BW Measurement and press START.

The instrument checks each active VP/VC to determine the percentage of bandwidth used by that channel.

10. Press STOP to end the bandwidth measurement (the measurement ends when all active channels have been measured).

11. Use RESULT to scroll the results screens in the top half of the display. There are five screens, each screen lists as many as eight channels.

12. To select a channel for further testing, use FIELD to highlight the Further measurement on item > field. Use VALUE to choose a detected channel to test and then press CONFIG-right.

To perform additional testing on the channel you selected, see Run the ATM Test, page 18–21.
Run a Cell Capture Test

The cell capture sequence is not available for STS 12c A1M applications.

Use the cell capture test to filter and view a specific cell stream, or a range of streams. This procedure shows how to set up and run the test.

1. From the Main Menu, select Terminal, Monitor, or Drop & Insert test mode and press MENU-down.

2. On the test setup screen, configure the transmitter, receiver, and payload as necessary for your test. For ATM on SONET signals, be sure the Payload is set for ATM. Press MENU-down.

3. On the test operation screen, configure the signal parameters as needed. For ATM on T-carrier, set the Data> field to ATM.

4. Press CONFIG-right to display the Control Screen menu. Use FIELD to select ATM Setup and press CONFIG-right again.

5. On the ATM Setup menu, select Cell Capture and press CONFIG-right.

For loop tests, configure the ATM transmit stream before you begin the VPI/VCI scan. See Configure Global ATM Parameters, page 18–10.
ATM Network Testing

Run a Cell Capture Test

6. Next select Cell Capture Mode and choose a mode. The capture mode determines what other setup screens will be presented (this example uses Cell Capture Mode>Range of VPIs).

7. Press CONFIG-right. The next Cell Capture screen is displayed.

The appearance of this screen depends on the capture mode selected in step 6. The selected mode is indicated in the title of the screen.

8. Use the FIELD and VALUE keys to set a VPI address range to capture. The test set will only capture cells that fall within the range you set.

9. Press CONFIG-right to display the VPI Masking setup screen.

You can refine the capture range by masking parts of the range entered in step 8. Use FIELD and VALUE to enter as many as four masks to be excluded from the capture range. Enable the masks by toggling the corresponding Enable: number On or Off.

Example: if you specify 10 to 88 in step 8 and a mask of 33 to 55, the test set captures cells with VPIs in the ranges 10 to 32 and 56 to 88.
ATM Network Testing

Run a Cell Capture Test

10. Start the cell capture test by pressing START.

The 156MTS captures cells using the criteria you defined. The test runs until 500 cells are captured, or until you press STOP. The number of cells captured is displayed in the Cells> field on the top half of the display.

11. Use the RESULT keys to scroll the top half of the display and view the header and payload of each of the captured cells. The ATM Cell # field on the top line indicates which cell is being displayed.

```
1 ATM Cell # 007  Final: 00:00:00.00
Cell Capture Complete  Cells>500
00000001 xx 03 59 01 07 03 59 01 07 03
09 01 01 03 59 01 07 03 59 01 07 03 09
01 07 03 59 01 07 03 59 01 07 03 59 01
07 03 59 01 07 03 59 01 07 03 59 01 07

<ATM Cell Capture-Range of VIPis>
Display Cell #> 001
Capture VIP> 01 To FF

Press ACTION to display selected cell#
Press < RESULT > to scroll
```

12. To avoid scrolling through all the cells, enter the number of the cell you'd like to view in the Display Cell #> field and then press the ACTION key.
Set up for ATM Testing

ATM testing features are available when the payload is set for ATM.

1. From the Main Menu press FIELD to select a testing mode.

2. Press MENU-down. The testing setup screen for the mode you select is displayed (this example shows Terminal testing mode).

   TERMINAL TESTING
   Tx Rate: STS1/OC1     Rx Rate: STS1/OC1
   Payload: STS1/ATM

   Select Tx and Rx Rates first
   then select payload.
   Press MENU-dn to enter test mode.
   Press MENU-up to return to Main Menu.

3. Use FIELD and VALUE to set the transmitter (Tx Rate:) and receiver (Rx Rate:). For Monitor and D&I modes the transmitter and receiver are set simultaneously (Tx/Rx Rate:).

4. Next press the right FIELD key to select the Payload: parameter. Use VALUE to set the payload to an ATM selection.

   - For OC-12, select 12c/ATM or 3c/ATM; for OC-3, select 3c/ATM.
   - For STS-1 and OC-1, select STS1/ATM.
   - For DS3, DS1, or E1 select DS3, DS3/DS1, DS3/E1, DS1, or E1 as appropriate for your test.

5. Press MENU-down. The test operation screen is displayed.

Before you configure the ATM parameters, you should decide which ATM test mode to use. See Choose an ATM Test Mode, page 18–8.
Choose an ATM Test Mode

1. From the test operation screen press CONFIG-right to display the Control Screen menu.

   | Global Settings | Data Link Control |
   | Alarm Control   | ATM Setup         |
   | APS Control     | DS3 Prog Pattern  |
   | DS3 FEC Control |                 |
   | DS3 C-Bit Control |
   | SONET OH Control |

2. Select **ATM Setup** and press CONFIG-right to display the ATM Setup menu.

<table>
<thead>
<tr>
<th>ATM Standard Active</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard</td>
</tr>
<tr>
<td>UPI/UCI Scan</td>
</tr>
<tr>
<td>Transfer Delay</td>
</tr>
<tr>
<td>Inter-Arrival Time</td>
</tr>
<tr>
<td>Cell Capture</td>
</tr>
</tbody>
</table>

3. Select the ATM test mode that you want to use.

   Refer to the table on page 18–9 for help selecting an ATM test mode.

4. Proceed with the ATM parameter setup. See **Configure Global ATM Parameters**, page 18–10.
ATM Network Testing

Choose an ATM Test Mode

How to select an ATM test mode

1. Find the ATM *measurements* you want to make in the table below.
2. Note the ATM *test mode* that meets your needs and check the requirements and restrictions associated with it. You will probably use Standard mode unless you are making cell delay measurements.
3. Select the corresponding mode on the ATM Setup menu (see page 18–8).

<table>
<thead>
<tr>
<th>If you want to measure...</th>
<th>Bandwidth, Cell Count, HEC errors, BER, Misinsert, PLCP, Alarm, OAM</th>
</tr>
</thead>
<tbody>
<tr>
<td>...Plus...</td>
<td>AAL-1 (cell loss, CRC) Cell Transfer Delay (round-trip delay) Inter-cell Arrival Delay</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>...Select this Test Mode:</th>
<th>Standard</th>
<th>Cell Transfer Delay</th>
<th>Cell Inter-Arrival Delay</th>
</tr>
</thead>
<tbody>
<tr>
<td>Traffic Shaping</td>
<td>Yes (2% or 10% BW step only)</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>BW Step Size</td>
<td>2% (no bkgrnd), 10%, Line rates.</td>
<td>2%</td>
<td>2%</td>
</tr>
<tr>
<td>Fgnd Cell Type</td>
<td>AAL-0, AAL-1</td>
<td>Test Cell</td>
<td>Test Cell</td>
</tr>
<tr>
<td>Fgnd Distribution</td>
<td>Continuous</td>
<td>Continuous</td>
<td>Continuous</td>
</tr>
<tr>
<td>Fgnd OAM</td>
<td>Yes (Continuous distribution)</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Rx Chan Cell Type</td>
<td>AAL-0, AAL-1, AAL-3/4, AAL-5</td>
<td>Test Cell</td>
<td>Test Cell</td>
</tr>
<tr>
<td>Bkgnd Cells/OAM</td>
<td>Yes (10% BW step only)</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>

**Note:** There is only one ATM test mode for STS-12c. STS-12c ATM testing features 5% bandwidth step size, AAL-0 cell type, and continuous distribution. Background cells and OAM cells are not available. See *Setup for STS-12c ATM Testing*, page 18–19)
Configure Global ATM Parameters

- When you press CONFIG-right from the ATM Setup menu, the ATM Global Setup screen is displayed.

```
<ATM SETUP II: Global Setup>
Cell Scramble: Off
Circuit/Path Notation: Hex
Traffic Shaping: Off
EW Step Size: 10% with Bkgnd AALs
Cell Delineation: HEC
```

1. Use FIELD and VALUE to set cell scrambling (Cell Scramble) and to set the cell address format (Circuit/Path Notation).

2. Set traffic shaping on (Basic) or Off.

3. Next set the foreground channel bandwidth step size. You can select 2% or 10% increments, or select a nominal line rate.

**Note:** If you select 2% bandwidth increments or a line rate, transmit background channels are disabled and ATM setup screens 5 and 6 are not displayed.


5. Press CONFIG-right when done. The Foreground Channel Control screen is displayed (see Configure the ATM Foreground Channel (no traffic shaping), page 18-11).
Configure the ATM Foreground Channel (no traffic shaping)

Note: If you set Traffic Shaping to Basic (see step 2, page 18–10) proceed to Configure the ATM Foreground Channel (with basic traffic shaping), page 18–12.

- From the ATM Global Setup screen, press CONFIG-right to display the Foreground Channel Control screen.

```
<ATM SETUP #2: Fgnd Channel Control>
BW 30.6% Type>AAL0
Distribution>Continuous
Cells Per Burst>100 Period>0.0 Sec
OAM:Enable>Off Type>F5 >H15 >End
>>>Press ACTION to send Single Burst<<<
```

1. Use FIELD and VALUE to set the bandwidth (BW) used by the foreground channel. The bandwidth can be set in increments of 2% or 10%, depending on the BW Step Sizes (see step 3, page 18–10).
   - If you set BW Step Size to a “line rate” (see step 3, page 18–10), BW is replaced by Line Increment. Choose the Nominal rate, or adjust the rate up or down in five steps (-5 to +5).

2. Select Type> and use VALUE to set either AAL0 or AAL1 for the foreground channel. If you did not select Standard test mode, this field is set to Test Cell (see step 3, page 18–8).

3. Next select a interleave transmission mode (Distribution>). If the test mode is not Standard, this field is set to Continuous.

4. If you selected Single Burst or Periodic Burst for Distribution, use FIELD and VALUE to set the number of cells transmitted each burst (Cells Per Burst>) and the length of time between bursts (Period>).
   - From this screen only, press ACTION to trigger a single burst of foreground channel cells.

5. Next configure the OAM injection parameters (Distribution> must be set to Continuous). Choose the type, alarm, and segment.

6. Press CONFIG-right when you have finished. The Cell Payload Data screen is displayed (see Set ATM Cell Payloads, page 18–13).
Configure the ATM Foreground Channel (with basic traffic shaping)

Note: If you set Traffic Shaping to Off (see step 2, page 18–10) refer to Configure the ATM Foreground Channel (no traffic shaping), page 18–11.

This procedure configures the bandwidth and distribution of the ATM foreground channel, and sets the foreground OAM transmit function.

- From the ATM Global Setup screen, press CONFIG-right to display the Foreground Channel Control screen.

```
<ATM SETUP #2: Fgnd Channel Control>
PCR>100%  SCR>100%  MBS>0100
Service Type>CBR  AAL Type>AAL1
Distribution>Continuous Period>0.1 Secs
OAM:Enable>Off Type>F5  >HIS  >End
>>>Press ACTION to send Single Burst<<<
```

1. Use FIELD and VALUE to set the peak cell rate (PCR), sustained cell rate (SCR), and maximum burst size in cells (MBS). These parameters are used to calculate the "leaky bucket algorithm" for traffic shaping when Service Type is set for VBR (see next step).

2. Set Service Type to either CBR (constant bit rate) or VBR (variable bit rate). When Service Type is set to CBR, the PCR value is used for the foreground channel bandwidth.

3. Select AAL Type> and set either AAL0 or AAL1 for the foreground channel.

4. Next select an interleave transmission mode (Distribution>.

5. If you selected Single or Periodic for Distribution, set the length of time between bursts (Period>). The number of cells in a burst is defined by MBS (see step 1).

- From this screen only, press ACTION to trigger a single burst of foreground channel cells.

6. Next configure the OAM injection parameters (Distribution> must be set to Continuous). Choose the type, alarm, and segment.

7. Press CONFIG-right when you have finished. The Cell Payload Data screen is displayed (see Set ATM Cell Payloads, page 18–13).
Set ATM Cell Payloads

This procedure sets the payloads of the foreground channel and idle cells, and defines the user-programmable ATM test patterns.

- From the Foreground Channel Control screen, press CONFIG-right to display the Cell Payload Control screen.

1. Use VALUE to set the payload pattern for the ATM foreground channel.

2. Use FIELD to select Idle Cell Data> and use VALUE to set a hexadecimal value for the payload of the transmitted idle cells.

3. Next use FIELD and VALUE to enter a value for the 32-bit foreground pattern. The value is entered in hexadecimal.

4. In the same manner, use FIELD and VALUE to enter a value for the 32-bit background pattern.

**Note:** The background pattern is only available when traffic shaping is off and the bandwidth step size is set to 10% increments.

5. Press CONFIG-right when you are finished. The fourth ATM setup screen is displayed (see Set the Foreground, Idle and Receive VP/VC, page 18–14).
ATM Network Testing
Set the Foreground, Idle and Receive VP/VC

Set the Foreground, Idle and Receive VP/VC

This procedure sets the cell header fields for the foreground channel, idle cells, and receive channel. It also sets the receive channel cell type.

- From the Cell Payload Data screen, press CONFIG-right to display the fourth ATM screen.

```
<ATM SETUP #4>

<table>
<thead>
<tr>
<th>GFC</th>
<th>VPI</th>
<th>UCI</th>
<th>PT</th>
<th>CLP</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fgnd Hdr:</td>
<td></td>
<td>01</td>
<td>0001</td>
<td>000</td>
</tr>
<tr>
<td>Idle Hdr:</td>
<td>0</td>
<td>--</td>
<td>----</td>
<td>000</td>
</tr>
<tr>
<td>Rx Chan:</td>
<td>-</td>
<td>01</td>
<td>0001</td>
<td>----</td>
</tr>
<tr>
<td>Rx Cell Type&gt;</td>
<td>AAL0</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

1. Use FIELD and VALUE to set the generic flow control bits (GFC), virtual path identifier byte (VPI), virtual circuit identifier bytes (VCI), payload type bits (PT), and cell-loss priority bit (CLP) for the foreground channel cell headers (Fgnd Hdr:).

2. Next set the GFC, PT, and CLP for the transmitted idle cells (Idle Hdr:). The idle VP/VC address is not editable.

3. Set the VP/VC for the receive channel (Rx Chan:). The test set uses this address to make "selected VP/VC" measurements (see Selected VP/VC Measurement Screens, page 20–4).

4. Use FIELD and VALUE to set the cell type for the received channel (Rx Cell Type>). If you did not select Standard test mode this field is set to Test Cell (see step 3, page 18–9).

5. Press CONFIG-right when you are finished.

   - If you set a bandwidth step size of 10% (see step 3, page 18–10), the Background Channel Control screen is displayed. See Configure the ATM Background Channels (traffic shaping off), page 18–15.

   - If you set a bandwidth size of 2%, the display returns to the test operation screen and you are ready to begin the test (see Run the ATM Test, page 18–21).

Note: You can go back to the other ATM screens by pressing CONFIG-left.
Configure the ATM Background Channels (traffic shaping off)

**Note:** If you set **Traffic Shaping**> to **Basic** (see step 2, page 18–10) proceed to **Configure the ATM Background Channels (with basic traffic shaping)**, page 18–16.

- From the fourth ATM setup screen, press CONFIG-right to display the Background Channel Control screen.

**Note:** This screen is not displayed if **BW Step Size**> is set to 2%. See **Configure Global ATM Parameters**, page 18–10.

```plaintext
<ATM SETUP #5: Tx Bkgnd Channel Control>
Type> PALS
Data> All 0s
Enable: 1> Off 2> Off 3> Off 4> Off
OAM> Enable> Off Type> F5 > AIS > End
```

For STS-12c ATM applications, see **Setup for STS-12c ATM Testing**, page 18–19.

1. Use **VALUE** to set the background cell type (**Type>**). Next use **FIELD** and **VALUE** to set the payload (**Data>**).

2. Use **FIELD** and **VALUE** to select and activate or deactivate the four background channels (**Enable: 1>** through **4>**).

3. Next set the OAM parameters (**Distribution>** must be **Continuous**, see step 3, page 18–11). Choose the type, alarm, and segment.

4. Press CONFIG-right. The Background Header Setup screen is displayed.

```plaintext
<ATM SETUP #6: Tx Bkgnd Header Setup>
GFC VPI UCI PT CLP
Hdr1: 0 02 0001 000 0
Hdr2: 0 03 0001 000 0
Hdr3: 0 04 0001 000 0
Hdr4: 0 05 0001 000 0
```

5. Use **FIELD** and **VALUE** to configure the cell headers for the four background channels. The fields are the same as for the foreground (See **Set the Foreground, Idle and Receive VP/VC**, page 18–14).

6. Press **CONFIG-right** when you are finished. The Misinserted Cell Error Control screen is displayed (see page 18–18).
Configure the ATM Background Channels (with basic traffic shaping)

**Note:** If you set Traffic Shaping> to Off (see step 2, page 18–10) refer to Configure the ATM Background Channels (traffic shaping off), page 18–15.

- From the fourth ATM setup screen, press CONFIG-right to display the Background Channel Control screen.

**Note:** This screen is not displayed if BW Step Size> is set to 2%. See Configure Global ATM Parameters, page 18–10.

```
<ATM SETUP #5: Tx Bkgnd Channel Control>
Enable: 1>Off 2>Off 3>Off 4>Off
Service Type: 1>CBR 2>CBR 3>CBR 4>CBR
AAL Type: 1>AAL5 2>AAL5 3>AAL5 4>AAL5
OAM:Enable>Off Type>F5 >AIS >End
```

1. Use FIELD and VALUE to set each of the four background channels (1–4) On or Off.

2. Set the Service Type for each background channel to either CBR (constant bit rate) or VBR (variable bit rate).

3. Next set the AAL Type for each background channel.

4. Set the OAM parameters (Distribution> must be set to Continuous, see step 3, page 18–11). Choose the type, alarm, and segment.

5. Press CONFIG-right. The Background Payload Data screen is displayed.

```
<ATM SETUP #6: Tx Bkgnd Payload Data>
Data 32-bit Pattern
1>32-Bit Prog >9ABCDEF0
2>32-Bit Prog >9ABCDEF0
3>32-Bit Prog >9ABCDEF0
4>32-Bit Prog >9ABCDEF0
```

6. Use FIELD and VALUE to configure the payloads of the four background channels.
ATM Network Testing

Configure the ATM Background Channels (with basic traffic shaping)

7. Press CONFIG-right. The Background Header Setup screen is displayed.

![ATM SETUP #7: Tx Bkgnd Header Setup]

<table>
<thead>
<tr>
<th>Hdr</th>
<th>GFC</th>
<th>VPI</th>
<th>VCI</th>
<th>PT</th>
<th>CLP</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hdr1</td>
<td>0</td>
<td>02</td>
<td>0001</td>
<td>000</td>
<td>0</td>
</tr>
<tr>
<td>Hdr2</td>
<td>0</td>
<td>03</td>
<td>0001</td>
<td>000</td>
<td>0</td>
</tr>
<tr>
<td>Hdr3</td>
<td>0</td>
<td>04</td>
<td>0001</td>
<td>000</td>
<td>0</td>
</tr>
<tr>
<td>Hdr4</td>
<td>0</td>
<td>05</td>
<td>0001</td>
<td>000</td>
<td>0</td>
</tr>
</tbody>
</table>

8. Use FIELD and VALUE to configure the cell headers for the four background channels. The fields are the same as for the foreground (See Set the Foreground, Idle and Receive VP/VC, page 18–14).

9. Press CONFIG-right when you are finished. The Misinserted Cell Error Control screen is displayed (see page 18–18).
Configure Misinserted Cell Errors

This procedure the misinserted cell injection capability. Misinserted cells can be injected during ATM testing by setting the error type (Err: Type>) to Misins Cell.

- From the Background Header Setup screen, press CONFIG-right to display the Misinserted Cell Error Control Screen.

```
<ATM SETUP #7: Misinsert Cell Err Cntl>
    Period>0.1 Secs
    Data>All is
    32-bit Pat>ABCDEF01
```

1. Use FIELD and VALUE to set the Period. This is the amount of time between cell misinsertions when the error injection Rate is set to Periodic.

2. Use FIELD to select the Data field and use VALUE to set the payload pattern for the misinserted cells.

3. Next use FIELD and VALUE to configure the value of the 32-bit user pattern in hexadecimal (32-bit Prog). The pattern is used when Data is set to 32-Bit Prog.

4. When you are finished, press CONFIG-right to return to the test operation display.
Setup for STS-12c ATM Testing

This procedure configures the unit for ATM testing on STS-12c signals.

1. To configure the test set for STS-12c/ATM testing, set the transmitter and receiver for OC-12, and set the payload for 12c/ATM. (See Setup for ATM Testing, page 18–7.)

2. On the test operation screen, use FIELD and VALUE to set the transmit timing source (STSN: TxC1k>) as desired. This parameter can be set to internal, loop timing, or external timing sources.

3. Press CONFIG-right to display the Control Screens menu.

4. Select ATM Setup from the Control Screens menu and then press CONFIG-right. The first STS-12c ATM setup screen is displayed.

5. Set cell scrambling on or off, and then set the display notation for circuit and path addresses to either decimal or hexadecimal.

6. Press CONFIG-right. The second STS-12c ATM setup screen is displayed.

7. Set the bandwidth percentage for the transmit channel (TxBW>) and then activate the transmit channel (Enable>On).

8. Next set the payload for the transmit channel cells (Active Cell Data>) and the idle cells (Idle Cell Data>).

9. If you selected the user-programmable pattern (32-bit Prog) for the transmit channel data, program the pattern in hexadecimal (32 Bit Pattern>).
ATM Network Testing

Setup for STS-12c ATM Testing

10. Press CONFIG-right. The third STS-12c ATM setup screen is displayed.

<table>
<thead>
<tr>
<th>$\text{Tx Hdr:}$</th>
<th>$\text{GFC}$</th>
<th>$\text{VPI}$</th>
<th>$\text{VCI}$</th>
<th>$\text{PT}$</th>
<th>$\text{CLP}$</th>
</tr>
</thead>
<tbody>
<tr>
<td>$\text{Idle Hdr:}$</td>
<td>$\text{01}$</td>
<td>$\text{0001}$</td>
<td>$\text{000}$</td>
<td>$\text{0}$</td>
<td></td>
</tr>
<tr>
<td>$\text{Rx Chan:}$</td>
<td>$\text{01}$</td>
<td>$\text{0001}$</td>
<td>$\text{---}$</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

11. Configure the cell header for the transmit channel (Tx Hdr), setting each of the header fields as appropriate (GFC, VPI, VCI, PT, and CLP).

12. Next configure the GFC, PT, and CLP for the idle cell headers, if desired.

13. Configure the VP/VC address for the receive channel (Rx Chan: VPI and VCI). This is the address the test set uses to make “selected VP/VC” measurements.

14. Press CONFIG-right to return to the test operation display.

- You are now ready to run the test. See Run the ATM Test, page 18–21.

**Note:** You can go back to the other ATM screens by pressing CONFIG-left.
Run the ATM Test

- After you have configured the ATM foreground and background channel parameters you are ready to begin the test.

1. Press START to begin testing. On the first line of the display the elapsed time begins to increment.

```
1 STS1-STS1 (ATM) Elapsed:00:00:28.00
ATM Measurement Summary
Valid Cell Delineation: ON
Selected UP/UC Cell Rcv'd: ON
Total Active BW (Hz), Avg: 22,392,484
Rx UP/UC BW (Hz), Avg: 5,460,387
```

```
STS1: TxC1k>Int Scramble>On
Tx>STSX1 Rx>STSX1
Err: Type>ATM Pyld Rate>Off
```

2. If you want to inject ATM errors use FIELD and VALUE to select an ATM error type in the Err: Type> field, and to choose an appropriate injection rate (Rate>).

3. Press ERROR INJECT to inject the errors.

4. Use the RESULT keys to scroll through different measurements on the upper half of the display.

5. To inject bursts of ATM cells, access the Foreground Channel Control screen and use the ACTION key to trigger the bursts. See Configure the ATM Foreground Channel (no traffic shaping), page 18–11.

6. To end the test, press STOP.
ATM Network Testing
ATM Traffic Selection 19–2
Global ATM Parameters (ATM SETUP #1) 19–4
   About Cell Transmission 19–2
Foreground Channel Control Parameters (ATM SETUP #2) 19–6
Cell Payload Parameters (ATM SETUP #3) 19–12
Header Setup Parameters and Receive Cell Type
   (ATM SETUP #4) 19–13
Background Channel Control Parameters (ATM SETUP #5) 19–17
Background Payload Data Parameters (ATM
   SETUP #6—traffic shaping on) 19–19
Background Header Setup Parameters
   (ATM SETUP #6—traffic shaping off;
   ATM SETUP #7—traffic shaping on) 19–20
Misinserted Cell Error Control Parameters
   (ATM SETUP #7—traffic shaping off; ATM
   SETUP #8—traffic shaping on) 19–21
STS-12c ATM Parameters 19–22
ATM Error Injection 19–23

ATM Configuration Reference
ATM Traffic Selection

The type of ATM traffic to be tested is determined by the **Payload** selection on the Terminal or Monitor testing setup screen (Terminal mode is shown here):

```
TERMINAL TESTING

Tx Rate: STS1/OC1  Rx Rate: STS1/OC1
Payload: STS1/ATM

Select Tx and Rx Rates first
then select payload.
Press MENU-dn to enter test mode.
Press MENU-up to return to Main Menu.
```

The **Tx Rate**, **Rx Rate**, and **Payload** fields must be set as described below (for Monitor modes the rates are set together):

**OC12–OC12 12c/ATM:** For testing ATM on STS-12c signals.

**STS1/OC1–STS1/OC1 STS1/ATM:** For testing ATM on STS-1 electrical signals or OC-1 optical signals.

**All Other Rates:** ATM can be performed on the lowest rate signal indicated in the **Payload** selection. For example in a OC12–OC3 DS3 test setup, ATM testing is available on the DS3 signal. To use the ATM capability, the **Data** field must be set to ATM on the test operation screen (press MENU-down from the test setup screen).

About Cell Transmission

The primary test channel is the foreground channel. You specify the service type (CBR or VBR), the bandwidth used by this channel, and the transmission method. The remaining bandwidth can be either idle cells or as many as four different background AAL channels. The bandwidth that is not assigned to the foreground channel is divided evenly among the active background channels. OAM cells can be inserted on the foreground or background channels.
The ATM Setup Menu

The ATM Setup menu provides access to the ATM test modes and setup screens. When ATM Setup is selected from the Control Screens menu, the following menu is displayed:

```
ATM Standard Active

Standard
VPI/VCI Scan
Transfer Delay
Inter Arrival Time
Cell Capture
```

The first line: This line indicates which ATM mode is active. The active mode is the mode that was last selected from this menu. Each mode is described below (for information selecting the test mode see Choose an ATM Test Mode, page 18–8):

**Standard**: This mode is for performing BERT or cell-loss measurements. Background channels are enabled in this mode (see Bandwidth Step Size, page 19–4).

**Transfer Delay**: This mode is for performing cell transfer delay measurements. The foreground channel uses only test cells (see Foreground Channel Type, page 19–8), OAMs and background channels are disabled.

**Inter Arrival Time**: This mode is for performing inter-cell arrival time measurements. The foreground channel uses only test cells (see Foreground Channel Type, page 19–8), OAMs and background channels are disabled.

- For information on using the VPI/VCI Scan, see Run an Automatic VP/VC Scan, page 18–2.
- For information on using Cell Capture, see Run a Cell Capture Test, page 18–4.
Global ATM Parameters (ATM SETUP #1)

The ATM Global Setup screen is accessed by selecting an ATM test mode from the ATM Setup menu.

*Cell Scrambling* > switches the ATM cell payload scrambler **On** or **Off**. Cell scrambling is used to guard against the payload information mimicking the SONET scrambling sequence, which could result in an excess zeros condition.

*Circuit/Path Notation* > selects the display notation for the VP/VC address information on the ATM setup screens. **Hex** sets hexadecimal notation; **Decimal** sets decimal notation.

*Traffic Shaping* > (Not available for STS-12c) switches the traffic shaping feature on and off.

**Off**: Traffic shaping is not used. Foreground channel is CBR.

**Basic**: Traffic shaping is active. The foreground channel can be set to VBR, and the PCR, SCR, and MBS parameters are used to define the "leaky bucket" algorithm. See *Leaky Bucket Algorithm*, page 19-7.

*Bandwidth Step Size* > (Not available for STS-12c) selects how the bandwidth is defined for the foreground channel (see *Foreground Channel Bandwidth*, page 19-6). **BW Step Size** can be set as follows:

- **10% with Bkgnd AALs**: The foreground bandwidth is set in increments of 10 percent. Background ATM channels are enabled in this mode (only available when Test Mode is set to **Standard**).
- **2% with no Bkgnd AALs**: The foreground bandwidth is set in increments of 2 percent, however background ATM channels are **disabled**. This is the only selection when Test Mode is set to **Cell Transfer Delay** or **Cell Inter Arrival Time** (see next page).
ATM Configuration Reference

Global ATM Parameters (ATM SETUP #1)

**DS0/TS (56k) Line Rate:** Sets the foreground bandwidth to a nominal rate of about 63 kHz. This corresponds to an ATM data rate of about 56 kHz, plus associated overhead.

**DS0/TS (64k) Line Rate:** Sets the foreground bandwidth to a nominal rate of about 72 kHz. This corresponds to an ATM data rate of about 64 kHz plus associated overhead.

**DS1 Line Rate:** Sets the foreground bandwidth to a nominal rate of about 1.53 MHz. This corresponds to an ATM data rate of about 1.54 MHz minus the associated overhead.

**E1 TS0/16 Line Rate:** Sets the foreground bandwidth to a nominal rate of about 1.92 MHz. This corresponds to an ATM data rate of about 2.04 MHz minus the associated TS0/16 overhead.

**E1 TS0 Line Rate:** Sets the foreground bandwidth to a nominal rate of 1.98 MHz. This corresponds to an ATM data rate of about 2.04 MHz minus the associated TS0 overhead.

**DS3 HEC Line Rate:** Sets the foreground bandwidth to a nominal rate of 44.08 MHz. This corresponds to an ATM data rate of about 44.73 MHz minus the associated overhead.

**STS1 Line Rate:** Sets the foreground bandwidth to a nominal rate of 48.20 MHz. This corresponds to an ATM data rate of about 51.84 MHz minus the associated overhead.

**DS3 Cell Mapping**

(Available for DS3 only) **Cell Delineation** sets how the ATM cells are mapped to the DS3 signal:

- **HEC:** Cells are mapped with HEC-based cell delineation.
- **PLCP:** ATM traffic is mapped into 125 μs PLCP frames carried on the DS3 signal.
Forefront Channel Control Parameters (ATM SETUP #2)

The ATM Foreground Channel Control is accessed by pressing CONFIG-right after configuring the Global Setup screen.

When Traffic Shaping is set to Off (see Traffic Shaping, page 19-4), the display appears as follows:

```
<ATM SETUP #2: Fgnd Channel Control>
SNR:100% Type:AAL0
Distribution:Continuous
Cells Per Burst:100 Period:0.0 Sec
OAM:Enable:Off Type:F5 >AIS >End
>>>Press ACTION to send Single Burst<<<
```

When Traffic Shaping is set to Basic, the display appears as follows:

```
<ATM SETUP #2: Fgnd Channel Control>
PCR:100% SCR:810% MBS:8100
Service Type:CER AAL Type:AAL1
Distribution:Continuous Period:0.1 Secs
OAM:Enable:Off Type:F5 >AIS >End
>>>Press ACTION to send Single Burst<<<
```

**Forefront Channel Bandwidth**

**BW**: sets the bandwidth used by the transmit foreground channel and can be set from 000% through 100% in increments of either 10% or 2% (5% for STS-12c, see page 19-22). See Bandwidth Step Size, page 19-4. This field is available when 10% or 2% is selected for BW Step Size, and when traffic shaping is off.

**Line Increment**: This field adjusts the selected “Line Rate” bandwidth. The bandwidth can be adjusted up or down by about 3 percent in 10 steps (-5 through +5) or set to Nominal (no adjustment). This field is only available when BW Step Size is set to a Line Rate selection. See Bandwidth Step Size, page 19-4.

**Note**: Bandwidth that is not assigned to the foreground channel is used by the background channels or idle cells. Foreground cells are interleaved with the idle or background cells to achieve the specified bandwidth (see ATM Foreground Cell Interleaving, page 19-10).
Foreground Channel Control Parameters (ATM SETUP #2)

VBR Traffic Profile

(Traffic shaping on) The **PCR**, **SCR**, and **MBS** fields define the VBR traffic profile. These fields are used to calculate the "leaky bucket" algorithm when **Service Type** is set to **VBR**.

**PCR**: Peak Cell Rate. The maximum bandwidth that can be used by the VBR traffic.

**SCR**: Sustained Cell rate. The nominal average bandwidth used by the VBR traffic.

**MBS**: Maximum Burst Size. The maximum number of cells that can be transmitted in a single burst of the VBR traffic.

Service Type

(Traffic shaping on) **Service Type** determines whether the traffic is constant or variable bit rate.

**CBR**: Constant Bit Rate. Uses only the PCR value to set the transmit bandwidth.

**VBR**: Variable Bit Rate. Uses the PCR, SCR, and MBS fields to calculate the "leaky bucket" algorithm (see figure below).

---

Leaky Bucket Algorithm

![Leaky Bucket Algorithm Diagram]

- **Bandwidth**
- **PCR**
- **SCR**
- **MBS**
- **Time**
Forefront Channel Type

The **Type>** or **AAL Type>** field selects the ATM adaptation layer (AAL) protocol used for the foreground channel. **Type>** can be set to the following:

- **AAL0**: A constant bit rate (CBR) cell with a standard header and 48 bytes of user-definable payload. This type is only available when **Test Mode>** is set to **Standard**.

- **AAL1**: A CBR cell with standard header, one byte for sequence check (SC) and 47 bytes of user-definable payload. This type is only available when **Test Mode>** is set to **Standard**.

- **Test Cell**: A special CBR cell with a standard header, a 32-bit time stamp, and 44 bytes of user-definable payload (see **Test Cell Structure**, page 19–15). This type is used for cell delay testing. **Type>** is automatically set to **Test Cell** for **Cell Transfer Delay** or **Cell Inter Arrival Time** test mode (see The ATM Setup Menu, page 19–3).

Foreground Channel Distribution

**Distribution>** sets the cell interleaving mode for the foreground channel. This parameter can be set as follows:

- **Continuous**: The foreground channel is transmitted continuously, interleaved at the selected bandwidth (**BW>**). See **Foreground Channel Bandwidth**, page 19–6.

- **Single Burst**: A single burst of cells is transmitted, interleaved at the selected bandwidth, when the ACTION key is pressed. The number of cells in the burst is defined by **Cell Per Burst>** (see below). This selection is not available when **Test Mode>** is set for **Cell Transfer Delay** or **Cell Inter Arrival Time**.

**Note**: The **Single Burst** function only works when this screen is displayed.

- **Periodic Burst**: A single burst of cells is transmitted repeatedly at user-specified intervals. The number of cells in the burst is defined by **Cells Per Burst>**. The time interval between bursts is defined by **Period>** (see below). See ATM Periodic Burst Transmission Mode, page 19–10. This selection is not available when **Test Mode>** is set for **Cell Transfer Delay** or **Cell Inter Arrival Time**.

- **Off**: No foreground channel cells are transmitted.
ATM Configuration Reference

Foreground Channel Control Parameters (ATM SETUP #2)

**Burst Size**  
**Cells Per Burst**: defines the number of cells transmitted when a foreground channel single or periodic burst is activated. The numbers of cells can be set from 000 through 512.

**Note:** For DS3 ATM, if the bandwidth (BW) is set for 2% or 4% do not set a burst size higher than 200 or 400 cells, respectively.

**Burst Period**  
**Period**: sets the interval between periodic cell burst transmissions. For example, if Period is set to 5.0, a cell burst (as defined by BW and Cells Per Burst) is activated every 5 seconds. Period can be set from 0.0 through 9.9 seconds in 0.1 second increments. See ATM Periodic Burst Transmission Mode, page 19–10.

**Note:** If you set Period to 0.0, no periodic bursts are transmitted.
ATM Configuration Reference
Foreground Channel Control Parameters (ATM SETUP #2)

ATM Foreground Cell Interleaving

Foreground channel interleaved with idle or background cells

Foreground channel bandwidth = 100%

Foreground channel bandwidth = 50%
Background channels all turned OFF

Foreground channel bandwidth = 20%
Background channels all turned ON

ATM Periodic Burst Transmission Mode

Elapsed time between periodic bursts set by Period>

Foreground channel inter-cell gap set by BW>

N = Number of cells in each burst, set by Cells Per Burst>

Remaining time in period filled with idle or background cells

19-10
OAM Cell Parameters

The **OAM**: parameters control the generation of OAM cells on the foreground channel. Note that OAM parameters are only available when **Distribution** is set to **Continuous** and the **Test Mode** is set to **Standard**. OAM functions are not available for STS-12c ATM.

OAM Enabling

The **Enable** field turns foreground OAM generation **On** or **Off**. When this field is set to **On**, OAM cells are inserted on the transmit foreground channel.

OAM Type

The three **Type** fields determine the format of the OAM cells inserted when **Enable** is set to **On**. The OAM type fields are as follows:

- **Flow**: Sets the OAM flow to **F4** (for VCs), **F5** (for VPs), or **F4&F5** (both types are generated).
- **Alarm function**: Sets the function of the generated OAM cell to either **AIS** (alarm indication signal), **RDI** (remote defect indication), or **AIS&RDI** (both).
- **Payload type**: Sets whether the OAM cell applies to the entire path (**End** = end-to-end) or only to the segment (**Seg**).

OAM Cell Transmission

When OAM insertion is active (**OAM:Enable** is **On**) the set inserts OAM cells on the transmit foreground channel at an average rate of approximately ten OAM cells each second. This rate is maintained for each active OAM cell type. The different types of cells are inserted in the following order:

1. F4 AIS
2. F4 RDI
3. F5 AIS
4. F5 RDI

OAM cell insertion will not be less than one OAM cell each second and not more than 1% of the transport capacity.
Cell Payload Parameters (ATM SETUP #3)

The setup screen for STS-12c ATM is different. See STS-12c ATM Parameters, page 19–22.

The ATM Cell Payload Data setup screen is accessed by pressing CONFIG-right from the Foreground Channel Control screen.

```
<ATM SETUP #3: Cell Payload Data>
Fgnd Data>2^15-1
Idle Cell Data>00
32-Bit Fgnd Pattern>12345678
32-Bit Bknd Pattern>9ABCDEF0
```

Foreground Cell Payload

- **Fgnd Data>** sets the foreground payload pattern that is sent on the transmit ATM stream, and is compared with the receive ATM stream for bit error measurements. **Fgnd Data>** can be set to the following:

  - $2^{15}-1$, $2^{20}-1$, $2^{23}-1$: PRBSs ($2^{15}-1$ is a $2^{15}-1$ PRBS).
  - **1010**: A repeating pattern of alternating ones and zeros (1010...).
  - **1100**: Repeating pattern of two ones alternating with two zeros (1100...).
  - **Live**: Live traffic pass-through.
  - **All 1s**: A continuous all-ones pattern (1111...).
  - **All 0s**: A continuous all-zeros pattern (0000...).
  - **32-Bit Prog**: Repeating pattern set by **32-Bit Fgnd Pattern>** (below).

Idle Cell Payload

- **Idle Cell Data>** sets the payload for the transmit idle cells. This parameter can be set from 00 through FFhexadecimal. The binary equivalent of this value is repeated to fill the cell payload.

User-defined ATM Patterns

- The **32-Bit Fgnd Pattern>** and **32-Bit Bknd Pattern>** fields define the user ATM patterns for the foreground and background streams. Each of the eight digits can be set from 0 through F (hex). The binary equivalent of the hex value forms the 32-bit binary pattern. The appropriate pattern is used when **Fgnd Data>** or background **Data>** is set to **32-Bit Prog**.

**Note:** When traffic shaping is on, the background cell payloads are defined on the Background Payload Data screen. Chapter 19, **Background Payload Data Parameters (ATM SETUP #6—traffic shaping on)**.
Header Setup Parameters and Receive Cell Type (ATM SETUP #4)

The ATM Header Screen is accessed by pressing CONFIG-right after configuring the Cell Payload Data setup screen.

<table>
<thead>
<tr>
<th>&lt;ATM SETUP #4&gt;</th>
</tr>
</thead>
<tbody>
<tr>
<td>GFC</td>
</tr>
<tr>
<td>Fgnd Hdr:</td>
</tr>
<tr>
<td>Idle Hdr:</td>
</tr>
<tr>
<td>Rx Chan:</td>
</tr>
<tr>
<td>Rx Cell Type&gt;</td>
</tr>
</tbody>
</table>

Cell Header Types

The following three types of cell headers can be defined on the 156MTS. Header fields that are displayed as "---" cannot be edited. See Cell Header Parameters, page 19-14, for a description of the header fields.

**Fgnd Hdr:** Foreground channel header. Configures the cell header parameters for the foreground transmit channel.

**Idle Hdr:** Idle cell header. Configures the cell header parameters for the transmitted idle cells. The VPI and VCI are always set to zero.

The idle cells are true idle cells if the CLP is set to 1. The idle cells are *unassigned* cells if the CLP is set to 0.

**Rx Chan:** Receive channel header. Configures the VP/VC address for the receive channel. Received cells with VP/VC addresses matching Rx Chan are used to calculate measurements based on "Selected VP/VC" (OAM cells are not counted).
ATM Configuration Reference

Header Setup Parameters and Receive Cell Type (ATM SETUP #4)

**Cell Header Parameters**

*ATM Cell Header Structure*, page 19–15 shows the parts of the header.

**GFC**: Generic Flow Control. Sets the first four bits of the cell header. This parameter can be set from 0 through F (hexadecimal). GFC is not editable for Rx Chan.

**VPI**: Virtual Path Identifier. Sets bits 5 through 12 of the cell header. The VPI is part of the cell address and can be set from 00 through FF (hexadecimal) or 000 through 255 (decimal). VPI is not editable for IdleHdr (idle VPI = 000).

**VCI**: Virtual Channel Identifier. Sets bits 13 through 28 of the cell header. The VCI is part of the cell address and can be set from 0000 through FFFF (hexadecimal) or 00000 through 65535 (decimal). VCI is not editable for IdleHdr (idle VCI = 0000).

Note that a VCI value of 0003 or 0004, indicates that the cell is an OAM cell. If you use a PRBS or all-zeros pattern while transmitting a stream of “OAM” cells, you can cause inadvertant OAM alarms.

**PT**: Payload Type. Sets bits 29 through 31 of the cell header. The payload type field can be set from 000 through 111 (binary). PT is not editable for Rx Chan.

Note that a PT value of 1XX, where X is any value, indicates that the cell is an OAM cell. If you use a PRBS or all-zeros pattern while transmitting a stream of “OAM” cells, you can cause inadvertant OAM alarms.

**CLP**: Cell Loss Priority. Sets bit 32 of the cell header. CLP can be set to either 1 or 0 (binary). 1 indicates that the cell can be discarded during heavy cell traffic conditions. CLP is not editable for Rx Chan.
ATM Configuration Reference

Header Setup Parameters and Receive Cell Type (ATM SETUP #4)

ATM Cell Header Structure

53-byte ATM Cell

Cell Header

Information Bytes

Byte 1 2 3 4 5 6 53

GFC: Generic Flow Control

VPI: Virtual Path Identifier

VCI: Virtual Channel Identifier

PT: Payload Type

CLP: Cell Loss Priority

HEC: Header Error Control sequence

Test Cell Structure

53-byte ATM Cell

Cell Header

Time Stamp

Payload

Byte 1 5 6 7 8 9 53

5-Byte Header

4-Byte Time Stamp

44-Byte Payload
Rx Cell Type - sets the ATM adaptation layer protocol for the receive channel. This parameter can be set as follows:

**Note:** The AAL selections are only available in Standard ATM test mode (see page 19-3).

**AAL0:** Received cells are constant bit rate (CBR) cells with a standard header and 48 bytes of payload.

**AAL1:** Received cells are constant bit rate (CBR) cells with a standard header, one byte for sequence check (SC), and 47 bytes of payload.

**AAL3/4:** Received cells use AAL-3/4 segmenting (with cell-based and packet-based CRC).

**AAL5:** Received cells use AAL-5 segmenting (with packet-based CRC).

**Test Cell:** Received cells are time-stamped CBR cells with a standard header, four bytes for the time stamp, and 44 bytes of payload (see Test Cell Structure, page 19–15). Rx Cell Type - is automatically set to this selection in the Cell Transfer Delay or Cell Inter Arrival Time test modes (see page 19–3).

**Note:** BER measurements can be performed on the receive pattern when Rx Cell Type - is set to Test Cell, as long as the received cells match the test cell format.

**Note:** For inter-arrival measurements, the received cells can be any type, as long as the VP/VC address matches the Rx Chan.
Background Channel Control Parameters (ATM SETUP #5)

The Background Channel Control screen is accessed by pressing CONFIG-right from the Header Setup screen (ATM SETUP #4).

When Traffic Shaping is set to Off, the screen appears as follows:

```
<ATM SETUP #5: Tx Bkgnd Channel Control>
Type>AAL5
Data>All 0s
Enable: 1>Off 2>Off 3>Off 4>Off
0AM:Enable>Off Type>F5 >AIS >End
```

When Traffic Shaping is on, the screen appears as follows:

```
<ATM SETUP #5: Tx Bkgnd Channel Control>
Enable: 1>Off 2>Off 3>Off 4>Off
Service Type 1>CBR 2>CBR 3>CBR 4>CBR
AAL Type: 1>AAL5 2>AAL5
3>AAL5 4>AAL5
0AM:Enable>Off Type>F5 >AIS >End
```

Note: Background channel parameter screens are not available when BW Step Size is set to 2% with no Bkgnd AALs (see Bandwidth Step Size, page 19-4).

**Background Channel Activation**

Enable: 1> through 4> controls transmission of each of the four background channels. A channel set to On is transmitted; a channel set to Off is not transmitted. If Type> is set to Idle (traffic shaping off only), no background channels are transmitted regardless of their Enable setting.

**Background Service Type**

Service Type: 1> through 4> sets the type of service for each of the background channels. Each can be set to either CBR (constant bit rate) or VBR (variable bit rate). Not available when traffic shaping is off.
Background Cell Type

For AAL-3/4 and AAL-5, the set transmits a 500 cell packet with appropriate internal CRC, and so forth.

The **Type** or **AAL Type** field sets the ATM adaptation layer protocol used by the background channels. **Type** can be set as follows:

- **AAL3/4**: Cells use AAL-3/4 segmenting (with cell-based CRC).
- **AAL5**: Cells use AAL-5 segmenting (with packet-based CRC).

**Idle**: (Traffic shaping off only) Background channels are disabled. Only idle cells are transmitted in non-foreground bandwidth, regardless of the **Enable** field settings.

Background Cell Payload

When traffic shaping is off, the **Data** field is available and sets the payload for all the background channel cells as follows:

- **All 1s**: A continuous all-ones pattern (1111...).
- **All 0s**: A continuous all-zeros pattern (0000...).
- **32-Bit Prog**: A repeating pattern defined by the **32-Bit Bkgnd Pattern** field (see *User-defined ATM Patterns*, page 19–12).

OAM Cell Parameters

The **OAM**: parameters control the generation of OAM cells on the background channels. Note that background OAM parameters are only available when at least one background channel is enabled (**On**).

**OAM Enabling**

The **Enable** field turns background OAM generation **On** or **Off**. When this field is set to **On**, OAM cells are inserted on all active background channels.

**OAM Type**

The three **Type** fields determine the format of the OAM cells inserted when **Enable** is set to **On**. The OAM type fields are as follows:

- **Type** → **flow** → **alarm function** → **payload type**

**Flow**: Sets the OAM flow to **F4** (for VCs), **F5** (for VPs), or **F4 & F5** (both types are generated).

**Alarm function**: Sets the function of the generated OAM cell to either **AIS** (alarm indication signal), **RDI** (remote defect indication), or **AIS & RDI** (both).

**Payload type**: Sets whether the OAM cell applies to the entire path (**End** = end-to-end) or only to the segment (**Seg**).
OAM Cell Transmission

When OAM insertion is active (OAM: Enable > On) the set inserts OAM cells on the transmit background channels at an average rate of approximately five OAM cells each second on every channel. This rate is maintained for each active OAM cell type. The different types of cells are inserted in the following order:

1. F4 AIS
2. F4 RDI
3. F5 AIS
4. F5 RDI

For each background channel OAM cell insertion will not be less than one OAM cell each second and not more than 1% of the transport capacity.

---

Background Payload Data Parameters
(ATM SETUP #6—traffic shaping on)

When the traffic shaping feature is on, the background channel payloads are set on this screen. This screen is not displayed when traffic shaping is off.

```
<ATM SETUP #6: Tx Bkgnd Payload Data>
Data  32-bit Pattern
1>32-Bit Prog >9ABCDEF0
2> All 1s >9ABCDEF0
3> All 0s >9ABCDEF0
4>32-Bit Prog >9ABCDEF0
```

The Data 1> through 4> fields control the payload pattern for each the four background channels individually. Each channel’s payload can be set to one of the following:

**32-Bit Prog:** The user-defined programmable pattern. Enter the pattern in hexadecimal on the right side of the screen.

**All 1s:** A repeating all-ones pattern

**All 0s:** A repeating all-zeros pattern.
Background Header Setup Parameters
(ATM SETUP #6—traffic shaping off;
ATM SETUP #7—traffic shaping on)

The ATM Transmit Background Header setup screen is accessed by pressing CONFIG-right after configuring the Background Channel Control or Background Payload Data screen.

<table>
<thead>
<tr>
<th>Hdr 1</th>
<th>Hdr 2</th>
<th>Hdr 3</th>
<th>Hdr 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 02 0001 000 0</td>
<td>0 03 0001 000 0</td>
<td>0 04 0001 000 0</td>
<td>0 05 0001 000 0</td>
</tr>
</tbody>
</table>

When traffic shaping is off, this is ATM Setup screen #6; when traffic shaping is on, this is screen #7.

**Note:** Background channel parameter screens are not available when **BW Step Size** is set to 2% with no Bkgnd AALs (see Bandwidth Step Size, page 19–4).

**Hdr1 through Hdr4:** These fields determine the cell headers for each of the transmit background channels. The header is used when the corresponding background channel is enabled (see Background Channel Activation, page 19–17).

For information on the cell header fields, see Cell Header Parameters, page 19–14.
Misinserted Cell Error Control Parameters
(ATM SETUP #7—traffic shaping off; ATM SETUP #8—traffic shaping on)

When traffic shaping is off, this is ATM Setup screen #7; when traffic shaping is on, this is screen #8.

The ATM Misinserted Cell Error Control screen is accessed by pressing CONFIG-right after configuring the Background Header Setup screen.

```
<ATM SETUP #7: Misinsert Cell Err Cnt1>
Period> 3.1 Sec
Data> All Is
32-bit Pat> ABCDEFF01
```

- **Period** > set s how often a misinserted cell is injected when the error inject rate is set to **Periodic**. This field can be set from 0.0 through 9.9 seconds.

- **Data** > sets the payload pattern of the misinserted cells. This field can be set as follows:
  - All 1s: A repeating all-ones pattern.
  - All 0s: A repeating all-zeros pattern.
  - 32-Bit Prog: The user-defined programmable pattern. Enter the pattern in hexadecimal in the 32-bit Pat> field.

**Injecting Misinserted Cells**

The Misinserted Cell Error Control screen configures the injection of misinserted cells on the transmit ATM stream. To inject misinserted cells, set **Err: Type** > to **Misins Cell** and then set **Rate** > to **Single**, **Periodic**, or **Off**. Misinserted cells are injected when you press the ERROR INJECT key.

```
STSI: TxClk>Int, Scramble>On
Tx>STSI
Rx>STSI1
Err: Type>Misins Cell, Rate>Periodic
```
STS-12c ATM Parameters

For ATM on STS-12c signals, three configuration screens are used:

\[
\begin{align*}
\text{<STS-12c ATM SETUP #1>}
\text{Cell Scramble}> & \text{On} \\
\text{Path/Circuit Notation}> & \text{Hex}
\end{align*}
\]

\[
\begin{align*}
\text{<STS-12c ATM SETUP #2>}
\text{TxBW}> & \text{050B} \\
\text{Enable}> & \text{On} \\
\text{Active Cell Data}> & \text{2^31-1} \\
\text{Idle Cell Data}> & \text{00} \\
\text{32 Bit Pattern}> & \text{12345678}
\end{align*}
\]

\[
\begin{align*}
\text{<STS-12c ATM SETUP #3>}
\text{GFC UPI UCI PT CLP}
\text{Tx Hdr}: & \text{0 01 0001 000 0} \\
\text{Idle Hdr}: & \text{-- ----- 000 0} \\
\text{Rx Chan}: & \text{-- 01 0001 --- --}
\end{align*}
\]

These parameters are the same as for other ATM modes. Use the table below to find the sections where the parameters are described.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cell Scramble&gt;</td>
<td>See <em>Cell Scrambling</em>, page 19-4.</td>
</tr>
<tr>
<td>Path/Circuit Notation</td>
<td>See <em>Address Notation</em>, page 19-4.</td>
</tr>
<tr>
<td>TxBW&gt;</td>
<td>See <em>Foreground Channel Bandwidth</em>, page 19-6.</td>
</tr>
<tr>
<td>Enable&gt;</td>
<td>Turns ATM transmission <em>On</em> or <em>Off</em>.</td>
</tr>
<tr>
<td>Active Cell Data&gt;</td>
<td>See <em>Foreground Cell Payload</em>, page 19-12.</td>
</tr>
<tr>
<td>Idle Cell Data&gt;</td>
<td>See <em>Idle Cell Payload</em>, page 19-12.</td>
</tr>
<tr>
<td>32 Bit Pattern</td>
<td>See <em>User-defined ATM Patterns</em>, page 19-12.</td>
</tr>
<tr>
<td>Tx Hdr, Idle Hdr, Rx Chan</td>
<td>See <em>Cell Header Types</em>, page 19-13, and <em>Cell Header Parameters</em>, page 19-14.</td>
</tr>
</tbody>
</table>
ATM Error Injection

ATM errors can be injected when the payload is set for ATM. Some error types apply specifically to ATM, but other non-ATM error types can affect the ATM stream or PLCP frame as well (see ATM-Affecting Error Types, page 19–24).

Note: For information on injection rates, see About Error Injection Rates, page 27–7.

HCS Byte: Causes header error control (HEC) field errors by inverting the HEC byte of every transmitted cell on every channel. Note that this effect causes loss of cell synchronization (LOCS). Rates: Off, Continuous (STS-3c); Single, 6 Consec, 7 Consec, 8 Consec, Continuous, Off (STS-12c).

HCS Bit: Generates bit errors in the ATM cell header checksum field. Rates: Off, Continuous.

ATM Pyld: Generates bit errors in the payload of the ATM cells. Rates: Single, 1.0E-3, 1.0E-6, Off (non STS-12c modes); Single, 1.0E-2 through 1.0E-9, Burst, Off (STS-12c).


SN CRC/Par: (AAL-1 only) Generates sequence number CRC/parity error. Rates: Off, Single.

Misins Cell: (AAL-1 only) Generates misinserted cells. Rates: Off, Single, Periodic.

PLCP B1 Bit: (PLCP only) Generates bit errors in the PLCP frame’s B1 byte. Rates: Off, Continuous.

PLCP FEBE Bit: (PLCP only) Generates bit errors in the PLCP frame’s FEBE field (bits 1–4 of the G1 byte). Rates: Off, Continuous.


PLCP POI: (PLCP only) Generates errors in the Path Overhead Indicator (P) bytes of the PLCP frame. Rates: Off, Continuous.
**ATM Configuration Reference**

**ATM Error Injection**

ATM-Affecting Error Types

The following table lists error injection types for ATM modes, and indicates which types affect the ATM cell stream or PLCP frame.

<table>
<thead>
<tr>
<th>Error Type</th>
<th>ATM Specific</th>
<th>Affects ATM or PLCP</th>
</tr>
</thead>
<tbody>
<tr>
<td>HCS Byte</td>
<td>✓</td>
<td>No</td>
</tr>
<tr>
<td>HCS Bit</td>
<td>✓</td>
<td>No</td>
</tr>
<tr>
<td>ATM Pyld</td>
<td>✓</td>
<td>No</td>
</tr>
<tr>
<td>Loss of Cell</td>
<td>✓</td>
<td>No</td>
</tr>
<tr>
<td>SN CRC/Par</td>
<td>✓</td>
<td>No</td>
</tr>
<tr>
<td>Misins Cell</td>
<td>✓</td>
<td>No</td>
</tr>
<tr>
<td>REI-P or REI-L (FEBE)</td>
<td></td>
<td>No</td>
</tr>
<tr>
<td>Section BER, Line BER, or Path BER</td>
<td></td>
<td>No</td>
</tr>
<tr>
<td>B1 Byte, B2 Byte, or B3 Byte</td>
<td></td>
<td>No</td>
</tr>
<tr>
<td>H Pointer</td>
<td></td>
<td>No†</td>
</tr>
<tr>
<td>A1/A2 Frame</td>
<td></td>
<td>No†</td>
</tr>
<tr>
<td>DS3 Data, DS3 Dat, Par</td>
<td></td>
<td>No</td>
</tr>
<tr>
<td>DS3 BPV</td>
<td></td>
<td>No</td>
</tr>
<tr>
<td>DS3 Frame</td>
<td></td>
<td>No†</td>
</tr>
<tr>
<td>PLCP B1 Bit</td>
<td>✓</td>
<td>No</td>
</tr>
<tr>
<td>PLCP FEBE Bit</td>
<td>✓</td>
<td>No</td>
</tr>
<tr>
<td>PLCP A1/A2 Bit</td>
<td>✓</td>
<td>No</td>
</tr>
<tr>
<td>PLCP POI</td>
<td>✓</td>
<td>No</td>
</tr>
</tbody>
</table>

† May affect ATM (or PLCP) if a Loss of Pointer or Loss of Frame condition results from injecting this type of error.
ATM Indicators  20–2
ATM Measurement Summary Screen  20–3
Selected VP/VC Measurement Screens  20–4
Total Cell Stream Measurement Screens  20–6
ATM Payload Bit Error Measurements Screen  20–9
ATM AAL-1 Cell Loss Measurements Screen  20–10
ATM AAL-1 SN CRC/Par Error Measurements Screen  20–11
ATM AAL-1 Misinserted Cell Measurements Screen  20–12
ATM Delay Measurements  20–13
ATM OAM Alarm Status  20–14
ATM OAM Alarm Seconds  20–15
PLCP Measurement Screens (DS3 only)  20–16
ATM Alarm Status  20–20
ATM Alarm Seconds  20–21

ATM Measurement Reference
### ATM Indicators

#### DS1 Alarm and Status Indicators

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>HIST/ALARMS</strong></td>
<td></td>
</tr>
<tr>
<td>LOCS</td>
<td>Loss of cell synchronization</td>
</tr>
<tr>
<td>SCNR</td>
<td>Selected cell not received</td>
</tr>
<tr>
<td>PLCP LOF</td>
<td>Loss of PLCP frame synchronization</td>
</tr>
<tr>
<td>PLCP YEL</td>
<td>PLCP Yellow alarm</td>
</tr>
<tr>
<td>VP-AIS</td>
<td>Virtual Path alarm indication signal (F5 OAM)</td>
</tr>
<tr>
<td>VP-RDI</td>
<td>Virtual Path remote defect indication (F5 OAM)</td>
</tr>
<tr>
<td>VC-AIS</td>
<td>Virtual Circuit alarm indication signal (F4 OAM)</td>
</tr>
<tr>
<td>VC-RDI</td>
<td>Virtual Circuit remote defect indication (F4 OAM)</td>
</tr>
<tr>
<td>LOPAT</td>
<td>Loss of cell payload pattern synchronization</td>
</tr>
<tr>
<td><strong>STATUS</strong></td>
<td></td>
</tr>
<tr>
<td>CELL SYNC</td>
<td>Cell synchronization achieved</td>
</tr>
<tr>
<td>CHNL MTCH</td>
<td>Selected Rx Chan cell type received</td>
</tr>
<tr>
<td>PAT SYNC</td>
<td>Cell payload pattern synchronization achieved</td>
</tr>
<tr>
<td>PLCP SYNC</td>
<td>PLCP frame synchronization achieved</td>
</tr>
<tr>
<td>ERRORS</td>
<td>ATM errors detected</td>
</tr>
</tbody>
</table>

20–2
ATM Measurement Summary Screen

For each screen, an “s” indicates Summary results level and a “d” indicates Detail level. See To Display More Measurement Screens, page 1–10.

PLCP is Physical Layer Convergence Protocol: a method for mapping ATM cells onto a DS3 facility. See PLCP Measurement Screens (DS3 only), page 20–16.

ATM Measurement Summary

Valid Cell Delineation or Valid PLCP Sync: ATM signal status: Displays On when a valid ATM signal is being received.
- For HEC-delineated ATM, the item is Valid Cell Delineation.
- For PLCP ATM (DS3 only), the item is Valid PLCP Sync (valid PLCP signal synchronization).

Selected VP/VC Cell Rec’d: Selected ATM channel status: Displays On when ATM cells are detected that match the VPI/VCI address set for the received channel. See Rx Chan, page 19–13.

Total Active BW (Hz), Avg: Average total active ATM bandwidth: The total average bandwidth used by all ATM traffic on the received signal, in Hertz.

Rx VP/VC BW (Hz), Avg: Average selected ATM channel bandwidth: The average bandwidth (in Hertz) used by the input ATM channel that matches the VP/VC setting for the received channel. See Rx Chan, page 19–13.

Note: F5 OAM cells (cells with a payload type value of 1xx) with a VP/VC address that matches the Rx Chan are not counted for “Selected VP/VC” measurements. OAM cells are only counted for “Total Cell Stream” measurements.
Selected VP/VC Measurement Screens

These two screens display measurements based on the selected receive channel (cells with VP/VC address matching the receive channel setting; See Rx Chan, page 19-13).

**Note:** When results relating to the selected VP/VC on the received channel are calculated, OAM cells (cells with a PT value of 1xx) with that address are not counted. OAM cells are only included in "Total Cell Stream" calculations.

**Screen #1**

This screen displays measurements relating to the bandwidth of the selected channel.

<table>
<thead>
<tr>
<th>Measurement</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>TR0 STS1 - STS1 (ATM)</td>
<td>00:11:13.91</td>
</tr>
<tr>
<td>Selected VP/VC Measurements</td>
<td></td>
</tr>
<tr>
<td>Rx BW (Hz), Avg:</td>
<td>7,771,430</td>
</tr>
<tr>
<td>Rx BW (%), Avg:</td>
<td>0.18</td>
</tr>
<tr>
<td>Rx BW (Hz), Current:</td>
<td>13,268,749</td>
</tr>
<tr>
<td>Rx BW (%), Current:</td>
<td>0.30</td>
</tr>
</tbody>
</table>

**Rx BW (Hz), Avg:** Average selected receive channel bandwidth in Hertz: The average bandwidth of the selected receive channel since the beginning of the test, in Hertz.

**Rx BW (%), Avg:** Average selected receive channel bandwidth percentage: The average percentage of total bandwidth used by the selected receive channel since the beginning of the test, as a value from 0 through 100%.

**Rx BW (Hz), Current:** Current selected receive channel bandwidth in Hertz: The average bandwidth of the selected receive channel for the previous 2.25 seconds, in Hertz.

**Rx BW (%), Current:** Current selected receive channel bandwidth percentage: The average percentage of total bandwidth used by the selected receive channel in the previous 2.25 seconds, as a value from 0 through 100%.
Screen #2

This screen displays measurements relating to cell counts on the selected channel.

```
1 STS1-STS1 (ATM) Final: 00:10:11.93
Selected VP/VC Measurements #2
Cell Count: 1.15E+06
Cells per Second, Avg: 18171
Cells per Second, Current: 31294
```

**Cell Count:** Selected receive channel cell count: The total number of cells received since the beginning of the test, in scientific notation.

**Cells per Second, Avg:** Average selected receive channel cell rate: The average number of cells received each second since the beginning of the test.

**Cells per Second, Current:** Current selected receive channel cell rate: The average number of cells received each second during the previous 2.25 seconds.
Total Cell Stream Measurement Screens

These three screens display measurements relating to the entire receive ATM cell stream.

Screen #1

This screen displays measurements relating to the bandwidth of the entire ATM cell stream.

<table>
<thead>
<tr>
<th>Measure</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active BW (Hz), Avg</td>
<td>25,794,068</td>
</tr>
<tr>
<td>Active BW (%)</td>
<td>0.56</td>
</tr>
<tr>
<td>Active BW (Hz), Curr</td>
<td>44,042,480</td>
</tr>
<tr>
<td>Active BW (%)</td>
<td>100</td>
</tr>
</tbody>
</table>

**Active BW (Hz), Avg:** Average active ATM bandwidth: The average bandwidth used by all ATM cells since the beginning of the test, in Hertz.

**Active BW (%), Avg:** Average active ATM bandwidth percentage: The average percentage of total bandwidth used by ATM since the beginning of the test. Result is a value from 0 through 100%.

**Active BW (Hz), Curr:** Current active ATM bandwidth: The average bandwidth used by all ATM cells during the previous 2.25 seconds, in Hertz.

**Active BW (%), Curr:** Current active ATM bandwidth percentage: The average percentage of total bandwidth used by ATM during the previous 2.25 seconds. Result is a value from 0 through 100%.
Screen #2

This screen displays measurements relating to errors in the header error control field on the entire ATM cell stream.

NonSTS-12c ATM

For ATM on rates other than STS-12c, this screen appears as follows:

```
1 STS1-STS1 (ATM) Final: 00:00:00.00
Total Cell Stream Measurements #2
HEC Error Count: 7
HEC Errors/Cell Ratio: 4.13E-07
```

HEC Error Count: Header error control field error count: The total number of HEC errors detected.

HEC Error/Cell Ratio: Header error control field error ratio: The ratio of HEC errors to the total number of cells.

STS-12c ATM

For STS-12c ATM, this screen appears as follows:

```
1 OC12-OC12(12cATM) Final: 00:00:00.00
Total Cell Stream Measurements #2
HCS Error Count (correctable): 6
HCS Error Count (uncorrectable): 4
Total Error Count: 10
HCS Errors/Cell Ratio: 4.16E-07
```

HCS Error Count (correctable): Correctable header checksum error count: The total number of correctable header error control (HEC) field errors. A correctable HCS error is defined as a HEC field in which a single bit is errored.

HCS Error Count (uncorrectable): Uncorrectable header checksum error count: The total number of uncorrectable HEC errors. An uncorrectable HCS error is defined as a HEC field in which two or more bits are errored.

Total Error Count: The total number of correctable and uncorrectable HEC errors.

HCS Errors/Cell Ratio: The ratio of HEC errors to the total number of cells received.
Screen #3

This screen displays measurements relating to cell counts on the entire ATM cell stream.

<table>
<thead>
<tr>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 STS1-STS1 (ATM) Final</td>
<td>00:01:07.66</td>
</tr>
<tr>
<td>Total Cell Stream Measurements #3</td>
<td></td>
</tr>
<tr>
<td>Cell Count:</td>
<td>7.01E+06</td>
</tr>
<tr>
<td>Cells per Second, Avg:</td>
<td>103875</td>
</tr>
<tr>
<td>Cells per Second, Current:</td>
<td>103874</td>
</tr>
</tbody>
</table>

**Cell Count:** Total ATM stream cell count: The total number of cells received since the beginning of the test, in scientific notation.

**Cells per Second, Avg:** Average total ATM stream cell rate: The average number of cells received each second since the beginning of the test.

**Cells per Second, Current:** Current total ATM stream cell rate: The average number of cells received each second during the previous 2.25 seconds.
ATM Payload Bit Error Measurements Screen

This screen displays BER measurements based on the foreground channel.

**Note:** In a loop test the foreground and receive channels must be set to the same AAL type, or else LOP or excessive bit errors will be detected. See *Foreground Channel Type*, page 19-8, and *Receive Cell Type*, page 19-16.

```
1 STS1-STS1 (ATM)  Final: 00:00:13.50
ATM Payload Bit Error Measurements
Err Count:  7   Sec Ago:  2
Err Ratio, Avg: 4.48E-08 ES: 4
Err Ratio, Curr: 3.70E-08 EFS: 9
Pat Sync: ON  %EFS: 69.23
```

**Err Count:** Foreground channel error count: The number of pattern bit errors detected on the foreground channel. **Sec Ago** displays the number of seconds elapsed since the last error occurred.

**Err Ratio, Avg:** Foreground channel average bit error ratio: The number of pattern bit errors over the total number of bits received since the beginning of the test, in scientific notation.

**Err Ratio, Curr:** Foreground channel current bit error ratio: The number of pattern bit errors received in the previous 2.25 seconds over the total number of bits received during the same period (in scientific notation).

**ES:** Foreground errored seconds: The number of seconds that had at least one ATM pattern bit error since the beginning of the test.

**EFS:** Foreground error-free seconds: The number of seconds in which no ATM pattern bit errors occurred since the beginning of the test.

**%EFS:** Percentage of foreground channel error-free seconds: The percentage of total seconds, since the beginning of the test, that had no foreground channel payload errors.

**Pat Sync:** Foreground channel pattern synchronization: Displays **On** to indicate that pattern synchronization has been achieved with the received ATM channel.

**Note:** In a loop test, if a received channel (such as a background channel) has the same VP/VC address as the foreground channel, that channel will cause ATM payload bit errors and may also cause loss of pattern synchronization.
ATM AAL-1 Cell Loss Measurements Screen

The screen displays results based on AAL-1 cell loss measurements on the receive channel (not applicable for STS-12c ATM).

**Note:** This screen is only applicable when the receive channel type is set to AAL1. See Receive Cell Type, page 19-16.

```
1 STS1-STS1 (ATM) Final: 00:01:01.01
ATM AAL1 Cell Loss Measurements
Count: 7 Sec Ago: 5
Err Ratio, Avg: 3.67E-06 ES: 7
Err Ratio, Curr: 0.00E+00 EFS: 54
%EFS: 88.52
```

**Count:** ATM AAL-1 cell loss count: The number of cells lost based on missing sequence numbers on the received AAL-1 cells. See **Ago** displays the elapsed time since the previous cell loss.

**Err Ratio, Avg:** Average cell loss ratio: The number of cells lost over the total expected number of receive cells (cells actually received plus cells lost), since the beginning of the test.

**Err Ratio, Curr:** Current cell loss ratio: The average cell loss ratio for the previous 2.25 seconds.

**ES:** Cell loss errored seconds: The number of seconds in which at least one cell loss occurred.

**EFS:** Cell loss error-free seconds. The number of seconds during which no cell losses occurred.

**%EFS:** Cell loss error-free seconds percentage: The percentage of all seconds since the beginning of the test during which no cell losses occurred.

**Note:** To perform cell loss measurements in a loop test, both the foreground channel and the receive channel must be set to AAL-1.
ATM AAL-1 SN CRC/Par Error Measurements Screen

This screen displays results based on CRC-3 and parity errors in the sequence number protection bits of the AAL-1 sequence check byte (not applicable for STS-12c ATM).

Note: This screen is only applicable when the receive channel type is set to AAL1. See Receive Cell Type, page 19–16.

```
1 STS1-STS1 (ATM) Final: 00:00:00.00
ATM AAL1 SN CRC/Par Error Measurements
Count: 11 Sec Ago: 0
Err Ratio, Avg: 2.00E-05 ES: 6
Err Ratio, Curr: 2.64E-05 EFS: 10
%EFS: 62.50
```

**Count:** AAL-1 CRC-3 and parity count: The number of sequence number protection CRC and parity errors. **Sec Ago** displays the elapsed time since the previous error.

**Err Ratio, Avg:** AAL-1 CRC-3 and parity average error ratio: The number of CRC and parity errors over the number of selected channel cells received, since the beginning of the test.

**Err Ratio, Curr:** AAL-1 CRC-3 and parity current error ratio: The average CRC/parity error ratio for the previous 2.25 seconds.

**ES:** AAL-1 CRC-3 and parity errored seconds: The number of seconds in which at least one CRC or parity error occurred.

**EFS:** AAL-1 CRC-3 and parity error-free seconds. The number of seconds during which no CRC or parity errors occurred.

**%EFS:** AAL-1 CRC-3 and parity error-free seconds percentage: The percentage of all seconds since the beginning of the test during which no CRC/parity errors occurred.
ATM AAL-1 Misinserted Cell Measurements Screen

This screen displays results based on the detection of misinserted cells. A *misinserted cell* is a cell with a valid sequence number received out of the proper order.

**Note:** This screen is only applicable when the receive channel type is set to AAL1. See *Receive Cell Type*, page 19–16.

```
1 STS1-STS1 (ATM) Final: 00:00:00.00
ATM AAL1 Misinserted Cell Measurements
Err Count: 7 Sec Ago: 2
Err Ratio, Avg: 4.22E-06 ES: 7
Err Ratio, Curr: 1.42E-05 EFS: 46
%EFS: 86.79
```

**Err Count:** AAL-1 misinserted cell error count. The number of misinserted cells. **See Ago** displays the elapsed time since the previous error.

**Err Ratio, Avg:** AAL-1 misinserted cell average error ratio. The number of misinserted cells over the number of selected channel cells received, since the beginning of the test.

**Err Ratio, Curr:** AAL-1 misinserted cell current error ratio. The average misinserted cell error ratio for the previous 2.25 seconds.

**ES:** AAL-1 misinserted cell errored seconds. The number of seconds in which at least one misinserted cell occurred.

**EFS:** AAL-1 misinserted cell error-free seconds. The number of seconds during which no misinserted cells occurred.

**%EFS:** AAL-1 misinserted cell error-free seconds percentage. The percentage of all seconds since the beginning of the test during which no misinserted cells occurred.
ATM Delay Measurements

This screen displays results based on ATM cell delay measurements (not applicable for STS-12c ATM).

- When the ATM Test Mode> is set for Cell Transfer Delay the measured delay is the time elapsed from when a cell is transmitted on the foreground channel output, to when it is detected on the receive channel input.

- When the ATM Test Mode> is set for Cell Inter Arrival Time, the measured delay is the difference in the arrival time of adjacent cells at the receive channel input.

**Note:** For cell inter-arrival time measurements the received cells can be any type, as long as the VP/VC address matches the receive channel (Rx Chan).

**Note:** This screen is not applicable for ATM Standard test mode. See *The ATM Setup Menu*, page 19–3.

<table>
<thead>
<tr>
<th>1 STS1-STS1 (ATM) Final: 00:00:39.59</th>
<th>ATM Delay Measurements (in Seconds)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Current</td>
</tr>
<tr>
<td>Min. :</td>
<td>1.25E-05</td>
</tr>
<tr>
<td>Max. :</td>
<td>2.21E-05</td>
</tr>
<tr>
<td>Typical:</td>
<td>3.58E+00</td>
</tr>
</tbody>
</table>

**Current-Min:** The shortest delay measured in the previous 2.25 seconds.

**Average-Min:** The average of all Current-Min values since the beginning of the test.

**Peak-Min:** The shortest delay measured since the beginning of the test.

**Current-Max:** The longest delay measured in the previous 2.25 seconds.

**Average-Max:** The average of all Current-Max values since the beginning of the test.

**Peak-Max:** The longest delay measured since the beginning of the test.

**Typical:** The average of the Average-Min and Average-Max values.
ATM OAM Alarm Status

This screen displays the current and historical status of ATM OAM alarms (not applicable for STS-12c ATM).

| 1 STS1-STS1 (ATM)  | Final: 00:00:00.00 |
| ATM OAM:       | Alm Hist |
| F4 <UP> AIS:  | ON -- |
| F4 <UP> RDI<FERF>: | ON -- |
| F5 <VC> AIS:  | -- ON |
| F5 <VC> RDI<FERF>: | -- ON |

For each alarm, the current status (Alm) and historical status (Hist) is listed. If Alm shows On, the alarm condition is present. If Hist shows On, an earlier occurrence of the alarm condition was detected.

Each OAM alarm indication is cleared when its corresponding condition is not detected for three seconds.

**F4 (VP) AIS:** F4 flow (virtual path) alarm indication signal: Declared when the received OAM cell has a VCI of 3 (segment) or 4 (end-to-end), OAM cell type bits set to 0001, and function type bits set to 0000.

**F4 (VP) RDI<FERF>:** F4 flow (virtual path) remote defect indication (far-end receive failure): Declared when the received OAM cell has a VCI of 3 or 4, OAM cell type bits set to 0001, and function type bits set to 0001.

**F5 (VC) AIS:** F5 flow (virtual circuit) alarm indication signal: Declared when the received OAM cell has a PT of 100 (segment) or 101 (end-to-end), OAM cell type bits set to 0001, and function type bits set to 0000.

**F5 (VC) RDI<FERF>:** F5 flow (virtual circuit) remote defect indication (far-end receive failure): Declared when the received OAM cell has a PT of 100 (segment) or 101 (end-to-end), OAM cell type bits set to 0001, and function type bits set to 0001.

**Note:** Transmitting a foreground channel with a PT value of 1xx and a PRBS or all-zeros payload can cause unintended OAM alarms. See PT, page 19–14.
ATM OAM Alarm Seconds

This screen displays alarm seconds counts of ATM OAM alarms (not applicable for STS-12c ATM). The alarms are defined in ATM OAM Alarm Status, page 20–14.

<table>
<thead>
<tr>
<th>ATM OAM Alarm Seconds</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1 STS1-STS1 (ATM) Final:</td>
<td>00:00:00.00</td>
</tr>
<tr>
<td>F4 (UP) AIS:</td>
<td>40</td>
</tr>
<tr>
<td>F4 (UP) RDI(FERF):</td>
<td>36</td>
</tr>
<tr>
<td>F5 (VC) AIS:</td>
<td>119</td>
</tr>
<tr>
<td>F5 (VC) RDI(FERF):</td>
<td>25</td>
</tr>
</tbody>
</table>

**F4 (VP) AIS:** The number of seconds during which an F4 AIS alarm was declared.

**F4 (VP) RDI(FERF):** The number of seconds during which an F4 RDI alarm was declared.

**F5 (VC) AIS:** The number of seconds during which an F5 AIS alarm was declared.

**F5 (VC) RDI(FERF):** The number of seconds during which an F5 RDI alarm was declared.
PLCP Measurement Screens (DS3 only)

PLCP measurements are based on the physical layer convergence protocol (PLCP) used to map ATM cells onto DS3 facilities (see Physical Layer Convergence Protocol (PLCP), page 21–5). These measurements are only applicable if the payload is set to ATM/PLCP-Based Cell Delineation.

This screen displays an overview of basic PLCP signal status.

<table>
<thead>
<tr>
<th>Count</th>
<th>Sec Ago</th>
</tr>
</thead>
<tbody>
<tr>
<td>B1 BIP:</td>
<td>37012</td>
</tr>
<tr>
<td>Frm &amp; POI:</td>
<td>3317952</td>
</tr>
<tr>
<td>FEBE:</td>
<td>93975</td>
</tr>
</tbody>
</table>

**Count** indicates the number of errors since the beginning of the test; **Sec Ago** indicates the number of seconds elapsed since the previous error occurred.

**B1 BIP:** PLCP B1 parity error count: The number of parity errors indicated by the PLCP B1 byte bit-interleaved parity (BIP) check.

**Frm & POI:** PLCP frame and path overhead error count: The number of PLCP framing and path overhead indicator (POI) errors.

**FEBE:** PLCP far-end block error count: The number of far-end block errors as indicated by the PLCP G1 byte.
### PLCP B1-BIP Measurements Screen

This screen displays measurements based on the PLCP bit-interleaved parity check (BIP). The BIP uses the B1 byte and is computed over the entire PLCP frame, excluding the A1, A2, P, and trailer bits.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 DS3-DS3&lt;ATM-PLCP&gt;Final:</td>
<td>00:00:00.00</td>
</tr>
<tr>
<td>PLCP B1-BIP Measurements</td>
<td></td>
</tr>
<tr>
<td>Err Count:</td>
<td>37012</td>
</tr>
<tr>
<td>Err Ratio, Avg:</td>
<td>1.14E-05 ES: 5</td>
</tr>
<tr>
<td>Err Ratio, Curr:</td>
<td>0.00E+00 EFS: 73</td>
</tr>
<tr>
<td>%EFS:</td>
<td>93.59</td>
</tr>
</tbody>
</table>

**Err Count:** PLCP BIP error count: The number of B1 BIP errors detected since the beginning of the test.

**Err Ratio, Avg:** PLCP average BIP error ratio: The average ratio of BIP errors to the total number of received bits from which the BIP is computed, since the beginning of the test.

**Err Ratio, Curr:** PLCP current BIP error ratio: The ratio of BIP errors detected during the previous 2.25 seconds to the total number of received bits from which the BIP is computed during that same period.

**ES:** PLCP BIP errored seconds: The number of seconds in which at least one BIP error occurred, since the beginning of the test.

**EFS:** PLCP BIP error-free seconds: The number of seconds in which no BIP errors occurred.

**%EFS:** PLCP BIP error-free seconds percentage: The percentage of the total number of seconds since the beginning of the test in which no BIP errors occurred.
PLCP Combined Frame and POI Measurements Screen

This screen displays measurements based on the PLCP framing (A1 and A2 bytes) and path overhead indicators (P bytes or POI bytes).

<table>
<thead>
<tr>
<th>Measurement</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Final</td>
<td>00:00:00.00</td>
</tr>
<tr>
<td>Err Count</td>
<td>3317952</td>
</tr>
<tr>
<td>Err Ratio, Avg</td>
<td>1.48E-01 ES: 6</td>
</tr>
<tr>
<td>Err Ratio, Curr</td>
<td>0.00E+00 EFS: 72</td>
</tr>
<tr>
<td>%EFS</td>
<td>92.31</td>
</tr>
</tbody>
</table>

**Err Count:** Frame/POI error count: The number of frame and POI byte errors detected since the beginning of the test.

**Err Ratio, Avg:** Frame/POI average error ratio: The average ratio of frame and POI byte errors to the total number of frame and POI bytes received, since the beginning of the test.

**Err Ratio, Curr:** Frame/POI current error ratio: The ratio of frame and POI byte errors detected in the previous 2.25 seconds to the total number of frame and POI bytes received in that same period.

**ES:** Frame/POI errored seconds: The number of seconds in which at least one frame or POI byte error occurred, since the beginning of the test.

**EFS:** Frame/POI error-free seconds. The number of seconds in which no frame/POI errors occurred.

**%EFS:** Frame/POI error-free seconds percentage: The percentage of the total number of seconds since the beginning of the test in which no frame or POI byte errors occurred.
This screen displays measurements based on the PLCP far-end block error field (bits 1-4 of the G1 byte). The FEBE reports the number of B1-BIP received by the far end.

**Err Count:** PLCP FEBE error count: The number of FEBE errors detected since the beginning of the test.

**Err Ratio, Avg:** PLCP FEBE average error ratio: The average ratio of FEBE errors to the total number of received bits from which the FEBE (B1-BIP) is calculated, since the beginning of the test.

**Err Ratio, Curr:** PLCP FEBE current error ratio: The average ratio of FEBE errors detected in the previous 2.25 seconds to the total number of received bits from which the FEBE (B1-BIP) is calculated during that same period.

**ES:** PLCP FEBE errored seconds: The number of seconds in which at least one FEBE error occurred, since the beginning of the test.

**EFS:** PLCP FEBE error-free seconds: The number of seconds in which no FEBE errors occurred.

**%EFS:** PLCP FEBE error-free seconds percentage: The percentage of the total number of seconds since the beginning of the test in which no FEBE errors occurred.
ATM Alarm Status

For each alarm, the current status (Alm) and historical status (Hist) is listed. If Alm shows On, the alarm condition is present. If Hist shows On, an earlier occurrence of the alarm condition was detected.

HEC-based ATM

This screen is for HEC-delineated ATM tests.

<table>
<thead>
<tr>
<th>1 STS1-STS1 (ATM) Final: 00:00:00.00</th>
</tr>
</thead>
<tbody>
<tr>
<td>ATM: Alm Hist</td>
</tr>
<tr>
<td>LOCs: -- ON</td>
</tr>
<tr>
<td>SCNRI: -- ON</td>
</tr>
<tr>
<td>Pyld LOP: -- ON</td>
</tr>
</tbody>
</table>

**LOCs**: Loss of cell synchronization: Declared when the test set cannot synchronize with the ATM cell stream.

**SCNR**: Selected cell not received: Declared when the test set cannot detect any receive cells that match the address information on the receive channel (see Rx Chan, page 19-13).

**Pyld LOP**: Payload loss of pattern: Declared when the unit cannot synch to the test pattern in the payload of the foreground test channel.

DS3/PLCP ATM

This screen is available for DS3 PLCP-based ATM tests, and displays the current and historical status of ATM and PLCP alarms.

<table>
<thead>
<tr>
<th>1 DS3-DS3 (ATM/PLCP) Final: 00:00:00.00</th>
</tr>
</thead>
<tbody>
<tr>
<td>ATM: Alm Hist</td>
</tr>
<tr>
<td>PLCP LOF: -- ON</td>
</tr>
<tr>
<td>PLCP YEL: ON --</td>
</tr>
<tr>
<td>SCNRI: -- ON</td>
</tr>
<tr>
<td>Pyld LOP: -- ON</td>
</tr>
</tbody>
</table>

**PLCP LOF**: PLCP loss of frame: Declared when the test set cannot synchronize with the DS3 PLCP framing.

**PLCP YEL**: PLCP Yellow alarm, or remote alarm indication (RAI): This is detected in the last four bits of the G1 byte.

**SCNR**: Selected cell not received: Declared when the test set cannot detect any receive cells that match the address information on the receive channel (see Rx Chan, page 19-13).

**Pyld LOP**: Payload loss of pattern: Declared when the unit cannot synch to the test pattern in the payload of the foreground test channel.
ATM Alarm Seconds

HEC-based ATM

This screen displays alarm seconds counts of ATM alarms. The alarms are defined in ATM Alarm Status, page 20–20.

```
1 STS1-STS1 (ATM) Final: 00:00:00.00
ATM Alarm Seconds
LOCS: 17
SCNR: 17
Pyld LOP: 17
```

**LOCS:** Loss of cell synchronization seconds: The number of seconds in which a LOCS alarm was present.

**SCNR:** Selected cell not received alarm seconds: The number of seconds in which an SCNR alarm was present.

**Pyld LOP:** Payload loss of pattern: The number of seconds in which an LOP alarm was present.

DS3/PLCP

This screen displays alarm seconds counts of ATM and PLCP alarms. The alarms are defined in ATM Alarm Status, page 20–20.

```
1 DS3-DS3(ATM/PLCP) Final: 00:00:00.00
ATM Alarm Seconds
PLCP LOF: 17
PLCP YEL: 0
SCNR: 17
Pyld LOP: 17
```

**PLCP LOF:** PLCP loss of frame seconds: The number of seconds in which a LOF alarm was present.

**PLCP YEL:** PLCP Yellow alarm or RAI seconds: The number of seconds in which a Yellow or RAI alarm was present.

**SCNR:** Selected cell not received alarm seconds: The number of seconds in which an SCNR alarm was present.

**Pyld LOP:** Payload loss of pattern: The number of seconds in which an LOP alarm was present.
Basic Cell Structure  21–2
AAL-0 Cell Implementation  21–2
AAL-1 Cell Implementation  21–3
AAL-3/4 Cell Implementation  21–3
AAL-5 (SEAL) Cell Implementation  21–4
ATM Test Cell Structure  21–4
Physical Layer Convergence Protocol (PLCP)  21–5
Basic Cell Structure

Cell Header

GFC: Generic Flow Control
VPI: Virtual Path Identifier
VCI: Virtual Channel Identifier
PT: Payload Type
CLP: Cell Loss Priority
HEC: Header Error Control sequence

AAL-0 Cell Implementation

53-byte ATM Cell

5-byte Cell Header

48-byte CBR Payload

53
AAL-1 Cell Implementation

53-byte ATM Cell

- CSI: Convergence Sublayer Indicator
- SC: Sequence Count
- CRC: CRC-3 (cyclic redundancy checksum)
- Parity Bit

AAL-3/4 Cell Implementation

53-byte ATM Cell

- ST: Segment Type
- SN: Sequence Number
- MID: Message Identification
- LI: Length Indication
- CRC: CRC-10 (cyclic redundancy checksum)
ATM Formats

AAL-5 (SEAL) Cell Implementation

AAL-5 (SEAL) Cell Implementation

ATM Test Cell Structure

ATM
Physical Layer Convergence Protocol (PLCP)

The DS3 PLCP is based on a 125 µs frame within the DS3 payload, which provides for the transmission of 12 ATM cells for each PLCP frame. There is no fixed relationship between the PLCP frame and the DS3 frame.

**Physical Layer Convergence Protocol—DS3**

<table>
<thead>
<tr>
<th>Framing bytes</th>
<th>POI bytes</th>
<th>POH bytes</th>
<th>53 bytes</th>
</tr>
</thead>
<tbody>
<tr>
<td>A1</td>
<td>A2</td>
<td>P11</td>
<td>Z6</td>
</tr>
<tr>
<td>A1</td>
<td>A2</td>
<td>P10</td>
<td>Z5</td>
</tr>
<tr>
<td>A1</td>
<td>A2</td>
<td>P9</td>
<td>Z4</td>
</tr>
<tr>
<td>A1</td>
<td>A2</td>
<td>P8</td>
<td>Z3</td>
</tr>
<tr>
<td>A1</td>
<td>A2</td>
<td>P7</td>
<td>Z2</td>
</tr>
<tr>
<td>A1</td>
<td>A2</td>
<td>P6</td>
<td>Z1</td>
</tr>
<tr>
<td>A1</td>
<td>A2</td>
<td>P5</td>
<td>F1</td>
</tr>
<tr>
<td>A1</td>
<td>A2</td>
<td>P4</td>
<td>B1</td>
</tr>
<tr>
<td>A1</td>
<td>A2</td>
<td>P3</td>
<td>G1</td>
</tr>
<tr>
<td>A1</td>
<td>A2</td>
<td>P2</td>
<td>M1</td>
</tr>
<tr>
<td>A1</td>
<td>A2</td>
<td>P1</td>
<td>M2</td>
</tr>
<tr>
<td>A1</td>
<td>A2</td>
<td>P0</td>
<td>C1</td>
</tr>
</tbody>
</table>

POI: Path overhead indicator bytes.
POH: Path overhead bytes.

13 or 14 nibbles
ATM Formats
Store and Recall Functions
Configuration Storage and Retrieval

Follow this procedure to save a test set configuration in memory.

1. Configure the test set the way you want.

2. When you have finished setting up the instrument, press MENU-up to return to the Main Menu.

   MODEL 156 MAIN MENU
   Auto Setup
   Terminal Testing
   Monitor Testing
   Drop & Insert Testing
   DS3/DS1/ATM Scans & Pointer Sequences
   Setup System Parameters
   Store and Recall configurations

   Press < FIELD > to highlight item, then
   Press MENU-down to select item.

3. Use FIELD to select Store and Recall Configurations and press MENU-down. The Store/Recall Configurations screen is displayed:

   STORE/RECALL CONFIGURATIONS    Status
   Action: Store
   Test #: 1
   Press MENU-dn to initiate action.
   Press MENU-up to go to Main Menu.

   1 > EMPTY
   2 > EMPTY
   3 > EMPTY
   4 > EMPTY
   5 > EMPTY
   6 > EMPTY
   7 > EMPTY
   8 > EMPTY
   9 > EMPTY
   10 > EMPTY

4. Use VALUE to set Action to Store.

5. Press FIELD to select Test #, and then use VALUE to choose a memory location in which to store the configuration.

- If there is already a configuration stored in the memory location you choose, you are prompted to overwrite it (press MENU-up) or leave it (press MENU-down). If you do not want to overwrite the existing configuration, select a new memory location (see step 5).

The configuration is entered in the list on the right side of the display in location you selected. The date and time the configuration was stored is shown on the line below Test #.

<table>
<thead>
<tr>
<th>STORE/RECALL CONFIGURATIONS</th>
<th>#</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action: Store</td>
<td>1</td>
<td>OOC3-0C3 (ATM)</td>
</tr>
<tr>
<td>Test #: 1</td>
<td></td>
<td>2 EMPTY</td>
</tr>
<tr>
<td>10/11/95 11:13:00</td>
<td></td>
<td>4 EMPTY</td>
</tr>
<tr>
<td>Press ENTER to initiate action.</td>
<td></td>
<td>5 EMPTY</td>
</tr>
<tr>
<td>Press MENU to go to Main Menu.</td>
<td></td>
<td>6 EMPTY</td>
</tr>
</tbody>
</table>

7. Press MENU-up to return to the Main Menu.

Retrieve a Test Set Configuration

Follow this procedure to retrieve a test set configuration that is stored in memory.

1. From the Main Menu use FIELD to select Store and Recall Configurations and press MENU-down. The Store/Recall Configurations screen is displayed:

<table>
<thead>
<tr>
<th>STORE/RECALL CONFIGURATIONS</th>
<th>#</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action: Recall</td>
<td>1</td>
<td>OOC3-0C3 (ATM)</td>
</tr>
<tr>
<td>Test #: 1</td>
<td></td>
<td>2 EMPTY</td>
</tr>
<tr>
<td>10/11/95 11:13:00</td>
<td></td>
<td>4 EMPTY</td>
</tr>
<tr>
<td>Press ENTER to initiate action.</td>
<td></td>
<td>5 EMPTY</td>
</tr>
<tr>
<td>Press MENU to go to Main Menu.</td>
<td></td>
<td>6 EMPTY</td>
</tr>
</tbody>
</table>

2. Use VALUE to set Action to Recall.
3. Press FIELD to select Test #, and then use VALUE to choose the memory location from which you want to retrieve the configuration.

4. Press MENU down.

   The configuration is read from memory and implemented in the test set. The display switches to the appropriate test operation screen.

5. Begin your test.

   • If you inadvertently recalled the wrong configuration, or if you want to change the configuration and resave it, press MENU-up to return to the Store/Recall Configurations screen.
Results Storage and Retrieval

Store Test Results

Follow this procedure to store the current test results into the next available memory buffer.

1. Configure the test set and run your test.

2. Either while the test is running or after the test has stopped, press STORE. The results are stored, and the memory buffer number on the top line of the display is incremented.

```
1 DS3-DS3<ATM/FLCP>Final: 00:00:00.00
ATM Measurement Summary
Valid Cell Delineation: --
Selected UP/UC Cell Rcv'd: --
Total Active BW (Hz), Avg: --
Rx UP/UC BW (Hz), Avg: --
```

The memory buffer number indicates the next buffer that will be used for results storage.

3. When you want to store more results, press STORE again.

The complete range of measurements for the selected test mode is stored in the memory buffer. The results are retained in memory even when the unit is switched off.

Note: Press CLEAR at any time to erase all stored results.

- Each time you store results, the next buffer is automatically selected. If you want to select a different memory buffer:
  - Make sure the test is stopped.
  - Press RECALL repeatedly to increment the memory buffer number. The buffer number and test mode name flash rapidly to indicate the display is in recall mode. Empty buffers show Nothing Stored.
  - When the memory buffer you want is shown press EXIT.
  - Press STORE to save the current test results.
Recall and Review Test Results

Follow this procedure to recall any test results that have been previously stored (see Store Test Results, page 22-5).

1. Make sure that a test is not running. Press STOP if necessary to end the current test.

2. Press RECALL. The buffer number and test mode name flash rapidly to indicate the display is in recall mode.

   2 OC3-OC3 (ATM)   Final: 00:00:00.00
   ATM Measurement Summary
   Valid Cell Delineation: --
   Selected UP/UC Cell Rcv’d: --
   Total Active BW (Hz), Avg: --
   Rx UP/UC BW (Hz), Avg: --

3. Press RECALL repeatedly to cycle through the memory buffers (1–12) until the buffer you want to view is displayed.

   The display changes to show the results stored in each memory buffer. If a memory buffer is empty, the display shows Nothing Stored.

4. Use the RESULT keys to scroll through the measurement screens available for the stored test results, just as you would in normal test mode.

   Because all test data is stored, you can adjust the results level to see more screens, regardless of the results level setting at the time the results were stored. See To Display More Measurement Screens, page 1–10.

5. If you want to print stored results, select the memory buffer you want and press the PRINT key. See Chapter 24, Printing, for more information on the print function.

6. Press EXIT to leave recall mode and return to the normal display.

Note: Press CLEAR at any time to erase all stored results.
Event Logging

Configure and View Event Logging

The Event Logging Setup and View display allows you to view logged events and configure which events are logged.

1. To access the Event Logging Setups display select **Setup System Parameters** from the Main Menu and press MENU-down.

2. Select **Event Logging Setups** from the Setup menu and press MENU-down.

<table>
<thead>
<tr>
<th>Event Log</th>
</tr>
</thead>
<tbody>
<tr>
<td>03Mar 03:09:59 Power On</td>
</tr>
<tr>
<td>03Mar 04:01:41 Start DS1-DS1 (DS1)</td>
</tr>
<tr>
<td>03Mar 04:01:41 DS1 LOS Alarm On</td>
</tr>
<tr>
<td>03Mar 04:02:53 DS1 LOS Alarm Off</td>
</tr>
</tbody>
</table>

*Event Print: No*

<table>
<thead>
<tr>
<th>Bit</th>
<th>DS1/E1</th>
<th>DS3</th>
<th>SDHET</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frame</td>
<td>Don't Log</td>
<td>Don't Log</td>
<td>Don't Log</td>
</tr>
<tr>
<td>CRC/F-BIP</td>
<td>Don't Log</td>
<td>Don't Log</td>
<td>Don't Log</td>
</tr>
<tr>
<td>BPU</td>
<td>Don't Log</td>
<td>Don't Log</td>
<td>Don't Log</td>
</tr>
</tbody>
</table>

3. Use **FIELD** and **VALUE** to set the event logging choices in the bottom of the display. These settings are used when you run tests.

4. Use **RESULT** to scroll through logged events in the upper half of the display. The date and time is displayed for each logged event.

   See **Event Logging Setup Parameters**, page 22-8 for more information on event logging parameters.

5. Press **MENU-up** to exit the display.
Event Logging

Setup Parameters

<table>
<thead>
<tr>
<th>Event Print: No</th>
<th>DS1/E1</th>
<th>DS3</th>
<th>SONET</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bit</td>
<td>Don’t Log</td>
<td>Don’t Log</td>
<td>Don’t Log</td>
</tr>
<tr>
<td>Frame</td>
<td>Don’t Log</td>
<td>Don’t Log</td>
<td>Don’t Log</td>
</tr>
<tr>
<td>CRC/P/BIP</td>
<td>Don’t Log</td>
<td>Don’t Log</td>
<td>Don’t Log</td>
</tr>
<tr>
<td>BPV</td>
<td>Don’t Log</td>
<td>Don’t Log</td>
<td>Don’t Log</td>
</tr>
</tbody>
</table>

Automatic Printing of Events

**Event Print** switches automatic printing of events on and off. When this parameter is set to On events are automatically printed as they occur, according to the setting of the event type fields (see below).

While the event memory is limited to 50 stored events, automatic event printing provides for an unlimited hard-copy log of events.

Logged Events Selections

The following table describes the events that can be selected to be logged, as shown on the display.

<table>
<thead>
<tr>
<th>Error Type</th>
<th>DS1/E1</th>
<th>DS3</th>
<th>SONET</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bit</td>
<td>Bit errors</td>
<td>Not applicable</td>
<td></td>
</tr>
<tr>
<td>Frame</td>
<td>Framing errors</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CRC/P/BIP</td>
<td>Cyclic redundancy check and parity check errors</td>
<td></td>
<td></td>
</tr>
<tr>
<td>BPV</td>
<td>Bipolar violation</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Event Logging Mode

Each type of event listed for a specific rate on the display can be set to one of the following event logging modes:

**Don’t Log:** The event type is not logged.

**Log All:** Every occurrence of the event type is logged.

**Sqlch E-3 through Sqlch E-6:** Event log squelch. The event is logged, but when the error rate exceeds the squelch threshold for ten seconds further event are not logged. Squelching is removed when there are five seconds in which the error rate is less than the threshold. “Squelch on” and “squelch off” messages are entered in the event log.

**Sqlch:** Event log squelch (low error rate). This is similar to the Sqlch E-N rates described above, but the squelch threshold is one error per second.

Example: A selection of Sqlch E-3 for the Bit error type corresponds to a threshold of $1 \times 10^{-3}$, or one bit error out of 1000 bits.

---

22–8
Global Settings  23-2

Configuration Lock During Test  23-2
Measurement Display Configuration  23-2
Trouble Scan Activation  23-2
Error Squelching During Alarms  23-3
Test Pattern Inversion  23-3
Jitter Threshold Configuration  23-3

Auxiliary Test Setup Parameters  23-4

Test Duration Mode  23-4
Timed Test Length  23-4
Automatic Printing  23-5
Automatic Result Storage  23-5
Optical Tx Power-up State  23-6
STS-12 Numbering Scheme  23-6  (3-3)
VT1.5 Channel Setup Mode  23-6
Transmit DS2 X-Bit Status  23-6
DS1 Block Size  23-7
BITS Clock Output Source  23-7

Administrative Setup Parameters  23-8

Printer & Remote Port Parameters  23-8
System Date and Time  23-8
IEEE 488 Interface Parameters  23-8

Global, Auxiliary, and Administrative Setups
Global Settings

The Global Settings choice is always listed on the Control Screens menu. Selecting Global Settings and pressing CONFIG-right calls the Modify Global Configurations screen:

- **Modify Config While Running?** enables or disables adjustments to the test set's configuration while a test is running (RUN indicator lit). This parameter can be set as follows:
  - **No:** The test set's main mode configuration cannot be changed during a test. However, screens accessed through the Control Screens menu can be changed.
  - **Yes:** The configuration can be changed during a test; changes take effect immediately. Note that changing signal parameters during a test can cause unexpected results and misleading measurements. However, this is a good way to experiment with the setup and observe changes in real-time.

- **Results Level** configures the level of detail provided when viewing measurements. Results Level can be set to either Summary or Detail.
  - Each measurement screen is either a “summary” or a “detail” screen. Summary screens show higher-level information. Detail screens show more in-depth information. When Results Level is set to Summary only summary screens can be viewed. When Results Level is set to Detail all screens (both summary and detail) can be viewed.

- **Trouble Scan** switches Trouble Scan ON or OFF. For more information on using Trouble Scan, see To Use Trouble Scan, page 1–7.
  - **Note:** When you press the TROUBLE SCAN key, the Trouble Scan feature is automatically set to On.
Global, Auxiliary, and Administrative Setups

Global Settings

Error Squelching
During Alarm

Inhibit Errors on Alarm? sets whether errors are counted during alarm conditions. When this parameter is set to Yes, errors are not counted during alarm conditions. When this parameter is set to No, errors are counted during alarm conditions.

Test Pattern
Inversion

Inv PRBS? enables and disables inversion of the transmit PRBS patterns. When this parameter is set to No, PRBSs selected in the Data field are transmitted normally. When this parameter is set to Yes, transmitted PRBSs are inverted (binary 0s switched to 1s, and 1s switched to 0).

Jitter Threshold
Configuration

Jitter Hits Thresh sets the jitter hits threshold used for making jitter hits measurements. This item is only displayed if a jitter option is installed in your test set. Jitter Hits Thresh comprises two fields, as follows:

WB: Wide-band jitter. This parameter sets the jitter hit threshold for all jitter (phase variation equal to or greater than the wide-band cut-off frequency). WB is set in unit intervals (UI) from 0.1 through 6.9 in 0.1 increments.

HB: High-band jitter. This parameter sets the jitter hit threshold for high-band jitter (phase variation equal to or greater than the high-band cut-off frequency). HB is set in unit intervals (UI) from 0.1 through 1.9 in 0.1 increments.
Auxiliary Test Setup Parameters

The Auxiliary Test Setups parameters apply to all test modes, and are accessed by selecting Auxiliary Test Setups from the Setup System Parameters menu.

<table>
<thead>
<tr>
<th>Auxiliary Test Setups</th>
</tr>
</thead>
<tbody>
<tr>
<td>Test Dur. Mode:</td>
</tr>
<tr>
<td>Continuous</td>
</tr>
<tr>
<td>Timer Duration:</td>
</tr>
<tr>
<td>00:01:00 (hh:mm:ss)</td>
</tr>
<tr>
<td>Auto. Print Mode:</td>
</tr>
<tr>
<td>Off</td>
</tr>
<tr>
<td>Auto. Store Mode:</td>
</tr>
<tr>
<td>Off</td>
</tr>
<tr>
<td>Sub Menu Opt Pwr:</td>
</tr>
<tr>
<td>Off</td>
</tr>
<tr>
<td>Auto Tst: Stop</td>
</tr>
<tr>
<td>Pwr Up Optical Tx State: Last State</td>
</tr>
<tr>
<td>STS12 # Scheme:</td>
</tr>
<tr>
<td>STS3#, STS1#</td>
</tr>
<tr>
<td>UT Counting: UT Group</td>
</tr>
<tr>
<td>OS2 Tx-XBit: 0</td>
</tr>
<tr>
<td>DS1 Block Size:</td>
</tr>
<tr>
<td>2Kbit</td>
</tr>
<tr>
<td>DS1 LOP &amp; ODF Hold-off: 0.0 Seconds</td>
</tr>
<tr>
<td>Bits Clik Out Derived from: STS-N Rx Clik</td>
</tr>
</tbody>
</table>

Test Duration Mode

**Test Dur. Mode** sets the test length and repeat mode as follows:

**Continuous**: Tests begin when START is pressed and run continuously until STOP is pressed.

**Timer**: Tests begin when START is pressed, run once for a specified duration and then stop automatically. The test duration is determined by the **Timer Duration** field. (Tests can be stopped before the duration ends by pressing STOP.)

**Timer/Restart**: Tests begin when START is pressed, run for a specified duration and then repeat automatically. Each test's duration is determined by the **Timer Duration** field. (Tests can be stopped before they end by pressing STOP.)

Timed Test Length

**Timer Duration** sets the duration used for Timer and Timer/Restart duration modes, and can be set in the format **hh:mm:ss** from **00:00:00** through **99:59:59**, where **hh** is hours, **mm** is minutes, and **ss** is seconds.

**Note**: If you set **Timer Duration** to **00:00:00** and select a timer test duration mode, the test set will run **Continuous** duration mode tests.
Global, Auxiliary, and Administrative Setups

Auxiliary Test Setup Parameters

Automatic Printing

Auto. Print Mode selects the mode for the automatic printing of test results, as follows:

Off: Test results are not automatically printed.

Timed Test End: Test results are automatically printed at the end of every timed test.

On Error: Test results are printed during a test when an error is detected.

Every 15 Minutes: Test results are automatically printed every 15 minutes when a test is running.

Every 2 Hours: Test Results are automatically printed every two hours when a test is running.

Automatic Result Storage

Auto. Store Mode selects the mode for the automatic storage of test results into the test set's 12 memory locations. The instrument automatically stores the results in the next higher available memory location. When location 12 is reached, the storage begins again at location 1. When all 12 memory location have been used, the test set writes over the previous data.

Auto. Store Mode can be set as follows:

Off: Test results are not automatically stored.

Timed Test End: Test results are automatically stored at the end of every timed test.

On Error: Test results are stored during a test when an error is detected.

Every 15 Minutes: Test results are automatically stored every 15 minutes when a test is running.

Every 2 Hours: Test Results are automatically stored every two hours when a test is running.

Automatic Test Start

Auto Tst sets whether a test is automatically started when you press MENU-down from the test setup screen to go to the test operation screen. When Auto Tst is set to Start, a test is automatically started. When Auto Tst is set to Stop, a test will not begin until you press START.
Global, Auxiliary, and Administrative Setups

Auxiliary Test Setup Parameters

Laser State on Test Setup Screen

Sub Menu Opt Pwr controls whether the optical transmitter is active (laser on) when you press MENU up to go to the test setup screen from the test operation screen. When this item is set to Off (the default) the laser is deactivated; when this item is set to On the laser remains active. (The “test setup screen” is where you select the Tx Rate, Rx Rate, and Payload; the “test operation screen” is where you view results and configure signal parameters.)

Optical Tx Power-up State

For information on the optical transmitter (laser) power-up state, see Optical Transmitter Power-up State, page 3–6.

STS-12 Numbering Scheme

For information on the STS-12c numbering scheme, see STS-12 Channel Numbering Scheme, page 3–3.

VT1.5 Channel Setup Mode

The table shows the two VT counting modes. Note that VTs are always mapped using the group scheme.

VT Counting Mode sets the method for specifying VT drop and insert channels on a SONET signal. This parameter can be set as follows:

VT Group: VT channels are specified in groups of seven, each comprising four VTs. A channel is specified as VT 1 through 4 in VT group 1 through 7.

1 through 28: VT channels are specified by their position in the overall STS-1 signal, from 1 through 28.

<table>
<thead>
<tr>
<th>VT Group:</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position in Group</td>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
<td>6</td>
<td>7</td>
</tr>
<tr>
<td>VTs (1–28)</td>
<td>15</td>
<td>16</td>
<td>17</td>
<td>18</td>
<td>19</td>
<td>20</td>
<td>21</td>
</tr>
<tr>
<td>4</td>
<td>22</td>
<td>23</td>
<td>24</td>
<td>25</td>
<td>26</td>
<td>27</td>
<td>28</td>
</tr>
</tbody>
</table>

Transmit DS2 X-Bit Status

DS2 Tx-XBit sets the status of the X-bits on the transmitted DS2 signals (each DS3 comprises seven DS2s). The X-bits provide an alarm status for the DS2. DS2 Tx-XBit can be set to 0 (alarm on) or 1 (alarm off).
Global, Auxiliary, and Administrative Setups

**Auxiliary Test Setup Parameters**

**DS1 Block Size**

The **DS1 Block Size** sets the DS1 information block size for testing applications involving block transfer protocols (such as video telephony). This parameter can be set from **2Kbit** through **8Kbit** (kilobits). The block size is used to compute block error measurements (see *DS1 Block Error Measurements Screen*, page 12–6).

**BITS Clock Output Source**

**BITS Clock Out Derived from** selects the source of the BITS signal output at the rear-panel BITS CLK OUT port, and can be set as follows:

**STS-N Rx Ck**: The BITS timing is derived from the receive SONET signal, as selected on the test operation screen. This mode is similar to the operation of BITS operation on SONET terminal equipment.

**STS-N Tx Ck**: The BITS timing is derived from the selected timing source (**TxCk**) on the test operation screen. This allows the BITS timing output to be derived from the BITS input or the test set's internal Stratum 3 clock.
Administrative Setup Parameters

The Administrative Setups display is accessed by selecting Administrative Setups from the Setup System Parameters menu.

Printer & Remote Port Parameters

Printer and Remote set the communications parameters for the rear-panel PRINTER RS-232 and the REMOTE RS-232 ports. The fields can be set in the format: bbbbd-s-pppp, where:

bbb: Sets the baud rate. This field can be set to 300, 1200, 2400, 4800, 9600, or 19200 baud.

d: Sets the number of data bits to either 8 or 7.

s: Sets the number of stop bits to either 1 or 2.

pppp: Sets the parity to None, Odd, or Even.

System Date and Time

The Data & Time fields set the unit's time-of-day clock and calendar in the format: mm/dd/yy hh:mm:ss, where mm=month, dd=day, yy=year, hh=hours, nn=minutes, and ss=seconds.

IEEE-488 Interface Parameters

The SCPI/IEEE-488 interface is configured by the following two parameters:

IEEE-488 Addr: Sets the test set's IEEE-488 instrument address. This field can be set from 00 through 31.

SCPI Via: Selects the rear-panel interface port that is used for the SCPI interface connection. This field can be set to either REMOTE-IEEE-488 or REMOTE-RS-232.
Set up for Printing  24-2
Configure Automatic Printing  24-3
Print on Demand  24-4

Printing
Set up for Printing

Follow this procedure to prepare for printing from the test set.

1. Switch off power on both the printer and the 156MTS.

2. Connect one end of an appropriate RS-232 serial cable or to the rear-panel PRINTER RS-232 port on the test set. Connect the other end of the cable to the printer. (See Printer Port, page 27-2, for the serial port pinout.)

3. Switch on the printer and test set.

4. From the test set's Main Menu, use FIELD to select Setup System Parameters and then press MENU-down. The Setup menu is displayed.

5. Use FIELD to select Administrative Setups and press MENU-down. The Administrative Setups screen is displayed:

```
Administrative Setups

| Printer:          | 9600,8-1-None |
| Remote:           | 9600,8-1-None |
| Date & Time:      | 01/07/95 03:09:59 |
| GPIB Addr:        | 29          |
| GPIB Via:         | IEEE-488    |
```

6. Use FIELD to highlight the parameters for the Printer port. Set the baud rate, data bits, stop bits, and parity to match your printer.

7. Press MENU-up to exit the Administrative Setups screen.
Configure Automatic Printing

After you connect a printer and configure the printer port, follow this procedure to set what information is printed automatically during a test.

1. From the Main Menu use FIELD to select Setup System Parameters and press MENU-down. The Setup menu is displayed.

2. On the Setup menu, select Auxiliary Test Setups and press MENU-down. The Auxiliary Test Setups screen is displayed.

3. Use FIELD and VALUE to select Auto Print Mode and set it as desired. You can select no automatic printing (Off), printing at the end of timed tests, or periodic printing (see Automatic Printing, page 23-5).

4. Press MENU-up to return to the Setup System parameters menu and use FIELD to select Event Logging Setups. Press MENU-down; the Event Log screen is displayed.

5. Use VALUE to set Event Print to Yes (events printed) or No.

6. Press MENU-up to exit the Event Log display.
Print on Demand

Whether or not you enable automatic printing (see *Configure Automatic Printing*, page 24-3), you can generate a measurement results and configuration report any time a test is running.

- To generate a printed report while a test is running, press PRINT. The PRINT indicator lights while the data is being transmitted.
Remote Front Panel at a Glance  25–3
Setup for Remote Front Panel Operation  25–4
Use Remote Front Panel Operation  25–6
Setup for SCPI/IEEE-488 Remote Operation  25–7
Use the SCPI/IEEE-488 Interface  25–8
Using an Answer-only Modem  25–9

Using Remote Control
About Remote Control

The 156MTS can be controlled from a remote control device using either of two methods: the Remote Front Panel allows you to simulate front-panel key presses from a connected terminal or PC with a terminal emulator. Option UHR, SCPI/HP-IB Interface, allows you to use SCPI commands (Standard Commands for Programmable Instruments) over an HP-IB or RS-232 interface.

This chapter describes how to set up for either type of remote control operation, and how to use the Remote Front Panel option to control the test set. For information on controlling the 156MTS using the SCPI/HP-IB interface, refer to the SCPI Programmer's Guide (part number 09.0600-0005).
Using Remote Control

Remote Front Panel at a Glance

Key Functions List
( ) = key plus Shift

Test Set Display area

LED Indicator area
. = off, * = on

Remote Front Panel Keyboard Functions

<table>
<thead>
<tr>
<th>Key</th>
<th>Key Function</th>
<th>Shift + Key Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>ENTER key</td>
<td>MENU key</td>
</tr>
<tr>
<td>2</td>
<td>NEXT (right) RESULT key</td>
<td>PRIOR (left) RESULT key</td>
</tr>
<tr>
<td>3</td>
<td>Right FIELD key</td>
<td>Left FIELD key</td>
</tr>
<tr>
<td>4</td>
<td>Right VALUE key</td>
<td>Left VALUE key</td>
</tr>
<tr>
<td>5</td>
<td>START key</td>
<td>STOP key</td>
</tr>
<tr>
<td>6</td>
<td>DS3 History LEDs RESET key</td>
<td>DS1 History LEDs RESET key</td>
</tr>
<tr>
<td>7</td>
<td>STS-1 History LEDs RESET key</td>
<td>PRINT CONTROL key</td>
</tr>
<tr>
<td>8</td>
<td>ERROR INJECT key</td>
<td>DISPLAY HOLD key</td>
</tr>
<tr>
<td>9</td>
<td>RECALL key</td>
<td>EXIT key</td>
</tr>
<tr>
<td>0</td>
<td>STORE key</td>
<td>CLEAR key</td>
</tr>
<tr>
<td>r</td>
<td>Redraw remote display</td>
<td></td>
</tr>
</tbody>
</table>

*KEY FUNCTION (shift fcn)*

1 ENTER (MENU)  2 Next (prev) Result Page
3 Next (prev) Field  4 Next (prev) Field Value
5 Start (Stop) Test  6 Clear DS3 (DS1) History
7 Clear STS1 History (Print)  8 Err Inject (Display Hold)
9 Recall Stored (End Recall)  0 Store (erase All Stored)

Press PREV FIELD/NEXT FIELD to select.  Press ENTER for next level of selection.

--- DS1 --- DS1 --- VT --- STS-N ---

<table>
<thead>
<tr>
<th>Alm</th>
<th>Stat</th>
<th>Alm</th>
<th>Stat</th>
<th>Alm</th>
<th>Stat</th>
<th>Errors</th>
</tr>
</thead>
<tbody>
<tr>
<td>LOS</td>
<td>Sig * LOS</td>
<td>Sig * FAIS</td>
<td>LOS</td>
<td>STS-N Sig * B1 CV</td>
<td></td>
<td></td>
</tr>
<tr>
<td>FFM</td>
<td>M1 * OFF</td>
<td>SF * FYEL</td>
<td>LOP</td>
<td>STS-N Frm * B2 CV</td>
<td></td>
<td></td>
</tr>
<tr>
<td>LOP</td>
<td>CBit</td>
<td>LOL</td>
<td>ESP</td>
<td>LOFNR</td>
<td>Valid Ftr* B3 CV</td>
<td></td>
</tr>
<tr>
<td>AIS</td>
<td>Fat</td>
<td>AIS</td>
<td>Fat</td>
<td>LOCLE</td>
<td>PEKE</td>
<td></td>
</tr>
<tr>
<td>AIS</td>
<td>CBit</td>
<td>Yel</td>
<td>BNZS</td>
<td>Err</td>
<td>-- Others</td>
<td></td>
</tr>
</tbody>
</table>

---

General

25-3
Setup for Remote Front Panel Operation

The Remote Front Panel option operates by exchanging commands and data with a controller (such as a PC running a terminal program) through the test set's rear-panel REMOTE RS-232 port. You can connect to the test set either directly or using modems.

**Direct Connection**

The following procedure describes how to connect a PC or terminal directly to the test set. Before you begin, make sure you have an RS-232 serial cable with appropriate connectors or adapters to match the test set and your PC.


2. Connect the other end of the serial cable to the appropriate port on the PC or terminal.

3. Configure the PC and the test set to the appropriate communications settings. Refer to the documentation that came with your PC for configuration instructions. See *Test Set Configuration*, page 25-5 to configure the 156MTS.

**Dial-up Connection**

A dial-up connection requires a modem at each end; one modem connected to the PC and another connected to the test set. The modem connected to the test set must be configured for auto-answer.

Before you begin, make sure you have an RS-232 *null-modem* cable with appropriate connectors or adapters to match the test set and your modem. See *Null-modem connections*, page 27-2, for null-modem pinout data.

1. Connect one end of the null-modem cable to the rear-panel REMOTE RS-232 port on the test set.

2. Connect the other end of the null-modem cable to the appropriate port on the modem.

3. Connect the modem to a working telephone jack.

4. Connect the other modem to a telephone line and to the PC. Refer to the documentation that came with your modem and PC for installation instructions.
Using Remote Control

**Setup for Remote Front Panel Operation**

5. Configure the PC, modems, and the test set to the appropriate communications settings. Refer to the documentation that came with your PC and modems for configuration instructions. See Test Set Configuration, page 25-5 to configure the 156MTS.

**Test Set Configuration**

Before using the remote front panel feature of the 156MTS, you must configure the rear-panel REMOTE RS-232 port. Follow this procedure to set the baud rate and data handling parameters.

1. From the test set's Main Menu, use FIELD to select *Setup System Parameters* and then press MENU-down. The Setup System Parameters menu is displayed.

2. Use FIELD to select *Administrative Setups* and press MENU-down. The Administrative Setups screen is displayed:

```
Administrative Setups

Printer: 9600 8-1-None
Remote: 9600 8-1-None
Date & Time: 01/07/95 02:09:59
IEEE-488 Addr: 29
SCPI Via: IEEE-488
```

3. Use FIELD to highlight the parameters for the *Remote* port. Set the baud rate, data bits, stop bits, and parity checking to match your printer.

**Note:** Both the test set and the device to which it is connected (PC or modem) must be configured identically.

4. Press MENU-up to exit the Administrative Setups screen.
Use Remote Front Panel Operation

**General**

1. Set up and configure the test set and controller; see *Setup for Remote Front Panel Operation*, page 25-4. Make sure the test set is switched on.

2. Start remote control from the controller. For example, launch a terminal emulator on your PC. The remote front panel displays on the controller (see *Remote Front Panel at a Glance*, page 25-3).
   - If the display is blank, press the "r" key on the PC keyboard to force a screen redraw.

3. Use the number keys along the top of the keyboard (*not* the numeric keypad) to mimic the keys on the front panel of the test set.

   The number key actions are listed in the **Key Function** display area. Each key has two actions: one when you press only that key, and one when you hold Shift and press the key. The Shift action is listed in parentheses.

   **Note:** You can still control the test set using the front panel. Commands entered are reflected on the remote front panel display.

**Test Example**

1. With the Main Menu shown on the controller's display, press the "3" key to select the type of test you want to run. (The "3" key corresponds to pressing the right FIELD key on the test set).

2. Press "1" to display the test setup screen (the same as pressing MENU-down).

3. Press "3" and "#" (Shift-3) to select the Tx Rate, Rx Rate and Payload fields. Use "4" and "$" (Shift-4) to set the values for these fields.

4. Press "1" again to display the test operation screen; and then press "3," "4," and Shift as necessary to configure any signal parameters as required for your application.

5. Press the "5" key to start the test.

6. Press "2" and "@" (Shift-2) to view other measurement screens in the top half of the display (this corresponds to using the RESULT keys).

7. Press "%" (Shift-5) to stop the test.
Setup for SCPI/IEEE-488 Remote Operation

This section briefly describes how to set up the 156MTS for SCPI/IEEE-488 control. For more information see the *SCPI/IEEE-488 Interface Programmer's Manual* (Manual Part Number 09-0600-0005).

1. Connect the remote cable to a port on the rear of the 156MTS (SCPI control can be implemented using either an IEEE-488 or RS-232 interface). For pinouts see *Printer and Control Ports*, page 27-2.
   - If you are using an IEEE-488 interface, connect an HP-IB cable to the REMOTE IEEE-488 port.
   - If you are using an RS-232 interface, connect a serial RS-232 cable to the REMOTE RS-232 port.

2. Connect the other end of the cable to a port on the controller device.

3. From the Main Menu, use FIELD to select **Setup System Parameters** and press MENU-down.

4. Select **Administrative Setups** from the Setup System Parameters menu and press MENU-down.

   ![Administrative Setups](image)

   - **Printer**: 9600,8-1-Hone
   - **Remote**: 9600,8-1-Hone
   - **Date & Time**: 01/07/95 02:09:59
   - **IEEE-488 Addr**: 29
   - **SCPI Via**: REMOTE-IEEE-488

5. If you are using SCPI through the RS-232 port, use FIELD and VALUE to set **Remote** (baud rate, data bits, stop bits, and parity).

6. If you are using the SCPI interface through an IEEE-488 interface, use FIELD and VALUE to set the address (**IEEE-488 Addr**).

7. Next set which port is being used for the SCPI interface (**SCPI Via**).
Use the SCPI/IEEE-488 Interface

After you have connected the 156MTS and SCPI controller, and configured the test set’s interface parameters, you are ready to activate SCPI mode.

1. Using the SCPI/IEEE-488 interface on the controller device, send the reset string “*RST” to the test set, or use the :SYST:REM command.

These commands puts the test set in SCPI/HP-IB mode. *RST sets all parameters to their default values; :SYST:REM maintains the current parameter settings. Refer to the SCPI/HP-IB Programmer’s Manual for more information.

2. When the test set is in SCPI mode, the display changes to show the following:

<table>
<thead>
<tr>
<th>SCPI Remote Mode Final: 00:00:00.00</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trouble Scan</td>
</tr>
<tr>
<td>SONET LOS:  HIS  DSZ LOS:  HIS</td>
</tr>
<tr>
<td>SONET LOF:  HIS  DSZ LOP:  ON</td>
</tr>
<tr>
<td>SONET LOPNTR: ON  DSZ FFM:  ON</td>
</tr>
<tr>
<td>PATH CV:  18273645  More...</td>
</tr>
</tbody>
</table>

Enable Display of Results and Alarms

SONET:off  ATM:off
DS3:ott     VT1.5:off
T-Carrier:off
Results Level:1

Note: When the test set is in SCPI mode, most front-panel controls are inoperative. Setup operations must be done using SCPI commands from the controller.

3. Use the FIELD and VALUE keys to configure which results are shown on the test set display while the unit is in SCPI mode.

4. Next use FIELD to select Results Level and then use VALUE to set the results level for the level of measurement detail you want.

5. Use the RESULT keys to scroll through measurement screens in the upper half of the display. The measurement screens available depend on the results enabled in the lower half of the display.
Using an Answer-only Modem

Option UIIS provides an external, answer-only modem for remote dial-up applications with your 156MTS.

The following commands were used to program the modem at the factory. The modem retains its programming when power is switched off; however, if you change the settings, you can return to the factory configuration by entering the commands as listed below.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ATSO=1</td>
<td>Set auto-answer on.</td>
</tr>
<tr>
<td>AT&amp;C1</td>
<td>Enable carrier detect output (pin 8).</td>
</tr>
<tr>
<td>AT&amp;Y0</td>
<td>Use profile 0 on power up.</td>
</tr>
<tr>
<td>ATF0</td>
<td>Activate baud rate scan and synchronize.</td>
</tr>
<tr>
<td>AT&amp;U1</td>
<td>Use QAM modulation encoding.</td>
</tr>
<tr>
<td>ATQ1</td>
<td>Disable responses (no “OK” response to commands).</td>
</tr>
<tr>
<td>ATE0</td>
<td>Disable command echo.</td>
</tr>
<tr>
<td>AT&amp;W0</td>
<td>Store this configuration as user profile 0 in the modem’s non-volatile memory.</td>
</tr>
</tbody>
</table>

Modem Cable

When using the modem with a CERJAC test set, you must use the special modem cable (included). The cable has DB-25P connectors at each end, and provides the following connections:

```
<table>
<thead>
<tr>
<th>Cable End A</th>
<th>Cable End B</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>3</td>
</tr>
<tr>
<td>3</td>
<td>2</td>
</tr>
<tr>
<td>4</td>
<td>8</td>
</tr>
<tr>
<td>5</td>
<td>20</td>
</tr>
<tr>
<td>6</td>
<td>7</td>
</tr>
<tr>
<td>7</td>
<td>4</td>
</tr>
<tr>
<td>8</td>
<td>6</td>
</tr>
<tr>
<td>20</td>
<td></td>
</tr>
</tbody>
</table>
```
Using Remote Control
Download Procedure  26-3
About the DOWNLOAD Program   26-6

Downloading
Operating
Software
About Software Downloading

At CERJAC Telecom Operation, we are continuously working to enhance and improve the operation of our products. Some product enhancements do not require new hardware in the test set, but reside in the instrument's operating software. You can upgrade the test set's operating software without opening the case or making any internal modifications to the test set. Simply download new operating software using a PC and a CERJAC distribution diskette.

There are two different types of operating software that can be downloaded:

- **Host software**: This is the general “operating system” of the test set.
- **Feature specific software**: This includes software associated with a specific option, such as ATM or STS-12c.

The basic procedure for downloading operating software to the test set includes:

- Install the download program and software files on your PC, and check the for “readme.txt” files which contain the latest information.
- Connect the test set to your PC.
- Start the test set in Download mode.
- Execute the download procedure on the PC.
- Restart the test set.

In addition, the download procedure can be modified to meet the specific needs of your application.

**Note:** Depending on the age and hardware configuration of your test set, you may not be able to take advantage of all the new features incorporated in a software release. CERJAC's Technical Support department can help you determine if a hardware upgrade is necessary to support the features you desire. Call 1-800-9-CERJAC or contact your HP representative.
Download Procedure

The following procedure describes how to download Host or feature-specific software (such as ATM) to the test set. Be sure to read any release notes that came with the software distribution diskette.

**Note:** Be sure to check the distribution diskette for any "readme.txt" files which may contain additional information and instructions about the download procedure.

**Caution:** The download procedure clears all stored data and test set configurations.

**Caution:** This procedure creates a directory called "UPGRD" on your C: hard drive. If your PC already has an UPGRD directory, the installation will delete its contents. Make sure you move any important files to another directory before you begin this procedure.

1. Insert the software distribution diskette in your PC's disk drive.
2. Install the download program and test set software files on your hard drive by doing one of the following:
   2a. *From Windows:*
      - In Program Manager, select Run... from the File menu.
      - In the Command Line box type A:INSTALL and click OK.
   2b. *From DOS:*
      - Type the letter of the distribution disk's drive (for example "A:"), and press Enter.
      - Type INSTALL and press Enter.

The installation program creates the C:\UPGRD directory or, if the directory exists, deletes the contents of the directory. Next the installation program copies and decompresses files to the C:\UPGRD directory.
3. View the contents of the CAUPGRD directory and make a note of the operating software files.
   - Host software files have the name MTSxxxxx.OUT
   - Feature specific software files have names like ATMxxxxx.HEX where “ATM” indicates the name of the feature.

3a. To view the directory contents from Windows:
   - Double-click on the File Manager icon to launch it.
   - Click on the C: drive icon.
   - Double-click the UPGRD directory.

3b. To view the directory contents from DOS:
   - Type DIR CAUPGRD and then press Enter.

4. Start the download program by doing one of the following:

4a. From Windows:
   - In Program Manager, select Run... from the File menu.
   - In the Command Line box type
     
     CAUPGRD\DOWNLOAD\filename
     
     where filename is the name of the file you want to download.
   - Click OK.

4b. From DOS:
   - Verify the DOS prompt is in the UPGRD directory. Type
     CD CAUPGRD and press Enter if necessary.
   - Type DOWNLOAD filename and then press Enter.

The CERJAC Download screen is displayed.

5. Switch off your CERJAC test set and use a straight-through RS-232 cable to connect the REMOTE RS-232 port on the test set to a COM port on the PC.

6. Press and hold the MENU-up key and then switch on the test set.

7. Continue holding MENU-up until the download screen is displayed.
Download Procedure

8. Next press one of the following keys:

- If you are downloading the Host software, press the START key and proceed to step 10.

- If you are downloading feature software, press the appropriate key listed on the display. For example, press MENU-down for ATM. The screen displays the following message:

   Model 156 MTS SONET Maintenance Test Set
   Boot PROM Version X.XX Oct 11 1993
   Serial#: MTSXXXXX
   
   Current ATM Firmware: X.XX Nov 13 1991
   Press START key to download,
   or Power off to cancel.

9. If you are downloading feature software, press START again. The display indicates that the old software has been erased and the set is ready for the download.

   Caution: Wait for the "software erased" message before moving to the next step.

10. At the PC, press Enter to start the download.

   When the download is complete, the test set displays a message that the download was successful.

11. Switch the test set off and then on again to reset it.

   The download is complete.
About the DOWNLOAD Program

The DOWNLOAD.EXE executable file is included on the distribution diskette when you receive your operating software upgrade. While simply typing DOWNLOAD to execute the program is adequate for most applications, the DOWNLOAD program accepts several variables that modify its operation for special cases.

The full format for the download command is as follows:

```
DOWNLOAD filename.ext /Pn /In /Bnnnn /Annn
```

The parts of the command are described below.

**DOWNLOAD**: The root command. Starts the software download process. If no parameters are specified the default values are used (see below) which is equivalent to typing DOWNLOAD /P1 /I4 /B38.4 /A3F8.

**filename.ext**: Selects the software file to be downloaded. Operating software files end with the extension .OUT; feature-specific files end with the extension .HEX. If no file is specified, the program downloads the first file in the working directory that has the .OUT extension.

**/Pn**: Specifies the COM port to be used on the PC, where n is 1 through 4. For example /P3 selects COM3. If no port is specified, COM1 is used.

**/In**: Specifies the system interrupt request line (IRQ) for the COM port, where n is 1–7. For example /I4 selects IRQ 4. If no IRQ is specified, IRQ 4 is used for COM1 and COM3 and IRQ 3 is used for COM2 and COM4.

**/Bnnnn**: Specifies the baud rate for the COM port, where nnnn is 1200, 4800, 9600, 19.2, or 38.4. For example B19.2 sets the baud rate to 19.2 Kbaud. If no baud rate is specified, 38.4 Kbaud is used.

**/Annn**: Specifies the COM port's base address in hexadecimal notation, where each digit of nnn can be 0 through F. For example A3F8 sets the base address for 3F8h. If no base address is specified the base addresses 3F8, 2F8, 3E8, and 2E8 are used for COM1 through COM4, respectively.
General Specifications
Printer and Control Ports

### Printer Port

**PRINTER RS-232:** RS-232C (DCE) with request-to-send and clear-to-send. DB-25 pin connector.

<table>
<thead>
<tr>
<th>Pin</th>
<th>Function</th>
<th>Pin</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Rx Data input</td>
<td>7</td>
<td>Signal ground</td>
</tr>
<tr>
<td>3</td>
<td>Tx Data output</td>
<td>20</td>
<td>Data terminal ready (DTR); tied to pin 4</td>
</tr>
<tr>
<td>4</td>
<td>Request to send (RTS) input</td>
<td>5</td>
<td>Clear to send (CTS) output</td>
</tr>
</tbody>
</table>

### Remote Port (RS-232)

**REMOTE RS-232:** RS-232C (DCE) with request-to-send and clear-to-send. DB-25 socket connector.

<table>
<thead>
<tr>
<th>Pin</th>
<th>Function</th>
<th>Pin</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Rx Data input</td>
<td>6</td>
<td>Tied to pin 5 for modem applications</td>
</tr>
<tr>
<td>3</td>
<td>Tx Data output</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Request to send (RTS) input</td>
<td>7</td>
<td>Signal ground</td>
</tr>
<tr>
<td>5</td>
<td>Clear to send (CTS) output</td>
<td>Others</td>
<td>Not used</td>
</tr>
</tbody>
</table>

### Null-modem connections

To connect to a modem use a “null-modem” cable or adapter as described in the following table (Also, see *Modem Cable*, page 25–9):

<table>
<thead>
<tr>
<th>End “A” Pins</th>
<th>to</th>
<th>End “B” Pins</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>8</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>4</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>End “A” Pins</th>
<th>to</th>
<th>End “B” Pins</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>20</td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>6</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>7</td>
<td></td>
</tr>
</tbody>
</table>
General Specifications

Printer and Control Ports

Remote Port (IEEE-488)

**REMOTE IEEE-488:** HP-IB (GPIB) interface. 24-conductor, type 57 microribbon socket connector. Conforms to IEEE-488.1 standards.

<table>
<thead>
<tr>
<th>Pin</th>
<th>Function</th>
<th>Pin</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>DIO 1</td>
<td>13</td>
<td>DIO 5</td>
</tr>
<tr>
<td>2</td>
<td>DIO 2</td>
<td>14</td>
<td>DIO 6</td>
</tr>
<tr>
<td>3</td>
<td>DIO 3</td>
<td>15</td>
<td>DIO 7</td>
</tr>
<tr>
<td>4</td>
<td>DIO 4</td>
<td>16</td>
<td>DIO 8</td>
</tr>
<tr>
<td>5</td>
<td>EOI</td>
<td>17</td>
<td>REN</td>
</tr>
<tr>
<td></td>
<td>End or Identify</td>
<td></td>
<td>Remote enable</td>
</tr>
<tr>
<td>6</td>
<td>DAV</td>
<td>18</td>
<td>pair w/6</td>
</tr>
<tr>
<td>7</td>
<td>NRFD</td>
<td>19</td>
<td>pair w/7</td>
</tr>
<tr>
<td>8</td>
<td>NDAC</td>
<td>20</td>
<td>pair w/8</td>
</tr>
<tr>
<td>9</td>
<td>IFC</td>
<td>21</td>
<td>pair w/21</td>
</tr>
<tr>
<td>10</td>
<td>SRQ</td>
<td>22</td>
<td>pair w/10</td>
</tr>
<tr>
<td>11</td>
<td>ATN</td>
<td>23</td>
<td>pair w/11</td>
</tr>
<tr>
<td>12</td>
<td>Shield</td>
<td>24</td>
<td>Signal ground</td>
</tr>
<tr>
<td></td>
<td>Earth ground</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Error Burst Triggering

**BURST ERR IN:** Burst error injection trigger input: TTL level, 50 ohm, BNC. When the receive level is high, error injection is active. The error injection **Rate** field must be set to **Burst**, see **About Error Injection Rates**, page 27–7.
Data Link Interfaces

**RS-232 Data Link Port**

**DATA LINK RS-232 port**: DB-25 socket connector. See *SONET Datalink Control Parameters*, page 3-18.

<table>
<thead>
<tr>
<th>Pin</th>
<th>Signal Name</th>
<th>Pin</th>
<th>Signal Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>1, 7</td>
<td>Ground</td>
<td>10</td>
<td>Receive Sync Out</td>
</tr>
<tr>
<td>2</td>
<td>Transmit Data In</td>
<td>15</td>
<td>Transmit Clock Out</td>
</tr>
<tr>
<td>3</td>
<td>Receive Data Out</td>
<td>17</td>
<td>Receive Clock Out</td>
</tr>
<tr>
<td>5</td>
<td>Transmit CTS Out</td>
<td>All others</td>
<td>Not used</td>
</tr>
<tr>
<td>9</td>
<td>Transmit Sync Out</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**RS-422 Data Link Interface**

**DATA LINK RS-422**: DB-25 socket connector. See *SONET Datalink Control Parameters*, page 3-18.

<table>
<thead>
<tr>
<th>Pin</th>
<th>Signal Name</th>
<th>Pin</th>
<th>Signal Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Transmit Data In (NEG)</td>
<td>14</td>
<td>Transmit Data In (POS)</td>
</tr>
<tr>
<td>4</td>
<td>Transmit Clock Out (NEG)</td>
<td>16</td>
<td>Transmit Clock Out (POS)</td>
</tr>
<tr>
<td>6</td>
<td>Transmit Sync Out (NEG)</td>
<td>18</td>
<td>Transmit Sync In (POS)</td>
</tr>
<tr>
<td>8</td>
<td>Receive Data Out (NEG)</td>
<td>20</td>
<td>Receive Data Out (POS)</td>
</tr>
<tr>
<td>10</td>
<td>Receive Clock Out (NEG)</td>
<td>22</td>
<td>Receive Clock Out (POS)</td>
</tr>
<tr>
<td>12</td>
<td>Receive Sync Out (NEG)</td>
<td>24</td>
<td>Receive Sync Out (POS)</td>
</tr>
<tr>
<td>1, 7</td>
<td>Ground</td>
<td>Others</td>
<td>Not used</td>
</tr>
</tbody>
</table>
Handset Interface

**HANDSET:** RJ-11 socket connector. See *SONET Datalink Control Parameters*, page 3–18.

### Handset Interface Pinout

<table>
<thead>
<tr>
<th>Pin</th>
<th>Signal Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Transmit In (NEG)</td>
</tr>
<tr>
<td>2</td>
<td>Receive Out (POS)</td>
</tr>
<tr>
<td>3</td>
<td>Receive Out (NEG)</td>
</tr>
<tr>
<td>4</td>
<td>Transmit In (POS)</td>
</tr>
</tbody>
</table>

**Note:** The handset interface is not available on test sets equipped with Option 231. See *Option 231*, page 27–6.
Physical and Electrical Characteristics

Physical

Size (WxHxD): 14.5 x 7.5 x 16.0 inches (36.8 x 19.0 x 40.6 cm).

Weight: 30.0 pounds (13.8 kg).

Electrical

AC Line: 100 to 240 Vac; 47 to 63 Hz; 200 VA maximum.

Fuse rating:

Warning! This test set requires different fuses for 115 Vac and 230 Vac operation. Refer to the table below.

Warning! Disconnect power before replacing fuse. For continued fire protection, replace with same type of fuse.

<table>
<thead>
<tr>
<th>Fuse Rating</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>115 Vac Operation</strong></td>
</tr>
<tr>
<td><strong>230 Vac Operation</strong></td>
</tr>
</tbody>
</table>

Option 231

If your 156MTS is equipped with Option 231, the unit complies with the directives required to display the “CE” mark for shipments into Europe. Refer to the Declaration of Conformity that was shipped with your unit for a list of the regulations to which the test set conforms.

Handset Option: The SONET datalink handset connector is not available on units equipped with Option 231.

Environmental

Operating Temperature: 0 to +45 °C (+32 to +113 °F).

Storage Temperature: -20 to +70 °C (-4 to +158 °F).

Humidity: 5 to 90%RH, noncondensing.
About Error Injection Rates

When you inject errors on the transmit signal, the error injection speed or number of repetitions is controlled by the alarm Rate field. The available rates vary depending on the selected error Type.

**Single:** One occurrence of the error type is transmitted each time the ERROR INJECT key is pressed.

**1.0E-X:** A steady error rate of the selected type begins when the ERROR INJECT key is pressed, and stops when the key is pressed again. The LED is lit when errors are being injected. This value sets the error ratio so that $1 \times 10^{-X}$ (1-out-of-$10^{X}$) bits of the selected type are errored. For example, selecting 1.0E-2 would error $1 \times 10^{-2}$ bits, or one bit out of every $10^{2} = 100$ bits.

**X Consec:** Injects errors for $X$ consecutive frames or occurrences. These values are useful for testing alarm detection thresholds, and may be set just above or just below the threshold.

**Continuous:** Errors are injected into every bit or byte of the selected type. Injection is toggled on and off using the ERROR INJECT key.

**Burst:** Error injection is active when a logic high level is present at the rear-panel BURST ERR IN jack. See Error Burst Triggering, page 27-3.

**Off:** No errors are injected. The ERROR INJECT key is disabled so that errors are not inadvertently injected.
GLOSSARY

AAL: ATM adaptation layer. Two sublayers of the BISDN protocol model that handle the segmenting of service payloads into ATM cells.

AB/ABCD: Signaling bits for DS0 and TS channels.

ac: Alternating current.

AIS: Alarm indication signal. Originally called a “Blue” alarm.

ALBO: Automatic line build out.

all-ones: A bit pattern made up entirely of binary 1s.


APS: Automatic protection switching.

asynchronous: Not synchronized; not timed to an outside clock source.

ATM: Asynchronous transfer mode. A multiplexing and switching scheme using fixed-length cells comprising a header and payload section. There is no fixed relationship between cell generation and the transmission medium.

background channel: Additional channels on the ATM stream that are not the foreground channel.

bandwidth: A network’s or channel’s capacity to carry traffic.

BER: Bit error ratio. The number of errored bits over the total number of bits. This term is often used interchangeably with bit error rate (the number of errored bits per second).

BERT: Bit error ratio testing. This term is often used interchangeably with bit error rate testing.

BIP-n: Bit-interleaved parity n. An error monitoring scheme in which an n-bit code is used to provide proper parity over a specific part of a signal.

B-ISDN: Broadband ISDN. See also ISDN.

bit: A basic unit of data. A bit can be set to either a zero or a one.

BITS: Building integrated timing supply. A stratum 1 clock source, typically in a CO.

Blue alarm: See AIS.

BnZS: Bipolar with n-zero substitution. A line coding scheme in which n consecutive zeros are replaced by a substitution code to maintain a high pulse density. Typical codes are B3ZS for DS3 and B8ZS for DS1.

BPV: Bipolar violation. The occurrence of a pulse that breaks the alternating polarity rule.

BW: See bandwidth.

byte: Eight bits. Usually refers to a particular location in a frame.

C-bit: The third, fifth, and seventh overhead bits in a DS3 signal’s M-subframes.

C-bit parity format: A DS3 framing format.

CAS: Channel associated signaling.
CBR: Constant bit rate. A type of service in an ATM network for steady rate voice or synchronous data.

CCITT: Consultative Committee on International Telegraph and Telephone.

cell: Basic unit in ATM transmission. A 53-byte ATM cell comprises a 5-byte header and 48 bytes of information.

cell header: The first five bytes of an ATM cell.

cell loss priority bit: Bit 32 of an ATM cell header (bit 8 of byte 4).

clock: The timing of, or timing source for, digital telecom equipment.

CLP: See cell loss priority bit.


COFA: Change of frame alignment. A shift in the alignment of a signal's framing bits.

concatenation: The grouping of SONET STS payloads to form one large payload.

CP-bit: The third, fifth, and seventh overhead bits in the third M-subframe of a C-bit parity formatted DS3 signal.

CRC: Cyclic redundancy checksum. A basic error-checking technique.

CSES: Consecutively severely errored second.

CV: Code violation.

D4: See SF.

Daly pattern: A repeating 55 octet pattern.

datalink: A transmission path for data.

dB: Decibel. Standard unit for transmission loss, gain, and relative power ratios.

dBdsx: Decibels relative to the DSX level.

dBm: Decibels relative to one milliwatt.

de: Direct current.

DCC: Data communications channel.

DCE: Data circuit-terminating equipment. Equipment that provides the interface between a DTE device and a transmission circuit. For example, a modem.

DRS: Digital reference signal.

DS0: Digital signal level 0; typically 64 or 56 kb/s.

DS1: Digital signal level 1; 1.544 Mbs.

DS2: Digital signal level 2; 6.312 Mbs

DS3: Digital signal level 3; 44.736 Mbs.

DSX: A digital signal cross-connect and patch bay.

DTE: Data terminal equipment. Equipment that converts user information into data signals for transmission. For example, a PC.

E1: A CCITT digital signal of 2.048 Mbs.

EFS: Error-free second.

error rate: The number of errors per second. Compare error ratio.

error ratio: The number of errors over the total number of bits. This term is often used interchangeably with error rate, although they are two different measurements.

ES: Errored second. A second in which at least one error occurred.

ESF: Extended Superframe framing format (DS1).

F-bit: Framing bit.

F4 OAM: An ATM OAM cell with a VCI of 3 or 4 (decimal), used for VC OAM. See also OAM cell.
**F5 OAM**: An ATM OAM cell with a PT of 4 or 5 (decimal), used for VP OAM. See also OAM cell.

**FAS**: Frame alignment signal.

**FEAC**: Far-end alarm and control. The FEAC channel uses the third C-bit to carry alarm and control information.

**FEBE**: Far-end block error.

**FERF**: Far-end receive failure.

**FFCV**: Frame format coding violation.

**FFM**: Frame format mismatch.

**foreground channel**: The primary ATM channel used for ATM BER testing, etc.

**frame**: A group of bits, timeslots, or bytes whose unique positions can be identified relative an alignment signal or pointer.

**FT1**: Fractional T1. A subrate signal on a DS1, comprising N number of DS0 channels. See also N x 64.

**GFC**: Generic Flow Control. The first four bits of byte 1 in an ATM cell header.

**GPIB**: General purpose interface bus. See HP-IB.

**HCS**: Header check sequence. See HEC.

**header**: See cell header.

**HEC**: Header error control. A CRC field in the ATM cell header (byte 5).

**hexadecimal**: A base-16 numbering system in which the digits range from 0 through F. A hexadecimal value is noted with a subscript "h," for example: "2A0F_h."

**HDB3**: High-density bipolar with three-zero substitution. A line coding scheme.

**HP-IB**: Hewlett-Packard interface bus. A control bus for instruments.

**Hz**: Hertz.

**idle cell**: An ATM cell with a VP/VC address of 00000000, PT of 000, and CLP of 1. Compare with unassigned cell.

**idle signal**: A signal transmitted to indicate that a channel is not in use.

**IEEE-488**: Another name for the HP-IB or GPIB.

**ISDN**: Integrated Services Digital Network.

**ISO**: International Standards Organization.

**jitter**: Short-term variation in the phase of a digital signal (includes phase variation above 10 Hz).

**kbs**: Kilobits.

**kHz**: Kilohertz.

**LBO**: See line build-out.

**LCD**: Liquid crystal display.

**LCVA**: Line code violation alarm.

**LCVR**: Line code violation rate.

**line**: In a SONET network, the part of the path between two consecutive line terminating network elements.

**line build-out**: A circuit that simulates the signal attenuation of a specified cable length.

**line identifier**: A FEAC bit sequence that indicates which DS3 or DS1 line is to be affected by a loopback command.

**LOCS**: Loss of cell synchronization.

**LOF**: Loss of frame.
loopback: A state in which the transmit signal is reversed back as the receive signal, typically by a far-end network element.

LOS: Loss of signal.

M-bit: M-subframe framing bit. Bit 1 of the fifth, sixth, and seventh M-subframes in a DS3 signal.

M13: A DS3 framing format, or the multiplex between the DS1 and DS3 levels.

MBLT: Mobile both-line terminal framing format.

Mbs: Megabits per second. One megabit equals one million bits.

MBS: Maximum burst size.

M-frame: See multiframe.

MFA: Multiframe alignment. See multiframe.

MHz: Megahertz.

misinserted cell: An ATM AAL-1 cell that has a valid sequence number but is received out of order.

monitor level: The signal level at a DSX Monitor point.

multiframe: A set of consecutive frames in which the position of each is defined in relation to a multiframe alignment signal.

N x 64/N x 56: A subrate signal on a DS1 formed by using N number of 64 kbs or 56 kbs channels.

NDF: New data flag.

NIU: Network interface unit.

nm: Nanometer. One-billionth (10^-9) of a meter.

NNI: Network-network interface. The demarcation point between two networks.

O-bit: DS3 overhead communication channel bits.

OAM cell: Operation and maintenance cell. An ATM cell with a payload type value of 1xx.

OC-1: Optical carrier signal, level 1 (51.840 Mbs).

OC-N: Optical carrier signal, level N (N number of OC-1s).

octet: Eight bits. Typically refers to a group of bits that spans more than one byte. Compare byte.

OH: See overhead.

OOF: Out of frame.

orderwire: A voice or data circuit used for maintenance purposes.

overhead: The bits or bytes in a frame or cell that are not the payload. Overhead provides for signal control and monitoring.

P-bit: Parity bit. The P-bit channel of a DS3 comprises the P1 and P2 bits of the M-frame and provides parity information for the preceding M-frame.

parity: An error checking method that uses extra bits to provide even or odd parity for a specific group of bits.

path: In a SONET network, the connection between the point where the frame for a signal is assembled, and the point where it is disassembled.

path overhead: The portion of STS overhead contained with the SPE.

payload: The information bits of a frame or cell. Those bits that are not part of the overhead.

payload pointer: The pointer that indicates the beginning of the SPE.

payload type: Three bits in the fourth byte of an ATM cell header indicates the payload type for the cell.

PCR: Peak cell rate.
**PDH:**  Plesiochronous digital hierarchy

**PLCP:**  Physical layer convergence protocol. A protocol that defines the mapping of ATM cells onto a facility. DS3 PLCP comprises a 125 µs frame within the DS3 payload; there is no fixed relationship between the PLCP frame and the DS3 frame.

**POH:**  See *path overhead*.

**POI:**  Path overhead indicator.

**pointer:**  See *payload pointer*.

**PRBS:**  Pseudorandom bit sequence. A test pattern that simulates live, random traffic.

**QRSS:**  Quasirandom sequence signal.

**RAI:**  Remote alarm indication.

**RDI:**  Remote defect indication.

**SC:**  Sequence check. The first byte after the header in an AAL-1 ATM cell.

**SCNR:**  Selected cell not received.

**SCPI:**  Standard commands for programmable instruments. A remote instrument control language.

**SCR:**  Sustained cell rate.

**SDH:**  Synchronous digital hierarchy.

**section:**  The part of a SONET *path* between a terminal network element and a regenerator, or between two regenerators.

**SEE:**  Severely errored event.

**SF:**  Superframe format. DS1 framing format.

**SLC-96™:**  Subscriber loop carrier system 96. An AT&T T1 framing format.

**SN:**  Sequence number. A unique value indicating the transmission order of ATM cells. Also called *sequence count*.

**SONET:**  Synchronous optical network.

**SPE:**  Synchronous payload envelope. The part of the STS frame not including the transport overhead.

**STS-1:**  The basic synchronous transport signal. A 125 µs frame (51.840 Mbs).

**STS-N:**  Synchronous transport signal N, where N indicates the number of STS-1s interleaved to generate the signal.

**STS-Ne:**  Concatenated STS signal. An STS-N in which the payloads are grouped to carry a super rate signal.

**sub-multiframe:**  A division of a multiframe that also contains multiple frames. Also called an M-subframe.

**synchronous:**  Synchronized. Occurring at the same rate or period; sharing common timing with an outside timing source.

**T1:**  See *DSI*.

**timeslot:**  A unique, cyclic time interval; typically providing a single channel.

**timing:**  See *clock*.

**traffic profile:**  In ATM, the characteristics of a cell stream as defined by its peak cell rate, sustained cell rate, and maximum burst size.

**transport overhead:**  The portion of STS overhead including section OH and line OH.

**TS:**  See *timeslot*.

**TS0:**  Timeslot zero. The first timeslot in an E1 frame.
**TS16**: Timeslot sixteen. The 17th timeslot in an E1 signal, used to provide channel associated signaling.

**TTL**: Transistor-to-transistor logic. A standard transmission level with a logic low of zero volts and a logic high of 5 volts.

**UAS**: Unavailable seconds.

**UI**: Unit interval. The duration of one clock cycle, or pulse period, for a given rate.

**unassigned cell**: An ATM cell with VP/VC of 000/0000 and a CLP of 0. Compare with *idle cell*.

**UNI**: User-Network Interface. The demarcation point between the customer premise and the network.

**V**: Volts.

**Vac**: Volts, alternating current.

**VC**: Virtual channel. A path between two points identified by a label rather than a fixed physical path.

**VCI**: Virtual channel identifier. The label assigned to a VC.

**Vdc**: Volts, direct current.

**VF**: Voice frequency.

**VP**: Virtual path. A route, identified by a label, for a group of VCs transmitted between common points.

**VPI**: Virtual path identifier. The label assigned to a VP.

**Vpk**: Volts peak.

**VT**: Virtual tributary.

**VT1.5**: A virtual tributary carrying a DS1 (1.544 Mbs) signal.

**X-bit**: The first overhead bit in the first and second M-subframes of a DS3 M-frame.

**Yellow alarm**: (DS1) Also called a remote alarm or RAI, this alarm indicates a near-to-far transmission failure.
Warranty

The HP E4480A CERJAC 156MTS Test Set (excluding lasers) is warranted by Hewlett-Packard against defects in materials and workmanship for three years after shipment to the Customer. The three-year warranty period applies only to the original purchaser and is not transferrable without the express written permission of Hewlett-Packard. Laser transmitters carry a one-year warranty. If Hewlett-Packard receives notice of such defects during the warranty period, HP will at its option either repair or replace the equipment which proves to be defective. HP does not warrant that the operation of the equipment will be uninterrupted or error free. If HP is unable, within a reasonable time, to repair or replace any equipment to a condition as warranted, Customer will be entitled to a refund of the purchase price upon prompt return of the equipment to HP. This warranty does not apply to defects resulting from improper or inadequate maintenance or calibration by Customer, Customer supplied software, interfacing or supplies, unauthorized modification or improper use, operation outside of the published environmental specifications for the equipment, or improper site preparation or maintenance by customer.

THE ABOVE WARRANTIES ARE EXCLUSIVE AND NO OTHER WARRANTY, WHETHER WRITTEN OR ORAL, IS EXPRESSED OR IMPLIED. HP SPECIFICALLY DISCLAIMS THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT WILL HP OR ITS SUBCONTRACTORS BE LIABLE FOR LOSS OF DATA OR FOR DIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL (INCLUDING LOST PROFIT), OR OTHER DAMAGE WHETHER BASED IN CONTRACT, TORT, OR OTHERWISE.
Calibration and Service

Calibration

This instrument must be calibrated only by authorized CERJAC or HP personnel. Unauthorized service or calibration will void the warranty.

The HP E4480A CERJAC 156MTS requires calibration every three years. To arrange for calibration, please contact HP Service Test Division (CERJAC) Technical Support at 1-800-923-7522 or 978-266-3300.

Service

If your 156MTS does not appear to be operating properly, carefully check all configuration parameters and connections. Improper selection of timing modes or drop channels, for example, can cause unexpected operation.

To reset the 156MTS to its factory-default settings, switch the instrument on while pressing and holding the STOP key. Release the STOP key when the display shows “Performing Cold Start.” When the factory defaults are reset, you can use a patch cord to loop the instrument back on itself and perform simple tests to verify its operation. If this procedure does not solve your problem, call HP Service Test Division (CERJAC) Technical Support at 1-800-923-7522 or 978-266-3300. Trained personnel are available to help solve your problem or determine if the unit must be returned for repair.
Returning a Unit for Repair

If your 156MTS must be returned, a Technical Support representative will assign a return material authorization (RMA) number. No product will be accepted for service without an RMA number.

Ship the instrument to: Repair Department
Hewlett-Packard Service Test Division
2 Robbins Road
Westford, MA 01886 USA

Be sure to mark the RMA number on the outside of the shipping container. In addition, be sure to include the following information:

- Model number (E4480A) and name (156MTS)
- Serial number
- Your name and phone number
- A written description of the problem
- Return “ship to” address
- Invoice address
- Payment information (if unit is out of warranty)
Index

A

A/2 bytes
- error injection 3-29
- error measurements 4-12

AAL type
- cell structures 21-2-21-4
- foreground channel 19-8
- receive channel 19-16

action/local key 1-2

Administrative Setups
- screen 23-8

alarms
- ATM measurements 20-20
- DS1 measurements 12-16
- DS3 measurements 8-13
- E1 16-15
- error squelching 23-3
- SONET 2-8, 3-29
- STS-N measurements 4-24
- VT measurements 4-33

APS
- configure 2-4
- measurement screen 4-15
- message 3-11
- mode 3-12
- passthrough 3-20
- requested channel 3-12
- setup parameters 3-11

ASCII characters hex values 3-17

ATM
- address notation 19-4
- automatic channel scan 18-2
- background channels 18-15, 18-16, 19-18
- BW step size
- cell capture 18-4
- configure VP/VC 18-14
- error injection 19-23
- GFC 19-14
- global setup
- parameters 18-10, 19-4
- idle cell payload 19-12
- indicators 20-2
- MBS 19-7
- payload type 19-14
- PCR 19-7
- periodic burst mode 19-10
- receive channel 19-13
- receive cell type 19-16
- SCR 19-7
- setup menu 19-3
- setup parameters 19-1-19-22
- test mode 19-3
- testing 18-1
- traffic shaping 19-4, 19-7
- user pattern 19-12
- VBR profile 19-7
- VCI 19-14
- VPI 19-14

ATM cell
- burst size 19-9
- payloads 18-13
- scrambling 19-4
- structure 21-2
- test cell 19-8, 21-4

ATM foreground channel 18-11, 18-12, 19-13
- distribution 19-8
- interleaving 19-10
- setup 19-6

ATM measurements 20-1-20-21
- AAL-1 CRC/parity 20-11
- AAL-1 misinserted cells 20-12
- alarms 20-20
- cell loss 20-10
- HEC errors 20-7
- payload bit error 20-9
- PLCP 20-16
- selected VP/VC 20-4
- total cell stream 20-6

ATM on STS-12c 19-22

ATM rx channel
- measurements 20-4

ATM SETUP screens
- #1 Global Setup screen 19-4
- #2 Foreground Channel Control
  screen 19-6
- #3 Cell Payload Data
  screen 19-12
- #4 screen (header and rx
  channel) 19-13
- #5 Transmit Background
  Channel Control
  screen 19-17
- #6 Transmit Background
  Header Setup screen 19-20
- STS-12c 19-22
Auto Setup key 1-2
automatic print mode 23-5
automatic test start 23-5
Auxiliary Test Setup display 23-4

B
B1 byte
CV measurements 4-5
error injection 3-28
B2 byte
CV measurements 4-6
error injection 3-28
B3 byte
CV measurements 4-9
error injection 3-28
background channels
AAL type 19-18
activation 19-17
configure 18-15, 18-16
header setup 19-20
payload 19-18
bandwidth—see BW

BITS timing
input 3-2, 3-4
output source 23-7

block errors
DS1 measurements 12-6
E1 measurements 16-7
block size 23-7

BPVs
DS1 measurements 12-10
DS3 measurements 8-10
E1 measurements 16-11
STS-1 measurements 4-13

burst error input 1-3
burst error trigger 27-3, 27-7
BW
foreground channel 19-6
step size 19-4

calibration and service 2
C-bit 7-11
CDI (DS1 idle) 11-8, 12-12
CE mark 27-6
cell capture
running a test 18-4
cell interleaving 19-10
periodic bursts 19-9, 19-10
cell loss measurements 20-10
cell loss priority 19-14

CLP 19-14
Code>
    DS1 11-3
    E1 15-4
cold start 1-8

Configuration From>
    DS0 11-19
    DS1 11-17
configuration lock during test 23-2
configuration storage recall 22-3
store 22-2
contrast keys 1-2

correctable HEC errors 20-7
counting mode (VT) 3-26, 23-6
    configure 2-11

D
D&I channel—see D&I>
D&I>
    DS0 11-11
    DS1 11-6
    STS-1 3-8
    STS-3c 3-10
    TS 15-7
Daly pattern 11-5

Data>
    ATM background channel 19-18
    ATM foreground channel 19-12
    ATM idle cells 19-12
    DS0 11-11
    DS1 11-4
    DS3 7-3
    EI 15-3
    FE1 15-9
    FT1 11-9
    STS-1 3-8
    STS-12c 3-9
    STS-3c 3-9
    STS-Nc 3-9
    TS 15-7
datalinks
    configure 2-7, 10-5
    handset port 1-3, 27-5
    ports 27-4
date and time 23-8
display 1-4
display hold key 1-2, 1-9
download
    DOWNLOAD program 26-6
drop & insert mode 1-13
drop channel—see Drop>
Drop
DS0  11-11  
DS1  11-6  
DS1 from dual DS3  7-6  
E1  15-5  
STS-1  3-7  
STS-3c  3-10  
TS  15-6  
VT  3-25  
VT group  3-26  

DS0
bit error measurements  12-20  
configure  10-8  
D&I channel  11-11  
drop channel  11-11  
error injection  11-8  
insert channel  11-10  
payload  11-11  
setup
   parameters  11-10  11-12  
signaling drop port  13-4  
signaling scan  10-17, 11-19  
testing  10-1  
tx signaling  11-12  
VF measurements  12-19  

DS1
automatic drop scan  10-15  
block size  23-7  
CDI  11-8  
configure  10-4  
D&I channel  11-6  
drop channel  11-6  
DS0  11-10  
DS1/E1 alarm and status  
   LEDs  1-2  
   error injection  11-8  
   ESF datalink message  10-5  
   framing format  11-3, 13-6  
   PT1  11-9  
   idle code  11-8, 12-12  
   indicators  12-2, 16-2  
   insert channel  11-6  
   line code  11-3  
   loop codes  11-8, 11-14  
   payload  11-4  
   rx level  11-4  
   setup parameters  11-2, 11-8  
   status screen  12-18  
   termination mode  11-4  
   testing  10-1  
   tx level  11-3  
   tx timing  11-2  
   user patterns  10-6, 11-13  

DS1 measurements  12-1-12-22  
   alarms  12-16  
   bit error  12-4  
   block error  12-6  
   BPV  12-10  
   CRC-6  12-7  
   DS0  12-19, 12-20  
   ESF FDL  12-13  
   framing error  12-8  
   FT1  12-21  
   idle/CDI  12-12  
   jitter  4-23, 12-15, 16-14  
   loop codes  12-13  
   signal  12-14  
   slips  12-11  

DS1 structure  13-6  
DS1 DROP jack  11-6  
DS1/E1 connectors  1-2  

DS2
   frame format  9-5  
   measurement screen  8-20  
   transmit X-bit  23-6  

DS3
   alarm and status LEDs  1-2  
   C-bits  6-7, 7-11  
   configure  6-4  
   drop and insert  7-4  
   dual DS3 setup  6-5, 7-5  
   E1 mapping  16-5  
   error injection  7-17  

FEAC  6-7, 7-8  
FEBE bits  7-4  
frame format  7-2, 9-5  
indicators  8-2  
payload  7-3  
rx level  7-2  
setup parameters  7-1, 7-17  
testing  6-1  
tx DS2 X-bit  23-6  
tx level  7-2  
tx timing  7-4  
user pattern  6-9, 7-14  
X-bit  7-4  
DS3 C-Bit Control screen  7-11  
DS3 connectors  1-2  
DS3 FEAC Control screen  7-8  
DS3 measurements  8-1-8-21  
   alarms  8-13  
   bit error  8-4  
   BPV  8-10  
   C-bit monitor screen  8-12  
   CP-bit parity  8-7  
   DS2  8-20  
   dual DS3  8-3  
   FEAC  8-11  
   FFCV  8-9  
   frame error  8-8  
   jitter  4-23, 12-15, 16-14  
   P-bit parity  8-6  
   P-bits  8-12  
   PLCP  20-16  
   signal  8-15  
   status screen  8-17  
   X-bits  8-12  
DS3 overhead bits  9-6  
DS3 pulse mask  
   results  8-18  
   setup  7-12  
   test  6-11  
DS3 DROP jack  7-4
Index

dual DS3 7-5
DS1 drop 7-6
LED sharing 7-6
measurements 8-3
setup parameters 7-7
test setup 6-5

E

E1
block size 23-7
configure 14-4, 14-9
drop channel 15-5
DS1/E1 alarm and status
LEDs 1-2
DS3 mapping 15-5
error injection 15-10
FE1 15-9
framing format 15-2, 17-5
indicators 12-2, 16-2
insert channel 15-4
line code 15-4
payload 15-3
rx level 15-4
setup parameters 15-2-15-5
signaling scan 14-11
status screen 16-17
termination mode 15-4
testing 14-1
timeslot mode 15-6
TS setup parameters 15-6
tx level 15-4
tx timing 15-2
E1 measurements 16-1-16-19
alarms 16-15
bit error 16-4
block error 16-7
BPV 16-11
CAS frame error 16-9
CRC-4 16-10
jitter 4-23, 12-15, 16-14
signal 16-13
slips 16-12
TS 16-18, 16-19
TS0 frame error 16-8
TS16 frame error 16-9
E1 multiframe structure 17-6
E1 structure 17-5
error inject key 1-2
error injection
about error injection
rates 27-7
ATM 19-23
ATM-affecting error
types 19-24
burst input 1-3
burst trigger 27-3, 27-7
DS1/DS0 11-8
DS3 7-17
E1 15-10
SONET 3-28
VT 3-30
error squelching 23-3
ESF datalink message 10-5
ESF loop codes 11-14
event logging setup
parameters 22-8
Event Logging Setups menu 22-7

F

FDL 12-13
FE1
setup parameters 15-9
FEAC
alarm and status codes 7-8
measurement screen 8-11
setup parameters 7-8
transmission 7-8
FEBE
bits 7-4, 9-5
far-end FFCV count 8-9
FFCV measurements 8-9
foreground channel
AAL type 19-8
bandwidth 19-6
bit error measurements 20-9
cell distribution 19-8
configure 18-11, 18-12
distribution 19-10
header 19-13
payload 19-12
frame slips—see slips
measurements
framing format—see Frm>

Frm>
DS1 11-3
DS3 7-2
E1 15-2
front panel 1-2

FT1
bit error measurements 12-22
configure 10-7
setup parameters 11-9
testing 10-1
G
G1 byte
FEBE measurements 4-10
REI-P 4-10
GFC 19-14
GPIB—see IEEE-488

H
H1SS (H1 byte) 3-15
handset 1-3
handset interface 27-5, 27-6
HEC errors 20-7
hex values
ASCII characters 3-17
ATM programming 19-4
history reset key 1-2
HP-IB—see IEEE-488

I
idle cells
header 19-13
payload 19-12
idle code (DS1) 11-8, 12-12
IEEE-488
address 23-8
interface port 23-8
operation 25-8
setup 25-7
in-band loop codes 11-14
Ins>
DS0 11-10
DS1 11-6
E1 15-4
STS-1 3-7
STS-3c 3-10
TS 15-6
VT 3-23
VT group 3-26
insert channel—see Ins>
insert STS-1 channel numbering—see STS-12 numbering scheme
Inv PRBS? (invert PRBSs) 23-3

J
J0 byte
display screen 4-21
programming 3-16
J1 byte
display screen 4-21
programming 3-16, 3-22
jitter
hits measurements 4-23, 8-16, 12-15, 16-14
hits threshold 23-3
mask measurements 4-23, 8-16, 12-15, 16-14
measurements 4-23, 12-15, 16-14

K
K1/K2—see APS

L
laser 3-6
laser state during test setup 23-6
LCD display 1-2, 1-4
LEDs
ATM indicators 20-2
DS1/E1 indicators 12-2, 16-2
DS3 indicators 8-2
dual DS3 mode 7-6
STS-N indicators 4-2
VT indicators 4-27
Line (SONET span) 5-8, 5-10
line code—see Code>
line FEBE—see REI-L
line overhead bytes 3-14
loop codes
DS1 11-8
DS1 results 12-13
user-programmable 11-14

M
main menu 1-4
measurements
pulse mask 8-18
memory keys 1-2
misinserted cell results 20-12
mode—see test mode
Modify Global Configurations screen 23-2
monitor mode 1-12

N
navigation keys 1-2
Nx> (base rate) 11-9, 11-11

O
OAM cells 19-14
OC-1
rx source 3-5
setup parameters 3-4
tx timing 3-4
OC-12 rx source 3-2
OC-3 rx source 3-2
optical signal connectors 1-2
optical transmitter 3-6
Option 231 27-6
order at mux input
(STS-12) 23-6
order of transmission
(STS-12) 23-6
orderwire 1-3
Other>
  DS0 11-10
  DS1 11-6
  STS-1 3-7
  STS-3c 3-10
  TS 15-6
  VT 3-24
  VT group 3-26
Other>E1 15-5
Oths> (E1) 15-5
Oths>—see Other>DS1
out-of-band loop codes 11-14
overhead bytes 3-14
overhead configuration 2-5
P
passthru
  DS1 11-5
  DS3 7-3
Path (SONET span) 5-8, 5-10
path overhead
  bytes 3-15
  results screen 4-20
Path Overhead Control
  screen 3-15
patterns
  55 octet 11-5
  PRBS inversion 23-3
  user programmable 7-14, 10-6, 11-13, 19-12
patterns—see also Data>
payload type 19-14
payload—see Data>
P-bits display 8-12
PLCP
  error injection 19-23
  measurements 20-16
  structure 21-5
pointer
  automatic sequence 2-9
  error injection 3-29
  STS-12c measurements 4-15
pointer measurements 4-14
power-up optical transmitter
  state 3-6
PRBS inversion 23-3
print key 1-2
printing 24-1
  automatic 23-5, 24-3
  automatic event printing 22-8
  printer port parameters 23-8
  setup 24-2
Prog32>
  STS-12c 3-9
PT 19-14
pulse mask
  results 8-18
  running a test 6-11
  setup 7-12
R
rear panel 1-3
receive channel 19-13
  cell type 19-16
  measurement screens 20-4
  VP/VC 19-13
REI-L
remote control 25-1
  IEEE-488 interface
  parameters 23-8
  remote port parameters 23-8
SCPI/IEEE-488 25-7
remote front panel 25-3
  operation 25-6
  setup 25-4
repeating tests 23-4
restore default settings 1-8
results level 23-2
results storage
  automatic store 23-5
  clear 22-6
  recall 22-6
  store 22-5
RS-232 datalink port 3-18, 7-15,
  11-16
RS-422 datalink port 27-4
rx level—see Rx>
Rx>
  DS1 11-4
  DS3 7-2
  E1 15-4
  OC-1 3-5
  STS-1 3-5
  STS-N 3-2
S
SCPI
  operation 25-8
  setup 25-7
scrambling
  ATM cells 19-4
  STS-1 3-4, 3-8
SDH 3-15
Section (SONET span) 5-8, 5-10
section overhead bytes 3-14, 3-16
Section Overhead Control
  screen 3-15
Section Trace 3-16
Select>
FE1  15-9 
FT1  11-9 

service  2 

Setup Menu 
ATM  19-3 

Setup menu
administrative setup  23-8
auxiliary test setups  23-4 

signaling
drop port  13-4
DS0  11-12
TS  15-7 

signaling scan
DS0  10-17
E1  14-11 

slips measurements
DS1  12-11
E1  16-12 

SONET
alarms  3-29
DCC pass-through  3-19
error injection  3-28
J1 Path Trace Control
screen  3-16
orderwire handset  1-3
overhead bytes  5-10
overhead
parameters  3-13-3-17
parameters  3-1-3-30
VT parameters  3-23 

SONET measurements  4-1-4-26
APS  4-15
line code violations  4-6
path code violations  4-9
path FEBE  4-10
path overhead results  4-20
path trace display  4-21
pointer  4-14
REI-L  4-7
REI-P  4-10
section code violations  4-5
transport overhead
results  4-19
speaker keys  1-2
Start/Stop keys (test pause)  1-2 

STS-1
D&I channel  3-8
D&I payload  3-8
drop channel  3-7
insert channel  3-7
rx level  3-5
rx source  3-5
scrambling  3-4, 3-8
setup parameters  3-4, 3-7
tax level  3-5
tax timing  3-4 

STS-1 frame  5-8 

STS-1 measurements
BPV  4-13
jitter  4-23, 12-15, 16-14
signal  4-22 

STS-12 numbering scheme  23-6 

STS-12c
ATM  19-22
ATM HEC errors  20-7
bit error measurements  4-11
concatenated frame  5-11
pointer measurements  4-15
setup parameters  3-9 

STS-3c:
bit error measurements  4-11
drop channel  3-10
error injection  3-28
insert channel  3-10
pointer measurements  4-14
REI-L measurements  4-7
setup parameters  3-9 

STS-3c frame  5-11

STS-N
alarm and status LEDs  1-2
alarms measurements  4-24
frame measurements  4-12
indicators  4-2
pointer measurements  4-14
receive source  3-2
setup parameters  3-2
status screen  4-26
tax timing  3-2 

STS-N connectors  1-2
STS-N frame  5-9
concatenated  5-11 

STS-Nc
setup parameters  3-9 

Sub Menu Opt Pwr  23-6
System Configuration
screen  1-11

system parameters
event logging  22-7
system configuration  1-11 

T

Term>
DS1  11-4
E1  15-4 

terminal test mode  1-12
termination mode—see Term>
test duration mode  23-4
test mode  1-12
ATM  19-3 

test mode label  1-4, 1-12
test operation screen  1-4
test pause (Start key)  1-2, 1-9
test sequences
signaling scan  11-19
timed test length  23-4
timeslot—see TS
Index

Tone> 15-7
traffic profile 19-7
traffic shaping 19-4
transport overhead
  results screens 4-19
Transport Overhead Control
  screen 3-14
Trouble Scan 23-2
Trouble Scan key 1-2

**T**

bit error measurements 16-19
  configure 14-7
D&C channel 15-7
  drop channel 15-6
insert channel 15-6
measurements screen 16-18
payload (data) 15-7
payload (tone) 15-7
setup parameters 15-6–15-10
signaling drop port 13-4
  signaling scan 11-19
testing 14-1
timeslot mode 15-6
tx signaling 15-7

**S**

TS0 frame error
  measurements 16-8
TS16 frame error
  measurements 16-9
  tx level—see T<sub>x</sub>
  tx timing—see T<sub>x</sub>C<sub>lk</sub>

**T<sub>x</sub>**

DS1 11-3
DS3 7-2
STS-1 3-5

**T<sub>x</sub>C<sub>lk</sub>**

DS1 11-2
DS3 7-4
E1 15-2
OC-1 3-4
STS-1 3-4
STS-N 3-2

**T<sub>ype</sub>**

  background channel 19-18
  foreground channel 19-8
  receive channel 19-16

**U**

uncorrectable HEC errors 20-7
user patterns
  ATM 18-13, 19-12
  DS1 10-6, 11-13
  DS1 loop 11-14
  DS3 6-9, 7-14
  E1 11-13
  STS-12c 3-9

**V**

V5 byte
  FEBE measurements
    (VT) 4-30

VP measurements 12-19

VP/VC
  address notation 19-4
  automatic scan 18-2
  background channel 19-20
  configure 18-14
  foreground channel 19-13
  receive channel 19-13
  setup 19-14

**V**

configure 2-11
error injection 3-30
indicators 4-27
setup parameters 3-23

VT alarm and status LEDs 1-2
VT mapping
  counting mode 2-11, 3-26, 23-6
  drop channel 3-25
  drop VT group 3-26
  insert channel 3-23
  insert VT group 3-26
Other VTs payload 3-24
VT group mapping 3-27
VT measurements 4-27–4-34
  alarms 4-33
  code violations 4-29
  FEBE 4-30
  pointer measurements 4-31
VT overhead bytes 5-13
VT1.5 format and mapping 5-12

**W**

warranty 1

**X**

X-bit 7-4
  DS2 23-6
X-bits display 8-12
Reader Comment Card

We welcome your evaluation of this manual. Your comments and suggestions will help us improve our publications.

<table>
<thead>
<tr>
<th>Please check one box for each statement</th>
<th>Strongly Agree</th>
<th>Agree</th>
<th>Disagree</th>
<th>Strongly Disagree</th>
</tr>
</thead>
<tbody>
<tr>
<td>The manual is well organized.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>I can find the information I want.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>The index is thorough.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>I can easily understand the instructions and procedures.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>The instructions are complete.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>The manual is clearly written.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>The concepts and vocabulary are easy to understand.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>The examples are clear and useful.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>The manual contains enough examples.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>The illustrations are clear and helpful.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>The manual contains enough illustrations.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>The layout and format enhance the manual’s usefulness.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>The information in the manual is accurate.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>The manual as a whole is a good learning tool.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>The anticipated quality of the documentation influences my first-time purchase decision.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>The quality of this manual would influence future decisions to purchase CERJAC products.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>This manual meets my overall expectations.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Please write additional comments, particularly if you disagree with a statement above. Use additional pages if you wish.

_____________________________________________________________________________________

_____________________________________________________________________________________

_____________________________________________________________________________________

HP Product No: __________________________ Manual Part No: __________________________

Name: __________________________ Title: __________________________

Company: __________________________ Phone: __________________________

Address: __________________________

City: __________________________ State: _______ Zip Code: __________________________

Detach this card and mail it (postage paid). Or fax this side to:
HP Service Test Division, Attention Technical Publications Manager, at 978-266-3350.
Attention: Technical Publications Manager

Westford, MA 01886-4113
2 Robbins Road
Service Test Division
Hewlett-Packard

Postage will be paid by addressee
FIRST CLASS MAIL PERMIT NO. 56 WESTFORD, MA
BUSINESS REPLY MAIL

Fold here

Please do not staple
Tape here